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Introduction

Thank you for purchasing the Model 22X PCB Automated Optical Inspection (AOI) system. To ensure
proper use, please read this User's Manual carefully.

- It is forbidden to reprint or copy the part or all of contents of this manual without permission.
- Contents of this manual may change without notice for improvement.

Please be advised of the following:

1. Users should have basic computer skills. Personal computers and peripherals have been purchased
by proxy, and our responsibility, when failures or problems occur, shall be limited to making repair
and replacement requests to the computer manufacturer

2. Regarding all defects and bugs in the software, update notices will be sent to you for 1 year after
shipment. The latest software is available for free download at http://www.marantz-mek.co.jp .

3.Please dedicate a personal computer for use only with this device. Changes in the operating environ-
ment may lead to decreased performance or result in defective operation.

4. Failures and problems that occur within 1 year after purchase, and for which we are responsible, will
be repaired and improved at no additional charge. However, please understand that we will not be
responsible for any data loss that occurs during the repair process. Data restoration shall be the cus-
tomer’s responsibility.

5.The principle of pattern matching is based on measuring the level of similarity between two images.
The tolerances for determining similarity can be set higher or lower. However, the inspection result
may incline toward either OK or NG.

6. We will not be liable for any damage to the inspected PCB by our AOI or for missing or False NGs.

7. The brightness of lighting may change depend on environment, please calibrate the lighting regularly
using the 22X software.
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1. Model 22X

Model 22X is a PCB Automated Optical Inspection (AOI) system that inspects PCBs (Printed Circuit
Boards) for the presence of parts, misalignments, incorrect parts and letters, extra parts (such as sol-
der balls and scratches), as well as detecting solder printing, solder shorts and solder fillets.

H Model 22X Features

*The inspection process is very simple; using the mouse, just make a frame over the component/part to
be inspected or drag & drop the inspection frame from library on component.

*The Model 22X can inspect PCBs after many processes; after solder printing, after chip placer, after
mounter, and after re-flow.

*The Model 22X displays the inspection results in 3 view modes;
Map View, NG List View, NG Cell View.

H Inspection Procedure Overview
The Inspection procedure of Pattern Matching algorithm is as follows:

Place the Inspection Frame onto the part of the PCB that you want to inspect.

Store the Master Picture for each Inspection Frame. The Master Picture is an OK sample picture.
Compare the Inspection Frames to the Master Picture.

The Inspection Frame is divided into small grids and within each grid, if the difference rate caused
by the subtraction (displayed as light leakage) is within acceptable tolerances, it will be judged
OK. If the rate is out of acceptable tolerances, it will be judged NG. Color in each grid is also
checked, which means that even if the brightness and geometry are the same, the Inspection
Frame will be judged NG if the color is different.

As described above, the inspection method is quite simple, but OK/NG criteria can be customized in vari-
ous ways. Moreover, screen displays can be customized for ease of use. Various Inspection settings are
possible depending on the PCBs manufacturing process. Using this manual as a reference, please find
the method that best meets your needs.
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2. 22X Interface

22X interface differs depending on the camera. 4M interface and 5M interface are displayed here. For the
detail of each components, see the next page.

4M screen

5M screen
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Main Window (4M size Display)

-------------- il

—®

o4

6568

16 17,18 19
O C
@/./

D

Ne

o

No. Name Description
An area used in many tasks such as changing the displayed area or placing
1 Work area )
Inspection Frames.
] Used to create stamp from automatic stamp creation wizard, or select In-
2 | Pointer Tool . . .
spection Frames. Frames can be moved by dragging and dropping.
used to create Inspection Frames. The default is the Rectangle tool, but by
3 Inspection Frame |clicking and holding down the mouse, you can select the Rectangle, Oval or

Tool

Polygon. This tool can also be changed to the Stamp tool while

selecting a stamp.

4 | Move Tool Moves the camera and changes the display area.
This button moves the PCB to the front in order to gject it. By holding mouse
5 | Eject Button down, sub menu appears. You can select menu from “Eject”, “Home”, and
“Origin”.
When inspecting both sides of the PCB, this button allows you to select
6 | Swap A/B Button _ nepecting _ I P We Yo
either the A or B-side.
7 | Map View Button Used to create or display the Map View, or to display NG Symbols.
When you click on the frame, the PCB moves by the Pitch value. The Pitch
. value can be customized from the Settings Menu > Configuration > Gen-
8 | Pitch Button _ . . I
eral and changing the Pitch X%/Pitch Y%. Operator name is displayed on
the lower left of the frame and Lot number is displayed on the upper right.
9 | Message Bar Information and warnings about the inspection frame are displayed.
When you select the inspection frame in the Work Area, the Master Picture
. of the selected frame will be displayed here. The W button displayed on the
10 | Master Picture

upper left is the Master Picture Pull-Down Menu that includes menu items to
edit the Master Picture. The magnification rate can be changed at the top.

4

2. 22X interface




Main Window (5M size Display) ?

No. Name Description
Displays the position of each cell on the PCB. When a cell is selected, de-
11 | Cell Map Area tails of the selected cell are displayed in the work area. When a cell is se-
lected in the Cell Map Area, Inspection Frames will not be displayed.
12 | Cell Menu Button Pull-Down menu for cell operations.

13

Cell Selection Tool

The Cell Menu Button becomes active only after selecting this tool and
dragging over cells.

14

Cell Expansion Tool

The selected cell(s) within the Cell Map Area will be enlarged.

This tool allows you to set the blend rate when displaying the PCB image as
the cell map background. The PCB image will not be displayed when no cell

15 | Blend Tool , ) L .
is selected. The PCB image is displayed clearly at FULL, but the cells will
become somewhat blurry.

16 | Re-inspection This button is for inspecting the selected Inspection Frame again.

17

Analyze Button

This button is for analyzing the selected Inspection Frame.

18

Add Master Picture
Button

This button is for adding the selected Inspection Frame image as a Master
Picture.

19

Delete Button

This button is for deleting the selected Inspection Frame.

20

NG Pause Button

This button sets the system to pause when an NG point is found during in-
spection. To use this setting, click to highlight this button before inspection.

21 | Start Button This button starts inspection.

This button stops inspection. When this button is pressed, the next inspec-
22 | Stop Button ) , o ) ,

tion will start from the beginning of the inspection process.

This button pauses inspection. When pressing the Start Button, the inspec-
23 | Pause Button

tion is re-started from the paused position.
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3. Startup, Shut Down and
Authorisation

Operations for Startup and Shut Down as well as Authorisation are explained in this chapter.
If Software Installation or initial settings are required, please refer to chapters 25 and 26.

3-1 Startup

The Startup procedure is as follows:

1. Turn on the power on the 22X machine.

2. Press the power key of the Mac to start up the computer.

3. If the 22X software is included as a startup item, the program will launch automatically. If not,
double click the 22X icon to launch the software.

4. After starting up, message for machine warm-up will be displayed. This message will be dis-
played whenever you reboot the computer.

5. When the “Warm-Up” button is clicked, the 22X machine confirms the Origin positions and
begins the warm-up procedure until lighting stabilization is done. Press “Cancel” button, and
message will disappear when warm-up procedure is not necessary.

6. If warm-up procedure is not done, press “Origin” button to confirm the Origin positions.

* The user can set the warm-up time. Click on the clock icon in the warm-up dialog to enter the warm-

up time. The warm-up time can be set in minute increments ranging from 5 to 60 minutes.

3-2 Shut Down

The Shut Down procedure is as follows:

1. Select Shut Down from the File menu to shut down the 22X software.

2. Select Shut Down... from the Apple Menu on the left top corner of the Mac screen to shut
down the system.

3. Turn off the power on the 22X machine.
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3-3 Authorisation

Authorisation sets the user level.

Operator Mode ...... Allows operations for inspection.
Programmer Mode ...... Allows editing of inspection programs.
Supervisor Mode ...... No limits.

The mode can be changed by selecting File menu > Authorisation (Screen 1). Supervisor Mode is re-
quired to make 22X system settings. In that case, please follow these steps:

1. Password setup is required when you enter Operator Mode for the first time. When the entry
dialog is displayed, enter a password up to 16 characters.

2. Enter the password again and the mode will switch. The software will launch in the selected
mode the next time you run the software.

Menu bar is hidden on the Operator Mode. Following items are displayed when clicking the top of 22X:

Open Opens an inspection program.

Open Recent file Opens the lis of programs recently used.
Operator Login Logins by entering an operator name registered.
Edit Mode Switches authorisation.

Print Prints a list.

Lot Number Enters a lot number.

Verify all locations without inspection Confirms every locations.

Use Barcode Reader Uses a barcode reader.

Shut Down Closes 22X and turns off the Mac.

* The password is required when changing from Operator Mode to Programmer Mode, or from Pro-
grammer Mode to Supervisor Mode.
* In Programmer Mode, the following items in the Settings menu cannot be changed; Calibrate Pixel/

cm, For Supervisor, Mechanical Calibration (except Check) and Reset Camera.

3-3

(Screen 1) (Screen 2)
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3-4 Operator Login

Who was operating AOI? By using Operator Login function, it will be obvious. Operator Login should not
be set if AQI is run by one person. But in the factory, many operators may work in different time schedule.
The AQI operator name can print on roll-paper or send to data server software CS-Center together with
the inspection result.

Please create and activate account as following;

1. Start 22X in Supervisor mode or Programmer mode.

2. Select Operator Account in Settings menu's Configuration (Screen 1).

3. Operator Account window opens (Screen 2). Press "+" button to add new operator, and press
"-" button to delete operator.

4. Set Log-in ID, Password, and Protect mode (optional). Protect mode can be selected from
"Unset", "Operator Mode", "Programmer Mode", and "Supervisor Mode". Initial setting is "---"
(No setting). Setting stays as same as setting which had been set at last time you close 22X.

5. If the checkbox "Show Login window at software startup" is checked, log-in window is
displayed at startup from next time, and software can't be started without log-in (Screen 3).
After log-in, the [Logout] button is displayed.

6. 22X starts by Protect mode which had been set at procedure 4. Operator name is displayed
after log-in at the bottom left of Work Area (Screen 4).

7. If you start software in Operator mode, Operator Login menu is selectable and operator can
login also from this menu. This menu is useful at factory, in case the line keeps working and
can't stop AOI, from this menu, new operator can login without stopping AOI.

* In order to save AOI Operator name, "Show Login window at software startup" must be checked and
all staff has to login always.

3-4

(Screen 1) (Screen 3)

(Screen 4)

(Screen 2)
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AQI operator name can be confirmed on repairing software CS-Repair greater version than below.

CS-Center: Version 1.1.3.1 CS-Repair: Version 1.1.3.2

9
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4. Quickstart Guide

In order to use this software effectively, it is important to create an accurate Inspection program.. Creating
a good Inspection Program is the key to enabling a smooth inspection process. This chapter outlines the
operation for creating and verifying an Inspection Program (please refer to related chapters for details of
settings and other items).

Work Flow

Here is the basic inspection work flow:

4 N

WV [Creating Inspection Program ]
1. Preparation
Execute Automatic calibration.
2. Setting the PCB (Described in Chapter 6)
Correctly set the PCB and place Fiducial Mark(s).
3. Creating Stamp Library (Described in Chapter 7, 8 and 9)
Create Inspection Frames on the components you want to inspect. Only area where these
Inspection Frames are placed will be inspected.
4. Pasting Stamps
Paste stamps on the same components on PCB
5. Cell Optimization (Described in Chapter 11)
Merge neighboring cells to reduce the inspection time.
6. Test Run / Improvement
Test run the Inspection Program with the PCB used to create the program. If there are any
problems, review the program..
7. Creating Map View (Described in Chapter 12)
Create Map View for verification/classification.

V[ Tune-Up ]
8. Inspect another PCB

Run the Inspection Program with different PCBs.

VW [ Starting Inspection |
9. Let's start inspection
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The above is just one example of an inspection workflow. The optimal method will vary depending on your
environment. Once you are familiar with the application, please identify the optimal method for effective
inspection.

* This software can handle CAD data when creating an Inspection Program (comma or tab delimiter
data in the CSV/Text format). By loading CAD Data, you can set Inspection Frames based on loca-
tion data contained in the CAD Data. Since part numbers are included in the data, it is much easier
to find the corresponding parts, and much faster to make the Inspection Program. Details for this
process are described in the following chapter.

4-1 Preparation

V¥ 4-1-1 Selecting the PCB

For accurate inspection, you need to select a reliable PCB to create the Master Pictures. Due to varia-
tions in the color of PCBs and components, and the glare of the solder, trial PCBs and old PCBs are not
suitable for creating the Master Picture.

V¥ 4-1-2 Calibration Settings
Confirm whether brightness and color are set up correctly

. Select Calibrate from the Setting menu.
. When the dialog “Move to calibration position?” appears, click OK.
. The Work Area is colored in grey and the color meter will be displayed.

AW N

. Click on the Auto Cal. button and make sure that all the color meter indicators except for satu-
ration and hue are pointing close to the center. In some kind of machines, indicators may lean
(Screen 1).

5. If your AOI has Diffuse-On Axis LED, press [renew DOAL timing] to adjust the lighting timings.

6. Press Finish to exit calibration.

7. Press the Eject button to move the carrier to the front.

In case of 5M + ML Lighting

Screen 1)

"
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V¥ 4-1-3 Environment Settings Confirmation

Select General from the Setting > Configuration menu. Normally, this can be left at the default set-
tings, but the settings may need to be changed depending on the PCB. Please refer to Chapter "Settings"
for details.

4-2 Setting the PCB

V¥ 4-2-1 PCB Carrier Adjustment (Desktop type only)

The carrier width should be adjusted to match the width of the PCB. Loosen the knobs on the carrier rall,
adjust the width to match the PCB, and tighten them well. If the PCB is even slightly loose, the results will
not be accurate, so please make sure that the PCB is completely fixed (Screen 1).

In F series and S (GTAZ) series with top clamping, PCB will move to the position of clamping when clicking
“PCB Width Setting in sub menu when PCB is in eject position (Screen 2). You can adjust the width to
prevent PCB shifting after moved position. Also the model with the area sensor can perform adjustment
without detecting a sensor.

V¥ 4-2-2 Fiducial Mark(s) Setting
Set fiducial marker(s). For more detail, see the chapter 6 “Create Fiducial Markers”.

1. Display a marker in the center of the screen by using the Move Tool and Pitch Button.

2. Select Inspection Frame Tool, and create a frame about twice the size of the marker (Screen 1).

3. Select Assign Fiducial Mark from the Edit menu. A square icon appears within the frame, and
this frame will be recognized as the Fiducial Mark (Screen 2).

4. Click the frame to display the Marker Setting Window. Choose a method to detect a Fiducial
Mark from tabs above the window.

5. Activate the Centering Button by adjusting Contrast divergent Lever on method1 (Screen 3) or

U-2-1

(Screen 2)
4-20 (Screen 1)

(Screen 1) (Screen 2)
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4-2-2
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(Screen 5)

clicking Histogram on method?2 (Screen 4).
6. Keep pressing Centering Button to unite red lines above the button (Screen 5), then click OK.
7. Following the same procedure, set a second Fiducial Marker (Sub-Marker) on the diagonally op-
posite side.

4-3 Creating Stamp (Library)

This software inspects only the areas designated as Stamp Frames. It first checks the Inspection Frame
displayed on-screen, then the nearest Inspection Frame and so on. Creating Inspection Frame is a

very important process that defines the areas to be inspected while also creating an Good sample for
comparison. The recommended procedure here is to create Stamps starting from the top left and then
move right or down by Pitch Button.

You can create stamp by drawing frame with mouse. Please refer to Chapter 7 for creating stamps.

13
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4-4 Pasting Stamps

Library for many components may be created in the previous step. Next step is placing stamps on all
components on PCB. When you have CAD data, move to the next chapter. When you place stamps
manually, there is two ways to place stamps; “one by one” or “multiple and automatic”

The operation to place “one by ong”.
Select “Stamp Palette” from Stamp menu. Stamp list will be shown. Select a (pack) stamp. After
selecting a stamp, mouse cursor holds transparent stamp picture (Screen 1).
Move mouse cursor onto the component, and click the mouse. Stamp will be pasted.
There are two methods for "multiple and automatic" paste. One is to paste stamps on the similar images
of the current view in Work Area and the other is to paste stamps on Map View, that is, on the whole PCB
at once automatically.

The method to paste stamp automatically in the current view:

1. Select “Stamp Palette” from Stamp menu. Stamp list will be shown. Select a (pack) stamp, the
mouse cursor holds transparent stamp picture (Screen 1).

4-4

(Screen 1)

2. Select "Automatic Paste (Current View)" from Stamp menu. Stamp will automatically be
pasted on similar components in Work Area (Screen 2).

*The number of stamp pasted is shown in the message bar at the bottom left.

4-4

| L

(Screen 2)
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4-4

=

(Screen 3)

3. There is short cut for "Automatic Paste", press "command + g" on keyboard. After executing
Automatic Paste, if there is still a few components on where no stamp is pasted, press
"command + g" quickly twice or three times. The threshold of matching is more tolerant on
second and third "command + g". As a result the components on where no stamp is pasted will
now have stamps (Screen 3).

The method to paste on the whole Map View:

1. Select “Stamp Palette” from Stamp menu and show Stamp list on the screen.
2. Create a Map View by clicking the glasses icon of the bottom menu bar.
3. Select "Automatic Paste (Map View)" from Stamp menu. [Automatic Paste List]
window appears. Add here the stamps you want to paste from the stamp list .
First, click a stamp from the Stamp list and move the mouse cursor to [Automatic Paste
List] window. When the mouse cursor shape changes into "+", click the mouse there.
The stamp is added in [Automatic Paste List]. (Screen 4)
If you want to paste multiple stamps, repeat the same steps. If you want to delete a stamp from
the list, click on the stamp and press [delete] key from the keyboard.

*Stamp without Master Picture cannot be added in the Automatic Paste List.

4. When completed the [Automatic Paste List], click [Start] button and 22X software starts pasting
the stamps in Map View.
* Stamp is not pasted at the edge of frame.
* Stamp is not pasted on angled component (such as 30 degrees, not 0/90/180/270 degrees).

* Stamp is pasted by referring master picture, therefore not all stamps are pasted.

4-4

(Screen 4)
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4-4

=

(Screen 5)

There stamps won't be pasted automatically: color too simple (one or two colors only), not
characteristic, including solder which shape and reflection differs. (Screen 5)

* The automatically pasted stamps have frames colored in red. By pressing [Stop] button, the
frame color turns back to normal.

* Automatic pasting on Map View takes time. (It takes about 20 minutes to paste 10 different
stamps on M sized PCB.) Recommended to use this function when you have enough time.

4-5 Cell Optimization

By optimizing cells, neighboring cells will be merged, thus reducing the total number cells and improving
inspection speed. After placing inspection frames, select all cells in the Cell Map, click on the Pull-Down
menu and select Cell Optimization (Screen 1).

* This is not necessarily the best way for optimization. There are other methods for optimization. Refer
to Chapter 11, "Cell Operation" for more details.

4-5

(Screen 1)
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%-6

(Image 1)

4-6 Tune-Up/Improvement

Now, click the Start Button

If the procedure has been followed correctly, the inspection will be executed starting with the Main Mark-
er > Sub-Marker > Inspection Frames, then move to the Eject position and OK/NG will be displayed in
the Work Area.(Image 1).

If NG is displayed, the filter setting may be too sensitive, reacting to camera noise or even to slight board
misalignments. Please check the NG Inspection Frame and adjust filter settings. For adjusting, please read
Chapter 8 for pattern matching frames, and Chapter 9 for histogram frames. Adjust untill all inspection
frames to be OK.

* In this procedure, the exact same PCB is being inspected, but it will not always return a 100%
match. The discrepancies are due to slight differences between the picture from the Master Picture

setup and the picture at the time of inspection. To avoid unnecessary re-inspections, this program is

designed to judge OK within a user-set range of acceptable tolerances.

4-7 Creating Map View

Click on the Eyeglass Button to create a PCB Map. NG points are displayed in red. Now, the work for
creating the Inspection Program is complete.

4-8 Inspect other PCBs

For the next step, the Inspection Program should be tested using a different PCB. Since the condition of
components/parts varies from PCB to PCB, it is important to test the inspection program using a second
PCB to adjust the tolerance of the Inspection Program in order to avoid False NGs and missing NGs.

1. Remove the PCB used for creating Inspection Program and set a different PCB.

2. Press the Start button on the machine to start inspection.

Even though there may be no actual NGs, slight differences will be detected NG. These will be displayed
on the screen as red frames or red cells (Screen 1).

3. If there are any NG points, the Map View with red marked NG points will be displayed after the
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4-8

(Screen 1) (Screen 2)

inspection. (when Display NG on Map is checked in Setting > General Setting (Screen 2)),
otherwise an NG message is displayed in the Work Area.

If NG is displayed, the filter setting may be too sensitive, Please check the NG Inspection Frame and
adjust filter settings. For adjusting, please read Chapter 9 for pattern matching frames, and Chapter 10 for
histogram frames. Adjust untill all inspection frames to be OK.

4-9 Actual Inspection

Inspection preparation is now complete. Let’s start inspection. While inspecting, if there are too many false
NG or a missing NG, please read next “Handling of missing NGs” and “Handling of false NGs”.

* Please carefully check if there are any NG points that have been missed or if there are any OK points

that have been flagged as NG (False NG). The following explains how to handle these cases.

4-10 Handling of missing NGs and false NGs

If an obvious defect has been missed or good components are detected NG, please try the following. In
order to reduce False NGs, the filter setting should be kept at high accuracy while slackening the tolerance

- Tune-up parameters of Pattern Matching and Histogram stamps.
- Change inspection algorithm (Pattern Matching <-> Histogram <-> Others).

First, you need to analyze the cause of the missing/False NG and find the problems.
Following is the methods to measure false NG of pattern matching frames.

V¥V 4-10-1 Analysis
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Following is the procedure to analyze False NGs.

1. Select the frame which was judged as NG. If you have moved from the Map View or the NG List
View, it is already selected.

2. Click on the Analyze button on the right. (Analysis can be suspended by clicking on the Stop
or Pause button.)

3. The interior of the frame is separated by grids. The sections divided by grids are colored in blue
or red. The blue frame is the matching area and the red frame shows the area that does not
match. In order to be judged as OK, all grids must be in Solid lined blue. The definition of the
grid colors is as follows (Screen 1).

Blue frame (Solid line) ... Within acceptable tolerances (OK)

Blue frame Dotted line ... Slightly out of acceptable tolerances NG
Red frame Solid line ... Matching NG

Red frame Bold line ... Saturation or hue NG

First, you need to closely study the color of the frames.

4. During the analysis, the cursor changes to a triangle, designating the direction being searched
for a matching pattern. The frame moves slightly to find the matching pattern.

5. In the end, the search for a matching pattern will terminate, marking the area as an NG. In this
case, the message bar will show the major causes of the failure. The failure definitions are as
follows:

H Mismatch - A pattern matching method is evaluated on each element of RGB. Pattern matching is
evaluated at each required resolution, and if acceptable tolerances are not met, it will be evaluated as a
Mismatch.

W Mismatch by Hue - After pattern matching is OK, hue differences are evaluated. Hue differences must
also fall within defined tolerances.

W Mismatch by Saturation (too low/too high) - After matching by hue, saturation differences are evaluated.
Saturation differences must also fall within defined tolerances.

After finding the problems, read Chapter 9 and change filter settings, add more master pictures or use
lighting selection to reduce missing/false NGs.

6. With Histogram stamps, open the setting window after analysis. You can confirm the % and
thresholds, read Chapter 10 and take measurements.

4-10-1

(Screen 1)
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4-11

(Screen 1)

If the frame has multiple Master Pictures, switch the Master Pictures and press the Analyze button again.
The analysis is executed only on the activated Master Picture.

4-11 Updating Stamps

When adjusting various Inspection Frames, you may need to change the frame size or the filter settings of
the same Stamp that is used in more than one place. If you change settings on Stamps one by one, you
are not taking full advantage of "common stamps".

Therefore, we recommend that you find optimum filter settings that can be used under as many conditions
as possible, and apply these changes to the Stamp itself. By using this method, you will no longer need to
edit the filter for each Inspection Frame. Just click on the Revising Stamps button (Screen 1) and select
Update all.

4-12 Save

Save the Inspection Program. For new Inspection Programs, the command will always be "Save As".
Changes to the software environment are also saved. From V6.8.0, a [Backup] folder is automatically cre-
ated in the folder where the inspection program is saved, which stores up to 3 generations of backups.
The backup file name will be [filename_backup-date-ofcreation].

1. Enter the file name.

2. Click on "Save".

3. The window title will change to the saved name.
* File name should be within 31 bytes. If exceeds, file name may not be shown/saved correctly.
* Save the programs in disks in Mac formatted. If you save them in Windows PC or Unix system

including NAS server, the program files are destroyed and you can't open them.

It is also possible to save data for both the surface and the back of the PCB as SIDE A and SIDE B. Refer
to 6-5, "Fiducial Mark and PCB side" for details.
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5. GAD Data Application Guide

This software can import CAD Data and NC data (Numerical Control Data) created by the P&P machine.
In this manual, such Data is called NC data. NC Data is a data file which indicates the coordinates of
components. The coordinates can be used to place each Inspection Frame into the Inspection Program.
This chapter explains how to apply NC Data.

This is a very useful method for positioning Inspection Frames, but since the size of the frame is not

included in the data, some additional works are required.

5-1 File Format to Import

The file formats that can be imported are one of the following. Rotation direction is counter clockwize.

1. CSV/TEXT Format (Comma, Tab separator)

This software also supports tab-delimited and comma delimited data. One component information must

be written in one line.

(Example)
1215,00795,000,1,R123, Partsname 1
1210,04455,090,2,C123, Partsname 2
3605,04430,000,3,D123, Partsname 3
3580,02665,000,4,E567, Partsname 4

This format follows the order “X, Y, W, Z, Ref.Des, Part Name”.
) S Absolute location in direction X in 1/100mm units (Example: 123.56 X12356)
Y...... Absolute location in direction Y in 1/100mm units (Example: 345.67 Y34567)
W...... rotation in 90 degree increments (Example: W00180)
Z....... Part cassette number

The absolute position in the .XY direction is in 1/100mm units, but when decimal points are included, the

data will be interpreted in mm units.

2. Panaformat Type 1

Text format, file starts with a “$” and ends with an “*”.

(Example)
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$
N001/0G1M0T004X+00000Y+00000Z-00V+W+

N002/0M004T000X-14760Y-18930Z001V3W7

N051/0M004T000X-14990Y-189852025V1WA1
N052/0M000T000X000000Y000000Z025V1WA1
N053/0*

In the example above, the software imports only X, Y, Z and W data (other data will be ignored).
* Numbers for W can be 1 = 45 degrees, 2 = 90 degrees, 3 = 135 degrees in Pana format. Do not

forget to press Step 90’ in following procedure to avoid to treat W=1 as 1 degree.

3. Panaformat Type 2

Type 2 includes Ref.Des and Part Names in addition to X, Y, Z and W values.

(Example)
% HEADER

% NCDATA
NOOO1X0YOWOZ1PN ()C ()M000100T/0;MARU1515
N0002X-08340Y+1666°0W000Z001PN (R1234)C (R 01)M000002T0/0;

4. 22X Data Format

Format that is output by 22X, which can be imported to 22X.

(Example)

$
X20300Y04500W00180200062;R121 \RA05010205

X21100Y11500W00180Z00062;R77 \RA05012005
X20300Y11500W00180Z00062;R10 \RA05047205

The format follows these rules:
$...... Data start
Ref.Des, 15 characters or less (Example: ;ABC)
\...... Part Name, 31 characters or less ( Example: \RA345)
data is delimited with line breaks
* e Data end
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Ref.Des and Part Name must be placed after the separators (X, Y, Z, W) and Ref.Des always precede Part
Name. Ref.Des and Part Name must not include " or “\.

Ref.Des and Part Name are not a requirement for NC Data. However, Ref.Des make the program much
easier to understand since Ref.Des will be included in the Stamp’s information and when showing the
inspection result in the Map View, 22X will display the Ref.Des next to the red circle pointing NG. When
applying Stamps to the corresponding components, the inclusion of Part Names will allow for a more
intuitive matching process. If NC Data contains the Part Name, the Stamp Name will be automatically gen-

erated from the Part Name while in Teach Mode.

5-2 Creating Stamps from CAD Data

5-2-1 Setting the PCB

Set the PCB. The PCB must be completely non-defective.

5-2-2 Importing Stamps
When using NC Data, a common technique is to create a Stamp beforehand, and apply the Stamp to the

components after importing NC Data. Before Importing NC Data, you should Import the Stamps that cor-

respond to the Part Names.

5-2-3 Importing NC Data

Select Import Data File from the File menu, and choose the NC Data file. NC Data can be imported for
either side A or side B, but the Inspection Frames for the first side must be set and Combine Cells After

Import must be completed before importing the other side.

5-2-4 Adjust PCB rotation

When NC Data is imported, the CAD coordinates arrangement window showing the coordinates of the NC
data will appear. Align it until it comes at the same position as the PCB by 3 buttons in orientation menu.
PCB size is shown at the bottom of the window.

* If the angle direction of your CAD data is clock wise, press flip to cw button.

Horizontally

When the lateral position of the layout and the actual PCB is inverse, click on Horizontally.

Vertically

When the longitudinal position of the layout and the actual PCB is inverse, click on Vertically.
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90 Degrees

When the layout and the actual PCB is misaligned by 90 degrees, click on 90 Degrees will rotate in ccw.

flip to cw
Switch the direction of rotation. Default rotation directory of this machine is counter-clockwise, but some

Mounters rotation is clockwise. By pressing this button, the rotate direction will be clockwise.

Flip marks
The coordinates X and Y are represented by the symbol mark of long square in the Position adjustment
window. By pressing this button, the marks rotate +90 degrees. This button only changes the view..

* When rotating Horizontally/Vertically, component angle may not match to stamp angle.

Step 90°
If you want 22X to interpret 89 degrees to 90 degrees because of inaccurate P&P machine, or data is in

Panaformat, press this button to convert odd angles to 0/90/180/270.

5-2-5 Positioning
Align the actual components shown in the Work Area and the NC Data coordinates shown in the Position

Adjustment Window by taking 1 fiducial point and 1 reference point (maximum 4 reference points).

(Screen 1)

1. If the data contains Part Name and Ref.Des, the CAD coordinates arrangement window will dis-
play the Ref.Des and Part Name when you move the cursor over the marks of coordinates. First,
select a point to be a fiducial and double click on it. The point should be nearest point from the
corner. The clicked point will be colored in red (Screen 2).

5-2-5

(Position Adjustment Window (Screen 1) (Screen 2)
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2.

In the Work Area, move to the component which corresponds to the coordinate chosen in
step.1, and set the component in the center of Work Area. Moving is possible by 4 arrow keys.
You can move 1 pixel by clicking arrow key. You can move 8 pixel by clicking arrow key with
pressing option or control key. You can move 64 pixel by clicking arrow key with pressing op-
tion + control keys. You can move a Cell by clicking arrow key with pressing shift key.

Click "Set fiducial" (Screen 3). The red color will turn blue, green grid is displayed and the win-
dow in separated into 4 blocks.

. Next, select a point in the CAD coordinates arrangement window that is diagonally opposite to

the fiducial point. This will be a reference point. Click on the mark, and it will be colored red,
and the camera will automatically move to that point in the Work Area.

. The component selected as a reference point will be displayed in the center of the Work Area.

If it is accurately aligned in the center, click OK and skip step 5. If it is misaligned, Move the
actual component to the center of the Work Area as well as step 2. After adjustment, the blue
point will be appeared at the corner of that block. (Screen 4)

. Confirm if the coordinates are in the center of the Work Area by clicking some marks. If they are

not aligned in center, take 2nd reference point. The 2nd reference point should be set in the
block where no fiducial or 1st reference point is set. After setting 2nd reference point and con-
firmation, if there is still misalignment, you can set 3rd reference point. (Screen 5) If your PCB is

5-2-5

(Screen 3) (Screen 4)

(Screen 5) (Screen 6)
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very large and the center of PCB is warping, you can set 4th reference point in the center area
which the color is altered.

6. If the CAD data contains fiducial markers coordinates, you can create main fiducial marker and
sub fiducial marker from the coordinates by setting them as fiducial point and 1st reference
point. In this case, click on the fiducial point or 1st reference point by pressing control keys.
Then blue fiducial point changes its shape into square, and red 1st reference point changes its
shape into circle. (Screen 6)

Note: Hints for selecting a fiducial and reference points

There are not many PCBs on which CAD coordinates match perfectly. Especially PCBs after reflow
oven are expanded, and after cooling down, they are shrinking and warping.

When setting a fiducial or reference point, the software can calculate the more accurately the closer

you set these points to the corners of PCB.
In case, if the components’ coordinates are gathered and there is distance from one fiducial marker,
delete coordinates of fiducial markers and arrange rest of coordinates, then create fiducial markers

manually. In this way, components’ coordinates can be set more accurately.

o /

* Reference points can be reset by pressing clear key, however fiducial can not be undo.

Click the OK button, the apply stamps window will appear.

5-2-6 Applying Stamps

The next step is applying stamps to Parts Name or Z number. When importing NC data, if the data has
Parts Name, then Parts Name is displayed in Stamp Applying Window than Z number. "Zxxxx" represents
the data without a Part Name. The software automatically names the components without Part Names.

"xxxx" begins from 0000.
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5-2-6
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(Screen 1) (Screen 2)

Stamp Applying Window (Screen 1)
1. Display coordinates of selected Parts Name in Work Area. If you can not guess a component from
Parts Name, it is possible to confirm the shape by moving with these buttons.
. Apply stamp automatically if Parts Name is equal to Stamp Name.
. Undo applying and delete newly created stamps.
. Parts name or Z number in NC Data file is listed.

. Total number of the parts.

If stamp library is loaded in advance, displayed here. The stamp in blue color represents Pack stamp.

2

3

4

5

6. Column to place the applicable stamp.

7.

8. Click on a Pack stamp, then stamps to configure the Pack stamp is displayed.
9

. Selected stamp or pack is displayed.

10. A copied stamp is created with new name of "Applied stamp name _ Parts Name". Press this button

with option key to apply the action to all stamps on Applying List.

11. Action settings window (Screen 2) is opened. Actions can be set when New Stamp button is pressed.

New stamp has master picture
Snap master picture automatically during Teach Mode (first inspection after quitting this Window.).

New stamp is created in Parts Name

A new stamp is created with “Parts name”. It is useful when you would like to manage stamps in origi-

nal CAD names. On default, new stamp is created with the name of "Stamp name_Parts name".
New stamp is created in root folder of Stamp List
The new stamp is created in the root directory of Stamp List. The advantage of creating new stamp

in root directory is that you can apply stamps by "Name to Name" next time. This is an option when

New stamp is created in Parts Name is active. On default, new stamp is created in the same directory

as applied stamp.

Enable partial match when NameToName

Stamp with same end-text can be searched. On default, when applying stamps by Name to Name,
whole Parts name should match to stamp name.

12. Search stamp(g).
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5-2-6

(Screen 4)

(Screen 3)

Basic procedure when applying stamps. (Screen 3)

- When you have no stamp library, do nothing and click OK.

- When you load stamp library, and there are stamps with same name as Parts name, execute "Name
to Name".

- When you load stamp library, and apply stamps from Stamp List, drag & drop (or double-click) the
stamps onto Applying List. If you want to apply a stamp to more than one components, select
by pressing shift key or command key.

- If you like to apply copied stamp from original stamp, press "New Stamp" button after drag & drop a
stamp.

Once applying is complete, click "OK". When there are no corresponding Stamps, a message "Some
CAD name was not applied any stamp. Are you sure to continue?" pops up. By pressing OK,

a message to ask Cell Optimization (Combine Cell) pops up.

5-2-7 Cell Optimization and converting Parts names to comments

In the message, you can select to optimize Cells now. (If no stamp is applied to any component, this
message does not be displayed because optimization is impossible.)
By executing Cell optimization, you can reduce inspection time because the number of Cells are

decreasing by combining Cells.

In case stamps are applied to all components, another message pops up. The message asks you to
execute only Cell Optimization (Optimize) or Cell Optimization + converting Parts names to comments
(Opt.+Comment). If you select Opt.+Comment, the Message Bar will display the Part Name during the
inspection in G/NG Confirmation Mode. If you only execute Optimize, you can not execute converting
Parts names to comments any more in following process. Then, Stamp Applying window will disappear,
and many squares (cells) will be displayed on the Cell Map (Screen 4).

* In case, some components are not applied stamps, the selection of Opt.+Comment is not displayed.
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5-2-8

(Screen 2)

(Screen 1)

(Screen 3)

5-2-8 Teaching

Click the Start button to start Inspection for Teaching.

Components without Stamps will show red cross marks, and the Inspection will pause here. The mes-
sage "No frame. Draw or pick stamp" will be displayed in the Message Bar. (Screen 1)

You can select a Stamp from the Stamp List

* To create a new Stamp from existent Stamp with a Part Name from CAD Data. Select a Stamp and

click the Copy button to activate the copy stamp option

In order to create a new Inspection Frame, Draw a Frame on the component with the Inspection Frame
Tool. Once a Frame is drawn, the inspection will proceed to the next component. When drawing a frame
by mouse, a pattern matching type frame will be created. But, if you switch Inspection Frame Tool to
Selection Tool (Screen 2) and draw a frame, Stamp Creation Wizard will be displayed and you can create
Pack stamp or Passive Component stamp (Screen 3).

* For detail of Stamp Creation Wizard, please read Chapter 7.

When stamp is assigned to all coordinates, teaching is completed

* Please move on to the next step even if there are NG points due to stamp misalignment Later,

misalignment can be adjusted.

29

5. CAD Data Application Guide



5-2-9 Changing Stamp Angles

With the Stamps created during NC Data import, all the same Stamp placed in the Work Area can be
rotated. Select a Stamp you want to change the angle and select Flip/Turn > Rotate Right/Rotate Left
in the Edit menu by pressing the Option key.

* After applying the Stamps, please make sure that the Inspection Frame is correctly overlaid on the
component in the Work Area. If the Inspection Frame is at an incorrect angle, the Stamp’s 0 degree

can be different from component in CAD data’s 0 degree.

5-3 Convert Part Names to Comments

If Part Names are not converted into Comments, execute this process right after.

Select Part name to comment from the Edit menu. This process should be executed before Combine
Cells After Import. After Combine Cells After Import, Part name to comment can no longer be se-

lected.

5-4 Combining Cells

After creating Inspection Frames, sometimes the positions of Cells are not ideal. Therefore, it is best to
merge cells together to improve efficiency. Select Combine Cells After Import. Neighboring cells will be
merged into single cells or optimized.

* If Combine Cells is not executed, a warning message will be displayed every time at file opening.

5-5 Confirming position of Inspection Frames

Click on the Cell one by one in the Cell Map Area to check if the Inspection Frames are placed in the cor-

rect positions.

* If all the Inspection Frames are misaligned toward a certain direction, press the command and op-
tion keys and drag the Work Area in order to adjust the components to the Inspection Frame using

the Pointer Tool.

5-6 Importing Additional CAD Data

After Combine Cells After Import is complete, additional NC Data that has been created separately, can
be imported into the same Inspection program. Additional imports are possible only after Combine Cells
After Import. It is impossible to apply a different Stamp to a component to which a Stamp has already

been applied in the first NC Data import procedure.
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5-7 Placing Fiducial Marks

In general, the NC Data does not contain Marker locations. If Markers are necessary, manually add the
Fiducial Marks.

* The sample screens of NC Data contain Marker locations.

5-8 Editing Stamps

Inspection Frames that did not have corresponding Stamps become new Stamps automatically. The
created Stamps have names of Part Names. "Zxxx" should look like "Z0012". Double click on the Stamp
Name shown in the Stamp List Window to change the Stamp Name.

If the stamp in the Stamp Library has an angle other than O degrees, the Stamps positioned in the Work

Area will be at an unexpected angle. In this case, refer to Chapter 10, "Stamp".

5-9 Filter Settings

Automatically created stamps are not optimized in filter settings. It may be necessary to set up filters for
each stamp (refer to Chapter 8 for Filter Settings).

If you change the settings of a stamp, the changes are automatically applied to all stamps of the same
type. If you change the size of a stamp or add/delete a master picture, click the Stamp Update button in
the upper right corner of the master picture area to apply the changes.

* If there are any stamp misalignments, improve the position.

* This chapter has covered the first half of Chapter 4, "Quickstart Guide". Please see 4-6 "Test Run/

Improvement" to continue.
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Note: Importing Gerber Data
Gerber Data converted by GBtmz software for Windows® can be handled like CAD Data importing.
Import the Gerber Data, and switch to one of the 3 buttons Solder Paste Inspection Frame,

Inspection Frame, and Positioning Only in the Position adjustment window for setup (Screen 1).

The Solder Paste Inspection Frame button automatically positions all of the frames as for
Solder Paste Check. At this time, the Stamps are created depending on the size of the Inspection
Frames.

The Inspection Frame button automatically positions Inspection Frames. However, since the
Gerber Data converted by GBtmz does not contain Part names, Stamps cannot be created auto-
matically.

The Positioning button does not create Frames. Press the Start button. When the inspection
is paused on the component marked by red cross, apply a Stamp from the Stamp List. Inspection

points that seem to be the same size, will have the same Stamps applied automatically.

The all zoom button is active on default. This means that all inspection frames will be Zoomed
frames. This button can be OFF by clicking. This means that frames which width or height is more
than 12 pixel will be non-Zoomed frames, and rests will be Zoomed frames.

* It is not possible to create Markers from fiducial/1st reference points.

Create Solder Paste Inspection Frame|

Create Inspection Frames

Positioning Only

(Screen 1)
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6. Fiducial Marker and PGB Side

When handling PCBs that have Fiducial Marks, you should set up the Fiducial Markers first for smooth

inspection data creation, and giving offset to PCB.

6-1 Create Fiducial Markers
You can select 3 methods - Method1, Method2 and Picture - to create Fiducial Markers. In plinciple,

Method1 or Method2 are used. Picture is used only when the Fiducial Marker cannot be detected.

6-1-1 Procedure common to Method1 and Method2
This section describes the marker creation procedure common to Method1 and Method2.

1. Display a marker in the center of the screen by using the Move
Tool and Pitch Button.

2. Select Inspection Frame Tool, and create a frame about twice
the size of the marker (Screen 1).

3. Select Assign Fiducial Mark from the Edit menu. A square Soreen -

icon appears within the frame, and this frame will be recog-

nized as the Fiducial Mark (Screen 2).

4. Click the frame to display the Marker Setting Window. Choose

a method to detect a Fiducial Mark from tabs above the win-

dow. If you select a method different from the initial setting, a Screen 2

confirmation message for resetting the setting will be displayed. Select Continue.
* The initial setting can be changed from Default Method on Details.
5. Select the shape, color, and black/white setting according to the shape and lightness of the

marker. AT (automatic) is basically used for color setting.

The following steps are different for Method1 and Method2. The following items explain each procedure.
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6-1-2 Procedure for Method1 612

Method1 is compatible with software Ver. 6.1.1 and prior. B

1. Adjust the Contrast divergent Lever so that the binarized part
on the screen has the same shape as the marker (Screen 3).
2. Centering button is activated after adjusting the Contrast

divergent Lever. Continue to press it down until red lines above Screen 3

3. Following the same procedure, set a second Fiducial Marker on the diagonally opposite side.

For more detail of the settings on Method1, see 6-2-2.

6-1-3 Procedure for Method2

Method2 is a highly accurate marker.

If you open an inspection program that includes this marker with software Ver. 6.1.1 or earlier, the marker

cannot be detected. You need to recreate a new marker. 6-1-3

1. Lines are spread from corners to around when Method2 is
set. Those lines mean a search range of the marker (Screen 4).
Search range can be edited on the setting.

2. Click the histogram part to binarize. Adjust settings so that the Screen 4

binarized part on the screen has the same shape as the marker

(Screen 5).

3. Centering button is activated if the marker is detected.

Continue to press it down until red lines above the button

4. Following the same procedure, set a second Fiducial Marker on

the diagonally opposite side.

Screen 5
Text area turns red if the detection fails. If auto detection fails, un-
&
check Auto Binarize and manually operate the threshold bar to find (I
11
a place where binarization is possible (Screen 6). You may be able to b a4
binarize by changing the color setting to something other than AT. T
Screen 6
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Switch Black/White to use a through-hole as a fiducial marker. Mark- |, .
ers can be detected stably without being affected by the surrounding
colors.
For more detail of the settings on Method?2, see 6-2-3.
Screen 7
6-1-4 Procedure for Picture

If Fiducial Mark detection is difficult, the Picture pattern matching is available instead of Fiducial Mark.

1. Display a marker in the center of the screen by using the Move Tool and Pitch Button.

2. Adjust the frame size to be slightly larger than the Fiducial Mark.

3. Select Assign Fiducial Mark from the Edit menu, click the marker frame and select Picture tab.

4. Lines are spread from corners to around. Those lines mean a search range of the marker (Screen
8). Search range can be edited on the setting.

5. To confirm whether the Marker is recognized correctly, double-click the frame or click TEST
button. A red cross will appear in the center of the frame (Screen 9).

6. The Master Picture Area will now show 1/1:50 at the top. The number 50 means OK with 50%
matching (Screen 10). To change this value, double-click the value, change the reference value

in the window, and click OK (Screen 11).

* Make sure in the Machine offset that all Inspection Frames are in the correct positions.

* This method is not suitable for reflective solder-plated patterns, or parts that differ by PCB.

6-1-4

(Screen 8) (Screen 9)

(Screen 10) (Screen 11)
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6-2 Marker Setting Window

This section describes settings on each methods.

6-2-1 Common functions on Method1 and Method2

Shape Select Button

Select the shape that matches the shape of the Fiducial; oval, rectangle or cross.

Color Button ﬂﬂﬂ

In the Fiducial Marker, the Marker must always be converted to 2 colors (ex. black and white).
The default AT shows automatic binarisation. If binarisation does not work well in AT, click red/green/

blue. The Fiducial Marker is binarised based on contrast of the selected color.

Black and White reversing button

Click on an icon depending on whether the inside of the Fiducial Marker is white (bright) or black (dark).

Centering button

This button moves the Fiducial Marker to the center in order to set the Marker accurately. Marker

position is fixed when the bars above the button are unified like this "= . This button becomes active

when you touch Contrast lever on Method1 or Histogram on Method2.
* This button can only be used when creating Fiducial Markers. You can no longer press the button

after closing the setting window.

Filter button

When binarisation does not work well due to lack of contrast, use this button to open the Filter and
adjust the contrast. Camera Special Settings are also available from V6.8.0. Refer to chapter 11 for

details on filter handling.

Side lamp
Turns on the side lamp to improve accuracy when there is little difference between the colors of the

Fiducial Mark and its surroundings, or when the edges cannot be detected and Marker is unstable.

Capture delay

This is the waiting time for the mechanical vibrations to subside after movement. The waiting time can

be set from 0-3000 (mm seconds), with the default value being 66.
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Retry Number
Designates the frequency of retries when Marker reading fails. It can be set from 1-10, with the default

value being 2.

Default method

Decides the method to be used next time from Method1, Method2 and Picture.

6-2-2 Unique functions on Method1

Contrast divergent Lever

This lever can be used to set the contrast divergence point. If
the value is X0 YO (+/-1) when you press down the mouse while

dragging, it means that the color has been binarised.

Size limit

Limits the size of Fiducial Markers.

Use virtual center

Use this function if the point is not stabilized with the Centering
6-2-2

button. In order to use this function, an accurate Virtual Center

must be obtained. In addition, even if this setting is ON, it will not run if a Virtual Center has not been
set. In order to obtain the Virtual Center, check Use Virtual Center during AT mode and press down

on the Centering button. Red lines will appear over the button. Continue to press down IE until they

become a single line (this feature is available only when creating Markers).

Picture Search

An option “Search fiducial with Master Picture”. With this option active, at first the fiducial frame
searches position with Master Picture, then binarizes the fiducial. This option is inactive on default
and can be active / inactive by each inspection program.

* If the Fiducials are the type that are embossed by lighting, they may be difficult to identify. Do not

create Markers if they are unstable or there is not enough surrounding space to apply contrast.

Low contrast control

In AT mode, turn this function ON when the border changes drastically when the Contrast divergent
lever is only slightly moved. The default level is 5. Note that if you increase the value too much, it will

have the opposite effect. If there is a lot of noise near the Fiducial Marks, lower the level.
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Auto length/width verification

This feature records the length and width at Marker setup as well as the dimensions. Level adjustment
is made automatically to adjust the detected Marker to the recorded size and dimensions. It is recom-

mended that you leave this item checked in AT mode.

6-2-3 Unique functions on Method2

Histogram Area

A histogram of the binarized image. The black dotted line is the
threshold bar, which can be changed manually when “Auto Bina-
rize” is off. Click here to detect a Fiducial Marker. If the detection

fails, text area below turns red.

Auto Binarize

If checked, the binarization threshold will be calculated automati-

cally. Uncheck it if you want to change it manually.

continuous (cont.)

Performs marker extraction processing continuously.

6-2-3

Search range

Sets the range of pixels to search the Fiducial Mark. The unit is pixel. Values are shared between the
Method2 and “Picture”. Search range disappears when the method turns from Method2 or Picture to

Method1.

zoom view

Enlarges the image during marker extraction processing.

debug view

Displays the information during marker extraction processing.

Image identify score check

To avoid misrecognizing objects of similar size, the correlation value with the registered image is cal-

culated, and the correctness is judged after detecting the marker.
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Save image for debug

Gets an image for the log when detection fails and save it in the marantz_AOlI folder.

Reset Centering

Unlocks the centering process. Same operation is executed with “Shift+OK” .

Profile chart

This is a graph for visually confirming the stability of edge detection.

6-2-4 Unique functions on Picture

Search range

Sets the range of pixels to search the Fiducial Mark. The unit is
pixel. Values are shared between the Method2. Search range
disappears when the method turns from Method?2 or Picture to
Method1.

TEST 6.0-4

A red center line is displayed on the marker to verify that the marker is recognized correctly.

Filter

See chapter 11 for more detail.
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6-3 Fiducial Marker Status

Fiducial offset becomes active when you inspect the program once. Normally the program must be
created / debugged in this status. Fiducial status is shown as following (Screen 1);

1. The cell including fiducial marker is shaped Oval in place of Rectangle in Cell Map Area.

2. Keeping Offset is displayed on bottom of fiducial marker frames, if fiducial offset is active.

3. To release the fiducial offset, press Stop button, or click the marker frame by mouse. A

message will be shown. Press Release to unlock (Screen 2).

Sometimes, you accidentally press Stop button, and make program without fiducial offset. As a result,

inspection frames are placed at unexpected position, and inspection result would be incorrect. There is an

option to prevent such careless mistakes (Screen 3).

6-3

(Screen 1) (Screen 2)

(Screen 3)
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6-4 Fiducial Marker Setting by Pattern Matching

6-4-1 Limitations

Fiducial can be assigned maximum 3. Assigning only one fiducial compensates XY position shifting,
assigning two fiducials compensates XY plus theta (angle) position shifting, and assigning three fidu-

cials compensates XY, angle and stretching/shrinking.

- 3rd fiducial frame must be created at the coordinate where X or Y of 1st and 2nd fiducials
crosses (Fig.1), and all fiducials must be at the 1/6 corner area of PCB to align large PCB
preciously. When assigning the 3rd fiducial, software allows a little distance from the exact XY
crossing position. However if there is large distance, an error message is displayed and you
can’t proceed the operation.

- When there is component (inspection frame) out of fiducial alignment area, you can’t assign the
3rd fiducial (Fig.2). If you still like to align such PCB with 3 fiducials, it is possible by following
operation; Create (Add) inspection frames_after assigning fiducial frames.

However, the alignment for components out of fiducials is less precision than components
within fiducials. Plus, the selected Cell on Cell Map won’t be painted for these components (this
is only the matter of appearance, no problem in function).

- PCB tilting or shrinking/stretching is possible to align, but PCB warping irregular can’t (Fig.3).

- You can’t define the 3rd fiducial in Block. For aligning panellized PCB at 3rd fiducial, please

assign to the PCB sheet.(Fig.4)

6-4-1

(Fig. 1) (Fig. 2)

(Fig. 4)
(Fig. 3)
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6-4-2 Streching/Shrinking offset with 2 fiducials
Often it is difficult to assign the 3rd fiducial. The accuracy is low but you can still giving stretching/shrinking

offset with 2 fiducials.

Create fiducial frames on main and sub fiducial. In setting window of sub fiducial, there is “stretch/
shrink” button at the right-bottom of OK button. Click this and you will be asked “Enable to
compensate size offset in addition to theta offset?”. Click OK, the button is turned to blue color
and stretch/shrink offset is enabled.

* If main fiducial and sub fiducial is too close (closer than 25mm), the button is not permitted to press.

* Not possible to assign when the fiducials are in block.
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6-5

(Screen 1) (Screen 2)

6-5 Manual Positioning at Reading Error

If a Marker error occurs, there are 3 corrective measures; Stop, Skip or Manual Adjustment.
Stop will terminate inspection, Skip will continue inspection without position correction by Fiducials,
and Adjust Manually will continue inspection by forcing the Fiducial Marker to be in the center of the

screen. Manual Positioning is effective for handling extremely unstable Markers.

Manual Positioning Procedure

1. If a Fiducial Marker reading error occurs during inspection, an error message will appear, and
then a dialog, shown in Screen 1, will be displayed.

2. If you click Adjust Manually, the part to be inspected (Fiducial Marker) will be displayed on the
screen, with a red cross pointer. The Start and Stop buttons will also be shown in red (Screen 2).

3. Drag the Fiducial Marker to the center of the screen. Click the Start button and the distance

dragged will be regarded as the offset, and inspection will be resumed.

Eject PCB at reading error

There is an option to gject PCB as defect when failing to read fiducial marker. This is useful for inline AQI
without operator where line must not be stopped by any reason. Activate "Eject PCB as NG when failing

to read fiducials".
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6-6 PCB Top/Bottom Side Recognition

One program can include data for both A (top) and B (bottom) sides. In this case, Stamps and preferences

will be shared. Set up according to the following procedure:

1. Find a place that clearly differs on side A and side B near the Fiducial Points and select it with

the Inspection Frame Tool (rectangular).

2. Double-click on the Frame, and reduce sensitivity using the Blur and Resolution filter so that

minor differences in the PCB will be judged OK, but
the B side will be judged NG. e

3. Select Edit > Assign to A side.

4. The letter A will be displayed on the Frame (Screen 1).

5. When setting up steps 3 — 4 for side B, switch over
to side B using the Swap A/B Side Button.

6. When inspecting, the side will be recognized first
and the data will be switched to the matching side. If

neither side matches, a message window will be dis-

played saying that the side could not be recognized.

(Screen 1)

* To change data from side A to side B, go to Edit > Side Edit > Swap A/B Side.

* To copy data from either side, go to Edit > Side Edit > Side Copy.

Auto A/B swap mode

To switch A/B, A/B... automatically, press Swap A/B Side Button with option key. Red arrow mark is

displayed on the button.

A block barcode on A side can be used on B side too.
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7. Easy & Speedy Stamp Creation

In this Chapter, the step of the stamp creation is introduced.

7-1 Stamp Creation Wizard

An wizard creating stamp by selecting component by mouse, without learning filter and parameter

settings.
V¥ 7-1-1 How to use

1. Select the Move Tool and move to the area where the top left of the component is displayed.

2. Switch to Selection Tool_ * | and press mouse down and drag a part in Work Area (Screen 1).
3. Dot line turns to blue line after holding mouse button for more than 0.75 second (Screen 2).

The blue frame can be resized. Press esc button to cancel.
4. Release the mouse button to open [Stamp creation] wizard (Screen 3).
5. Select suitable template from Template List.
6. Press OK button to input New Stamp name (Screen 4).

7. The stamps are saved in Stamp List, select Stamp Palette from Stamp menu to confirm.

7-1-1

=

(Screen 1) (Screen 2)

(Screen 4)

(Screen 3)
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When creating Inspection Frames, if the frame is too large, it will lead to slower inspection speed and to an
increase in False NGs. It is important to understand the characteristics of each component/part to create

proper Inspection Frames. Here are the typical methods for creating Inspection Frames:

+ Body of capacitors/resisters
Create a frame on the body in a bit smaller size, including lead (Screen -a)
« Polarity of tantal capacitor
Create a small frame on the body where polarity color is (Screen -b)
«Text
Create an accurate frame not to include too much empty space. (Screen -c)
+Lead of QFP
Use IC Lead Gap stamp (Screen -d)

(Screen -a)  (Screen -b) (Screen -c) (Screen -d)
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7-1-2

(Screen 1)

V¥ 7-1-2 Window

In Stamp Selection list, there are 3 methods to create a new stamp (Screen 1).

1. From Stamp List
If there are already stamps in Stamp List, the similar stamp(s) is listed from Stamp List. Selecting
the stamp and pressing OK button will paste the stamp.

* No similar stamp will be listed when size, shape or color is different.

2. Stamp Template
Major inspection libraries are supplied such as Solder Fillet, Component, Polarity or Text. There
aren't too many template but the templates for inspecting component are supplied for all
camera type because these cameras' color sensitivity is different.

- Normally the stamp made from template is non-zoom frame, however if the short side of the
rectangle is less than 0.6mm, the frame will be made zoomed.

3. Special Stamps
The following special stamps are available. Selectable stamps vary by model.

Passive Component Histogram Detect Solder Balls Lead Gap
Detect Bridging Doughnut Scratch Slit
Extra Parts Angle Z Axis Z Axis Auto Focus
NewCellAid KadoSta Assign Fiducial Mark Assign side marker
Block Mark Panel Block Mark Target Frame QR Code
Data Matrix Code 39 Code 128 Capture Stamp

47

7. Easy & Speedy Stamp Creation




V¥ 7-1-3 Example of inspecting Aluminum Electrolytic Capacitor

With Aluminum Electrolytic Capacitor, you need to create 4 frames "Component”, "Text", "Fillet" and

"Polarity".

1. First, create frame for "Component". Draw a frame on component by Selection Tool. Select
"FDL Body (position shift)" from Template. Save the stamp with new name (Screen 1).
This stamp will detect component "existence", "wrong" and "shifting". You do not need to adjust

this stamp. If there is false detection or detection failure after testing some pieces of PCB,
please adjust at the timing.

2. Next, create frame for "Text". Draw a frame on text. Select "Text (metal)" from Template. Save
the stamp with new name (Screen 2).

Open Filter Set window by double clicking the frame, and confirm if the text is clearly detected.

Press Brightness bar, the filtered image will be shown in screen (Screen 3). If the text is unclear,
slide Brightness or Contrast bar until you get the clear image. When adjusting levers doesn't
improve, test the other Text template. There are 4 kind of template to detect text.

3. Create frame for "Fillet". Draw a frame on fillet. Select "Fillet DL,HDL,FDL" from Template. Save

the stamp with new name (Screen 4). This stamp is Histogram stamp. Double click the stamp's
frame and open window (Screen 5).

7-1-3
(Screen 1) (Screen 2) (Screen 3)
(Screen 4) (Screen 5)
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(Screen 6) (Screen 7)

1. There is a trap frame. Move the trap frame to the position where image changes obviously

at defect. Resize the frame size if necessary.

2. There is a list to set the threshold of color tolerance at the right-middle in the window.
Select each RED/GREEN/BLUE color and press “Auto” button. Threshold will automatically
be set.

3. At the end, press check button and confirm if the result is OK. Paste the stamp on the fillet
at the opposite side by selecting from Stamp List and press space key twice to rotate 180

degrees.

4. Create frame for "Polarity". Draw a frame on polarity. Select "Polarity (Component, clear)"
from Template. Save the stamp with new name (Screen 6).
This stamp is Histogram stamp. Adjust trap frame and threshold as same as when you create
stamp for fillet.

5. Now all stamps are created. It will be easier to handle to make these stamps in a package as
Pack Stamp when pasting.
To make Pack Stamp, select all stamps by dragging mouse. Select Stamp Pack from Stamp
menu. Save the package with new name (Screen 7).

* Stamp Template is not included in 22X software. It must be installed by Installer together with 22X
software. If you upgrade software manually by copy and paste, template won' be installed and

Stamp Template list will be empty.
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(Screen 2)

(Screen 1)

(Screen 3)

(Screen 4) (Screen 5)

7-2 Create Stamps by Wizard from CAD data

With Stamp Creation Wizard, you can easily create stamp libraries after importing CAD data.

V¥ 7-2-1 How to use

1. Open For Supervisors menu from Configuration in Settings menu. Move to Assistant tab,
check on " Create program from CAD data in simple way" (Screen 1).

2. Import CAD data (Screen 2).
3. Arrange CAD data to meet the actual PCB in CAD coordinates arrangement window (Screen 3).
4. Assign stamps if there is any pre-loading stamp library in Stamp Apply Window (Screen 4).

5. Message to start teaching will be displayed. Press START button. There is an option "Parts
name always be stamp name". We recommend to check-on this option (Screen 5).

* By activating this option, you can create duplicated stamp easier. For example, if the second
component is very similar to the first component, by pasting the stamp for 1st component, it is
automatically duplicated in 2nd component's parts name. Without activating this option, by pasting

1st component's stamp is simply pasting stamp, new stamp for 2nd component isn't created.
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(Screen 6)

(Screen 8)
(Screen 7)

6. The first component is shown in the center of Work Area. Draw a frame on the component body
by mouse. Keep the mouse holding for 1 or 2 second, light-blue line will be shown. Release the
mouse. Stamp Creation Wizard will be displayed (Screen 6).

7. Select Stamp Template from Wizard or stamp type from Select Special Stamp below the
Wizard.

* When you are not satisfied with the frame size, press Cancel button in the wizard window. You can

re-draw the frame.

8. Screen is still stopping at the component. You can adjust more filter settings or even add
stamps for inspecting fillet, text or polarity (Screen 7).

9. Press START button to move to the next component. Create stamps in same procedure (Screen
8).

10. If there are similar components in different parts name such as 0402 size MLCC, paste
existent stamp from stamp list. Stamp is duplicated in new parts name with same setting.
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7-2-2

(Screen 1)

V¥V 7-2-2 Window

The window's contents is different from usually at creating stamps (Screen 1).

1. Template
Template recommended for component inspection. Standard filter setting is already set. All

stamps are created in Pack stamp.

2. Special Stamps
There are 3 selections; Pattern matching Pack stamp, Histogram Pack stamp and Passive
Component stamp.

3. Directory to save stamp in Pack
Because Pack stamp is created in parts name, the stamp must have another name. Therefore,
the stamp is saved in the folder. You can change folder name. Default folder name is _body.

4. Zoomed-in
At assigning "Pack(Matching)" or "Pack(Histogram)", you can select to create in Unzoomed or
zoomed.

* When this option is greyed-out, this means that the stamp is not possible to flip zoomed / Unzoomed.

52

7. Easy & Speedy Stamp Creation



7-3 Special Stamp for Passive Components

This is a special stamp for capacitors/resistors. You can choose this [Passive Components] stamp from

pull down menu of [Special Stamp] in the Stamp Creation Wizard,

The basic premise of this stamp is a capacitor/resistor contains two leads (electrodes) at both sides. This
stamp recognizes a capacitor/resistor by finding two leads first, then it assumes and finds capacitor/
resistor body between the leads and fillet outside of each lead.

Each part of capacitor/resistor is judged OK/NG by whether the matching rate of its color and area is
within the threshold or not.

This stamp also can check rotating and position shifting by detecting the center of each part.

*This function is not applicable for models without Side lighting and DOAL (Diffuse-On-Axis LED)
lighting.

*This function may not work properly when inspecting a red PCB under RGB layered illumination.
*Detection may not work properly on the customized RGB layered illumination machines which RGB

lighting position is reversing. (normally RGB, but became BGR)

: Lead
7-3 €a oK NG

o) (WD

Configuration: two fillets, two leads and a body Rotating: default limit is within 6 derees.

Fillet Body

Direction to be corrected

OK NG
v
100% 60%
40%
—

Position shifting: more than 66% of lead edge has to touch the fillet.
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7-3-1

Do not surround this side too big.
Otherwise, cannot detect properly.
]

f !
Surround this side
» to be +30% of
the original

Consider the area in case

component shifts or rotates

(Screen 1)

(Screen 2)

V¥ 7-3-1 How to Use

To use this stamp, detecting leads (electrodes) is the essential point. Therefore, make a stamp with a

component whose leads are easily distinguished.

1. Be sure that the mouse function is Selection function. Surround the component by dragging
the mouse and hold the mouse for a second. Stamp Creation Wizard runs. Choose [Passive
Components] from the bottom left pull-down menu of [Special Stamp].

* Be sure to surround the component a little bit bigger than the original component size so that it can
detect position shifting. (Screen 1)

* Be sure not to include silkscreen inside the frame with wave soldering PCB.

2. If the stamp recognizes the component as capacitor/resister, color and area information of each
part is immediately captured and shown in Stamp Setting Window. (Screen 2) If not, an error
saying [Unable to find component] appears and stamp creation is rejected. When pressed [Test]
button, you can confirm the detection level.

3. Click [Create] button if detection level is OK. When you make no change in Step 2.,default
threshold is automatically input in the threshold column.

Default threshold is as follows:

Color Difference Area Difference
Fillet 0.4 (40%) or less -> OK 0.5 (50%) or less -> OK
Lead (electrode) 0.6 (60%) or less -> OK 0.6 (60%) or less -> OK
Body 0.3 (30%) or less -> OK 0.7 (70%) or less -> OK

* When the value is "0.0" it means it matches 100% and when the value gets closer to "1.0" it means
the matching rate is getting worse.
* The default is [OFF] (not to inspect) for Fillet Area Difference. This is because fillet shape is not

uniform even in "GOOD" components and it is often not reliable to include it as inspection point.

4. Name the stamp in Stamp Name window and the stamp is created.
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V¥ 7-3-2 Stamp Debugging

The stamp created is not always having the standard color and size of all the same components. Paste
the stamp onto all the same components of the PCB and start inspection for debugging.

1. Press [Start] button and inspect all the frames. Usually, not all the components pass and you
will find some false NG.

2. Double click one of the false NG stamps. Stamp Setting Window opens. At the left bottom, a
pull-down menu is available to improve false NG.

*Add current color: Body Color
*Merge current color: Lead/Fillet Color
*More tolerant: Body Area Limit

*More tolerant: Rotation Limit

*More tolerant: Shifting Limit

3. [Add current color: Body color] is one of the typical method to reduce false NG. This means
that actual body color is different from the master body color. Unlike the other methods, this
does not change any thresholds or settings but simply adds a master color. The added color is
displayed in [+Body Color] window.

* The stamp can have maximum 24 colors.

* If you want to delete a color, double-click the color in the [+Body Color] window. When a dialog
appears, click [OK] to delete.

* Passive Component stamp has automatic positioning function. (searching for 8 pixels around the
component in the default setting.) In case a big difference lies between the master and the actual
component about the color or the whole image, the automatic positioning function will not work. To
solve this, the stamp will automatically add the actual component image as a master picture.

* In Passive Component Stamp, Master picture is only used for automatic positioning fuction and not
used for matching criterion.

* When handling a warping PCB and there is more than 8 pixel position shifting, you can set a wider
search range by following method: select the stamp and drag the bottom left edge of the stamp to

the outer area with pressing [Control] key.

4. After improvement, click [OK] button and the setting change will be automatically applied to all
the frames of the same stamp and they will be reinspected automatically.
When the inspection result is changed from [NG] to [Good], the inspection frame color will be
changed from Red to Blue.

5. If any of the False NG frames remain unchanged and still colored red, additional setting change
or body color addition is needed. Go back to Step 2. and debug the stamp again.
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7-3-3

Very tiny component

Lead color other than silver Large pad as bright as lead

Square Leads difficult to be recognized Components with  Body having multiple colors
more than 3 leads

Awkward lead shape

V¥ 7-3-3 Limitations

Below are limitations for [Passive Components] stamp.

* Capacitor/resistor having multiple body colors cannot be detected by this stamp.

* Capacitor/resistor whose body color is similar to leads color cannot be detected.

* This stamp may detect falsely and cause false calls as position shifting those capacitors/resisters
whose solder pads look like a part of lead, whose pad is as bright as lead or whose lead is shaped
awkward, not rectangle.

* Capacitor/resistor whose leads are difficult to be distinguished may not be detected.

* Under HDL illumination, a capacitor/resister having non-lead free solders is difficult to be detected
by this stamp.

* Resister values cannot be inspected with this stamp.

* Not possible to detect solder ball.

* You can make this a Pack Stamp. Filter setting, however, cannot be done from pack stamp setting

menu.
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7-3-4

Special setting A (18)

Special setting B (19)

® 200966006 ©

®

®
@
® ® ®

V¥ 7-3-4 Passive Components stamp setting window

Name

Description

1. Parts

The parts detected by Passive Components stamp is listed here. Usually it consists of the
following: Fillet (left), Lead (left), Body, Lead (right) and Fillet (right).

2. Master Color

Master color of each part is shown here.

3. Target (Actual) Color

This is the color of the inspection frame you are opening now.

4. Difference of Master
and Target color

Difference between Master color and Target color. Value ranges from 0.0 (100% identical)
to 1.0.

5. Difference of Master
and Target area

Difference between Master area and Target area. Value ranges from 0.0 (100% identical)
to 1.0.

6. Active / Deactive
Color inspection

You can define whether to activate / deactivate color difference detection. The default
setting is "ON" (activated).

7. Color Limit This is the threshold setting of color detection. Directly input the value you want.

8. Active / Deactive Area | You can define whether to activate / deactivate area difference detection. The default
Inspection setting is "ON" (activated) for "Body" and "lead".

9. Area Limit Threshold setting for area detection. Directly input the value ranging from 0.0 to 1.0.

10. +Body Color

When you add applicable body color besides the Master body color, the color you add is
listed in this window. You may have maximum 24 different colors in one stamp.

11. Rotation Limit

The angle difference limit between the master and the current component. Threshold can
be set by directly by inputting the value or by selecting value from drop down list.

12. Position Shift Limit

The position difference limit between the master and the current component. Threshold
can be set by directly inputting the value or by selecting value from drop down list.

13. Improve False Error

After inspection, open the inspection frame and change the settings and threshold to
improve False NG errors if needed. Color difference, area difference, rotation difference
and position shift can be improved by changing the threshold of each settings. Body
color difference NG can be improved by adding current body color in this menu.

14. Test

You can check the detection conditions of each part in the setting window.

15. Cancel

When clicked this button, setting window is closed without updating the setting.

16. Create/OK

When clicked this button, setting window is closed updating the settings. The update
setting is applied to all the inspection frames having the same stamp.

17. Copy

When you click Copy icon, you can create another stamp with the same settings. A new
window to input new stamp name appears. Name and click [OK], and it replaces the
master picture and master colors and make it as a new stamp.

18. Special setting A

Option menu to adapt the the same setting automatically to the opposite side when either|
the left or the right fillet/lead setting is changed.

19. Special setting B

Option menu to change the detection level of fillet. When the lens is extremely dirty, this
stamp cannot detect the fillet properly.
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8. Stamp Operation

Basically, this software performs inspection by detecting differences between Master Picture of Inspection
Frames and actual components. Normally Inspection Frames are saved as Stamp in Library.
When inspection frame is saved as stamp, it is called stamp. The Stamp can be selected from the Stamp

list, and once the frame is saved as a stamp, you can use it anytime when needed.

8-1 Create/ Operate/ Rotate/ Zoom/ Save/ Update/ Replace

Hl About Stamp and Inspection Frame

The definition of “Inspection Frame” is “a pattern matching frame not saved as stamp”. “Stamp” is a “re-

usable” frame. Each inspection frame has master pictures, and stamp shares the same master picture.

To create an Inspection Frame, first select the Inspection Frame Tool. The Inspection Frame Tool is set
to the Rectangle by default. Press down on this tool with the mouse, to display a pop-up window where
Rectangle, Oval and Polygon can be selected (if there are Stamps, Stamps can be selected t00)
(Screen 1-1). Select the tool according to the shape of the component/part to be inspected. The behavior
will be different depending on the tools.
* When drawing a frame, pressing and holding the mouse at the first point will zoom the screen 200%.
* When moving Inspection Frames, other Inspection Frames can be Hidden. Check Hide near frames
in Object Frame in Configuration from the Settings menu (Screen 1-2).

* Press the Capslock key to hide all Inspection Frames.

(Screen 1-1)

(Screen 1-2)
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V¥ 8-1-1 Create/Operate/Rotate/Zoom

H Rectangle

Create To create a Rectangle Inspection Frame, select Rectangle and drag the mouse over the
Work Area, starting from the corner of the component/part. Picture under the Inspection
Frame will be displayed in the Master Picture Area (Screen 2).

Move Move the mouse pointer over a Frame, the mouse pointer will change to a cross icon.
Move the Frame by dragging (Screen 3).

Resize Move the mouse pointer over the Handle on the upper left or the lower right of the Frame,
and the mouse pointer icon will change to an arrow icon. Drag the mouse to enlarge or
reduce the frame size. (Screen 4).

Rotate Move the mouse pointer over the anchor point on the top of the frame, the mouse pointer
will change to the Rotate icon. Drag the mouse and the frame can be rotated left/right to
+/-180 degrees (Screen 5). Dragging while pressing down the Shift key will limit the rota-
tion angle to 15 degrees steps for each rotation.

(Screen 2) (Screen 3) (Screen 4) (Screen 5)

H Oval

Create To create an Oval Inspection Frame, select Oval and drag the mouse over the Work area.

Move Handles will appear in all 4 corners when the Oval is selected. The mouse pointer chang-
es to a cross icon when moved over the lines, allowing the frame to be moved.

Resize Move the pointer icon over the Handle located in the upper left or the lower right.

Rotate Enable to set angle from Filter Set window. Please refer Chapter 8 for detail.

H Polygon

Create Select Polygon then click drag and release the mouse to create the first side of the poly-
gon. Then, move the mouse pointer and click to add polygon corners. Click on the first
point of the polygon or double click to complete the Polygon Inspection Frame.

Move When the mouse pointer is moved over the edge of a selected frame, the pointer changes
to a cross icon, and the frame can be moved.

Change For Polygons, the corner points will become Handles. The shape can be changed by

Shape clicking and dragging the Handles (Screen 6).
Rotate Enable to set angle from Filter Set window. Please refer Chapter 8 for detail.
shift key + dragging option key + dragging (Screen 6)
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H Selecting/Resizing Frames

Drag over frame(s) to be selected by using the Pointer Tool. To select all Inspection Frames in a Cell,
choose Select All from the Edit menu.

To resize, select the handle located on the corners and drag the Frame.

* Hold down the shift key to change the inspection frame size while maintaining the ratio.
Hold down the option key to change the inspection frame size symmetrically.

shift key + dragging option key + dragging

H Copy
Select an Inspection Frame with the Pointer Tool. Press down the Option key, while the mouse pointer is
over the Inspection Frame, the mouse pointer will change to a Stamp icon. Drag and drop the Inspection

Frame to create a new copy. Press the Shift key while to limit copying vertically and horizontally.

Hl Row Copy

Select an Inspection Frame using the Pointer Tool, and choose Row Copy from the Edit menu. The Row
Copy dialog will be displayed. Define how many pictures and the direction and spacing for each copy.
Check Duplicate Master Picture on when copying master pictures (Screen 7).

* Enable [Set Ref.des. name in consecutive number] to add numbers to the end of Ref.des.

M Duplicate Selection

When Duplicate Selection is selected from the Edit menu while the Inspection Frame is selected, the
selected Frame is copied by Cell units. The position and number of copies can be set up in the Duplicate
dialog. To copy to the right or down, enter negative values for the Pitch (Screen 8).

If no Inspection Frames are selected here, this menu becomes Matrix Copy into Cells, and copies all In-
spection Frames in the cell.

* Enable [Set Ref.des. name in consecutive number] to add numbers to the end of Ref.des.

(Screen 7) (Screen 8)
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(Screen 9)

H Arrange

Using the Arrange feature allows to align selected Inspection Frames to the top / bottom / left/ right / cen-
ter or same height/width. Select Align from the Edit menu and select the type of alignment. A preview is

displayed when the Frame is selected. Press OK to execute alignment (Screen 9).

H Copy / Paste

Copy / Paste, Rotate and Flip are available from the Edit menu or by using shortcut keys.

V¥ 8-1-2 Save as Stamp

Save the inspection frame as stamp.

1. Select the Inspection Frame that you would like to make a Stamp.

2. Select Stamp list from the Stamp menu to display the Stamp list.

3. Click the New button in the Stamp list.
A message window "Input a new name” will be displayed, enter the name of the Stamp here
(Screen 1). If a Stamp with the same name already exists, you will not be able to click OK. If you
would like to create directories, insert a : (colon) separator (Ex. Capacitor:0603 creates a Stamp

with the name 0603 in the folder Capacitor (Screens 2, 3)).

(Screen 2)

(Screen 1) (Screen 3)
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(Screen 4)
(Screen 5)

- You can also select Stamp name from folder list which is registered beforehand (Screen 4). With
this procedure, you can create the Stamp more easily by omitting the manual input of folder
name and part name at the time of importing CAD data.

Procedure
1. Create inspection frame for less than Tmm around Packed Stamp.

2. Display Stamp name registration window.

3. You can find Stamp name list from pull down menu.

W Stamp name registration window which will show Stamp name

- Create Stamp from Stamp template.

- By pressing F3 key, registrating Stamp name of inspection frame which has no registered name.

- "New Stamp" in the window for updating Stamp setting.

W Format of Stamp name in the list

- Stamp name is configured with "Folder name: Pack name".

W Addition or modification of folder name displayed in the list

- To change the folder name in the list, open "stampFolderList.txt” in "/User/Share" folder with text
edit, and overwrite save with any folder name. (Screen 5). Maximum folder names which can set
for "stampFolderList.text" is 1000. This file is created when the function is used for the first time.
Folder names with initial status are as follows.

" Body", "_Filet", "_Polarity", "_Short", "_Text"

The Stamp is now registered. The Stamps with rotated pictures will be displayed in italics, As this, you can

create stamp from zero, but you can easier create by Stamp Creation Wizard introduced in Chapter 4.
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8-1-3

(Screen 2)

(Screen 1)

V¥ 8-1-3 Stamp Update button

The modified stamp filter settings will be applied to all stamps. When resizing or adding/deleting a base
picture, the Stamp Update button will appear in the upper right corner (Screen 1).
1. Click the button, and a message window shown in Screen 2 will appear. If you would also like to
change the angle when changing Stamps, check 0 deg reset.
2. If you select Update all, the same settings will be applied to all Inspection Frames with this

Stamp applied. Click NewStamp to treat the updated Stamp as a different Stamp.

V¥ 8-1-4 Replace Stamp

Replaces applied Stamp(s) with a Stamp which id dragged from the Stamp list.

1. Set the PCB and move to the position of the Stamp that you would like to replace in the work area.

2. Display the Stamp list, and drag the new Stamp to the frame of the Stamp to be replaced in the
work area. If the angle is incorrect, rotate it with the Space bar.

3. Place the mouse pointer on the frame, and release the mouse button when the form of the
pointer icon is changed (Screen 1). Select [Current stamp only] to replace just a selected
Stamp. Select [All stamps] to replace all Stamps placed on the work area (Screen 2).

* When the message “Some frames couldn’t be replaced” is displayed, some of the Stamps could
not fit in the cell screen. In this case, the former Stamp will remain.

* The Stamp to be replaced with will only be applied to the side currently displayed.

V¥ 8-1-5 Function to Display Stamp Editor’s Name

In version 4.9.9r1 or later, you can display programmer name on Stamp Palette. Open “Settings for
Supervisors” window from menu Settings > Configuration > For Supervisor. Open Assistant tab. Put

check mark on “Display programmer name who modified the Stamp” (Screen 1).

8-1-4

(Screen 1) (Screen 2)
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8-2 Zoom and Magnification
V¥ 8-2-1 Zoom/Non-Zoom
The inspection frame can be switched to zoom mode. More detailed inspections can be performed, but

the false NG may be increased. Switch zoom/non-zoom appropriate for the object to be inspected.

Perform any of the following three operations to activate Zoom.

Click [Unzoom] displayed at the top of the master picture area to switch to [Zoom)].

Select Zoom-in from Zoom menu.

Press F1 key.

Unzoomed inspection frames are displayed in green, and inspection frames created in the zoomed view
are displayed in yellow (Screen 8). To turn a unzoomed inspection frame into a zoomed inspection frame,

select the box frame click [Flip Zoom/Unzoom] from [Zoom] menu (Screen 9).

8-2-1

(Screen 8) (Screen 9)

In Zoom mode, a portion of the camera’s total view is displayed. The currently displayed area is indicated

by a red frame in the master picture area. Drag the red frame with the mouse to move within the field.

8-2-1

64

8. Stamp Operation



V¥ 8-2-1 Zoom/Non-Zoom

Magnification ratio can be changed by clicking on [Scale] in the upper right corner of the screen or

[Magnification] in [Zoom] menu. When selecting [Input...], you can key in any ratio.

8-2-2

8-3 Stamp List

Select Stamp list from the Stamp menu and the Stamp list will be displayed (Screen 1).

All the stamps that you create is saved here.

8-3
L
(Screen 1) é é
(Within list)
No. Function details
. Except some special stamps, every stamp uses Master Picture(s). Double clicking
1 :Ita:ter Picture the small image of the Master Picture can switch some special stamps to be not
ats using the Master Picture(s).
When using directories, a folder icon is displayed here.
Folder icon/ When only one Master Picture is registered on the stamp, double-clicking this area
9 Horizontally displays the rotation icon and adds a 180-degrees-rotated Master Picture. This
flipped Master |is useful for inspecting parts that are not affected by orientation. The image can
Picture icon also be set by selecting [Make Stamp Reversible] in the Filter Settings window or in
the Stamp menu.
3 Stamp Name/ |The Stamp name or the level name is displayed here. The name can be changed
Level Name by double-clicking on it. The zoomed-in objects is displayed in an orange color.

For buttons above and below the list, see the next page.
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(Upper tier buttons)

Icon Function Details
Window moves automatically as below when the button is active.
Window - If the Stamp overlaps with the Work Area and mouse pointer is off of the
positon auto | Stamp List, the Stamp List will move aside.
ajustment |- If the Stamp List extends off the screen and the cursor is placed inside the
list, the windows moves automatically to view the entire contents of the list.
Stamps can be managed in hierarchical directories. + adds a level, and - re-
=== -_i_- Expand / moves a level. The number of levels must be a minimum of 1 and a maximum
Collapse of 4. The display width can be changed by placing the mouse pointer over the
top right corner of the frame of each level.
.-|-|-| Order Stamp names can be sorted in ascending or descending order.

Stamp name

The currently selected Stamp name is displayed here (the stamp name will not
be displayed if there is only 1 level even if the Stamp is on the lowest level.).

(Lower Tier Buttons)

Icon Function Details
By clicking this button after selecting the Stamp, only the selected Stamp
Disol will be displayed in the main area (this is the same feature as View Selected
ispla
E} Ip tyd Stamps in the Stamp menu). To return to the main screen, select Return to
| selecte
— main view from the Selected Stamp menu.
stamp only . . . i ,
Enable debugging stamplist with ‘C’ in the For Supervisor menu should
be activated.
Registers a new Stamp. It will become active when the Inspection Frame is
B New
selected.
Opens StampDB (Stamp library for database). By pressing Option key, it
Open ]
works as Load Stamp File.
ﬁ- Delet Deletes the Stamps. You can also select Delete from the Stamp menu.
] elete
To delete all unused Stamps at once, press it down and hold.
While active and a stamp is selected, the mouse cursor moves automatically
Magnet

to the similar component as magnet.
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8-4 Paste Stamps

V¥ 8-4-1 Paste Stamp manually

1. Click on a Stamp name in the Stamp list. The Inspection Frame Tool will switch to the Stamp
Tool (press down on the tool button to switch back to the Inspection Frame Tool). At the same
time, the name of the currently selected Stamp will appear in message bar.

2. When you move the mouse pointer inside the screen, a frame showing the size of the Stamp
will always be displayed. Even when the Stamp is Round or Polygon, the frame will be a square.
Place this square over the part/component to be inspected (Screen 1). If the Stamp has a mas-
ter picture(s), the master picture(s) will be displayed in the Master Picture area. If not, a picture
under the Stamp position (called local picture) will be displayed.

3. In order to rotate Stamps, press the Space bar before placing the Stamp. It will rotate 90 de-

grees clockwise each time you press the Space bar (Screen 2).

8-4-1

(Screen 1) (Screen 2)

V¥ 8-4-2 Paste Stamp by Magnet tool

Magnet tool helps you to paste stamps in good position easily. Stamp sticks on similar component/parts.

1. Activate "Magnet Tool" on Stamp List . Select a stamp from Stamp List.

2. Move mouse cursor closer to the similar component. The mouse will stick onto the component
and blink in blue frame. The thickness of blue frame changes in 3 levels. The thicker the line
is the higher maching level.

3. Click the mouse, stamp will be pasted in the good position.

* Magnet Tool does not recognize the component in different angle.

* Magnet doesn't work to angled component (such as 30 degrees, not 0/90/180/270 degrees).

8-4-2

(Screen 1) (Screen 2)
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8-5

(Screen 1)

8-5 Loading Stamp Files

To load a Stamp file, select Open Stamp File from the Stamp menu (Screen 1) and select an inspec-
tion program. To change the Stamp magnification, click on [Options] in the lower left corner of the Import
screen, check [Convert], and select the inspection program to import the stamps.

* If an inspection program is open, [Options] will be hidden and this function will not be available.
Select [ Open ] to display the conversion screen and set the pixel/cm before and after conversion. If you

select [ 25u ] - [ 10u ], the corresponding pixel/cm will be automatically input.

If Stamps with same names already exist, a list will be displayed to replace stamps (Screen 2).

The default setting replaces all Stamps with the same name in the list, therefore all Stamp names that al-
ready exist will be highlighted. If there are Stamps that you do not want replaced, click the corresponding
Stamp name to remove the highlighting.

When replacing, position, size and angles will not be changed, but all filters and mask settings will be
replaced. These changes will be applied to all positioned frames. When replacing a Stamp with Master
Picture(s), the size will also be replaced. Resizing will be executed with the existing frame as the center.

* While creating data from CAD data, if there are coordinates where no stamp is assigned, you can’t

load stamp.

(Screen 2)
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8-6 Stamp list for debugging

You can switch to the Stamp list to display the Stamp list for debugging When this Stamp list is shown, you
can select the Stamps to be shown and to be inspected (you can select multiple Stamps by clicking while
pressing down the Shift key). Tasks such as Filtering, resizing the frame or Masks, or adding Master Pictures
can be performed as usual, and the changes will be saved even when you go back to the original palette.

The Stamp list for debugging will have the same buttons as the Stamp list with some exceptions.

V¥ 8-6-1 How to Display

1. In order to activate the Stamp list for debugging, select Settings > Configuration > For supervi-
sor > Assist tab, and activate “Enable debugging stamp list with “C” (Screen 1) .

2. When you click on the C button in the Stamp list window, it will switch to Stamp list for
debugging.

3. In order to switch back to the original palette, close the Stamp list for debugging window.

8-6-1

(Screen 1)
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V¥ 8-6-2 Function

The debugging list is shown in screen 1. The differences between the normal list are explained below.

8-6-2

(Screen 1)

H Select Button (S button)

By highlighting this button, only the Stamps selected in the list will be displayed in the Work Area.
H Search

Enter the Stamp name here and press Enter to search for Stamps from the list.

l Search History Button (Magnifying glass icon)

Click here to display the search history, from which you can select Stamps.

B TYPE
Shows the type of each Stamp. Descriptions are as follows:
Short Name Stamp Type Short Name Stamp Type
BC39L Barcode 39) PACK Stamp Pack
BCDM Barcode data matrix BC128 Barcode 128
BCIL Barcode data BCQR Barcode QR code
EP EP Stamp BC39 Barcode 39
ICGAP LeadGap Stamp for IC CELLA Cell aid Stamp
SOLDM Mask for SPI BADM BlockMark Stamp
PTPCB Stamp to Paint SOLD Solder print inspection
RECT Rectangle CAPT Captured picture
OVAL Oval HISTs Histogram Frame
POLY Polygon RGN Region (area, mask)
MKOK OK Mark Stamp STO05 Extremely narrow frames
MKAW Always Mark Stamp MKNG NG Mark Stamp
ETTL

Acronym of TOTAL. This is a value that shows how many of these Stamps are currently being used. This
value is updated at the beginning or the end of inspection, and will not be updated immediately. It can be
manually updated by double-clicking on the number.

H NG

This value shows the number of NG (defects). The value is O before inspection. After the inspection has
been completed, the total number of NGs will be displayed. By default, if there are more than 5 defects,
the number will be displayed in red. Double click on the cell to temporarily change the default value of 5 to
another value within the range 1-9.

B NAME

This is the Stamp name. Font styles and background colors conform to the original Stamp list.

70

8. Stamp Operation



8-7 Stamp Pack

Stamp Pack is a group of multiple Stamps as one package. Stamp Packing seems like one Stamp in the

Stamp list window, and the settings depends on each individual stamp.

V¥ 8-7-1 Pack

1. You can create a Pack Stamp from multiple Stamps, but not from Frames.

2. Select the Stamps in the Work Area, and select [Create Stamp Pack] (Screen 1).

3. A window asks you to input a Pack name (Screen 2). Packs can be made from 1 Stamp. Fidu-
cial Marks and Marks assigning Side cannot be packed.

4. Packed Stamps will be shown on a blue colored background with embossed characters on the
Stamp list (Screen 3). Pack names can be changed in the same way as Stamps.

5. In order to confirm each Stamp’s settings, the Pack must be in edit mode. Select a pack in the
work area and double-click on the frame. A Pack Setting window will be displayed.

6. Select [Release Stamp Pack] to Release a packed stamp.

* Pack Stamp is almost same as normal stamp, however resizing and set Offset Limit is not possible.

8-7-1

(Screen 1) (Screen 2) (Screen 3)

H Pack Inspection and verification

Different inspection criteria can be included in a Pack. For example, zoomed /unzoomed Stamps, stamps

for Fillet Inspection, and Stamps with different Lightings can be put together. If there are NG of more than

one stamp in Pack stamp, only one voluntary NG reason is displayed during G/NG confirmation.

If the option “ Show multiple NG reasons in Pack stamp” is active in For Supervisors menu Mode tab,

more than one NG reasons can be shown. If there are too many NG stamps, or if Pack stamp is too

large and not enough free space to show many NG reasons, “... More” will be added after NG reason(s).

* When showing multiple NG reasons, the Reference Designator and Comment is displayed on the
upper. (On default, they are displayed together with NG reason.)

* Inspection result sent to Production Management Software CS-Center, does not include multiple NG

reasons even this option is ON. Only one voluntary NG reason is sent.
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V¥ 8-7-2 Pack Setting Window
The Pack Setting window includes the Pictures tab, the Matrix tab, and the Edit tab. If you input angle
value on left-bottom Rotation field, Pack Stamp rotates +/-180 degrees. By pressing up/down buttons,

+/-15 degrees are automatically input. Extra Settings enhance functions of Pack Stamp.

pPicture tab

This shows the Inspection Frames and their Master Pictures contained in the Pack.
* The master picture assigned as NG is shown with red frame, locked picture is shown with blue frame

and both assigned as NG and locked is shown with rose frame.

8-7-2

(Screen 4)

The usage of each button is as follows.

Name Description
Edit This is used to change Stamp positions contained in the Pack. Click here and the
mode will change to Edit Stamp Pack mode.
This button is used to edit filters of selected Stamps (blue on this screen). Click here,
Filter and the Set filter window will appear (the Set filter window can also be displayed by
double-clicking on the STAMP NAME or the numbers in the image).
Add pict. This adds a Master Picture to the selected Stamp.

Double-click the master picture to delete or switch Good/NG picture.
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pMatrix tab

This window enables a combination of inspection criteria within the Pack.

In general, in order for a pack to be judged as OK, all the Stamps must be judged OK. However, by setting

up search criteria here, you can allow a pack to be judged as OK even if components are judged as NG.

* Maximum 32 stamps can be used for matrix, however by activating “or setting in Pack more than 32

(matrix deactive)”, all stamps in Pack can be used for ‘or’ condition. However, A, B, C... matrix table is

not possible to use.

8-7-2

(Screen 5)

Displayed information is as follows.

Name

Description

or

Default value is 0. By changing this value from 1 to 99, the stamp with same num-
ber is in a group. Stamps in the group has a relation of OR condition. This means
that if one of the stamp is judged OK, the inspection result is OK whether the rest of
stamps are OK or NG.

A, B, C..f

By using Matrix criteria, you can set more complex. These combinations can be set
for up to 32 conditions from A to F.

H Pack Matrix Usage

Printed texts on parts vary by manufacturer. By using Matrix, the difference between characters by manu-

facturer can be accounted for while checking for defect parts.
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p-Edit tab

You can rename or duplicate Pack Stamp. When copying Pack, you can select if you use original child

stamp, or create new stamp from original child stamp by succeeding size/filter settings etc.

B-7-2

(Screen 6)

Displayed information is as follows.

Name

Description

DB

StampDB icon s displayed here if the stamp is registered in DB. When the stamp
name is altered, the synchronization with StampDB is released.

Stamp Name

Names of original pack stamp and its child stamps are displayed

Check box

Checked child stamp is replaced in newly generated stamp. Un-checked child
stamp is used in new Pack without change.

New Stamp Name

The field is editable. Input new Pack/child stamp names on which you check.

You can select [Check] or [Uncheck] from the icon. You can add or remove check-

button marks from all selected stamps in a table at once.
* Select [Duplicate] after replacing to confirm the modification.
Replaces selected stamp names in bulk. In the input dialog, enter the string you
want to change in the [Find] field and the string to be changed in the [Replace] field,
Replace

then click the [Replace] button to replace the string. Enable [Checked stamp only] to
replace just stamps checked in the Pack Settings window.

Auto Check/Input

If there are multiple child stamps with same name, check on one of them and
change its name. Then, press this button. The rest of this child stamp’s name will be
changed, and all checked on.

Duplicate

This button executes duplication. While executing, master pictures are automatically
taken for newly created Pack and child stamps. Also, select [Duplicate] to confirm
the modification of [Replace]. If you select [OK] without pressing [Duplicate], the
modification will not be reflected.
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BUnsynchronization with StampDB by renaming

Editing a stamp name with an icon in the [DB] column will result in a warning. Selecting [Force action] will

cause the icon in the [DB] column to disappear and synchronization with StampDB will be disabled.

H Pack Duplicate usage example

To make a new pack stamp “Pack:R0805_364" by copying the pack stamp “Pack:R0805_472"
At first, paste the pack stamp “Pack:R0805_472” onto the target component (resister with text 364) in
Work Area. Open Pack Setting Window.

1. Checked on child stamp No.4, and input new stamp name.

2. Input new pack stamp name.

3. Press Duplicate button.
Then, the pack stamp in Work Area is changed into “Pack:R0805_364I". On stamp library, there are new
stamps saved automatically, “Pack:R0805_364" and “text:364”.
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(Screen 8)

V¥ 8-7-3 Position (Editing Pack)

1. Press position button to get into Edit mode using, all other Inspection Frames will temporar-
ily be invisible, and the Packed Frame will change to a purple color (Screen 8). By placing the
mouse pointer on the Packed Frame, the pointer will change to an x icon, this will allow you to
make individual changes to Filters, Size and Position. You can make a copy of the Stamp by
pressing Option key while dragging the Stamp within the Pack. Each frame can also be deleted.

2. After editing, select Edit Stamp Pack from the Stamp menu or double-click on the Packed
Frame to return to the un-editable Pack state. This will now apply changes to the Pack and
child Stamps. If you would like to terminate the task while editing, change the Packed Frame

back to Edit Mode and press the Esc key.

V¥V 8-7-4 Pack Master

In many cases, the Pack method is used to gather Stamps for the component’s body, solder and elec-
trodes. Since there are electrodes and solder near the body, if by inspecting the body, the amount of
misalignment will be reflected to the electrodes and the solder, the entire cluster can be handled more effi-
ciently. In this case, the body will become the Pack Master (the Anchor Inspection Frame) within the Pack,

informing other frames of the offset. This is called the Pack Master Method.

Screen 1 shows how Pack Master Method is applied in case a. First, the component misaligned from the
original data position is detected, and then, according to it’s correlation to the component, the similarly
misaligned electrodes and solder junctions are inspected.

Meanwhile, case b shows an inspection not using the Pack Master method. The component is being
inspected, but since the correlation between the body and the electrodes/ solder junctions is not recog-

nized, it will be judged NG.

8-7-4

(Screen 1-a) (Screen 1-b)
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8-7-4

(Screen 2) (Screen 3) (Screen 4)

B Pack Master Setup

1. In order to use the Pack Master Method, go to Settings for supervisor >Action, check Activate
the Pack Master function (Screen 2).

2. Now, create a Pack, and press down on the Pack Icon on the Stamp list for more than 0.5 sec-
onds. The Stamp name background will change from light blue to light green. This shows that
the Pack Master method has been applied.

The Master Inspection Frame (anchor Inspection Frame) within the Pack will have a small light
blue mark on the top right corner (Screen 3). This mark is displayed for the frame created first.

3. While the Pack is selected, the master (anchor) can be changed by pressing Shift+Tab. Deter-
mine which part should become the master.

4. Within the Pack, the pack master will be inspected first, and the amount of misalignment de-
tected here will be applied as an offset to other frames within the Pack. The range for “Find” of
the frames that receive the offset will all be replaced to 2 pixels temporarily even if each frame
had a designated the range for “find”, and find will be run for only up to 2 pixels. This is because
with chip part inspections, finding too wide from the body position may result in missing NGs.

5. If you do not need a Pack Master, for example, when you have packed a row of BGA solder
positions, each must be inspected individually. In this case, press the small Packed Stamp
icon in the Stamp list for 0.5 seconds to remove the Pack Master feature. This will change the
background color of the Stamp list name from light green to light blue, and the corner mark will
disappear from the Pack in the work area (Screen 4). Pressing the small Stamp icon again for 0.5
seconds will change it back to the Pack Master Mode.

These settings will be saved and applied when creating the next new Pack.
* The number of the stamp assigned as master by shift + tab keys is colored in purple in Pack window.
* Pack master is not automatically applied to new packs even Enable the follow Pack Master function
is activated. Please set individually.
* Histogram stamp can’t be anchor, if Pack contains only histogram stamps, Pack master not applied.
* The Pack Master cannot be applied to frames with Special Camera Settings.
* If the Pack Master inspection result is NG, all other frames within the Pack will ignore the offset of

the Pack Master.
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* If Pack Master function becomes unnecessary, you can undo all pack stamps’ anchors by pressing

Option key on one of the pack stamp’s master picture icon in stamp list.

V¥ 8-7-5 Extra Settings No.1 Search Area

This function lets Pack Stamp search component by master picture of Pack Stamp.

* Take good master picture when using this function.
H How to set

1. Open Pack Settings window. Click Search tab in Extra Settings (Screen 1). Search area
can be selected from Non (don’t search), 0.1, 0.2 ... 0.5.

2. After selecting area, thin green line will be shown around the Pack Stamp (Screen 2).

3. When large area such as 0.5 mm is selected, thin blue line will be shown at the frame of
Pack Stamp picture (because it is too wide and can’t display in picture). (Screen 3)

4. If Pack’s master picture is featureless, or less different from surrounding, Search area can’t

be set. In this case, the master picture is crossed out (Screen 4).

H Caution
- Master picture of Pack Stamp may include not only component also PCB. If various shape

of silk print is painted around components, Pack Stamp may not find the correct place.
- Searching of Pack Stamp takes 2 Ms per inspection point. For example, if Search is acti-
vated on 1,000 inspection points, inspection speed will be decreased 2 seconds. Do not

set Search on unnecessary points.

V¥ 8-7-6 Extra Settings No.2 Measure/offset Angle
This is the function to inspect component’s position shifting (especially theta rotation). Without complex
settings, theta rotation of the components/connectors can be detected.Also, assign the detected angle for

rotation offset.
* NG points can not be confirmed in NG Cell View mode.

(Screen 1) (Screen 2) (Screen 3) (Screen 4)
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Hl How to set (Measure)

1. Open Pack Settings window. Click Angle Limit tab in Extra Settings (Screen 1). Angle
limit can be selected from Non (don’t search), 0.5, 1.0 ... 6.0.
Select “mylimit” in Angle Limit (Screen 2). Window for optional angle setting is displayed
(Screem 3), and you can set the angle with 0.1 step from 0.1 to 6.0.
When using AngleCheck stamp on the machine with DOAL lighting, DOAL is displayed for
selection. When you select DOAL, switching of main lighting and DOAL lighting is pos-
sible, so please use the function depending on the place and parts.

(Screen 3)

1

(Screen 2)

(Screen 1)

2. Select Area at the bottom of pull-down menu (Screen 4). Option settings for Angle Limit
window will be displayed (Screen 5a). In this window, you can set “Angle detection area”
or enhance “Image processing”.

3. The area that angle should be detected is shown by red frame. As below picture, Pack
Stamp which includes solder fillet, should exclude solder fillet area from red frame. De-

tection area should be component body only.

Click down arrow of Expand/Shrink long side, long side of the red frame will be shrunk,
click until solder fillet is excluded. Click upper arrow of Expand/Shrink short side, the
other side should be enlarged, in order to detect the edge of component stable.

4. Start inspection. The exceeded angle is shown on the NG component (Screen 5b).

1

(Screen 4) (Screen 5a) (Screen 5b)
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8-7-6

(Screen 6)

(Screen 7) (Screen 8) (Screen 9) (Screen 10)

5. You can even know the angle of good component by re-inspecting or analyzing. Result will
be displayed in message bar (Screen 6).

6. If Pack Stamp picture has less difference to compare with surrounding, the master picture
is crossed out (Screen 7).

7. If angle can not be detected well, test Image Processing in Option settings for Angle
Limit window. It can be improved. For detail of the options, please refer to the following
item “Option settings menu”.

Hl How to set (Offset)

H Notice

Select offset from pull down menu. Now up to maximum 12 degrees rotation is detected
and assigned as rotation offset. If it is failed to detect rotation, inspection continues with-

out offset.

- Component such as 0201 size (0402 in millimeter) is too small, as a result Angle Limit pull-
down menu is greyed out and unable to select (Screen 8). At least 36 pixels are necessary
for long side. (To convert in millimeter, approx. 0.9mm with 25 micron lens, 0.7mm with
18.8 micron lens and 0.35mm with 10 micron lens.)

- If the component edge is not sharp (trapezoid or rounded), the line for measuring angle can
not be clearly detected and an error message will be shown (Screen 9). Also if component
color is similar to PCB color, angle can not be detected.

- Angle is detected along long side. Therefore the Pack Stamp which shape is nearly square
such as SOP, can not exclude solder fillets even shrinking long side as much (Screen 10).
Such component is not suitable to detect angle in Pack Stamp setting. Try the method “In-
clude AngleCheck stamp in Pack Stamp” described on next.

- Angle Limit function requires 15 Ms per inspection point. However, the calculation is car-
ried out in the other thread. Therefore, this will not affect to inspection speed much.

- Angle limit can be set in 0.5 steps, nevertheless actual measurement accuracy is 0.08 de-
gree.

- NG pictures are not sent to CS-Center in NG Cell View or Auto send for all NG

in faster mode.
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H Include AngleCheck stamp in Pack Stamp

Though Pack Stamp already has the function to measure angle, there is an exclusive stamp to measure
angle called AngleCheck stamp. This stamp can be included in Pack Stamp, and in Pack Stamp this can
work as “Measure angle of desired area”, and “Able to use Image Processing options such as

Emphasize Contrast that AngleCheck stamp does not have”.

For example SOP mentioned in Notice on Page 7, is nearly square shape and can not exclude solder
fillets. But this can be measured well by using AngleCheck stamp in Pack Stamp (Screen 11).
* Expand/Shrink long side and Expand/Shrink short side is not possible to use when AngleCheck

stamp is included in Pack Stamp, because AngleCheck stamp can be resized flexibly (Screen2).

8-7-6

)

Various lines exist, could not detect angle. Could detect angle because detection area was limited.

(Screen 11)

(Screen 12)
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8-7-6

(Screen 13)

H Option settings window (Screen 13)

1.

Expand/Shrink long side

Make area of long side where angle is detected be longer/shorter. The
area is displayed in red rectangle. There is limit to expand/shrink.

Expand/Shrink short side|Make area of short side where angle is detected be longer/shorter. The

area is displayed in red rectangle. There is limit to expand/shrink.

@

Test

Confirm how line will be detected in current condition.

Default

Clear increase/decrease of item 1 and 2. Set detecting area to be on
default size.

Below options can be selectable after checking “Custom settings” on.

5.

Emphasize contrast

Enhance detection level.

6.

Exclude color element

In order to avoid detecting unclear/thin lines, exclude RGB color and
binarize in black/white.

Reduce noise

Exclude unclear/thin lines, and set only clear/thick line to be the
measurement target.

82

8. Stamp Operation




V¥ 8-7-7 Extra Settings No.3 Measure Distance

With this function, we can measure the shifting distance by setting the point to be base (Start Line). We
can obviously see the shifting amount numerically.

* Shifting to X direction can not be measured in current version. To Y direction only.

* If you can not find a good line to be Start Line, you can not use this function.

* This function is to detect slight position shifting in small area.

* The menu is greyed out until activating in For Supervisor's menu.
H How to set

1. First of all, activate this function. Open For Supervisor in Configuration menu. Select Plus
tab, check on Enable measuring [Distance] in Pack window. Press OK button in, then
quit For Supervisors settings (Screen 1).

2. Open Pack settings window. Check Distance on, then click Settings button (Screen 2).
Settings for measuring distance window opens (Screen 3).

3. Please refer Settings below, how to set measuring distance.

* When using Distance function, activate Search function also in Pack Settings window. If no Search
area is set, distance is measured from coordinates where you placed the pack stamp.

For example, below LED component is shifting 0.1mm downward. If no Search is set, the distance

is measured from the position where Pack Stamp is placed (Screen 4). If Search is set, Pack Stamp

searches LED component, correct distance is measured (Screen 5). The pack stamp’s position after

searching is shown by thin black frame by re-inspecting. The measurement accuracy is 0.01mm.

(Screen 2) (Screen 3)
(Screen 1)

(Screen 4) (Screen 5)
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(Screen 6)

H Start Line settings window (Screen 6)

1. |Detect Area

The black square indicated by red arrow in above picture is Detect Area.
Start Line should be found in this black area. Set the size, default value is
100x100 pixels. It is possible to set smaller value, however the information
to detect Line will be not enough and the detection will be unstable. Set
100x100 or 200x200 pixels. Maximum value is 300x300.

2. |Distance (mm)

Rose color line, that runs from the center of pack stamp to Start Line. This
defines the position of Detect Area. In above picture, Start Line is set to be
the border of the pattern, -7 in Y direction (7mm to upper), +2 is set for X (2mm
to right) in purpose of avoiding yellow silk print.

3. [Tolerance (mm)

Limit of shifting. Component will be judged as defect when distance between
the center of pack stamp and Start Line exceeds this value.

4. |Start Point (mm)

Set Start Line’s distance from the center of Pack Stamp. This defines the
standard distance. Normally you do not need to input here manually, because
after inputting “1. Detect Area” and “2. Distance (mm)”, length is automatically
calculated and result in “5. Current Point (mm)”. Press “6. set Current to Start”
button, then the value in Current Point will automatically be copied in Start
Point field.

5. |Current Point (mm)

Distance between the center of Pack Stamp and Start Line is automatically
calculated after inputting “1. Detect Area” and “2. Distance (mm)”. Input is not
permitted in this field.

6. |set Current to Start

The value in “5.” will automatically be copied in “4.” by pressing this button.

7. [Method

Start Line is detected by Edge method. The method is selectable from
brightness high to low or vice versa by switching H > L and L > H. Select
either that line can be detected clearer.

8. |Minimum luminosity

For detecting Edge steady, the brightness of 128 level is necessary. Normally
do not change this value. Nevertheless, according to PCB color, you may
decrease this level when you can not get enough luminosity, even after
switching Edge method or activating Emphasize contrast. The level can be
decreased at 64 minimum.

9. |Emphasize contrast

When detection of Edge is not successful, try this on. Sometimes Edge can
be detected well.
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(Screen 7) (Screen 8)
H Caution
When luminosity is not enough, a number is displayed with error message ‘No Line’ while

setting (Screen 7). Sometimes, detection may be succeeded by decreasing luminosity level
(Screen 8). However, brightness is not enough therefore some inspection points may fail to

be measured.

- Measure Distance function takes 1.5 Ms per inspection point. For example, if Distance is
activated on 1,000 inspection points, inspection speed will be decreased 1.5 seconds.
Plus, Search function must be used simultaneously, additional 2.0 seconds are required.

Do not use Measure Distance function on unnecessary points.

- It is not possible to set Start Line in the other FoV (Cell).
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8-8 Masking (Non-inspection area)

The Mask is used to designate non-inspection areas. Masked areas will be treated the same as the Mas-

ter Picture, and only the unmasked areas to be compared.

V¥ 8-8-1 Mask Settings

1. Select the Inspection Frame (Screen 1).

2. Select Edit Mask from the Pull-Down menu in the Master Picture Area (Screen 2).
3. Use the Edit tools beneath the Mask window to define the masked area (Screen 3).
4. Click OK to apply the Mask.

5. The masked area will be shaded (Screen 4).

There are the Rectangle, Oval, Pencil, Polygon and Line tools in Mask tools. The Rectangle mask can be
rotated. Draw a mask area with the Rectangle tool, at the end of drawing, press Option key. While press-
ing Option key, release your mouse. Again press the mouse button, and move the mouse to the direction
where you want to rotate the rectangle mask. When the mask area reaches to the desired angle, release
the mouse. The angle is shown at the message bar in Main screen. Pencil and Line tools can thicken lines

up to x3 by clicking x1 button. Undo is possible by pressing delete key (above return key).

M Editing mask size
In version 4.9.9r1 or later, you can change the size of “Rectangle” and “Oval” mask for “Pattern matching”
and “Scratch setting Stamp” . Use the Edit tools of “Rectangle” and “Oval” at the bottom of Mask Editor

window to define the masked area, then drag the anchors on Mask edge.

e

B8-8-1 ( )

(Screen 1) (Screen 2)

(Screen 3) (Screen 4)
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8-9 Reference Designators and Comments

Ref.Des. (= Reference Designator) and Comments can be applied to Inspection Frames and Stamps. For
example, when the component/part name is set as a Ref.Des,, it is easy to work by looking at the compo-
nent when importing NC Data. It is also possible to search for components/parts by the Ref.Des.
Inspection Frames include the Ref.Des. and other data such as unique number, position information,
number of inspections, number of NGs, data created and data updated (refer to “15-1 Exporting Data” for

details). The data can be displayed in Map View and exported to a text file.

V¥V 8-9-1 Input Ref.Des.

Select an Inspection Frame and select Input Ref.des. name from the Master Picture menu (Screen

1) to display the Ref.des. Properties (Screen 2). For example, a frame with the Ref.Des. “P1005R”, “1/1:
P1005R” will be displayed on the upper part of the Master Picture Area (Screen 3). Ref.Des. should be no
longer than 255 single byte characters.

If the Frame is duplicated by Duplicate Selection, (X. Y) will be added at the end of the copied Ref.Des.

H Set Ref.Des. name in consecutive number

In version 4.9.9r3 or later, you can apply Reference Designator number by fixed rules when you place the

Stamp. Open “Settings for Supervisors” window from menu Settings > Configuration > For Supervisor.

Open Assistant tab. Put check mark on “Set Ref.des. name in consecutive number”. When you place the

Stamp, Ref.Des. name is assigned with the rule “Stamp name — consecutive number”.

Ref.Des. name is assigned as same as for “Row Copy” function.

* If you place the Stamp more than 9999, consecutive number is not updated. All number will be 9999.

* This rule is not applied for the function of “Duplicate Selection” , “Matrix Copy Into Cells” , and “Multi
Duplicate” from the Cell menu.

* If Stamp name has more than 10 characters, Stamp name after 10th character will not be displayed.

8-9-1

(Screen 1) (Screen 2) (Screen 3)

87
8. Stamp Operation




V¥V 8-9-2 Find Ref.des.

List of all reference designator is displayed in ascending order when selecting Find Ref.des. in the Mas-
ter Picture menu (Screen 1). Number which is included in symbol name is displayed by numerical value
order, not character code. You can move to Symbol by clicking Jump button or Symbol name. Only the

Symbol including the input character is displayed when you use Search window.

V¥V 8-9-3 Show/ Enter Comments

When the operator judges OK/NG in the G/NG Confirmation Mode (See “13-4 G/NG Confirmation Modg”),
misjudgments may occur if the operator does not understand the programmer’s OK/NG concept correctly
Therefore, comments and orders of up to 30 single byte characters or 15 double byte characters can be
entered when creating Frames (Screen 1).

To apply a comment to all the same Stamp Frames, click on the Stamp button on the right of the com-
ment.

In the G/NG Confirmation Mode, this comment can be displayed in the Map view by checking Result with
Ref.Des comment in the Mode tab of the Settings For Supervisor window (Screen 2).

When importing NC Data containing Part Names, the Part Names can be converted as Comments. After
importing the data and before executing Combine Cells After Import, select Part Name to Comment

in the Edit menu (Screen 3) and click OK. Note that once Combine Cells After Import is executed, Part

Name to Comment cannot be selected.

8-9-2 8-9-3

(Screen 1) (Screen 1)
(Screen 2)

(Screen 3)
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V¥ 8-9-4 Ref.des. Properties

[Ref.des. Properties] window can be opened from the Window menu.
The window has the following contents.

Name Detail
Cell The number of the cell containing the inspection frame. This is a temporary number
assigned for identification.
Ref.des. Reference Designator of the inspection frame.
Comment Comment of the inspection frame. Click on the stamp button on the right of the column to

paste the comment to same frames.

Stamp Name

Stamp name registered at the time of creation. It cannot be changed.

Block No.

The number allocated at the time of blocking. It cannot be changed. See [11-5 Creating Cell
Blocks] for details.

Package Name

Package name can be registered.

Pin No.

Pin number can be registered.

This is the field for setting PCB number. The entry field appears when [Record inspection

PCB No. results by PCB number] is enabled in [LAN] in For Supervisor settings. See [11-6 Cell
Management with PCB Number] for details.
Move to the cell where the currently selected inspection frame exists. When multiple
Move to Cell inspection frames are selected, clicking moves to the cell where the topmost inspection

frame is located.

Reference Designator and comment of the selected inspection frame can be edited. Multiple inspec-
tion frames can be selected and edited simultaneously. A pencil icon will appear on the left of the Cell
number whose information has been edited.
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8-10 Frame Type and Show / Hide Setting

Select Show / Hide Object Type from the Window menu to display the Show/ Hide Object window.
In the Show / Hide Object window, Inspection Frames are categorized by type and user can set frames

to be visible or invisible.

V¥ 8-10-1 Frame type assignment

There are 2 tabs in the Show / Hide Object window. Default tab lists frames/stamps by shape and type
which this software defines such as Rectangle, Oval, Masked, Cell Aid, Solder paste, Custom 1 to 8 (Screen
1-a). In original tab, user can set the original frame type from ID 1 to ID 255 (Screen 1-b).

* Please refer to Chapter 9-2-1 Set filter Window to know how to apply original frame type to a frame.
Please refer to [Extra settings] on Chapter 10-4 [10-4 Settings Window] - [6. Control Panel] to know
how to apply original frame type to histogram inspection frame.

* Frame type defined in original tab is saved in software, therefore it is not possible to define per each

inspection data.

(Screen 1-b)

(Screen 1-a)
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(Screen 2-a)

(Screen 2-b)

(Screen 3)

V¥ 8-10-2 Display my original error message

Error message defined in error column is displayed together with machine original message after back
slash (/) when Display original NG error message, too is checked (Screen 2). By ticking both “Display
original NG error messages, too” and “Display comment with original NG error message”, displaying both
a comment applied on the inspection frames and an original error message is enabled.

Registered comments on the inspection frames are displayed by ticking Prioritize to display comment if

it is applied. Also, settings can be applied from/into another AOI by clicking Import/Export button on the

lower right.

V¥ 8-10-3 Send Original ID as NG-ID to CS-Center

If you use CS-Center, inspection point judged as NG is marked NG ID 0 usually, however if you assign
frame types, the ID number is sent instead of 0. Define frame type per inspection area like fillet, body, etc,
and define NG ID in CS-Center also the same. This is very powerful if you are activating “Auto send for all
NG”, because even sending NGs automatically to CS-Center, you can still roughly recognize the defective
trend on CS-Watch. Also it can be good reference when reviewing defects on CS-Repair or CS-Watch.

When using NG ID in this way, check "Assign NG ID input0-9" on.

* If a number is input from Tenkey, the number is sent to CS-Center in stead of frame type ID.

* If there are more than one defective stamps in Pack stamp, the younger ID number is sent.

* If you set frame type on both Pack stamp itself and stamps to configurate Pack stamp, the frame
type ID for Pack stamp is sent to CS-Center. Thus, "number from Tenkye" > "Pack Stamp frame ID"

> "youngest frame ID of a stamp in Pack stamp" .

V¥ 8-10-4 Stamp ID correspondence list

This list is displayed when clicking on ID to the stamps... (Screen 3). On this list, you can confirm which
stamp is assigned to what kind of original frame type.

However this is correspondence list for stamp, thus frame (not saved as stamp) is not listed. Stamp with
no ID, stamps which can not be assigned original frame type (Pack stamp, ExtraParts stamp, New Cell Aid

stamp and etc.) has ID:0.

o1
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By inputting ID number from 1 to 255 in correspondence list, you can define assign ID to stamp. By this

method, stamps such as Pack, ExtraParts, NewCellAid can also be assign ID.

V¥ 8-10-5 Hide / Show

Since Show / Hide can be applied by Frame type, it is easy to temporarily eliminate certain types of In-
spection Frames from inspection.

Clicking on the Eye Icon, closes the Eye, hiding the inspection area of that Category. Hidden areas will not
be inspected. Click again to open the Eye and show the Category, allowing that Category to be inspected
The value next to the frame type shows the number of Inspection Frames. For example, for Solder Paste
Check Inspection, the Inspection Frame will be counted as both Rectangle and Solder Paste, which

means that the total number may not be equal to the number of Inspection Frames (Screen 4).

8-10-5

)

(Screen 4)

92
8. Stamp Operation




V¥ 8-10-6 Control Tendency NG by NG-ID

Possible to set the number of NG inspection frame by each type in Show/Hide Object window. Possible
to show the alert when NG inspection frame more than set value is detected. This function is available

when Tendency NG function is activated.

H How to set
1. Display “Tendency/Ignore NG report” window from menu Settings > Configuration > Tendency NG.
2. Put check mark to “Active” at "Tendency NG" tab, and click “OK”.
3. Select "Show/Hide Object Type" from the "Window" menu to display the Show/Hide Object window.
4. From Original tab, set the number of inspection frame at NG column to display alert.
* NG column appears when Tendency NG function is activated.

5. Execute the inspection.

6. Alert message is displayed when NG inspection frame more than set value is selected (Screen 5).

8-10-6

(Screen 5)
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8-11 Assign Spot inspection
V¥ 8-11-1 How to set

You can set spot sampling in Show/Hide window’s original tab. Inspection for registers’ value or laser text

on IC are often detected NG by AOI because of misalignment or flux remaining on surface, though most of

them are actually Good. In PCB production line, if there are too many false NG, the whole line speed gets

slower and the rate of rolled through put yield is down. This function enables the spot testing of specified

inspection point such as text, register’s value. The setting is as following.

Input number in spot column where you want to assign spot inspection. Check Activate spot inspection

on the bottom of the window (Screen 1). In case you input 500 for type "r-text", the inspection for "r-text" is

executed on 1st time, 501st time, 1001st time... (Screen 2)

* All frames are inspected on the first time inspection.

* Count is initialized when closing inspection program or open other inspection program. If you want
to initialize during inspection, select Delete Logdata from Initialize in Edit menu. Be careful when

deleting Logdata, other logs are also deleted.

811
1stinspection 2nd to 500th inspection

)

(Screen 2)

(Screen 1)

/ N
Memo: Advice when applying spot inspection
If you apply spot inspection for a number on register,
you should better create a frame for body inspection to
check presence and reversing.
Filter Setting for the body frame can be very tolerant. Set
higher blur level, and set lower saturation and resolution.
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8-12 Automatic Positioning

When opening programs made by other 22Xs or making Cell copying or importing CAD data, position
misalignment may occur, it is time consuming to align one by one. Therefore, this software has an Auto
Reposition function. Select the Inspection Frame, and select Auto Reposition from the Edit menu or press
F4. The Inspection Frame will move to the position where it matches the Master Picture.

Also, pressing F9 aligns all Inspection Frames within the current Cell without selecting these Inspection
Frames. F10 aligns every Inspection Frame displayed within a Cell (including white Inspection Frames
which belong to other Cells), and include these white Inspection Frames into the Cell.

These Auto Reposition features will not function well if the difference between the Master Picture and the
local picture is too big, or the difference between the local picture and its surroundings is too small. Check

the positions with your eyes after Auto Reposition, and if it has not worked well, reposition manually.

8-13 Fixing Position
Opposite to the need of "Auto Reposition”, some of you need to "inspect at exactly same position as P&P
placed components" or " move back the frame exactly the same position after moving frame and adding
picture in pattern matching frame". There is an option to fix the frame position.
1. Open ForSupervisors menu from Configuration in Settings menu. Move to Action tab, check on
" Do not unlock fiducial offset ".
2. Open an inspection program. Debug the program. After debugging, frame position may change.
Press Start to check the program (Screen 1).
3. If there is any stamp which position has changed, an alerting message will be shown (Screen 2).
Select Back to Original position will move the frame(s) back to the original coordinates.
Select Update position will update the frame(s) position to new coordinates.

Pressing Cancel button will cancel the inspection. Also Cancel button can use to confirm which frame

is moved, the Cell including moved frame is colored in red in Cell Map Area. The moved frame is also

colored in red (Screen 3).

8-13

)

(Screen 1) (Screen 2) (Screen 3)

95
8. Stamp Operation




8-14 Load Program of Another AOI and Reposition

Misalignments caused by importing NC data or CAD data or from Duplicate Selection, can be corrected
by adjusting the offset of the Cell. To apply the offset only to specific cells, select the Move Tool and move
the Cell while pressing down the Option key (Screen 1).

To apply the offset to all Cells, press down the Option and Command keys while moving the Cell.

Bl Automatic Offset-- Reading programs made by different model machines.

When reading programs from machines with differing PCB sizes, the offset must be set because the Ori-
gin positions are different. In this software, the movement range of the machine is written in the program. If
the movement range of the program is different than the movement range of the current machine, a dialog
will be displayed asking if an offset should be set up or not. If this dialog is not displayed, the movement
range of the machines match.

When you press OK in the dialog, a rough offset will be set up.. The default offset values are X=0, Y=0,
please contact your local distributor for the proper values. To change these values, select For Supervisor
from the Settings menu and change the Machine Offset in the Movement tab (Screen 2).

However, since each machine is slightly different, final adjustments must be made manually by moving the
Cell or the Frames. In addition, if a programs for large PCBs are opened by a machine for small PCBs,
then a message, Position beyond movement limits, will be displayed. This means that the offset limit is

out of acceptable tolerances, making offset impossible.

H Automatic Offset — Reading programs made by machines of the same model.

Even if the machines are the same model, Origins vary by machine. So, when reading data created by
another machine, an offset will need to be set. If there are several machines of the same model, designate
one as the standard setup, and apply that offset value to the other machines.

The offset value should be entered in the Machine Offset dialog in the Movement tab in the Settings For
Supervisor window.

* Please be aware that the changed offset value will be applied to all of the Programs.

8-14

>

(Screen 1) (Screen 2)
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8-15 Convert stamp resolution

This function is useful for re-using inspection programs or stamps on new AOI with high resolution lens.

* If the illumination may differ, you need to re-take master pictures or tune-up histogram settings.

V¥ 8-15-1 How to convert

1. Select a menu.
To change the magnification of the inspection program, select [Open] from the File menu. To change the
magnification of a stamp, select [Open Stamp File] from the Stamp menu.

2. Finder is displayed. Select [Show Option] and check on [Convert] at the bottom, then select the

file that you want to convert (Screen 1).

O

3. Convert window is displayed. Select the resolution of this inspection program and the resolution

(Screen 1)

to output. Press Execute button (Screen 2).
22X version 6.6.3 or later has the resolution information registered in the inspection program, so the
resolution before conversion is set to [Inspection Program] and the resolution value is displayed in the
box on the right. If the resolution before conversion is [Inspection Program] and after conversion is
[Machine Manager Settings], the conversion can be performed by clicking [Execute] without changing
the values in principle.
If no resolution is registered, the value for [From] will be blank, so select a resolution from the pull-down
menu or set the resolution before conversion by entering a numerical value.

(Screen 2)

97
8. Stamp Operation




V¥ 8-15-2 Note

StampDB settings
When the converted stamps are registered in StampDB, setting is aquired. If the program contains
stamps which have the same name with DB, the window below will be displayed. Select stamps you want

to keep.

Stamps that do not support resolution conversion
Some stamps do not support resolution conversion. If placed, those stamps will be listed in TextEdit.

Non-supported stamps are as below.

Invalid stamps
CellAid NewCellAid CaptureStamp
BlockMark PanelBlockMark TargetFrame
NG Marking OK Marking Alway Marking
EP (Extra Parts) Solder ball
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9. Pattern Matching Method

9-1 How to Use

Pattern matching type is an inspection method that applies filter processing to an image and compares
the picture of a good product with the picture to make OK/NG judgment. If the difference in brightness or
color between a good and a bad product is close, the difference should be emphasized. If there are varia-

tions among good items, it is necessary to expand the range of good items.

9-2 Settings Window

V¥V 9-2-1 Set filter Window

Select the Pointer tool in the Work Area and double-click on the Inspection Frame, and the Filter Window

will appear (Screen 1). These settings can be confirmed in the Work Area in real-time.

9-2-1
(Screen 1)
H Brightness
Brightness can be adjusted within the range of -16 to +15. Click the icon on the right of the

Brightness to open Camera Special settings. For detail, please refer “20-1 Camera Special Settings”.

H Contrast

The contrast value can be adjusted within the range of -16 to +14. The highest value will be binarised into
black and white (BW). When converted, the brightness lever will be used to determine the divergence

point. The contrast can be changed using the Emphasis Area button to the left of the Contrast fader.
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H Hue

Hue (color condition) sensitivity can be adjusted. Moving the lever to the right (+ direction) will increase
sensitivity, and moving to the left (- direction) will decrease sensitivity.

Since monochrome images (white, black, gray) tend to react easily even to the slightest noise, sensitivity
should be lowered. An X will be shown when the value is set at the minimum, and the hue will not be de-
tected. When setting this item, the preview of the frame in the Work Area will be divided into two, showing
the range of acceptable colors (for example, with yellow parts, the left side may show red, and the right
side may show blue colors). The higher the sensitivity, the smaller the color difference in the two displays

will be (Screen 2).

H Saturation

Saturation (the shininess of color) can be adjusted. Moving the lever to the right (+ direction) will raise sen-

sitivity, and moving to the left (- direction) will lower sensitivity.

An X will be shown when the value is set at the minimum, and the Saturation will not be detected.

When setting this item, the preview of the frame in the Work Area will be divided into two, showing the ac-

ceptable range of brightness. The higher the sensitivity, the smaller the color difference in the two displays

will be (Screen 3).

* Optionally you can use Human Saturation instead of default saturation. Human Saturation's sensitiv-
ity is very much like human eyes. The option is selectable by checking on Apply Human Saturation

in General in Setting menu. The option is applied per each inspection program.

9-2-1

o

(Screen 2)

o

(Screen 3)

100

9. Pattern Matching Method



M Text

This setting binarises the Inspection Frame in black and white. This is used for inspecting text printed on
IC packages. When this box is checked, the left levers will change to those used to adjust brightness,
contrast and letter sensitivity (Screen 4). The Letter Sensitivity lever will change to AT when moved to the
far right, and will automatically binarise in black and white.It will change to AV when moved to the far left,
and will become a grayscale image. An another option button will be shown next to Text with RGB light

type AQOI. For detail of this option, please refer Chapter 20-7 Text filter for AOI with RGB LED.

H Fillet

Check this box when executing solder fillet inspection. Refer to Chapter 21 Solder Fillet Inspection.

H Position

Inspection Frames in which position misalignments occur depending on the PCB, can be made to be
judged OK by widening the inspection area, or, conversely, to be judged NG by limiting the acceptable
range of misalignment. Select the Position option for this setting.

* For details on this window, refer to 8-2 Position Limit/Tolerance Settings.

H NG is OK

When making judgments based on the existence of parts, an image with no parts can be recorded as the

Master picture, and be used as an OK when something is found. Check Match NG in this case.

H Edge

This filter extracts the outline of the picture in the frame. The extracted outline will be displayed in a light

color (normally white). When there is noise, both Blur and Edge should be used.

H Chase selection tab

This button sets the range for tracking a component/part. A component/part will be looked for within this
range, until inspection is OK. Click on the button to select the range of pixels to be tracked (Screen 5). If it

is set to 0, Track will not be executed.

9-2-1

(Screen 4) (Screen 5)
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H Resolution selection tab

This is used to designate how many pixels an Inspection Frame should be partitioned by. The default value
is the Default grid size in the Settings for supervisor window. It can be set within the range of 4 — 32
(Screen 6). Select a small value to look at details such as the shapes of letters, and select a large value

to ignore details. Inspections with high variances such as solder fillet inspection tend to have more false
reports when the frame is partitioned into grids. In this case, the frame can be partitioned into horizontal/

vertical, or not be partitioned at all (max).

M Special %

This corresponds to the Match Rate for OK in General Settings. You can set what % of a match will be
judged as OK. The default is OFF, and in this case, the Match Rate for OK will be applied. By highlighting
this button, the match rate within this filter can be changed within the range of 1 — 100% (Screen 7). Click

again to remove the highlight, and the Match Rate for OK will be highlighted.

H Blur level

The following 4 types of blurs will be selected by clicking:
Blur All : The entire image will be uniformly blurred. This is effective for decreasing false reports.
Horizontal Blur : Strong blur only in horizontal direction. Used to eliminate noise on a flat surface.
Vertical Blur : Strong blur only in vertical direction. Effective for deleting letters.
Electrode Blur : Blurs electrodes to decrease false reports.

The blur level can be changed up to 48 using the triangle icons on the right. Also, when you click inside
the Blur Range frame, an arrow will appear. Dragging the mouse in the direction of the arrow will change
the level (Screen 8). If you would like to ignore slight differences based on the condition of the parts, the

blur level should be set as high as possible.

9-2-1

(Screen 7)

(Screen 8)

(Screen 9)
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W Make Stamp Reversible

Adds the 180-degrees-rotated Master Picture of the currently selected stamp. This function is used to
register parts that are not oriented. The same operation can also be performed by selecting [Make Stamp

Reversible] from the Stamp menu.

B Show in real time

When this button is checked, inspection will be done in real time when changing filter settings. However, if
this button is activated, blur or Letter extract condition will not be displayed. We recommend to check-off

button when creating frames, and check-on when debugging.

H angle

Field to input component angle. By pressing up and down button, input +/-15 degrees automatically.
M Frame type

If you define original frame type in advance in Hide/Show in Window menu, the original frame types are

selectable. Please refer Chapter 8-10 Frame type and Hide/Show settings to define original frame type.

M light Selection

This feature only works in AOI with multi lightings. Refer to 9-4 “Image Filtering by Lighting Selection”.

Hl Camera Button

Renew or Add Master picture by clicking this button.

H test / analyze

Confirm inspection result or see inspection step.

H clear

Set filter to default.
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V¥ 9-2-2 Cautions When Setting Filters
M Re-inspection
When filter settings have been adjusted, make sure to confirm the results before moving on to the next
task. After changing filter settings, you can re-inspect and analyze the selected Inspection Frame with the
test button and the analysis button In the Set filter window
* When there are multiple Master pictures, re-inspection will be executed for all Master pictures,

but analysis will be run only for the one displayed on the screen. To analyze other Master pictures,

switch over Master picture displays and press the Analysis button.

H Sensitivity Setting

Please note the following when setting sensitivity.
There are many ways to set sensitivity, but in general, raising Contrast will increase sensitivity, and reduc-

ing the Resolution value will increase sensitivity to fineness.

+ When sensitivity should be increased Defects tend to be missed in the following cases.
In these cases it is better to set sensitivity to a high level.
1. The PCB color is dark, and components/parts are also dark
2. The components/parts are mainly black and white (monochrome), with little differentiating char-
acteristics

3. The frame is small (inspection target is small)

* When sensitivity should be decreased False reports tend to increase in the following cases.
This can be avoided by setting the sensitivity to a low level.
1. The color condition of the components/parts varies
2. Electrode area too large

3. The frame is large (inspection target is large)

B NG judgment

Steps in NG judgment by pattern matching are:

1. Pattern matching of each RGB element --> 2. Hue judgment --> 3. Saturation judgment.

Judgment must be OK in each step in order to move on to the next step. When judged as NG, a message

window will appear showing where the problem was found (up to which step was OK). The messages

include the following:
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1. Mismatch

Does not meet specified value in RGB pattern matching.

2. Mismatch by Hue

Does not meet specified value in Hue judgment. (OK in RGB pattern matching.)

3. Mismatch by Saturation (too low) Mismatch by Saturation (too high)

Does not meet specified value in Saturation judgment (OK in RGB pattern matching and hue judg-

ment.)

H Text Extraction

The Master picture and the Inspection Frame picture must overlap to a certain extent to make the Track
feature (Find target object feature) function well.

When making judgments based on letter extraction or binarising, if positions of pictures or text do not
overlap correctly, activate Find. It will be highly sensitive to differences when comparing binarised pictures.
In general, in order to prevent false reports, Blur All should be activated. If there are still false reports, try
lowering contrast (Screen 1).

If Letter B/W threshold in Settings for supervisor is O, the image will automatically become mono-
chrome. This setting will consider white objects as text even if the actual color of the text is black. In this

case, the sensitivity lever will be used to adjust the surrounding noise level.

H Limit of Text Extraction

Binarising (black & white) will be executed when Letter is selected, but in order to convert correctly, a more
than 5% difference in brightness will be necessary. If the text is blurred, it may be difficult to accurately
display by conversion, change letter sensitivity to AV. The picture will change to a grayscale image. Adjust
brightness and contrast here before applying Blur to eliminate excess noise. The effect by this process

is different from the binarising process. However, this method is not versatile. Please think of this as one

possible option.

H Position settings

When finding the misalignment of text in the horizontal direction, the Find will be more efficient if the area

is larger horizontally. In this case, you should set a Find area for each Inspection Frame.
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9-2-2

(Screen 1) (Screen 2)

9-3-1

(Screen 1)

l Show Matching%

When inspecting without speed priority, re-inspecting and analyzing each Inspection Frame, the inspec-
tion results can be displayed in %. Normally this may obstruct the view of the inspected object, so % is

hidden. To display, go to Settings for supervisor > Mode and Remove the check of Hide Matching%.

H Binarising Using Contrast Adjustment

When the contrast adjustment lever is set at a maximum, the value will be binarised in black and white,
and if Text Extraction is not selected, the saturation lever will change to Automatic Correction and be used
to adjust conversion levels (Screen 2). This will not change on the negative side but only on the positive
side, and the larger the value, the wider the accepted range will be.

When you continue to press down the button where you set the lever, the screen and the Master picture

will show the range of correction.
9-3 Position Limit/Tolerance Setting

When Position is selected in the Set filter window, the Position tolerance setting window will appear. You
can set the tolerance value here (Screen 1).

Position is mainly applied to items that are easily misaligned but would like to ignore the misalignment of,
such as text printed on a chip. If the Position Limit is designated, the misaligned distance can be obtained
when the results are displayed. You should set offset limit with chip parts that you would like to judge as

NG if misalignment exceeds this level.
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V¥ 9-3-1 Position tolerance setting Window

The following items can be defined in the Position tolerance setting window. Input values.

H Chase setting only

When this is selected, no searching or position limit is set (default).

W Default search range

The rate designated in Default find range frame in the Sensitivity tab of the Settings for supervisor will be

applied as the seeking range for Inspection Frame (default is 200%).

H Set search range

You can designate the seeking range in pixels. The values can also be confirmed and adjusted here. Use
the pull-down menu below to automatically set values depending on the proportion to the Inspection
Frame (1/2 - 1/5). If this value is 1/2, the seeking range will be 1/2 the length of the lateral side of the In-

spection Frame added to each side of the Inspection Frame.

H Set offset limit

The position limit can be designated in mm. When the limit is set here, the distance of misalignment will
be displayed with the results. The limit can also be designated by Command + drag. In addition, as with
Range designation, you can use the pull-down menu to automatically set the values by the proportion to

the lateral side of the Inspection Frame.

V¥ 9-3-2 Position tolerance setting Using the Mouse

H Set search range

To set the search range, select the Inspection Frame with the selection tool, and place the mouse pointer
on the bottom right corner. Press the Control key and the pointer icon will change. Press down the Control
key while dragging the mouse to set the range. The range will be displayed as a line extended from the

Inspection Frame (Screen 1).

9-3-2
(Screen 1)
(Screen 2)
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H Set offset limit

To set the offset limit using the mouse, select the Inspection Frame with the selection tool, place the
mouse pointer on the bottom right corner and press the Command key. After the icon has changed, press
down the Command key while dragging the mouse. The limit will be shown as a frame with 4 corners
(Screen 2).

* The maximum search/offset limit is 127 pixels.
9-4 Image Filtering by Lighting Selection

This feature only functions on AOI with multi lighting which can be switched off/on individually.

Settings for lighting at inspection can be selected on devices equipped with DOAL (Diffused On Axis
Lighting). Depending on the inspection, you can select from 6 options: Default, Main, Main + DOAL, DOAL,
Side, and Side + DOAL. Multiple settings can be applied to the same cell (these settings will not increase

the number of camera movements).

V¥ 9-4-1 Light Selection Window

Click on the light selection button in the Filter Setting window, and the lighting selection window will be

displayed (Screen 1).

H Default

Main light only. Select this to reset the other settings.

H Main

Main light.

Bl Main + DOAL

When the DOAL is shined on the PCB, the convex sections of parts will appear black since the light does
not reflect back. This setting combines the image from the main light to this part. When inspecting parts
that have colors similar to the PCB, Main + DOAL will enable stable inspection by making the PCB surface

glitter and make parts stand out.

9-4-1

(Screen 1)

108
9. Pattern Matching Method




H DOAL
This lighting shines on the PCB vertically and reflects back only the flat parts, with the flat parts appearing
white, and the convex parts black. It will be easier to check for the presence of solder or scratches that

are hard to detect with the main light.

H Side

The lamp shines from the side to vertically reflect light that hits objects with angles. It makes solder fillet

forms and text prints with laser markers stand out.

H Side + DOAL

This combines the side lamp red image with the black DOAL image. It is easier to see the condition of the
solder of the leads that are difficult to distinguish with only DOAL or side lamps because the image be-

comes all black or all red.

B Emphasize Color / - Color

[Emphasize Color] and [- Color] can be used on [Main + DOAL] and [DOAL] lighting.

Check [Emphasize Color] to make colors vivid. It can be used to detect unsoldered areas and inspect
solder fillets. Click [Non] to remove a color (Screen 2). The color can be chosen from red, green and blue.
This function can be utilized to remove the specified color when the color of the PCB is reflected in the
solder fillet. To use [Emphasize Color] and [- Color], check [Enable color with DOAL] from [For Supervisor]
- [Action] (Screen 3).

* With inspections that allow less solder in the pad, it may be judged as NG depending on the amount

of solder.

V¥ 9-4-2 Settings of Light Selection

1. Double-click on the Inspection Frame to display the Filter Setting screen.

2. Click on the light Selection on the bottom right to display the Lighting Selection window.
3. Click on a button and the Work Area will change to the selected lighting.

4. Choose the proper lighting, and click OK to close the window.

0-4-1

—— 1

(Screen 2) (Screen 3)
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5. Lighting selected here can be confirmed with the status icon located at the left of the Lighting
Selection button.
6. Press the Camera button to change the Master picture, and set filters if necessary.
7. After all the settings are complete, press OK and close the window. If the Master picture has not
been replaced, a warning window will appear.
Place the mouse pointer on the Inspection Frame for which you set the lighting selection, and the screen
will change to the selected lighting.
* If there is problem with captured image because of a flash synchronization, press the Renew DOAL

Timing button in the calibration window to make corrections.

9-5 Measurement against escaping NG and false NG
While debugging pattern matching stamps, if defect is escaped or if there are too many false NG, please

change filter parameters accordingly;

- If there is little difference in color tone between an OK and NG component, select only the

distinctive
part as the Inspection Frame.

- If the colors of both the component/part and the PCB are similar, use histogram algorithm.

- Change grid from default 8 to 6 or 5 to detect the details.

- Increase Hue/Saturation level to catch the slight difference of the color.

- The Chase Limits setting allows slightly misaligned parts to pass the inspection process. How-
ever, if the range is set too wide, parts that should fail will be passed. Decrease the Chase level

to be judged as NG or set Offset Limit in “Search” setting, in case the component is misaligned.

V¥V 9-5-1 Filter Adjustment

Check the analysis results, then adjust the filter. Inspection results will change depending on the settings
of the filters. To find the optimum settings, it is important to execute a re-inspection every time the filter
setting is changed for improvement. Set Filters by double-clicking on the Inspection Frame.

Handling false NG is to say in another word, “increase tolerance”. Set blur or increase blur level to absorb
the slight difference of lead area. Decrease Hue/Saturation level to absorb the slight difference of colors.

In addition, changing grid number is also effective. Default number is 8, this means OK/NG criteria is done
per 8 pixels. If you increase the grid pixel number such as 12 or 14, OK/NG criteria is done per 12 or 14

pixels. As a result, criteria becomes more tolerant.

V¥ 9-5-2 Adding Master Pictures

A quick way to reduce False NGs is by adding an additional Master Picture, that has been found to be
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False NG. The problem with this is, the more pictures there are for comparison, the longer the inspection
time will be, and it also narrows the choices of future adjustment methods. If possible, we recommend
using techniques like Filter Adjustment, that have been explained above. Master Pictures can be added by

the following procedure (Up to 24 Master Pictures can be saved.).

1. Select the frame.

2. Select Add Picture in the Pull-Down menu on the Master Picture Area.

3. The added picture will appear next to the existing Master Picture. Each Master Picture can be
activated using the slider bars below.

4. In order to Delete a Master Picture, display the picture to be deleted and select Delete Picture
from the Pull-Down menu on Master Picture Area. Please be careful because this process

cannot be undone.

V¥ 9-5-3 Change lighting

This is a feature limited to systems equipped with multi lighting. When inspecting a small component
mounted on a similar colored PCB, a common technique used to emphasize differences is to increase the
brightness and contrast settings. However, the disadvantage of this technigue is that the system will be
overly sensitive to the uniformity of the components/parts themselves, resulting in increased False NGs. In
addition, non-uniformity in the brightness of the solder area affects the shape and size of the surface area
in solder print inspection, resulting in non-uniformity upon inspection. Therefore, in order to make it easy
to see the difference between each image, change lighting or use combined lighting. This feature can be

accessed from the Filter Settings Window.

V¥ 9-5-4 Assign as NG picture

Adding Master Pictures will reduce False NGs, but since this process requires the pattern matching of all
Master Pictures, it will result in longer inspection times. Therefore, an effective way to reduce inspection
time is to assign Master Picture as NG picture. If there is a certain pattern that is judged to be, you can
register that pattern as an NG picture. Since the system first compares the picture with NG pictures, the
NG points can be judged NG before detailed analysis. This is effective, for example, in cases where errors
follow a certain pattern such as parts not being where they should be or part B being located where part
A should be. NG pictures can be added as Master Pictures, and then set as an NG pattern by selecting
Assign as NG picture from the Pull-Down menu in the Master Picture Area.

After these changes are made, inspect again. In order to improve accuracy, inspect at least 5 PCBs and

make filter adjustments to reduce False NGs.
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10. Histogram Analysis Method

Histogram Inspection judges Good/NG if the amount of Brightness of the target color out of Grey/Red/

Blue/Green is within the specified range of histogram.

10-1 How to Use

We recommend to use this inspection method for the unstable shaped parts which the inspection can be
result in False NG or escaping NG, such as solder paste or solder fillets.

Also, applying this for inspecting the color code on resisters or for inspecting simple color such as polari-
ties can make the inspection speed faster. This stamp can increase the inspection accuracy and perfor-

mance to use with the combination of pattern matching inspection.

10-2 General Procedure

1. Set a PCB (It is better if the board is a good one or if you already know the NG points.)
Draw a frame, go to Window -> Histogram Analyzer and open the window.

2. Open Sampling tab and press Sampling button. Press OK and quit the window.
A dialogue to input a stamp name appears, input stamp name.

3. Paste this stamp where to inspect, then start inspection.

4. After inspection, open Histogram Analysis Window and open Stamp tab.
Check images on sampling list, if there is any image which is widely shifting or obviously
defective, delete from the list by sub menu [Delete from list].

5. Press [sample image] button, and create composite image. Draw trap frames on the composite
image. Press [debugging] button in order to check if all sampling image can be OK.

Adjust trap frames until all sampling images to be OK.

10-3 Limitations

You can treat Histogram stamp as same as pattern matching stamp, however these are not possible.
- Set offset limit for position tolerance settings.
- Hold horizontally flipped master picture.
- Flip Zoom/Unzoom.
- Create from Oval/Polygon Frame.

- Rotate stamp with Option key
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10-4 Settings Window

Each function in this window is shown below;

No. Name Details
1 |Light Selection Selects lighting.
2 Blur Blurs the trap frame.
3 (Filter Sets a filter that facilitates detection.
4 \Work Area The inside of the inspection frame is displayed. Set the trap frame here.
5 |Trap frame tools Selects or deletes the shape of the frame to set on the inspection area.
6 |Graphs Displays the color % and judgment range within the selected trap frame.
7 |Sampling Extracts, debugs, and reads inspection frames of the histogram inspection.
8 |Trap frame attribute |Sets ID, group, and detection result comparison for each trap frame.
. . Sets trap frame settings, color selection for inspection, OK/NG settings,
9 |Histogram settings , . " . .
inspection conditions, special settings, and search range.
When the sampling button in [6. Sampling] is pressed and an inspection or
10 [Sampling image list  |re-inspection is performed, a list of inspection frames with the same name
stamp is displayed.
11 |Stamp Window Displays the Itype and number of stamps sampled. Stamps can be switched
by double-clicking on the name of the stamp.

The flow of setting inspection locations is as follows:

1. Select (4) trap box shape according to the inspection target and place it in (3) work area.

2. Set (1) blur settings, (2) filter settings, (5) detection range on the graph, (7) ID and group, and (8)

inspection settings within the frame.

3. (6) Set sampling and register as a stamp by clicking [OK] in the lower right corner.

Subsequent pages will explain each function in detail.
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1. Light Selection

The lighting can be changed for models with selectable lighting.

* Confirmation message is displayed after changing Lighting.

2. Blur

The meanings and recommended uses of each button are as follows;

Unblurred | No blurring.
Total Uniformly blurs the entire inspection frame. Effective in suppressing false NGs.
Horizontal |Blurs horizontally. Effective for eliminating noise on flat surfaces.
Vertical blurs Vertically. Effective for erasing text.
Edae Blurs the edges of the inspection frame. Effective for reducing false NGs at the
9 electrode.
After setting the blur type, the blur intensity within the inspection area can be set
Blur level , , . .
with the button or slider. The maximum value is 48.
3. Filter
. Checking this increases saturation balance of image in Work area. Check when you can
Saturation

not see enough contrast on the image.

Polarity

mark.

Checking this reinforces image contrast. Check when you can not distinguish a polarity

4. Work Area

Create trap frames by trap frame tools. Trap frame is colored in blue when Good, and colored in red

when NG.
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5. Trap frame tools

“Trap frame” represents the area to be inspected for criteria. Maximum 31 trap frames can be created.

Tools for creating the trap frame. Rectangle, Oval, Rounded Rectangle and Polygon tools
are selectable. Default tool is Rectangle tool.

Group select tool. Drag mouse on to multiple trap frames with this to make frames in
group. Selected trap becomes [OR] and group ID [gr] is set. Group ID is set on (7) Trap
frame attribute.

Mask tool for Rectangle, Oval, Rounded Rectangle trap frames. The slider is displayed to
adjust the mask size. Mask shape can be altered to the exact circle by clicking a button on
the right edge of the slider.

* Mask is not used for Polygon.

Synchronize tool. Changes on a trap frame can be applied to all trap frames with the
same group number [gr] or ID number [id]. Number O is regarded as not belonging to any
groups. The message “Apply to “group number” or “id number” ?” is displayed when
selecting. Choose a number to be synchronized.

Trash. Selected trap frame is deleted. Trap frame is also deleted by ‘Delete’ key.

* It is not possible to delete multiple trap frames at once.

6. Histogram Area

Each graph of Grey/Red/Blue/Green colors, percentage, and target range are displayed.

The grey scale bar on beneath is a reference for brightness/darkness.

Graphs

The color chosen in (8) Histogram settings is represented in bar graph. The other colors
are represented in line graphs.

Percentage

Displays the amount of light between the target range. It is colored in blue when the
amount is within OK percentage, and is colored in red when out of OK percentage.

Target range

The range between the dot lines is the target range for OK/NG judgement. The range
can be enlarge/narrow by dragging the dot lines. The target range can be moved without
changing the width by dragging on the letters of [%]. The exact positions of dot lines are
displayed on [< >] in trap frame condition.

* When you click anywhere within the judgment range, the area within the trap frame will be

highlighted in yellow.
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7. Sampling window

Debugging +Master/MNG pics

Performs inspection frame extraction and debugging, as well as loading of master picture and NGs.

All histogram Inspection frames are sampled by inspection with this button on.Possible to
activate from Window menu. Shorcut key is option+command-+F. When sampling is ON,
the icon is displayed in message bar.

Sampling
* Sampled data is deleted from sampling list. It does not mean that actual frames in

Work Area are deleted.
Debugging |By pressing this button, you can re-inspect all frames in sampling list.
+Master/NG , , , . N
. Read [master picture] and [master picture assigned as NG picture] on sampling list.
pics

8. Trap frame attribute list

Set an attribute for each trap frame; ID [id], Group [gr] and compare detection result [< >].

*The line colored in grey is selected trap frame in Work Area.

i ID number. Unique continuous numbers are automatically set when you create trap frames.
By manual keyboard input, you can change this number.
Group number. Number 0 is the default value when you create a trap frame. By inputting
another number, you can change this number. You can make trap frames with same num-
- ber in a group. There is ‘OR condition’ of inspection criteria in this group.
The images below contains 2 trap frames with [gr] number 1, in this case there is a condi-
tion ‘if one of the trap frame is OK, the other can be NG’
* [id] and [gr] numbers can be set from 1 to 32.
If the trap frame with the same ID is in the column directly below, select “<” (less than) or
<> “>” (greater than) to compare the detection results. The percentage of the trap frame to be
compared is judged as non-defective, and the OK% is ignored.
r— =
Copied ID1 L— =

. 7

A ~

60% > 13% = OK

ID1
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9. Trap frame condition table

Target range <>, % to be OK, inspection target color, reversing OK and NG are set on the table.

N

The roll of OK and NG changes. The target range not reached to OK % (=NG) results in
OK. Same function as NG=OK in filter setting window of pattern matching frame.

Target range

The histogram graph is from 0.00 to 1.00. The value in [<] is the position of left dot line. The
value in [>] is the position of the right dot line. These values change automatically by mov-

target color)

<>

(<) ing dot lines by mouse. Manual value input is also possible.

ok% Percentage which should be judged OK. Default value is 50%.

RGB

. . Selects inspection target color from GRAY / RED / GREEN / BLUE. The colors not selected
(inspection

here are out of inspection.

Number of condition(s), AND/OR, target range adjustment and Extra settings are set below the table.

[ - ] button deletes a condition, and [ + ] button adds a condition. They are useful when

Add/delete ) , ) , N ) )
[-/] you'd like to inspect more colors or inspect under multiple conditions. Maximum 31 condi-
tions can be added.
In case if a trap frame has multiple conditions. you can select their criteria condition to be
AND/OR AND condition [&], or to be OR condition [or]. In AND condition, all settings should be OK.
In OR condition, if one setting is OK then the rest can be NG.
Default condition is OR [or]. It can be switched to AND [&] by clicking on the pull-down.
Auto / Auto button sets target range and color automatically. Enlarge button enlarges target range
Enlarge 4%/ +0.03 to both side, and narrow button narrows target range -0/03 in both side.
Narrowb 4 Enlarge button does not spread when the range is over 50%, narrow button does not
shrink when the range is less than 5%.
Search: left |Decides the pixel(s) amount for the program to track the parts/components positions.

Search: right

Decides the pixel(s) amount for the program to search the histogram matching area.

Extra

settings

Menu for advanced settings. See the next page for detail.
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ltems for Extra Settings are as below.

Set an angle on histogram inspection frame. Enable to input 1 to 89. By check on “To all”

Angle option, the same stamped frames in Work Area change into angled frames.

Also this stamp on Stamp Library will change into angled stamp.
Frame Type |As same as pattern matching inspection frame, original frame type can be set.
Customize |Possible to customize the default value for search area. “Trap has all colors in AND condi-
default tion” is, normally one color is selected to analyze, with this option all 4 colors are selected
settings in AND condition.
Picture Image in Work Area can be displayed in only inspection target color. Blend (%) is the per-
display centage that the original image is blended. Activate this option when you are new to histo-
option gram inspection, and if it is difficult to decide where to create trap frames.
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10. Sampling List

The list for debugging efficiently. If [Sampling] button in 8. Sampling tab is ON, then inspect or re-inspect,

same stamps pasted on PCB is all collected and displayed here.

Picts Displays picture(s).

Displays matching %. It there are multiple trap frames in Work Area,

The minimum matching OK% from all trap frames is displayed when OK.

% The maximum matching NG% from all trap frames is displayed when NG.

* If Search for trap frame is set, % displayed here is the % after searching and moving.
Therefore the value can be different from which of shown in histogram graph area.

Different ID numbers and text colors are displayed depending on the inspection results.

id The detail is as below;
0:NG Red
1:0K Blue
2 : sample image Right Green
3 : master picture assigned as NG picture Rose
4 : master picture Dark Green

* List can be arranged in descending/ascending order by double clicking on [%] or [id].

Move to select frame
Delete from list

When double clicking on the picture, a sub menu pops up.
Move to select frame:  Move to the position in Work Area.
Delete from list: Delete from the list.
(Does not mean to delete stamp in Work Area)

Add as NG pic: Save the image as NG pic in stamp.

* Add as NG pic function is not active and un-selectable when saturation filter is ON.
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11. Stamp window

# Stamp
15 Fillet:Z0603

11 Fillet:R G603
3 Fillet:OFP_laad

& Polarity:tan

sampla image

Sampled stamps are listed by name with placed numbers. By double clicking on stamp name, sampled

images of the stamp is listed in sampling list.

# Displays the collected stamp number. If there is NG stamp, the number is colored in red.
Stamp Name of stamp(s).

Creates a composite image from all sampled images. The composite image has id num-
Sample ber 2. Once you press this button, composite images are generated not only for selected
image stamp but also for all stamps. Because the composite image is the average of all, it can be

the best example for drawing on trap frames for the first time.

* Please reload the sampling list by double clicking on the stamp name. Without reloading, composite

image is not displayed on sampling list.
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10-5 Hints for creating/adjusting trap frame

When creating trap frames, it is the most important to understand the feature of NG parts/components.
Place trap frames where differences between good part and defect part is obviously caught.

Here are the examples of trap frames to detect major defective phenomenons. (By Model22X HDL-350)

V¥10-5-1 Tombstone (Machine: M22X HDL-350)

Such error can clearly be detected with lighting combination of MAIN + SIDE + DOAL.
Paste histogram stamps on fillets of both side.

Good fillet is skewed, and skewed area is colored in red because of SIDE lighting detection.
Bad fillet is not soldered, thus not skewed and red.

Therefore, create a trap fame as below.

- All color except red is gathered around the middle of histogram. Select Blue/Green/Grey as inspection
target color. You may like to select Red because the image is Red, but in deed the graph of Red is not

characteristic enough.
- Press 4 I button a few times to increase tolerance slightly.

- Check the trap frame on bad fillet, it is detected as NG. The histogram is very bright in all colors, the
graph shape is very different from good fillet.

10-6 Measurement against escaping NG and false NG

If the traps allow NG to escape or if there are too many false NG, adjust accordingly.

1. [enlarge / narrow] target range. [increase / decrease] ok%.

2. Change the target color.

3. Add a target color. ex. Create 2 conditions by AND/OR; ‘should be more than 50% of red in
brighter area’ and ‘should be more than 50% of blue in darker area’.

4. Increase numbers of trap frames, and create a group from them. By placing multiple trap frame,
you can increase/decrease criteria tolerance. Also this is effective for position shifting.

5. If you have NG PCB, make trap frames which detect the NG correctly.
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10-7

(Screen 1) (Screen 2)

10-7 Convert pattern-matching stamp into histogram stamp

You can convert pattern-matching type stamp into histogram type frame by following procedure. This
is very useful. For example, in case if you want to change fillet inspection frames in Pack stamp into
histogram frames in current program, by using this function, you do not need to create new stamp and

replacing it to current stamp.

V¥ 10-7-1 Limitations

1. Stamp in Pack Stamp can not be converted from Pack Editing. The only way to convert stamp
in Pack is placing the stamp in Work Area and convert. Then the stamp in Pack also changes
into histogram stamp.

2. Stamps with custom setting (Custom 1 to 8, which can be set by clicking sun icon next to
Brightness adjustment bar in Set filter window) can not be converted into histogram stamp.
If you even want to convert, reset the custom settings.

3. Oval and Polygon frames transform into rectangle frames when converting into histogram.

4. The stamp holding horizontally flipped master picture can not hold the flipped master picture

anymore.

V¥ 10-7-2 How to convert
1. Select stamp in Work Area. Select Histogram Analyser from Window menu (Screen 1). A
message asks "Create a histogram-type inspection frame?", press OK.
2. Histogram Analysis Window opens. Set and quit the window.
3. The pattern matching type stamp in Work Area is converted into histogram type stamp. And
stamp in stamp list is also changed into histogram stamp (Screen 2).

* The change on stamp list can not be seen immediately, unless stamp list is updated, for example by

adding new stamp or by deleting a stamp.
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11. Cell Operation

A Cell is the area the camera can cover in one shot.
11-1 Basic Cell Operation

When executing operations such as creating Inspection Frames in the Work Area, the screen of that Work

Area will be recorded as a Cell. When creating another Inspection Frame after moving by using Pitch but-

tons or the Move Tool, the Inspection Frame created there will be stored in a different Cell.Cell positions

will be displayed in the Cell Map Area at the lower right. Clicking on a Cell on this map will display the cell

in the Work Area (Screen 1).

To edit Cells, drag the mouse over the Cell (Screen 2). The Cell will become shaded, showing that it is se-

lected. The selected Cell can then be edited using the Pull-Down menu in the Cell Map Area to perform

tasks such as Assign to Block, Duplicate, Delete, Flip and Turn (Screen 3).

* Shaded Cells mean that they are selected. Cells displayed in black are the Cells currently displayed
in the Work Area. This status does not activate the Pull-Down menu, therefore the Cell cannot be ed-
ited. Drag the mouse over the Cell to edit it.

If you want to perform the same task on multiple Cells, select multiple Cells. Press down the Shift key

while dragging the mouse over areas that are not selected yet to add to the selection. If there are Cells

that you want to eliminate from the selected area, click on the Cell while holding down the Command key.

(Screen 1)

(Screen 2) (Screen 3)
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11-2 Duplicating Cells

Multiple Cells can be duplicated in a bundle using the Multi Duplicate command. When working with mul-

tiple PCBs, once you set up an Inspection Frame for one PCB, the other PCBs can be set up by copying.

The procedure is as follows:

* Some special stamps may not be copied, barcode stamps will not be copied unless they belong to
block Cellss.

1. Select the Cell to be copied in the Cell Map Area, and select Multi Duplicate from the Cell
Menu, or select Matrix Copy Into Cells from the Edit menu.

2. When the Multi Duplicate dialog appears, designate how many copies will be made along the
X- and Y-axis at the desired pitch. When duplicating from upper left to lower right, the pitch
should be set to a negative value.

3. The Multi Duplicate dialog contains a Preview Map that shows how the selected Cell will be
copied. The copied Cell will be positioned in black, and if you click on the Cell in a position
where a copy is not needed, the Cell will change to white and will be removed from the copy
series (Screen 1).

*When there are too many copies to be displayed on the preview map, it is not possible to remove
copied cells from the copy series.

4. If there is a Cell in the exact same position that a copied Cell is to be placed, that Cell will be
replaced. In addition, if the gap between the existing Cell and the copied Cell is very small, the

Cell will be replaced. The Merge Nearby Cells trigger value, which sets the amount of mis-

(Screen 1)

Cell Map before Duplication Cell Map after Duplication
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alignment allowed to replace cells, can be changed from the Merge Nearby Cells in the Dupli-
cate window (the value of Merge Nearby Cells must be between 0.25 - 2.5mm).

With this feature, if you duplicate Cell A and make Cell A, when you modify the Cells, you only need
modify either Cell A or A" and duplicate the modified Cell on the other Cell.

5. After copying, confirm that the Cell is positioned as intended on the Cell Map. If the position
is noticeably wrong, select Undo from the Edit menu, or press Command + z and repeat the
procedure.

* If you want to copy the Barcode Stamp, open Copying window, and click “OK” with pressing Option
key. If there is check mark in “Apply for barcode in Block* function, Block number is assigned auto-

matically. For the detail of Block number, please refer to chapter “24-1-5 Block Assignment”.

11-3 Adjusting Cell Position

When the PCB is warping or parallel errors, misalignments occur. In this case, Adjust the Cell position.
1. Select the Cell you want to adjust in the Cell Map Area.
2. Select the Move Tool in the Work Area and drag over the screen while holding down the Option
key. The cursor icon will change, and as you move, the position of the Cell will move in the Cell
Map Area (Screen 1). If you want to move only along the X-axis or the Y-axis, drag while holding

down the Shift + Option. This will prevent the Cell from moving in other directions.

11-4 Rotate/ Flip Cells

By selecting the Cell and then selecting Flip Horizontal, Flip Vertical, Turn +90 or Turn -90 from the
Cell menu, the Cell can be flipped or rotated. In all cases, the center will be the center of the selected area.
With the case of 90 degree rotation, the Inspection Frame may be out of the Work Area due to differences

in the aspect ratio. In this case a new Cell will be created in the vertical direction.

)

(Screen 1)
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11-5 Creating Cell Blocks

In general, this software executes inspections starting from the location closest to the current position, but
this is not necessarily the most efficient method. Therefore, there is a feature that allows multiple Cells to
be unified as a Block and inspection can be executed by Block. Each Block will have a Block Number de-
fined, and the inspection will start from Cells not assigned to Blocks and continue on to lower numbered
Blocks.
If the original Block contains a fiducial mark(s), duplicating the entire Block will create a new Block that
contains a new fiducial mark(s). This feature is useful when the relative position of each Block differs slight-
ly in the multiple PCB.
When copied without creating Blocks, the fiducial mark(s) will be copied as a regular Inspection Frame.
H In order to create Blocks, select the Cells that you wish to unify in the Cell Map, and select Assign to
Block from the Cell Menu.
B When you click on the Cell Block in the Cell Map and hold down for longer than 0.5 seconds, a
Block Control menu will be displayed. The Block Number can be confirmed here (Screen 1).

H In order to exclude a Block from inspection, select Disable Block. In order to delete a Block, select

Remove Block.

H Block can be optimized. For example, if the order to Block the Cells are as Screen 2, camera moves
around as a result time is more consumed. By executing Block Optimizing, the Blocks are re-numbered
as Screen 3. Setting procedure is, select any block in Cell Map, display Block Control menu, click

Block Number, then a dialogue is displayed. Click “Optimize block position” button.

In order to change the number of a Block that has already been created, you must create the Block again.
The blocked cell can be inspected while [Machine number of separation data] is activated on [For Su-
pervisor] -[Plus].

* The Block Numbers will change when you choose Assign to Block, Delete Block, Assign Fiducial

Mark or set Cell Aid Stamps or Block Mark Stamps.

(Screen 1) (Screen 2) (Screen 3)
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11-6 Cell Management Using PCB Numbers

PCB number is used when you want to set a unit finer than a block and manage the inspection results for

each child PCB.

Block Number PCB Number

oUnbhWN=oWY

1

2 1
3 1
4 1
5 1
6 1
7 1
8 L

To use this setting, enable [Record inspection results by PCB number] added to [LAN] in [For supervisor].
When this setting is enabled, [PCB Number] will appear on the Ref.des. Properties window and an input

field will be added to the right side of the screen.
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To set PCB numbers, open [Ref.des. Properties] in [Window], select inspection frames you want to assign

group numbers to with the selection tool, and assign PCB numbers in [PCB No.]

If an inspection is performed with the [Record inspection results by PCB number] setting enabled, the
PCB number is sent to CatchSystem instead of the block number. Images below are CS-Repair. Block

number [1] or PCB numbers [6] to [10] are displayed after Ref.des. number.
Block Number PCB Number
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11-7 Block Mark Stamps

This software includes a special stamp called the Block Mark Stamp. This stamp is used to skip Block (or
Cell) inspection if the inspection result of this stamp is NG. Block Mark stamp is inspected first. If it is NG,
other area of the Block (Cell) where this stamp is belonging will not be inspected. This has been designed

to eliminate unnecessary inspections. This stamp is effective especially when inspecting penalized PCBs.

Normally the result of skipped PCB is NG, however you can change the result to be OK in ForSupervisors
menu "Result of Block skipped by ‘Bad mark’ should be OK” .

Block Mark Stamps should be used according to the following procedure:

1. Load the Special Stamp, BlockMark.

2. Select BlockMark from the Stamp List Window ), and place it on the part that will be criteria to
inspect or not (often called Bad Mark). Click OK when a message This stamp should become
part of a Block is displayed. Block Mark placed has a checkmark on the upper left (Screen 1).

3. As well as normal Frames, align the position and resize the Block Mark to fit. When you enlarge
the Frame, a message “Is this an inclusion frame?” will appear, but do not select this.

4. Start inspection. BlocMark stamp is inspected first, if the result is NG, the Block (Cell) that this
stamp is belonging will not be inspected. If the result is OK, inspection is executed as usual.

In case if you want to apply Block Mark stamp not to Block or Cell, but specified area, please set Block
Mark stamp as followings.

1. Select the message “Is this an inclusion frame?” displayed when resizing the stamp (Screen 2).
Drag the frame then target area (inclusion frame) is set, and the 4 corners of the Block Mark will
become rounded (Screen 3).

2. If you want to rotate the area (Inclusion Frame), select “and frame which has an angle?” instead
of “Is this an inclusion frame?”. Then a small window to input an angle will be displayed. Input

an angle, then the area (inclusion frame) will be rotated.

(Screen 2)

(Screen 1)
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1-7

(Sereen 3) (Screen 4)

3. This process can be repeated as many times as you are succeeded.

* This Block Mark will be applied only on Inspection Frames which are contained “completely” within
the Inclusion Frame.

* When the target area (inclusion frame) is defined to be smaller than the Block Mark, it does not work
as inclusion frame, but work as normal Block Mark.

*When making continuous copies of Blocks that contain a Block Mark Stamps, the Block Mark
Stamp will not be copied unless Assign to Block is executed.

* Block Marks cannot be packaged.

* If Block Mark’s inspection result is NG, it is displayed bigger in Map View than other NG (Screen 4).

130
11. Cell Operation




11-8 Cell Optimization

The fewer the number of Cells, the faster and more efficient the inspection will be. By using Cell optimiza-
tion in the Cell menu, you may be able to reduce the total number of Cells. In order to use this feature,
select multiple Cells that you want to optimize, and select Cell Optimization from the Cell menu. Unnec-
essary Cells will disappear, and the Inspection Frames that were contained in the eliminated Cells will be
merged into other Cells.

However, in order to optimize cells, the screen ratio settings must be accurate. Make sure that the Inspec-
tion Frames are overlaid correctly on the components/parts before performing this task. If not, change the
Pixels per 1 cm value in the For Supervisor menu, making adjustments so that the Inspection Frame

will be overlaid on the components/parts.

11-9 Merging Cells

M Merge Inspection Frames into One Cell

When Cells have many overlapping parts, you can manually merge Cells to reduce the number of Cells for
more efficient inspection.

For example, when a Cell is displayed in the work area, an Inspection Frame belonging to another Cell
may be displayed in a white frame. In this case, use the Pointer tool to select all the Inspection Frames
while holding down Control key, and those Inspection Frames will be merged to become Inspection
Frames belonging to the same Cell (Screen 1).

Even if the Cells do not have overlapping parts, you can use the same procedure to select Inspection
Frames belonging to adjacent Cells and unify them into one Cell (In order to perform this task, the Pixels
per 1 cm ratio must be accurate)

Inspection Frames that do not fit in one Cell due to minor misalignments can be merged by individually

clicking and dragging the frames while pressing down the Control key.

(Screen 1)
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l Merge All Inspection Frames Within the Work Area

In order to fit all Inspection Frames in the screen into one Cell, click in the Work Area while pressing down
Control + Shift. A square frame will appear momentarily, and the Cells will be merged. The size of this
frame will be determined by Pitch, which is defined in General Settings. If the value is 80%, then the frame
length will be 80% of the screen width. The Cells can be optimized by merging Inspection Frames using

Control + Shift click.

l Correct Misalignment and Merge Cells

Pressing F10 will correct all misalignments of frames currently displayed on the screen and merge them

into one Cell.

* If a function is assigned to F10 by Mac OS, this feature cannot be used. With Mac OS X 10.3 or later,
F10 is assigned to the show Application Window function. In order to remove this assignment, you
must change the settings in the Dashboard and Expose panel in System Preferences so that there

will be no function assigned to F10.
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11-10 Cell Map Operation

The buttons on the Cell Map Area are useful for Cell Map operations.

H Expanding Cell Map

In order to zoom into a part of the Cell Map, use the Cell Expansion Tool. The mouse pointer will change
to a magnifying glass. Select this tool and drag over the area to expand. The mouse pointer will change to
a hand icon. Click and drag the mouse to move around the expanded Cell Map area (Screen 1).

If you press down on the mouse button for longer than 0.5 seconds, the mouse pointer will switch back to
the magnifying glass, and the designated area will be zoomed further.

In order to reset the zoomed view, select the Cell Selection tool and click outside the Cell in the Cell

Map.

H Blending Pattern

If you have already created a Map View, you can use the Blend tool. The blend rate of the Map View and
the Cell Map will be displayed in "%" when you click the Blend tool. In general, this is set to "none" or at
about "60%" (Screen 2). Pattern blending is used to show the approximate position, and does not ensure
an accurate position.

This tool will not be available if you do not create a Map View.

1-10

)

(Screen 1)

(Screen 2)
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12. Verification after Inspection

After inspecting, the result is displayed OK or NG in the screen, and instant result (humber of total inspect-
ed frames, number of NG frames or cycle time) is displayed in message bar. NGs can be verified/identified
in many ways such as by displaying in the entire PCB picture (Map View) or displaying by list. This soft-

ware also has a mode to visually verify the actual PCB after inspection.(This software uses the expression

“Map View” to include all these display modes.)

12-1 Map View Mode

V¥V 12-1-1 Create and display Map View

¢ Click on the Eyeglass Button under the work area to display the Map View picture (Screen 1). If it is af-
ter an inspection, NG points will be displayed in red circles. (If you set 13-4-2 Prevent continuous Good
button clicking, the NG which must not be classified Good is displayed in red square.)

e |f there is no Map View, a verification dialog "Create Map” will appear. Click OK. Then the frames will be
taken sequentially starting from the bottom right corner of the PCB. The PCB Map is created in another
file named “program name_hdgv_A(B)". When you save the inspection program, a folder with 22X
logo is automatically created in the same directory where the insection program is (Screen 2), and both
inspection program and high density PCB Map is put in the folder (Screen 3).

After the Map is created, click again on the Eyeglass button to display the Map View (View window).

¢ The size of the Map View picture is determined by the monitor that was connected when the map was
created (screen pixels). If you would like to change the size due to monitor changes, recreate the Map
View using the NewMap button (or press Command + N in View window).

* The larger the Map View becomes, the more memory it requires.

12-1-4

(Screen 1)

(Screen 2) (Screen 3)
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V¥ 12-1-2 Map View Window (View window)

The Map View Window looks like Screen 1. Descriptions of each button and menu are as follows:

(Screen 1)

Header menus and buttons:

Info ltem Button

Click here and a pull-down menu will appear (Screen 2). Select the items to be
displayed from the 8 items above, and they will be displayed next to the NG
points that are shown with red circles. Error rate 0.00% and Error rate ppm
cannot be displayed at the same time. The Map View can be flipped using Ver-
tical reversing and Horizontal reversing.

Info File

A pull-down menu will be displayed (Screen 3). Information, Position, Past
(history) and Stamp information can be exported.

Inspection Count Bar

The current total number of inspections, number of points and NG points will be
displayed (Screen 4). Clicking here will display the Inspection History.

Grid Button

The grid will be displayed (Screen 5). The address will be displayed in letters for
horizontal, and in numbers for vertical directions. This address will be shown in
the format of “A01” for Print and Information output.

Inspection Area Dis-
play Button (Blue/

The blue button will show points that were never judged as NG in past inspec-
tions, and the purple button will show points that have been judged as NG at
least once. Click again to hide the circle points. If you set Unable to click Good

Purple) , . , o ,
button in G/NG confirmation mode, the NG is displayed in red square.
12-1-2
(Screen 2) (Screen 3) (Screen 4) (Screen 5)
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Footer menus and buttons:

NewMap Button

This is used to create a new picture for the Map View. If a new cell(s) is created

due to added inspection points, the added points may not be displayed, in this

case you will need to recreate the Map View.

* When the display is zoomed, the Circle Mark may become misaligned from
the zoomed section of the Map View picture. This is due to the misalign-
ment between the actual dimensions and the number of pixels. This can be

resolved by editing Pixels per 1cm and recreating the Map View picture.

Print Button

Click here and the Page Setup dialog will be displayed first, followed by the Print
dialog.

View Mode Switch
Menu

Switches between G/NG Confirmation/List view/NG Cell view. If the protect
mode is [Supervisor], Map view settings can be selected also. When the
setting is switched here, the window will be closed once, and opened with the
selected display mode the next time.

Freeze

If Freeze is checked, the Map View picture and the NG lists will not be deleted
even when the machine starts a new inspection. Use this when verifying NG
points during inspection.

Close Button

This will close the Map View window.
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12-1-3

(Screen 1)

(Screen 2)

V¥ 12-1-3 Display Operations in the Map View Mode
B Go to the specified point in the Work Area

When you double-click on any point in the Map View, the Map View will be closed and the place that you

clicked will be displayed in the work area. This is useful when making corrections to the inspection frames.

Bl Zoom into the specified area

¢ [f Info Items in the Map View are overlapped and hard to see, they can be zoomed in. Drag a part of the
Map View to select it (Screen 1), and that area will be enlarged (Screen 2) (you can also hold down the
mouse button at any given place until the mouse pointer changes to the magnifying glass icon).

® During zoom, the cursor will change to a hand shape when you drag the screen, and the entire screen
can be moved while it is zoomed.
Hold down the Shift key while dragging to move faster.

¢ Inspection points displayed in a circle can be displayed in the Work Area by double-clicking (if you dou-
ble-click on other areas, the Map View display window will simply close).

® The buttons on the top of the window will not be shown during zoom display.

e You can go back to the normal state by holding down the mouse button somewhere outside of the circle

mark until the mouse pointer shows “x1”.

* The Zoom display simply enlarges the picture, so the resolution will be low quality unless high den-

sity Map is created.

M Inspection Frame Offset

If the component/part in the picture and the position of the circle that designates the inspection area is

misaligned, hold down the Option key in the zoomed screen and drag to the correct position.
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12-1-4

(Screen 1) (Screen 2)

V¥ 12-1-4 Check results in the past

The Map View can display NG points found in previous inspections. Up to 1024 sets of inspection data

can be recorded, and the 1025th picture will be recorded as the 1st picture.

H Display results in the past

1. Press the Inspection Count bar on the top right corner of the Map View window, the list of
past inspections and the corresponding number of defects will be displayed in the pull-down
menu (Screen 1).

2. Select the number of the target inspection to display the NG points. You can also enter the
number of the target inspection in the “dJump to” dialog in Setting. Please note that images of
the NG points are not saved.

3. When you display the Map View next time, the current result will be displayed.

H Settings

Select Setting from the Inspection Count Bar on the top right of the Map View window, and a dialog will
appear (Screen 2). You can set the number to be displayed in the Pull down menu (up to how many pre-
vious inspection results should be displayed).

In general, the Map View displays the current result first, but you can make previous results display first.
To do this, hold down the Option key while selecting the start position from the pull-down menu with the

Inspection Count Button. Once selected, the value will be displayed in bold letters.

To cancel this setting, hold down the option key again while selecting the current number.

* The number of PCBs to be displayed is always the number from the first inspection, but here, the
designated number of pictures preceding the current inspection will be recorded.

* These settings will be recorded in the parameter file, and will be effective for other Inspection Pro-
grams when launched next time.

* NG points’ pictures will not be recorded in the past history. Pictures cannot be viewed, and picture

lists cannot be displayed.
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12-1-5

(Screen 1) (Screen 2)

V¥ 12-1-5 Defect Warning

This software counts the number of times a frame is judged as NG, and frames consecutively judged as
NG and frames that have a high number of cumulative NGs can be displayed in a special way in the Map
View: Consecutive NGs will flash in yellow, and cumulative NGs will flash in pink in the red circle (Screen 1).
The flashing count will be cleared when the next inspection starts or when the Stop button on the screen
is pressed, and will be counted from zero at the next inspection.

In order to activate this feature, select Configuration > Tendency NG and check Active in Tendency,
then set the number of Continued NG and Total NG in the NG report setting Window (Screen 2).
Default is 3 for Continued NG, 5 for Total NG.

12-2 NG List View Mode
Select NG List View in the View Mode Switch Menu, and the List Display Window will be displayed with

the Eyeglass button. The list will also be displayed after the inspection instead of the Map View.

WV 12-2-1 NG List Window

NG List window (Screen 1) will display NG points as a list. The Map View picture will be displayed on the

left, followed by the picture judged as NG and Master Picture. In the Map View picture, the target point will

be displayed as a red circle. As with the Map View, results in the list can be viewed during inspection.

¢ \When Freeze is checked, Map View pictures and NG Lists will keep displayed even under inspection.

e |f there are too many defects, pictures of NG points may not be displayed due to insufficient memory.

¢ When a Map View picture is double-clicked in a list, that area will be displayed in the Work Area, and
the NG frame will be selected.

* The NG List Window will be displayed after the next inspection is complete or after the eyeglass button

has been pressed. To go back to the Map View mode, select Map View from the pull-down menu.

12-2-1

(Screen 1)
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12-3 NG Cell View Mode

The NG Cell View mode is “Enable Good/NotGood verification by operator while inspecting next
PCB" This mode specializes in viewing previous results during inspection. This allows human verification

without stopping desk-top AOL.

V¥ 12-3-1 Advantages of NG Cell View Mode
- Defective component is displayed large in the center of window as well as G/NG confirmation
mode (See next chapter 12-4), operator can check one by one easily.

- Operator can confirm without stopping AOI.

- Data is sent to CS-Center after each inspection, requiring less time to wait for data transmission.

V¥V 12-3-2 Interface

PCB count lamp Displayed at the right bottom of Work Area. The lamps are on (colored in white)
when PCB is waiting for verification. Maximum 4 PCB data can be stored. The A
side is displayed in blue and the B side in red.

Flip View button This button is at the right bottom of operation window. It switches inspection
window and verification window.
* The window automatically switches to verification window after inspection.

Master Picture Master Picture and PCB Map can be switched by clicking there. If you display
Area PCB Map, the position of component currently verifying is highlighted by red circle.

Status Lamp The lamp at the right bottom corner of Work Area shows inspection progress.
Red: Memorizing NG pictures while inspecting. If AOI is connecting to CS-
Center, the blinking interval can be measure of transferring speed.
Store the result after inspection
Blue: Clear the result when verification is completed

Press end key to skip verifying current PCB and move to next PCB. The inspection result will be aborted.
If 4 lamps are occupied, and start inspecting 5th PCB, the result of 1st PCB will be aborted.
However if you set Update by Start button to be OFF (in Map view setting's NG cell veiw setting), a

warning message appears and the result will not be aborted.

12-3-2
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* If Update by Start button is OFF, operator can not start next inspection unless completing

verification. To skip classification and start next inspection, press end key to abort.

B Remarks: inspection speed
- In this mode, AOI is creating images of defective components while inspection. It takes 40 to 50

mm/sec per 1 point to create, this will affect inspection speed.

Bl Remarks when CS-Center is connected

- The inspection result of 1st PCB is automatically sent to CS-Center if you start inspecting
3rd PCB while 2 lamps are occupied, while Update by Start button is ON. This data is just
inspection result from AOI because it is not verified by operator. However no images of NG
components is sent.

- Also if you abort verification by pressing 'end key', just AOI's inspection result is sent and no
NG components image is sent.

- If Auto send ALL NG is used and all data is sent without verifying by operator, or operator does
not press Good button for good PCB to fix the result, correct inspection data will not be sent.
PCB number and inspection results may be combined incorrect or result may be sent double.

* NG Cell View can not be remotely controlled on CS-Center.
* Inspection result is NG if the inspection is skipped by BlockMark, even if you check on the

option "Result of Block skiipped by 'Bad mark' should be OK" is checked.

12-3-2
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V¥ 12-3-3 Basic Operation

1. Select this mode. Change view mode by pressing eye glasses button to NG Cell View.

2. Start inspection.

3. Screen changes to verification window from inspection window after inspection is completed.
One of PCB count lamp is on. If no defect is found, OK is displayed in the center of screen.
Press Good button to fix the result (Screen 1). If there are defects, operator should verify by

pressing Good/NG buttons (Screen 2).
4. When no PCB is waiting for verification, 'Ready' is displayed on screen (Screen 3). Start

inspection on this status, you can see the process of inspection penetrated on behind (Screen 4).

V¥V 12-3-4 Enable options

Some options in Map view setting can be applied to new NG Cell View.

NG cel view settings ... Update by START button

G/NG Confirmation Mode ... Zoom pictures, Assign NG-ID input 0-9,
Show whole group if NG, Show NG reason

Enable options in Extra settings for G/NG mode...  Unable to click Good, Interval timer

* Screen will be shown on selecting light when Stamp uses Lighting Selection.
* For detail of each option, please refer to 12-5 "Map View Settings Window". For Enable option in

Extra settings for G/NG mode, please refer to Chapter 22, "Options for G/NG Confirmation Mode".

12-3-3
(Screen 1) (Screen 2)
(Screen 3) (Screen 4)
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12-4 G/NG Confirmation Mode

In this mode, defective frames will be displayed one by one after the inspection for verifying.

V¥V 12-4-1 Basic Operation

Check G/NG Confirmation Mode in Map view settings (Screen 1). This setting will become effective

after closing the View Window.

1. When the inspection finishes in G/NG Confirmation Mode, 4 buttons; Good, NG, Previous and
Next will be displayed in the Cell Map Area (Screen 2). A shortcut key is allocated to each but-

ton.

e Good (up arrow) ... Judge the currently displayed point as Good
e Good + Shift (up arrow +shift) ...Judge as Good and add as master picture
* Only for NG of pattern matching or for NG in Pack Stamps that include pattern matching
¢ NG (down arrow) ...Judge as NG the currently displayed point
¢ Previous (left arrow) ...Go back to the previous point
¢ Next (right arrow) ...Move to the next point

2. Click the Mastar Picture area to display the Map View. Red circle is displayed with a red circle

(Screen 3). Click the Mastar Picture area again to display the Mastar Picture.

12-4

(Screen 1) (Screen 2)

(Screen 3)
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3. G/NG Confirmation is complete when the progress bar on the Good button has moved up to
select the last Good/NG. Results will be reflected in the verification history. The same results
will be reflected in the Map View picture. If Auto Printing is selected, the results will be printed

out to roll paper printer, or if data is set to send to CS-Center, will be transmitted.

In the NG List View mode, points judged as Good will be included in the list but with a blue
frame. When you click on a defective picture with a red frame, the frame will turn blue. This is

the same as a Good judgment, and this judgment will be reflected in the history (Screen 4).

* Press Esc key to exit from the G/NG Confirmation. Defective points are automatically judged NG.

* Please note that if Auto send for all NG is selected in Map view settings, all defective points will
be judged as NG. This option is for verifying on CS-Repair afterwards.

* The Mark number limit for machines equipped with marker pen unit will be ignored in the G/NG

Confirmation Mode.

12-4

(Screen 4)
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V¥ 12-4-2 Customizing text/master picture appearance

You can change the comment text size, display/not display master picture, etc in 12-5 Map View setting

Window. While verification, you can temporary hide comment or frames when they hide components.

tab: hide red frames which indicate defective area
space: hide comment and master picture
control: pattern matching frame with Text filter is displayed with filter. However the image quality

is less than when you adjust in filter settings window. NG Cell View mode not possible.

You can see through all master pictures by scrolling mouse wheel or clicking the picture.
Scrolling: Forward / Rewind by scrolling wheel up / down.

Clicking: Forward by clicking. Rewind by clicking with shift key pressing.

* Master picture assigned as NG picture will be skipped.
* G/NG confirmation mode only, not possible in NG Cell View.
* Only one master is sent to Rc22X/CS-Center. Therefore only one master picture can be seen on

Rep22X/CS-Repair.

V¥ 12-4-3 Display Comment

It is helpful to include comments (or Ref. Des. name) in order to accurately communicate the intentions of
the programmer to operators after inspection. Comments can be set up with the following steps. Com-
ments added here can be displayed in the Map View.

1. Check Setting for supervisor > Mode > Show Result with Reference and Comment (Screen 1).

2. Click on the Inspection Frame in the work area (Screen 2).

3. Select Input Ref. Des. name from the Master Picture Menu and enter comments. Up to 15

characters in double-byte, or 30 characters in single-byte, may be entered.
4. These are set up for each Inspection Frame, but if you input a comment in a stamp, click on the

Stamp Update button. Comments (and Ref.Des. name) will be entered in all Inspection Frames

12-4-3

(Screen 1) (Screen 2)
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with the same stamp in the Work Area (Screen 3). 19-4.3
Since these settings will not be registered to the Stamp
in the Stamp list, comments will not be included in the
Stamps placed after this instruction.

5. Check Show NG reason in the Map view settings.

6. If you want to display your original message, refer to
(Screen 3)

Chapter 8-10-1 Frame type assignment.
7. If you want to display multiple NG reasons in Pack, refer to Chapter 8-7 Stamp Pack.

VW 12-4-4 NG-ID Setting

In the Good/NG Confirmation Mode and the NG Cell View Mode, an ID can be set to NG. Check Assign
NG-ID input 0-9 in the Map view settings \Window, and press 0 = 9 on the numeric keypad instead
of clicking Not Good and the keys you pressed will be set as an ID for each defective point. To assign as
false NG, press comma (,) or period () keys. The results will be displayed in the Map View picture, and

printed from the roll-paper printer. The following will be printed:

New File [01.2.20 10:20 AM]

Total PCBs checked[20] block<0O> (Thomas)
Total NG PCBs [14] block<0>

Current result (check 272 NG 3) Spent time 9
BarNum 356512110

SYN TTL NOK/NG_ID
C101840
R682 8 4 1
C301 841

V¥V 12-4-5 Verify all points

On this mode, you can verify all points no matter if they are NG or Good. Even you can verify all points
without inspecting by AQI (AQI just captures images). This mode is for testing P&P machine or for testing

new PCB before mass-production. Also effective in case you want to send all images to CS-Center.

1. Check Setting for supervisor > Others > Verification Step Mode.

2. Click inside the Message Area, and a Magnifying Glass Icon will be displayed. Start inspec-
tion, AOI will not inspect at all, all points will be shown for G/NG confirmation.

3. Click again the Glass icon, the Glass icon will be colored blue (if you click again, the setting will
be disabled. In this case, set Verification Step Mode again). Start inspection, AOI will inspect,

however not only NG but also Good points will be shown for G/NG confirmation.
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12-5 Map View Settings Window

Most view settings can be set in this window (Screen 1). Select Map View Settings from View Mode

Switch Menu in the Map View Window or Window from the menu bar to access this window.

12-5

(Screen 1) (Screen 2)
Map view settings
Menu Function

Keep map view dur-
ing Inspection

When this is selected, the previous inspection results will be displayed during the
next inspection. Since machine power is mainly devoted to inspection, response
will be slower than with just the Map View Picture. If there is insufficient memory,
the picture may not be displayed.

Show yellow circle
after checking

When this is selected, the red circle (defective points) will turn yellow after veri-
fication and the number of remaining points to be verified will be shown by a
number and a progress bar. When the pointer is placed on the red circle, it will
turn yellow, and after every point is verified, the buzzer will sound and the Map
View Picture will momentarily go dim.

Change only after
mouse click

If it is selected, the color will not change unless you click on it. This is intended
to check whether you have verified all points (this may not function depending
on the size of the Map View Picture).

Grid color of map
address

The grid color can be changed. Click on the black square to select colors from
the color palette.

Show pictures on
map

When this is selected, the pairs of defective points and Master Pictures are dis-
played in the Map View if there aren’t too many defects. Maximum 24 is possible
to set. When there are too many pictures to be displayed, they will not be dis-
played on the Map View, but only when the cursor is placed on the red circle.

G/NG Confirmation Mode

Menu

Function

-Enable-

Sets the G/NG Confirmation Mode.

Beep

In the G/NG Confirmation Mode, if Good or NG is not specified within the time
frame set here, an intermittent warning will beep. The beep will not sound if “0”
is entered. The default is 30 seconds.
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Menu

Function

Optimize check se-
quence

Click here to display the menu and select sorting by XY (Coordinates), Comment,
New Stamp, NG type, Stamp Name or Location No.(Screen 2)) The default is No
sorting. No sorting is basically the order when stamp is pasted. If you would like
to match the order of G/NG Confirmation and List display, select No sorting.
Coment, Stamp Name and Location No. is ASCII order. This setting will affect
the defect marking feature regardless of the G/NG Confirmation Mode settings.

Dim Surrounding

It makes the area surrounding the target in the center of the screen darker for
easier verification. This effect is deactive on AOI with angular cameras.

Zoom pictures

This option will automatically zoom the picture to 2x display.

Assign NG-ID input
0-9

When setting up NGs in the OK/NG verification mode, IDs can be assigned us-
ing the numeric keypad. By clicking twice, the check mark changes to bar check
mark. A.B.C...Z keys will be ID numbers 10,11,12...35.

Auto send for all NG

Automatically sends all judgments in the Good/NG Confirmation Mode as NGs
by one click. By clicking twice, the check mark changes to bar check mark, and
fast data transfer is enabled. Fast data transfer mode is only available when con-
nected to CatchSystem.

Show pic. without mask

This shows master pictures without masks in the G/NG Confirmation Mode.

Display by selected
lighting

In the G/NG Confirmation Mode, this shows the image with the lighting set up in
the lighting selection.

Enable lighting
switching

This menu enables to switch lighting on G/NG Confirmation Mode by ticking
“Enable lighting switching” on “Setting at the whole view picture”. The option is
not enabled on Auto send for all NG (including fast data transfer mode) on G/NG
Confirmation Mode, NG Cell View Mode, and Online Teaching Software (OLT).

NG cell view settings

Menu Function

If this is checked, and 2 PCBs are already waiting for verification, then press
Update by START ] ] ] o
butt START button, the oldest PCB data is aborted without warning. If this is un-

utton

checked, you can not start next inspection unless verifying one PCB.

This setting is enabled in NG Cell View mode. Good button is automatically
Click Good clicked when the inspection result is [OK]. [Click time] allows you to set the

Automatically

number of seconds until the Good button is clicked from a minimum of 1 second
to a maximum of 10 seconds.

12-5

148

12. Verification after inspection




Menu

Function

Show NG reason

The defect reason will be displayed in red in the G/NG Confirmation Mode and
the NG Cell View Mode. Click it once to display defect reason and master pic-
ture (Screen 3). Click twice to display only defect reason (Screen 4).

Font size

Font size of [Show NG reason] message can be altered between 9 to 48.

Show inspection
result

If you untick this option, you can hide the inspection result message.

Show fillet pictures
colorized

When this is selected, the fillets in the Inspection Frame will be displayed in red,
and the other parts will be displayed in blue. This setting is available in the G/NG
Confirmation Mode.

Disable NEXT button
while not judged

This option prevents worker from unintentional skipping without a judgement.

Extra settings for G/
NG mode

This option prevents worker from omission of NG by adjusting OK button click-
ing settings. Refer to 22-1 [Prevent operator’s mis-judgement] for detail.

If you want to see the PCB area hidden by NG reason comment, press space key to invisible NG reason.

To make it visible, press space key again.

* Font size can also be adjusted in the "small/big" menu that appears when you click on the displayed

content (Screen 5).

* If the picture displayed in Work Area is too small and difficult to check, drag on the picture by

mouse, zoomed picture is displayed in Master Picture Area.

12-5

(Screen 5)

(Screen 6)
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12-6 About Instant Result displayed in Message bar

After inspection, the brief inspection result is displayed in message bar.

(Screen 1)

TTL : Total number of frames inspected

NG : Number of defective frames

AV. . Average time spent for inspecting one frame

LAP : Total time spent for inspecting this board

* If "Show result in message bar on counting Ref.Des" is active in Mode tab of For Supervisors menu,

TTL, NG and AV is calculated based on Pack stamp number.

Clicking message bar once will change the contents and the text color turns to blue (Screen 2).
Point : Total frames inspected side A: total frames inspected side B: total number of stamps (count

stamps in Pack too)

Pict. : Total master pictures used for inspection
AV. : Average % of total frames which results in % / total frames of side A+B
Use : Memory spent for this inspection

Clicking message bar again will change the contents and the text color turns to black (Screen 3).
Point : Total stamps inspected side A (count pack as 1 stamp) : total stamps inspected side B (count
pack as 1 stamp): total number of stamps (count pack as 1 stamp)

Pict. : Total master pictures of Pack used for inspection

AV. : Average % of total frameOs which results in % / total Pack stamps of side A+B
Use : Memory spent for this inspection
12-6
I TTL S10 MG 29 A% 1 99mmszec LAP & 30sec l
(Screen 1)
.F‘-:-int51III:III:T"1 Fict. 90 &Y. 73 U=ze 260 l
(Screen 2)
.F'-:-int 155032 Pict. 215 &Y. 85 ,Use 2.6M '
(Screen 3)
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13. Settings

Please note that these settings are applied to all inspection programs that you will create.

13-1 General Setting

To display General Setting, sclect Settings menu > Configuration > General.

131

(Screen 1)

Menu

Description

OK %

This is used to designate the percentage for making pattern matching judg-
ments. If the value is too high, even the slightest differences between parts may
be judged as defective, increasing the number of false reports. The default value
of 60% is a standard value. It can be set by each inspection frames.

Pitch X% / Pitch Y%

Designates the pitch % to move the PCB using the pitch button. If you set this
to 100%, the displayed area of the PCB will be changed without overlapping.
Around 80% is the most convenient value to prevent lack of inspection frames.

Emphasis Area

This is used to designate the area to be emphasized. Icons with bigger white
spots in the center will have stronger contrast.

More Emphasis

This will increase the contrast already emphasized in the Emphasis Area.

NG Re-inspect

This is used to reduce noise and false NG by inspecting and capturing again.

Numbers in the yellow box indicates times of additional inspection that camera

moves to the position. Rose box indicates times of additional capturing on the

additional inspection position.

* When a high value is designated here, inspection will take more time.

* When the Speed Priority option is bar-checked, additional capturing box
does not appear.

Find first an object

This setting detects misalignments of pattern matching inspection frames before
starting inspection. As this option is not set to whole inspection frames, it is
turned off usually.

Speed Priority

This mode stops displaying the currently inspected Cell and prioritizes inspec-
tion. Speed Priority allows a 25 — 30% increase in inspection speed.
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Menu

Description

Apply Human Satu-
ration

Saturation sensitivity of pattern matching frame becomes closer to the sensitivity
of human eyes.

Display NG on Map

Check here to automatically display the Map View after inspection if there is an
NG point, showing the position and details of the defect.

Warning frame Size

There will be redundancies if the Inspection Frame is too big. This box should be
unchecked under normal conditions.

Auto Printing

If NG points are contained in the results, the details are printed automatically. To
execute it, you must complete the printer settings in Page Setup from the File
menu in advance. Printing takes much longer than inspection. If printing instruc-
tions are issued frequently, do not check this box, and print manually.

Move via closest
cell

If this box is checked, inspection will be performed by moving to the cell closest
to the current position regardless of the order in which the cells were created.
When this is disabled, the camera will move in the order the cells were created.

Reduce/Enhance
light

Reduce gain of illumination. By clicking twice, it turns to “Enhance light” and
works to gain light. For details, please refer to chapter 20-5 “White or Black
PCB/Components Inspection”.

13-2 Frame Color Settings

Select Object Frame from the Configuration menu (Screen 1).

13-2

(Screen 1)

Menu

Description

Result OK, Result
NG, Not Inspected,
Out of Cell

designates each Frame color. Double-click inside the Frame to display the color
picker and select the color.

Narrow/Bold

Click on these buttons to change the width of the Frame with the above color
settings applied. Select the optimum line width here.

Hide near frames

Hides all other Frames when moving Frames. This is useful when the PCB is
hard to see.

Picture blend

When placing Stamps with Master Pictures, they will be shown blended in the
work area. The blend rate can be determined here. 0% will not show the Stamp
Picture, and 100% will hide the PCB.
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13-3

(Screen Movement)

13-3 Setting for Supervisor

Select Settings > Configuration > For Supervisor.

ltems in Setting for supervisor do not need to be changed in general.

V¥ Movement

Name

Description

Eject Position

Position that the carrier moves to when the Eject button is pressed.

Light Calibration
Position

This is where calibration will be performed.

Pixel/ cm Position

mm per dot settings will be applied.

Carrier fiducial top-left

Position for the top left Fiducial of the carrier. This is used to correct the
distortion.

Carrier fiducial

This is the distance between the fiducials of the carrier.

Maximum movement

This is the maximum value for mechanical movement.

Minus limit

The minimum value for mechanical movement in the negative direction.

Data offset

When reading Inspection Programs on other machines that have different
carrier sizes, the offset value can be set here.

Machine offset

When reading Inspection Programs on another machine that is the same
model, the offset value can be set here.

Carrier Origin

When sending data to CS-Center, input Carrier origin coordinates here.

User Home Position

There is Home button in sub menu of Eject button. You can input favorite
value here to be Home.

Current Position

The position is displayed as X, Y coordinates. This value will be updated to
the current position by clicking this button after changing the position.

Pixels per 1cm

This sets how many dots correspond to 1cm on the screen. The blue num-
ber on the side is the value at the fiducial of the carrier. Since V6.4.0, the
resolution has been increased and input to one decimal place is possible.

Reset Origin interval

If cumulative errors are suspected due to a missed pulse in a machine
driven by a pulse motor, you can give instructions to reset the origin. If this
value is 0, Reset Origin Interval will not be applied.

Dwell Time

This is the standby time to wait for the mechanical vibration to cease and
can be set in 0.1 second increments. When entered negative values, the

time becomes shorter. Enter the value n (-1 - -5) to set -(-n x 0.016) sec-

onds. When entered positive values, the time becomes longer. Enter the

the value n (1-5) to set (n x 0.1).
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Name

Description

Capture Wait

Capture Wait is a function to wait for a specified time before capturing to
reduce the vibration. This function is valid for models with a 5 Mpixel cam-

era; for the V22X, the setting is valid only when [Extend] - [Without blinking]
is enabled.

Click to open the menu.

Enable Capture Wait Function

Check here to enable Capture Wait.

Wait time

Sets the waiting time other than during inspection.

Max distance for wait

If the move distance is shorter than the value specified here, the wait time
becomes active. However, if it is the first move after startup or if the move
direction is reversed, the waiting time is valid regardless of the distance.

Wait time during inspection

Sets the waiting time during inspection.

The Max value of the Wait time is 5000 ms, and The Max distance is 20000 mm.
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(Screen Mode)

WV Mode

Name

Description

Print mode

Select whether the automatic printing should be executed in NG List for-
mat, Map View format, Roll printer, or 3rd party.

Analysis mode

Select the display mode during analysis. You can choose from Gray scale,
Hueand B + H + S.

Hide matching %

Hide the matching rate displayed on the Frame after inspection. This is
useful for high density PCBs.

Inspection Step mode

When Inspection Step mode is enabled with the NG Pause button
pressed, inspection will pause every time each inspection for 1 screen (1
cell) is complete. When Inspection Step mode is disabled, the inspection
will pause only when a defective point is found.

To activate the Inspection Step mode, the Speed Priority in General
Setting must be disabled.

Show result with Refer-
ence Designator

After inspection, place the cursor near the Frame and the Reference
Designator (Symbol) will be displayed along with the inspection results.

Show result with Block
Number

A block number is displayed next to the Symbol name on G/NG confirma-
tion mode when you make an inspection area a block after inputting Sym-
bol.

Show result with com-
ment

After inspection, place the cursor near the Frame and Reference Desig-
nator Comment will be displayed along with the inspection results.

Optimize Cell by pitch %

When optimizing Cells, optimize by pitch % set in General settings.

Do not use live images
while debugging

If AQI gets vibration influence by P&P machines, you can stop image

capturing while debugging. Camera only takes shot soon after moving to

the Cell. While inspection, this is deactivated automatically.

* On older machine which unables to use Light Selection, the fillet light will
not be shown correctly.

Show multiple NG rea-
sons in Pack Stamp

When Pack has multiple NG stamps, one voluntary NG reason is shown.
But if this is active, as much as NG reasons are shown.

Show inspection time
except PCB loading time

Normally inspection time includes the time while PCB is draw in. If this is
active, inspection time is count excluding PCB drawing in time.

Show result in message

bar on counting Ref. Des.

When checked this, Pack is simply counted as one even when it contains
multiple NG frames.
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(Screen Sensitivity)

V¥ Sensitivity

Name Description
Alert too big frame at file | If Warning frame Size in General Setting is checked, a warning will be
open displayed when a frame over the pixel size (width) set here is created.
Alert too small frame at | If Warning frame Size in General Setting is checked, a warning will be
file open displayed when a frame below the pixel size (width) set here is created.

Default grid size (pixel)

If the resolution is not set in filter settings, this value will be set as the de-
fault value.

Matching allowance (%)

resolution grid must meet the OK % set in General Setting, but they can
be set to be OK even if some grid boxes are less than the OK % value.
The Matching allowance determines the percentage of these grid box-
es. For example, if the Matching allowance is 20%, up to 2 grids out of
10 can be below the OK % to be judged as OK. However, those 2 grids
must fit within the area designated in the Maximum allowance area.

Maximum allowance area
(%)

Maximum allowance area sets the range to be judged OK even if the
result is under the OK % value. For example, if OK % is set to 60% and
the Maximum allowance area is 10%, grid boxes that fall within the
range of 50% - 60% will be subject to the Matching allowance.

Small/Big frame Search
threshold

This is an optional parameter for Find. The Find method differs by Frame
size. This setting is for the threshold of the size. For small Frames, all
pixels in the Frame will be searched. For big Frames, some sampled pixel
groups in the Frame will searched.

Small frame search
range (1/..)

When searching a small Frame with Find, the size of the search area (how
many times larger than the Frame) is set here.

Big frame coarse search

Since the Find for big Frames is time-consuming, the value to reduce
searching accuracy according to the size can be set here. A small value
will result in a rough search, and a large value will result in a detailed
search.

Text Black/White thresh-
old

When letters are extracted, they are extracted based on differences in
brightness. If that brightness does not exceed the value set here, it will not
be regarded as a brightness change. The default value is 5, and the small-
er the value, the higher the sensitivity. The range is between 1 and 96.
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Name

Description

Default Hue tolerance

This value defines the tolerance to hue differences between the Master
Picture and the picture in the Inspection Frame. This can be set within the
range of O - 65535.

Default Saturation toler-
ance

This value defines the tolerance to saturation differences between the
Master Picture and the Picture Inspection Frame . This can be set within
the range of O - 65535.

Brightness Variation
range (%)

If there is a hue defect, or the saturation is too low, you can set how much
compensation can be applied with brightness.

Default Pixel Search
(chase)

This designates the number of searches (tracks) made to identify misalign-
ment. Each search will look at 8 pixels around of the object. For example,
if the value is 5, it will search up to 40 pixels, searching in places up to 5
pixels away from the object. The maximum search distance is displayed
on the right in mm.

Red auto adjust range

This sets the upper limit of Auto Adjust on Fillet inspections.. 2 means
20%.

Limit number of used
picture

In Fillet inspections, Find is performed using the Master Pictures first. This
designates the number of Master Pictures used for inspection, including
the pictures used for Find

Solder Detect Gain

This is the sensitivity of solder detection when detecting a short circuit
with a doughnut stamp. The higher the value, the wider the area. The
default value is 1.0 and can be set in the range of 0.1 to 5.0.

High Speed Search

When using Highspeed Search for misalignment compensation, if the ma-
chine cannot find the coordinates where the matching rate is lower than
50%, it will terminate the search and start inspection at the original coordi-
nates. In the current model, this setting is always ON and therefore grayed
out.

Fillet search by red

The fillet part will be searched using a red LED.

Search text carefully

When letter extraction is set in the filter settings, it will run a very strict
search so that letters written in fine lines can be found. In the current
model, this setting is always ON and therefore grayed out.
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(Screen LAN)

V¥V LAN

Name

Description

Port, IP Address

When connecting to Rc22x software via LAN, input the terminal port and
the IP address, then press the Connect button on the right to connect.

Status

Displays the current connection status.

Wait (sec.)

The time to wait the reply from CS-Center/Rc22X. Default is 10 seconds.

Enable LAN for Rs22X/
CS-Center

Check here to connect to Rc22x via LAN at software startup and activate
the following items. If communication with the CS-Center is lost while it is
active, it will automatically attempt to reconnect.

Show remote G/NG
screen

Remotely operates G/ NG confirmation from CS-Center/Rc22X. The
Simple mode, is an abbreviated version, and Real mode, is the same
screen as displayed on the Mac. This must be checked for sending data.

Send inspection result
text

Inspection results will be sent to Rc22x in text format. The contents will be
the same as that of the output to the roll-paper printer.

Enable remote Start/
Stop

The machine can be stopped/started from the terminal. Press Tab + C to
stop and Tab + G to start up.

Send barcode number too

The inspection result will be sent to the server after reading the barcode.

Read before inspect (by
USB reader)

When this is checked, the operator should read the barcode before
inspection.

Send Good data too (dx,
dy)

Send not only NG results but also OK and False NG results including shift
information.

Send stamp name too

The stamp name will be added as NOTE column.

Send Cell images (CS-
Center only)

When connected to the CS-Center software, send Good images. When
this setting enabled on the AOI without UV lighting, press the button on
the right to set the lighting to be sent to CS-Repair. See the next page for
details of the function.

Send client name

Displays [CLIENT] on [Edit Recent Used] window. See 24-2-3 for details.

Unable to start
inspection when LAN-off

When disconnected to the CS-Center software, inspection can not be
started.

Decode barcode by
Rc22X/CS-Center engine

Normally barcode is decoded in 22X software, however special barcode
such as MicroQR must be decoded on Rc22X/CS-Center software.

158

13. Settings




Name

Description

Send data without
waiting eject (inline only)

Normally data is sent after ejecting PCB, however activating this function
will allow to send data right after inspection. Do not activate this unless the
decision of manufacturer.

Record inspection
results by PCB number

Enable this setting to subdivide the management of inspection results by
using PCB numbers instead of block numbers. For details, refer to “11-6
Cell Management Using PCB Numbers”.

When 22X version is V6.8.0 or later and CS-Repair version is V2.0.1.0 or later, lighting images other than

main lighting can be sent to CatchSystem. the added setting [ Send cell images (CS-Center only) | is

checked, the output lighting can be selected.

* For UV illumination inspection machines, this setting is grayed out and cannot be changed.

After activating the [ Send Cell Image (CS-Center only) ] setting, press the button to the right of the setting

to activate the lightings to be output. The activated lighting will be marked with a check mark. The Main

lighting is always output and the setting cannot be changed.
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To display the image of the set lighting in CS-Repair, left-click on the Ref.Des. picture displayed under the

split window.

Specify the lighting on the lower right tab of the Ref.Des. image window.
The lightings enabled on the 22X can be selected.

The image volume stored in the PC for CatchSystem increases with the number of lightings selected. The
size depends on lightings and image, but as a rough guide. As a reference, the following field of view with

5M camera and Main lighting will be about 300KB.
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(Screen Other)

V¥V Other

Name

Description

Auto lighting calibration
settings

Automatic adjustment of Brightness and White balance will be made at
minute intervals defined by the settings. This correction is for the software
to set an approximate value. It is not intended for hardware.

Alert regular calibration
(hour)

When performing calibration regularly, the time to show warning can be
set here.

Show warning if alert
ignored (min.)

When regular calibration alert is ignored, show warming message.

Alert if Gain value is too
high (not enough light)

When Gain value is high at calibration, there is possibility that florescent
light must be replaced.

Use Barcode Scanner

Change barcode reader settings here. You can set up the device type and
its purpose.

Do not save files when
opened by barcode scanning

When file is opened by barcode scanning, the file is opened in read-only
mode. Message to confirm save or not save file isn’t displayed.

Settings for In-Line AOI are available only when connected to an in-line model machine.

Name

Description

NG Y position

Unavailable on the current models.

Conveyer width

The conveyer width adjustment value.

PCB lift height

The regular height for backup pin.

Adjust conveyer width at
file opening

Conveyer width is automatically adjusted when the inspection program is
loaded.

Possible to change con-
veyer speed per file

Loader speed can be adjusted per file.

Stopping without ejecting
the PCB at NG of inspection

PCB stays clinched without discharging when NG is found during inspec-
tion. This function is used to correct the error without moving PCB.

Eject PCB without wait-
ing a movement of head

This option is available only for 12200mm special machine.
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(Screen Action)

WV Action

Name Description
Enable Apple Remote In the current model, this setting is grayed out.
Desktop

Alert when 22X starts to
use virtual memory

When the amount of memory used exceeds the actual memory capacity,
virtual memory (hard disk) is started to use. In the current model, this set-
ting is always ON and therefore grayed out.

Enable color with DOAL

When inspecting solder pads with no solder paste using DOAL, it may not
be able to make a judgment since the expected over exposure does not
occur. Use this option to add the color to the image obtained by the MAIN
LED, making it easier to detect solder pads with no solder paste.

Use wide screen

This feature enables inspection of all inspection Frames to be run in the
standard Frame cell size, saving inspection time even with the zoom op-
tion active. In the current model, this setting is always ON and therefore
grayed out.

Enable cache for faster
inspection

By using the cache, the matching rate at inspection will become slightly
wider and redundancies in the matching process will be eliminated, re-
ducing inspection time. Filters for the Master Picture will also be stored in
the cache. In the current model, this setting is always ON and therefore
grayed out.

Enable RAM for cached
file loading

When switching files by barcode, they will be stored in memory without
being saved as files each time, data is saved when the software is shut
down.

Activate Pack Master
function

Check here to inspect using the Pack Master Method. See 10-10 for
details.

Frames keep the original
position

If this is active, and any frame is moved during programming, an alert is
shown when pressing Start whether move back to original position, or
update the position.

Keep fiducial offset
anytime

Keep fiducial offset even Stop button is pressed.

Check 'Bad Mark' first
(before fiducial)

Inspect blockmark stamp before inspecting fiducial marks.

Result of Block skipped by
'Bad mark' should be OK

Option for G/NG confirmation mode. The result of PCB skipped by Block
Mark is OK when this is on.
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Name

Description

Read barcode in Block
skipped by 'Bad mark'

Normally the barcode pasted in the block skipped by '‘Bad mark' is not
scanned, but if this option is active, the barcode is read and sent to
Rc22X/CS-Center.

Do not change file name
after importing CAD data

After importing CAD data file, 22x inspection program name is
automatically changed to the name of the CAD data. This option enables
keeping file name unchanged. This setting is fixed as effective since Ver.
6.6.1.

Close Filter Set window
by clicking OK

Filter Set window is the floating type window. If this option is active,
window closes by pressing OK like a dialogue window.

At start, open the
file used last time
automatically

When starting up software, automatically open the file which is opened
last time.

N checkbox for color list
in Scratch designates NG
color

Activate "N"(NG is OK) of specified color in Scratch setting when you
execute the inspection by NG color. In the current model, this setting is
always ON and therefore grayed out.

Eject PCB as NG when
failing to read;

Activate this when you do not like to inspect PCB and eject it immediately
when set value of fiducial, side markers, or barcode does not match.

Show warm-up message

Activate this when you want to display the message of warm-up operation
when you start up 22X.

Output GPIO origin &
Error Signal Steady

For Origin completion and error, change the I/0-S output signal from one-
shot to level output.
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(Screen Plus)

V¥ Plus

Name

Description

Verify all locations with-
out inspection (Step
Mode)

You can check parts/components only by using the G/NG confirmation
mode without inspection. This is useful for PCBs where the parts/compo-
nents are mounted for the first time after switching PCB models. Please
activate “G/NG confirmation mode” in Map view ssettings.

Enable measuring
[Distance] in Pack window

Activate [Distance] function in Pack Stamp. For detail, see 10-10 Pack
Stamp.

Prevent inspecting incorrect
PCB by assigning barcode

Function to prevent human mistake of opening incorrect inspection
program. File switching is disabled.

Limit barcode number
when reading by handy
scanner

Enable to limit the input from barcode or keyboard for preventing error.
Select the desired number from list. Only effective when "Read before
inspection (by USB reader)" is activated in LAN setting.

Automatic file saving

Save file automatically at background per setting minutes. If there is no
change on file, file is not saved.If you are editing filter/stamp at saving
timing, save will be skipped by next timing.

Create a backup of the
inspection program
when saving

The [Backup] folder is created in the inspection program folder. Up to 3
generations of backups are automatically saved.

Create square stamps
automatically from CAD data

Create square stamps from CAD data without size information for
inspecting component present/absent.

Machine number of
separation data

Activate this when you want to split inspection area for the inspection with
multiple AOl's. You can split the inspection program up to 3 AOI's.

Input Lot Number with
File Open

The lot number edit screen is displayed each time the detection program
is opened.

Input a default as a Lot
number when the field is
blank

This function can be selected when the setting of [Input Lot Number with
File Open] is enabled. If you open a file and press [OK] while leaving the lot
number entry field blank, the present date and time will be automatically
entered as the 12-digit lot number. For more informations, see "Edit Lot
Number" on "14-1 Menu" - "Window Menu".

Without Blinking (USB
5M Camera model)

If checked, the camera lighting will blink only when necessary. This allows
you to perform inspections with less negative visual impact from flashing.
* This setting is only for 5M camera models.
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(Screen Assistant)

V¥ Assistant

Name

Description

Create program from
CAD data in simple way

Create stamp during CAD teaching in simple way by using Stamp Creation
Wizard.

Alert inspection reset by
stop button while CAD
teaching

Show alert when pressing stop button twice during CAD data.

Set Ref.des. name in
consecutive number

Activate when you want to put consecutive number to Ref.des. name
automatically for same Stamp name.
* Consecutive number you can set is from "0001" to "9999".

Display programmer
name who modified the
Stamp

Activate this when you want to display programmer name in Stamp detail
who modified the Stamp.

Enable debugging stamp
list with “C”

When this item is checked, the Stamp list for debugging window wiill
be displayed when the C button is clicked in the stamp list. This will make
debugging work easier.

Alert update of stamp
after resizing

This is for the beginner. To show update dialogue automatically after
resizning for user to prevent forgetting update.

Create fiducial frames
always in zoomed

Always create fiducial frames in zoomed even they are made in non-
zoomed frame.

Alert deletion of
inspection frame

Prevent human mistake to delete frame unexpectedly.

'or' setting in Pack more
than 32 (matrix deactive)

Maximum 32 stamps can be assigned ‘or' condition in matrix tab of Pack
setting. However activating this option enables to assign ‘or' condition to
all stamps in Pack. If this is active, matrix is deactive.
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(Screen Angular Camera) (Screen Bottom Inspection)

(Screen Add-ins) (Screen External)

V¥ Angular Camera (This menu is not displayed on AOI without Angular Cameras)

Please refer Chapter 28-2 "Settings Menu of Angular Cameras (Option)",

V¥ Bottom Inspection (This menu is only displayed on AOI inspecting from bottom)
B Movement Limit

Limit for Z axis up/down to prohibit the camera hitting jig or carrier.

V¥ Add Ins (paid option)
H OCR Add-in

Enables optical character recognition function.

V¥ External (paid option)
B External Communication

Enables external communication function.

166

13. Settings



13-4 Tendency NG / Ignore NG

Alert when defect is counted consecutively/cumulatively, or count as NG only when continuously NG.

V¥ 13-4-1 Tendency NG (Screen 1)
B Active

When same location is NG consecutively in multiple PCB, the inside red circle to mark NG location on

Map View is colored in blinking yellow. In case of NG cumulatively, is colored in blinking rose.

l Stop conveyer

Stop conveyer too in addition to the mark on Map View.

Bl Number of NG

The convayer stops when the number of NG exceeds this number.

Bl Continued NG / Total NG

Number of NG occured in the same location consecutively/cumulatively.

* Any of Continued NG / Total NG or Stop of No. exceeds limit, the count will be reset.

(Screen 1)
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V¥ 13-4-2 Ignore NG

This is a function “Count as NG after reaching to the setting continued NG number”, is use-

ful for high speed inline AOI to inspect text on components.The text inspection is tend to generate false
calls because text is not always beautifully printed. The text inspection before reflow is often done for
confirming if correct reel is set to the feeder. This means that you do not need to inspect all PCB for text.

By activating this function, AOI only reports NG when NG is reported continuously.

1. Select a stamp in Work Area.Open Settings -> Configuration -> Tendency NG/ Ignore NG

2. Check on "Active" and input number of after how many continuous NG is occurred (Screen 2).

3. The stamp not only selected but also in the same name will have the counter at the bottom left
of the frame.(Screen 3)

4. Start inspection. When frame is NG, the count will be increased (Screen 4).When the frame is
NG on next PCB (means continuous NG), the count will be increased. But when the frame is
OK on next PCB, the counter will be reset to 0. As well, if the filter is adjust, it is regarded as
debugging, the count is reset to 0. Count is also reset 0 at closing file.

5. The stamp frame will regarded OK until it reaches to continuous NG setting number even it is

actually NG.

(Screen 2)

(Screen 3)

(Screen 4)
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14. Menu and Shortcut List

14-1 Menu
V¥ File Menu
14-1
(Screen File Menu)
Menu Description
New Creates a new Inspection Program.
Open Opens an Inspection Program.

Open(B-side data)

Opens B-side data. This menu is displayed when there is data in A-Side and
B-Side is selected with the Swap button.

Open Recent File

Opens recently used files. Up to 50 files are stored here.

Import Data File

Imports the NC data (Numerical Control Data) of the pick and place machine

to make an Inspection Program. Select the NC data file from the file dialog and
import by selecting Open. You can select Matching, Histogram, Passive Compo-
nent, Scratch and OCR function besides the previous three special stamps.

Save Saves the Inspection Program. Up to three generations of backup data are
stored in the Backup folder.

Save As Saves the Inspection Program as a new file by changing its name.

Export... Converts file format of program file created by version 6.x when you use the file

with version 4.9.9 or older.

Export Data

Exports information such as NG, position and Stamps.

Information output

The output will be in a text format that can be used in spreadsheets and other
applications.

Position output

This is used to export the numerical coordinates of the Inspection Frames.

Past out put

Outputs result data for each PCB in a text format.

Stamp information

Outputs information for Stamps used by Inspection Programs as a text data.

Snap Shot Screen output, import and PCB image creation can be done.

Save Saves the currently displayed Work Area as an image file.

Open Opens pictures saved with Save or created in other applications.

Blend Pictures imported will be blended with the picture currently displayed in the

Work Area.

Open virtual PCB

Create PCB images be used in the Offline Teaching Software.
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Menu Description

Page Setup You can set paper size and, if a color printer is connected, ink settings.
Print The NG List or the defect locations in the Map View can be printed.
Preview Disprays the print preview. The preview header will include the total number of

inspected PCBs, the total number of defect areas and the total number of in-
spected areas.

Authorisation Changes authorization. See [3-3 Authorization] for detail.
Shut down Quits 22X and Shuts down Mac.
* Caution

- If you open program file created by software version 4.9.9 or older by 22X version 6.0.0 or greater,
and save after modified, program file will be saved with version 6.0.0 format.

- When you save the program file with software version 4.9.9 or older, back up file will be created in
the same directory of inspection file with same file name and prefix.

File name: "_v4_backup_22X_<file name>"

Example: _v4_backup_22X_fda350

- The characters below cannot be used for file name:

[¥?2<>] " A
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V¥V Edit Menu

14-1
(Screen Edit Menu)
Menu Description
Undo Cancels the previous operation. Some actions cannot be undone.
Cut Deletes the selected objects and stores it in memory (clipboard).
Copy Stores the selected objects in memory (clipboard).
Paste Pastes the objects stored in memory (clipboard).
Select All Selects all Frames displayed in the Work Area.
Row Copy Places multiple copies of the selected Frames at specified intervals in a row.,

used to place the same Frame, such as solder shorts between IC leads, in a
row. Copies can be made across cells.

Duplicate selection

Copy selected Frames by cells. If nothing is selected, everything contained in the
cell will be copied.

Arrange

Align selected Inspection Frames.

Auto Reposition

Automatically align Inspection Frame positions based on the Master Picture.

Flip/Turn

Rotates or flips selected Frames using the sub menu.

Initialize

Initializes the selected item below.

Delete Log Data

This command deletes the number of PCBs inspected, the number of total
points inspected, the number of total NG points and the records of each Frame
stored as Log Data. This command cannot be undone.

Clear Local / Master
Pictures

Clear all Master Pictures stored in each Frame in the Work Area, or clear the Lo-
cal Picture.

Clear Objects

All Frames will be deleted. Stamps on Stamp Lists and others will remain.

Automatic Positioning

Performs the same task as Auto Reposition to All Frames.

Side Edit

Selects the option below to switch the side.

Swap A/B side

Side A and side B can be switched.

Copy this side

Copys the selected side.

Assign Fiducial Mark

Sets the marker reading Frame.

Assign side marker

Allows one file to retain data for both A and B sides and automatically switch
sides.

Make Coverage
(Full)

This function is only for UV models. For details, please refer to the Capter “Con-
formal Coating Inspection”.
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V¥ Settings

14-1

(Screen Setting Menu)

Menu

Description

Calibrate

Perform calibration to maintain a consistent display color.

Configuration

Edits settings and preferences below.

General

Set software’s general preferences.

Object Frame

The Inspection Frame color and line thickness can be changed here.

For Supervisor

Set preferences for the inspection machine. In general, this does not need to be
changed.

Tendency NG

Issues special warnings in the Map View for Frames that are continuously judged
as NG or Frames that have many cumulative NGs.

Operator Account

Create operators account.

Mode to start next time

Enable to select UXGA (1600x1200), FHD (1920x1080), FHD2 (1920x1920), 5M
(2400x2000).

Tact Simulation

Opens Tact Simulation window on OFF-Line Teaching. See 23-6 for details.

Calibrate Pixel/cm

Set the millimeter versus dot (how many dots 10 mm equals on the screen) on
the screen. Display the measure on the screen, click on the two points and
enter the mm width, then [For Supervisor] - [Movement] - [Pixels per 1cm] will be
automatically adjusted.

Machine Setup

Sets parameters and movements below.

Parameters

Sets parameters for the machine. Change the setting value only when instructed
by the dealer.

Mechanical Calibration

Reads Fiducial Points in the four corners to adjust the movement. See the Hard-
ware Manual for details.

Machine Setup

Checks if configurations works well by using an optional testing plate.

Reset Camera

If signals from the digital camera could not be sent correctly and the image is
distorted or deleted, this command resets the signal from the camera.

Keep Door/Table
Closed

To kill door/table movement while debugging on Model U series with auto-table
and Model DL/HDL-460/650. This menu is not displayed in the other models.

Length Measurement
Setting

Enables the Length Measurement. See 16-13 for details.
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V¥ Stamp Menu

14-1

(Screen Stamp Menu)

Menu

Description

Stamp list

Opens the Stamp list Window.

Stamp list for
debugging

Opens the stamp list to debug settings. See 8-6-1 for details.

View Selected Stamps

Displays only selected stamps.

New Stamp Registers a new stamp.

Change Applys the changes to all same Stamps.

Duplication A new stamp duplicating the currently selected stamp will be added to the list.
The default stamp name will inherit the name of the duplicated stamp.

Delete Deletes a stamp.

Make Stamp Re- If only one Master Picture is registered, a 180-degree rotated version of the Mas-

versible ter Picture of the currently selected stamp will be added. This is the same func-

tion as the [Make Stamp Reversible] in the Filter Settings screen.

Use Stamp Picture

Applies a Master Picture to the Stamp. This feature makes it easier to manage
programs because each Inspection Frame does not need to have a Master Pic-
ture.

Open Stamp File

Opens Stamp file.

Automatic Paste
(Current View)

Pastes stamps automatically in current view.

Automatic Paste
(Map View)

Pastes stamp automatically in map view.

Create Stamp Pack

Makes selected Stamp Frames into a Stamp Pack.

Edit Stamp Pack

Makes the selected Pack Frame editable. You can resize and reposition each
Inspection Frame.

Release Stamp
Pack

Turns a packed Stamp into indivisual Stamps.

Stamp DB

Opens the Stamp DB window.
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V¥ Window Menu

14-1

(Screen Window Menu)

(Screen 1) (Screen 2)

Menu

Description

Hour Counter

Cumulative hours, operation hours, inspection hours and lamp hours are dis-
played in the Hour Counter. The colors of the numbers will change for each item.
Ground total time (TTL) and clearable total time (TTL2) can be displayed. The
Lamp Alarm can be set up using the pull-down menu (Screen 1). When TTL2
exceeds the time set here, the lamp display will change to red.

Inspection
information

The total number of inspections, the number of OK, the number of NG, and the
percentage of OK are displayed. The behavior of this screen varies depending
on the authorization settings. (> P. 176)

Solder Paste Check

Open the Area Edit Window to convert Inspection Frames for solder paste
inspection.

Conveyer operation

Display the Conveyer control panel for in-line machines.

Show/ Hide Object
Type

Categorize Inspection Frames by type and set up whether each Frame should
be shown or hidden. You can check the Inspection results by type, and you can
also exclude Inspection Frames temporarily.

LAN Window Displays the port on the PC where RC22x/CS-Center is used and the unsent
inspection results upon connection failure. See next page for details.
UserLogin Log in and Log out with registered operator.

Map view Settings

Opens Map view Settings window. See 12-5 for details.

Find Ref.des.

Opens Ref.des. list. See 8-9-2 for details.

Ref.des. Properties

Opens Ref.des. Properties window.

Edit Recent Files

Displays files which are opened recently. You can input the barcode number, lot
number and NOTE.

Edit Lot Number

Input a Lot Number on the Lot Number Edit screen (screen 2) and click OK to
register it. Only alphanumeric characters can be used and can be post up to 30
characters. An error message is displayed when more than 30 characters are
inserted.

Component Mounting
Accuracy Test

The amount of misalignment of each part is measured and a report is output.
enter the value for Test Cycles, press Start, and after the entered number of
inspections, report files are output in the inspection program folder.

Histogram Analyzer

Opens window for histogram method.

Filter Setting Window

Opens window for pattern matching method.
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[Display of Unsent Inspection Results]

When there are inspection results that have not been sent to the production control software, the
inspection date, time, barcode number, and inspection program file name are displayed in the message
field at the bottom of the screen. Up to 4 unsent inspection results will be accumulated.

Click [Delete all unsent inspection results] on the right side of the screen to delete inspection results.

* Deleted results cannot be restored.

When an attempt is made to run an inspection with 4 unsent inspection results accumulated, the following
warning is displayed before the inspection starts and the inspection is stopped.

Click [Cancel] to check the LAN connection and HUB, and confirm that the connection status has
improved before executing the inspection again. Unsent inspection results will remain until you reconnect.

To continue the inspection, select [Delete all unsent inspection results] on the Network window.

If [Enable LAN] is checked on [Settings For Supervisor], 22X will automatically attempt to reconnect to the

LAN while the LAN is disconnected. To stop reconnection, uncheck [Enable LAN].
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[Input a default as a Lot number when the field is blank] is enabled on [Plus] - [Input Lot Number with File
Open]. (Refer to 13-3 [Setting for Supervisor] - [Plus])

Entered Lot Number will be registered on the inspection program and [Edit Recent Files].

The lot number of the inspection program will not be registered until the file is saved. If you enter a lot
number and close the inspection program without saving it, the lot number will be registered only in [Edit
Recent Files]. When [Input Lot Number with File Open] is enabled and a file is opened from [Edit Recent

Files], the registered lot number will be displayed in the lot number entry field (Screen 3).

->

(Screen 3)

Other ways to display the lot number edit screen are as below;
- Shortcut: Command + E
- Tick Imput Lot Number with File Open on Settings for Supervisors

- Click the Lot Number display area on the upper right of the screen (Screen 4)

(Screen 4)

[Inspection information and the Authorization]

The inspection information screen operates differently depending on the protect mode.
In [Supervisor mode], the inspection information can be initialized with the Reset button. In [Operator
Mode], the Inspection Information screen cannot be opened or closed directly. Open the inspection infor-

mation screen in [Supervisor mode] or [Programmer mode], then switch to [Operator mode].
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V¥ Zoom Menu

(Screen Zoom Menu)

Menu

Description

Zoom In

The Zoom mode can be switched between standard magnification and 2x mag-
nification here.

Magnification

Changes magnification of the Work Area. It only affects the enlargement of the
screen and does not affect the unzoom/zoom of the inspection frame.

Hide Zoomed-in
Objects

Frames set with zoomed-In mode can be temporarily hidden.

Hide Unzoomed
Objects

Frames set with standard mode can be temporarily hidden.

Flip Zoom/ Unzoom

The selected Inspection Frames will be changed to other mode. Standard mode
will change to zoomed mode, and 2x mode will change to Standard mode.
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14-2 Shortcut Key List

* Alt key is represented as Option key here.

File Operation

Item Operation

New Command + N
Open Command + O
Save Command + S
Print Command + P
Quit Command + Q

Frame Operation

ltem Select H.g';fe Hg\?ement Cursor Operation

Undo J J J Command + Z

Cut J J J Command + X

Copy J J J Command + C

Paste J J J Command + V

Select Al J J J Command + A

Row Copy J J J Command + D

Automatic Stamp Paste J J Command + G

Edit Lot Number J J Command + E

Rotate Right J J J Select Frame |Command + R

Pack J J Command + K

Edit Pack Position J J Shift + Return

Histogram J J Command + F

Rotate Left J J J Select Frame |Command + L

Rotate Right J J J Select Frame |Command + R

Move frame by pixel J J J Select Frame |Command + < T—|

Move camera by pixel J J 20Trn;nfnd + shift +

Copy J J + Option + drag

Copy (X, Y directions only) J J + Option + drag + shift

Move Frame (Update Master Picture) J J + drag

Move Frame (Maintain Master Picture) J J + Command + drag

Change Frame Size J J '\4 drag

Rotate + Update Master Picture J J '\ Option + drag

Rotate Frame by 45 degrees J J '\ Option + Shift + drag

Set Search Range J J x Control + drag

Set Offset Limit J J "«  |Command + drag

Save New Stamp with master pic. J J Select Frame |F3

Add Master Picture J J Select Frame |F7

Open Filter Setting J J Select Frame |return (enter)

e S B Soct e [ L e e S
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Item Select H.g';?e Hg\?ement Cursor Operation
Offset All (all cells) J Command + Option + drag
Offset Selected Cells J Option + drag
Cell Optimization (Pitch area) J Control + click
Cell Optimization (drag by Control) J Control + drag
Hide frames temporarily J J J caps lock
Optimize selected Frame position J J J F4

Optimize position within cell J J J Fo

S;;gme cell import position within J J J F10
Operation

Item Location Operation

Zoom In/Out F1

To Previous Position (_) F5

To Next Position (_) F6

Select Pointer Tool 1

Select Frame Tool 2

Select Move Tool 3

Force Flip A/B Side Option + A/B Side Button (A/B)
Find Origin Option + Eject

Output Map View to File Map View Close + Command + Shift
Re-create New Map View Map View Command + N

Output Filter Setting Screen to File

Filter Setting Screen

Stop + Command + Shift

Linear Encoder Setting

Message Column

Display Window + Option

Blend Snapshot Screen

Command + B

Stamp DB

Command + F11

Auto Add False Report Picture

Option + Start

Show/Hide in G/NG Confirmation Mode

Space key

Extra setting in G/NG Confirmation Mode

Option + Clock Icon

Add picture in G/NG Confirmation Mode Shift + Good
Manually Enter Barcode Number Space key
Show/Hide Stamp List F8
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Errors

Typical error messages are listed here. When there are OK/Cancel buttons in the dialog box, make your

selection then take actions to fix the error based on the information below:

General

Message

Action

Cannot be completed because
dots/cm value not defined

This message is displayed when dots per cm is not set up. Confirm Settings
for Supervisor.

Imported data file incom-
patible.

This message is displayed when you try to import an unsupported format’s
NC data. Confirm that the data is Panaformat compatible.

Size is too small.

This message is displayed when the Inspection Frame size is too small. To
create a small frame, uncheck Warning frame Size in General Setting.

Size is too large.

This message is displayed when the Inspection Frame size is too large. To
create a large frame, uncheck Warning frame Size in General Setting.

Movement finished unsuccess-
fully.

This message is displayed when the camera movement could not be
completed within the allotted time. The inspection machine may have been
powered off, or the communication cable may have become loose.

Position beyond movement
limits (Correct position within
limits)

This message is displayed when Stamps are placed outside the inspection
area. Delete those Stamps.

Attempt to copy beyond
movement limits. Copying
stopped.

This message is displayed when Stamps are copied outside the inspection
area. The Stamp copy location may be too far away or there may be too
many copies to be made.

There was an object that can
not be distributed to a part.

This message is displayed when some areas can not optimized by Cell
Optimization after NC data (Numerical Control Data) import.

No ID reply from controller.

This message is displayed when the PC cannot receive data from the
machine due to the inspection machine being powered off during Inspection
Software startup, or because the communication cable is disconnected.
Check the power switch and communication cables.

When rotating, frames go out
of the cell (screen).

This message is displayed when the Inspection Frame does not fit inside
the Work Area after being rotated. Confirm the position of the Inspection
Frames.

Not all positions assigned to a
frame. Run again to complete.

This message is displayed when Cell Optimization is executed but not all of
the Stamps are allocated coordinates. Allocate all Stamps before executing
Cell Optimization.
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Message

Action

Cannot store more than 25
Master Pictures.

This message is displayed when you try to add 25 or more Master Pictures
to a Stamp. Delete unnecessary Master Pictures before adding new
pictures.

Map View has not been
created.

This message is displayed when you try to display the Map View when no
Map View has been created. Create a Map View first.

Cannot copy to the same
position.

This message is displayed if the Pitch for Duplicate is set to O when copying
Inspection Frames. Make sure that the pitch is appropriate.

Side Marker already defined.

This message is displayed when you try to create multiple Side Recognition
Markers. Delete old markers before creating new Side Recognition Markers.

Parameter for distortion is
inappropriate.

This message is displayed when the value for correcting distortion, “Top
left carrier fiducial” or “Carrier fiducial distance” is inappropriate.
Confirm these values in Settings for Supervisor.

Frame too close to the edge of
the cell (screen)

This message is displayed when you try to place an Inspection Frame at the
edge of the screen. Make sure that the object is displayed near the center of
the screen before placing the Inspection Frame.

There is no data for side A (B).

This message is displayed when sides are switched while only one side
contains data.

There is no discrimination
between side A(B).

This message is displayed when Side Recognition Markers have not been
set up. To execute automatic recognition, set up side recognition markers
first.

Cannot recognize board side

This message is displayed when side marker Recognition fails. Set the Side
Recognition Markers in a more easily recognizable location or readjust the
filter settings.

Marker Errors

Message

Action

Marker is not adjusted. Select
marker and adjust B&W.

This message is displayed if binarisation level adjustment for markers is not
performed. Double-click on the marker Inspection Frame and adjust the
binarisation level of the object.

Size is too small. Redefine.

This message is displayed if the Fiducial Mark size is too small to perform
center measurement after binarisation. If the center cannot be measured
even after binarisation is adjusted, position cannot be corrected with that
Fiducial Mark.

Size is too large. Redefine.

This message is displayed if the Fiducial Mark size is too large to perform
center measurement after binarisation. If center cannot be measured even
after binarisation, position cannot be corrected with that Fiducial Mark.

Main and Sub Marker both
defined. Delete before creating
a new one.

This message is displayed when you try to create a new Fiducial Mark after
the Fiducial Mark has already been set up. Delete the old Fiducial Mark
before creating a new Fiducial Mark.
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Message

Action

Failed to find marker.

This message is displayed when there is no Fiducial Point to be found, or
when binarisation and other adjustments are made inappropriately. Confirm
the Fiducial Points position and double-click on the Fiducial Reading Frame
to readjust the binarisation level.

Warning Query Dialog

Message

Action

Local picture(s) not stored.
Continue copy?

This message is displayed when you try to copy the Frame even if there is
no Master Picture contained in the Frame.Register Master Picture from a
good PCB before copying.

Create Map

This message is displayed when the Eyeglass Button is clicked after
Inspection Data has been created. Click OK to create the Map View Picture.

Save changes to the data
before quitting?

This message is displayed when you try to close the inspection software
without saving the program. Click Save to save the program.

Erase logged data? Cannot
undo this operation.

This message is displayed when Edit > Initialize > Delete Log Data is
selected. Since this operation cannot be undone, be careful when selecting
OK/Cancel.

Erase all local Master Pictures?
Cannot undo this operation

This message is displayed when Edit > Initialize > Clear Local Master
Pictures is selected. Since this operation cannot be undone, be careful
when selecting OK/Cancel.

Erase all objects? Cannot undo
this operation

This message is displayed when Edit > Initialize > Clear Objects is
selected. Since this operation cannot be undone, be careful when selecting
OK/Cancel.

Mechanical calibration values
renewed. Existing value will be
lost.

This message is displayed when Settings > Machine Setup >
Mechanical Calibration > Update is selected. When Mechanical
Calibration has already been executed once, this does not need to be
updated unless you move the machine.

Execute new mechanical
calibration. Caution: Older data
may need some adjustments.

This message is displayed when Settings > Machine Setup >
Mechanical Calibration > New is selected. When Mechanical Calibration
has already been executed once, you do not need to execute this function
unless you need to create new, machine specific, preference data.

Ignore Marker and continue?

This message is displayed when Fiducial Mark Recognition fails. You can
ignore and continue or manually adjust the position, but we recommend
that you go back and readjust the Fiducial Mark settings.

Move to calibration position?

This message is displayed when Calibrate is selected from the Settings
menu. Click OK to move the camera to the calibration position.

Move to measure position?

This message is displayed when Calibrate Pixel/cm is selected from the
Settings menu. Click OK to move the camera to the scale position.

Pictures with NG results will be
added automatically.

This message is displayed when inspection is executed while holding down
the Option key. This message notifies you that the mode is currently set to
automatically import the Master Picture from an Inspection Frame that will
give false reports.
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Macintosh to AOI connection

Message

Action

No.2000-0000
Not responding or hot replug

Communication with the camera is lost. If the following measures do not

restore the communication, please contact your distributor.

- Turn off the power to the PC and the equipment, and after 10 seconds,
turn on the power to the equipment and then to the PC.

- Turn off the PC and the equipment, unplug and plug the cables between
the PC and the equipment, and then turn on the equipment and the PC in
that order.

No.2001-0000
Driver not installed or Grab
card can't recognized.

This message is displayed when the software and hardware for video
capture are not functioning properly. The image cannot be displayed when
this occurs. Make sure the following;

- The machine switch is turned on.

- Cables between the machine and PC are connected properly.

- Video capture boards and driver software are installed properly.

Video will not work properly if have an incompatible combination of capture
board, video camera and driver softwares. If you are unsure of your
configuration, please contact your sales agent or the manufacturer.

No0.2002-0000
Can’t Videolnitialize

Communication with the camera is lost. If the following measures do not
restore the communication, please contact your distributor.

- The machine switch is turned on.

- Cables between the machine and PC are connected properly.

- Video capture boards and driver software are installed properly.

Video will not work properly if have an incompatible combination of capture
board, video camera and driver softwares. If you are unsure of your
configuration, please contact your sales agent or the manufacturer.

No0.2003-0000
Can't Open 232C

This message is displayed when serial communication with the device is not

possible. Please check the following:

- The machine switch is turned on.

- USBS3 - USB-C Cable between the machine and PC are connected
properly.

Machine Setup

Message

Action

Received a message of an
unidentified error.

This is an error that has no specific error messages. This may be displayed
when the inspection machine is turned ON/ OFF while the inspection
software is running. If this message is displayed frequently in other
circumstances, please contact the manufacturer.

A system error occurred in
movement control device.

This is a system error in the internal controller board of the inspection
machine. If this message is displayed frequently, please contact the
manufacturer.

A command error occurred in
movement control device.

This is a command error in the internal controller board of the inspection
machine. If this message is displayed frequently, please contact the
manufacturer.

Movement parameter error.

This is a parameter error in the internal controller of the inspection machine.
If this message is displayed frequently, please contact the manufacturer.

Must set Origin Position.
Continue?

This message is displayed when you try to move the position before setting
the Origin Position, or when you try to move the position after activating
emergency stop or the security system. Press the Origin Position button to
set the Origin Position.
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Message

Action

Servo error

This message is displayed when the motor RPM is slower than the preset
value. This may happen when the upper camera hits an obstacle while
moving, or when dust on moving parts has caused motor problems. This
message will also be displayed when operating power for the motor is
insufficient due to reduced power voltage or for other reasons. Pay attention
if the unit is plugged into an extension cord with multiple outlets.

Movement attempt beyond
minimum X value.

This message is displayed when the PC sends an instruction to move in the
negative direction on the X axis from the origin position (a position that is
physically impossible to move to). This will not generally happen with regular
data creation, but you will need to be careful when data is created from
imported NC data. When this error is displayed, please confirm the Frames
Position.

Movement attempt beyond
minimum Y value.

This message is displayed when the PC sends an instruction to move in the
negative direction on the Y axis from the origin position (a position that is
physically impossible to move to). This should not happen with regular data
creation, but you will need to be careful when data is created from imported
NC data. When this error is displayed, please confirm the Frames Position.

Movement attempt beyond
maximum X value.

This message is displayed when the PC sends an instruction to move
beyond the movement limit in the X axis direction from the origin position
(a position that is physically impossible to move to). This should not
happen with regular data creation, but you will need to be careful when
data is created from imported NC data or when transferring data from a
large inspection machine. When this error is displayed, please confirm
the Inspection Frame position. In addition, this error may be displayed

if the value for Maximum Movement has been changed in Settings
for Supervisor. In this case, please confirm the Maximum Movement
settings.

Movement attempt beyond
maximum Y value.

This message is displayed when the PC sends an instruction to move
beyond the movement limit in the X axis direction from the origin position
(a position that is physically impossible to move to). This should not
happen with regular data creation, but you will need to be careful when
data is created from imported NC data or when transferring data from a
large inspection machine. When this error is displayed, please confirm the
Inspection Frame position. In addition, this error may be displayed if the
value for Maximum Movement value has been changed in Settings
for Supervisor. In this case, please confirm the Maximum Movement
settings.

Security system activated.

This message is displayed when front cover, door cover or Area Sensors
are activated. After canceling, you will need to set the origin position. If
this warning is displayed unexpectedly, check the connection of the Limit
Switches on the covers.
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15. Export/Print data, Handle Similar
PCB hy One Program

This software can export various inspection programs’ information in text format.
By using these files, you will be able to check the data in a spreadsheet and easily save the results of pre-
vious tests. This Chapter explains how to export inspection data (Refer to Chapter 5 CAD Data Application

Guide for import).
15-1 Exporting Data

3 kinds of information can be exported from the Export Data of the File menu or Info File button in the
Map View window. You can select Information output, Position output, Past out put or Stamp In-

formation.

V¥V 15-1-1 Information Output

The data of each frame (serial number or address, Ref.des. name, number of inspections, number of de-
fects, date created, date updated) can be selected for export. Select the delimiter (Tab or comma), sort

sequence and output items in the dialog that is displayed when Information Output is selected (Screen 1).

* No.

This is the serial number assigned automatically in the order of creation (excluding Marks for side recog-
nition and Fiducial Marks). This number changes when frames are deleted or Marks for side recognition/
Fiducial Mark/CellAidStamps are added. The newly added frame will be assigned the latest number. Fi-
ducial Marks are handled differently, with the main marker being -1, and the sub-marker -2. Marks for side
recognition will be number 0.

* Map

15-1-1

(Screen 1)

186

15.Export/Print Data




This is the Address displayed when the Grid Button on the top right corner of te Map View is clicked.

® Ref des.

If Ref des. names are assigned to Frames or Stamps, the Program will include Ref des. names. If Ref des.
names are not assigned, this field will be left blank. If CAD Data has Ref des. names, frames will automati-
cally have Ref des. names assigned to it.

e TTLchecks

The cumulative number of times the frame was inspected.

e TTL NG

The cumulative number of times the frame was judged as NG.

e CreateDate

The date that the frame was newly placed or copied will be entered. The format at file export will be YY/M/D.
e UpdateDate

The date that the Frame was updated, by size change, filter change, picture addition, etc.

¢ False NG too (For printer)

Print False NG points in addition to NG points on paper roll printer.

® Add extra information

Stamp name is also output. If there is pack stamp, the list and number of stamp contained in pack stamp

is output. If there is stamp which original frame type is set, type name and error messages are listed.

B Export Format

The file to be exported will have the name of the inspection program and the date of export in line 1, col-

umn headers in line 2, and details from line 3 onward.

(Ex.)

newest / PCB TTL3/NG1 POINT TTL228/NG83 [ 06.11.2 4:52 AM ]
SYM,% ,ppm,TTL,NG,Begin,Modify

,0.00,0,2,0,06/10/19,06/10/19

,0.00,0,3,0,06/10/18,06/10/18

V¥ 15-1-2 Position output

This exports the coordinates of Inspection Frames as NC Data.

The output format will be available in 3 types from the pull-down menu (Screen 1):

Pana format (N1X-12345Y6789W09021)
22X Data Format (X-1234Y567W90Z00;R01 \Stamp)
CSV (Comma Separated Values) Format (X,Y,W,Z,Ref des,Stamp)
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15-1-2

(Screen 2)

The opening line of the output format will be $, data will start from line 2, and the last line will be * (except
CSV format, CSV format has no head line and end line). 22X Data Format and CSV format can be re-
imported to 22X without editing as CAD data.

Data is sorted by stamp number, which is automatically set by this software. The coordinates start from
the front left of the PCB and increase towards the back right corner, with the position units being fixed

decimal points in 1/100mm increments. The position shows the center of the Frame.

(Ex.)

$
N1X-38189Y12378W000Z-1
N2X-37700Y11838W000Z0

H Note:

1. If the ratio of actual dimensions and the displayed image (pixels per 1cm) is not accurate, the
accuracy of the positioning in the exported file will be low.

2. The further away from the center position of the Work Area, the lower accuracy of position in-
formation will be.

3. There can be around a 0.1mm error, though it depends on the frame positioning accuracy.

V¥ 15-1-3 Past out put

The Inspection history can be exported for each Inspection Frame. The Export format will be tab sepa-
rated. Rows (horizontal) will have Ref. des. names (these will be left blank if there are no Ref. des. names)
sorted in descending order of total NGs, and columns (Vertical) will have the number of inspections dis-

played in descending order. OKs will be O and NGs will be 1.
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V¥ 15-1-4 Stamp information

When you select Stamp Information, the Stamp information Window will be displayed in list format

(Screen 1).

B Format of Stamp information

When Stamp information is selected, the Stamp information Window will appear.

Detailed information and the settings ranges are as follows:

Item Contents Type
name Stamp Name Text
type Type of frame Text (rect,oval,poly......)
zoom Zoom property Numeric (0=noZoom , 1=zoom)
group Group ID Numeric (O=no group)
sizeX Horizontal Size Numeric (Pixels)
sizeY Vertical Size Numeric (Pixels)
pics Number of master pictures Numeric (O=non, 1-24)
percent Special % Numeric (0 — 100)
resolution Grid Numeric (4 — 16 , 0= )
lightness Brightness Numeric (-16 - 15)
contrast Contrast Numeric (-16 — 15, 15=black and White)
hue Hue Numeric (-16 — 15, -16=invalue hue)
saturation Saturation Numeric (-16 — 15, -16=invalue saturation)
blur type Blur Type Numeric (O=Full , 1=horizontal , 2=vertical , 3=side side)
blur level Blur Level Numeric (0 - 4096)
edge Edge Numeric (O=off , 1=on
letter Extract text Numeric (O=off , 1=0n)
NglsOk Judge NG as OK Numeric (0=off , 1=0n)
seek Seeking range Numeric (0-255< Pixels>)
findX Seeking range X Numeric (0-255< Pixels>)
findY Seeking range Y Numeric (0-255< Pixels>)
limitLong Offset limit X Numeric (0-255< Pixels>)
limitShort Offset limit Y Numeric (0-255< Pixels>)
fillet Fillet Numeric (1=Wave type)
wavelevel [Fillet waves Numeric (1 - 3)
waveVolume | Fillet volume Numeric (1 — 3)
waveDir. Fillet direction Text
cameraNo | Special camera setting Numeric (O=non, 1 - 8)
H Sort

Stamps can be sorted by item. Place the mouse pointer on the item that you would like to sort and hold

down on the mouse button to select descending order or ascending order (Screen 2).
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15-1-4

(Screen 1) (Screen 2)

V¥ 15-1-5 Stamp Information Export
Stamp information can be exported as text data. By using the exported data, Stamp Information can be
managed offline. Click Export in the Stamp information Window. A comma separated (CSV format) file

will be saved.

M Format of Exported File

The output file will have headers in line 1, item names in line 2, data starting from line 3, and the terminal

symbol at the last line.

(Ex.)

% STAMP_INFO_HEADER x.x

name,type...... cameraNo
1005B,rect.,1,,28,50,1,60,10,0,0,0,-10,3,1,0,0,0,5,,,,,,,.,

% END_OF_STAMP_INFO
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15-2 Print information by roll paper printer
If you use roll paper printer for AOI, you can print NG inspection points automatically soon after inspection.
Printed paper may be useful to confirm or repair NG points afterwards.

If you PCB has no barcode, 10 digit number is automatically given to each inspection result.

M Applicable printer

Star Micronics TSP143GT (width 79.5mm, enable to print 2 byte character) USB communication.
Star Micronics TSP143GTIIl (width 79.5mm, enable to print 2 byte character) USB communication.

* Star Micronics printer cannot be used on MacOS 10.14.

l USB Printer Settings

1. Install printer driver for Mac from attached CD-ROM.

2. Connect power cable and USB cable to the printer. Connect the other side of USB cable to
Mac's USB port. Power on the printer.

3. Start 22X software, select file menu then Print set (Screen 1). Change from Any printer to TSP***
in Format for setting (Screen 2), change Paper size from A4 to 72mm*20000mm (Screen 3).

4. If other printer is already used on this Mac, change default printer in Printer and Fax menu in
System Preferences.

* The advantage of this USB printer is that this can print with Italic-bold if there is defective Pack

Stamp component which contains more than one defect.

15-2

(Screen 1) (Screen 2) (Screen 3)
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H 22X Application Settings

1. Open Setting menu's For Supervisor, select Screen/Print tab, check on roll paper and set max.
print.

2. To set auto-print, open Setting menu's General, check "Auto printing" on. If you print manually,
select Print in File menu. When previewing, select Preview in File menu.

3. Set information to print. Select Information Output from Export Data in File menu. Or open
Map View and select Information Output from File menu. File saving dialogue pops up. Check

items on and quit this dialogue by Cancel. Please refer chapter 13-1 for details of each item.

H Print False NG

You can also print out false defect points too by option. Activate this in case you want to check PCB after
AOI inspection and human judgement if there is no mis-judgement.

Check on False NG too (For printer) option in Settings step 7. False NG point is marked ? on the head.

M Print barcode number as scannable barcode on roll paper

By installing barcode font in Mac, code39 type of barcode can be printed on roll paper.Please contact
your local reseller to get the font.
* This function is only for USB roll paper printer by STAR micronics. Mac OS must be greater than 10.7

to use barcode font.

H Printing format

General inspection information is written on header, NG (and False NG) points follows.
M22XDL-350
MacPro
TEST [ 2008.8.1 10:33:41 ]
Total PCBs checked[35] block<0> (Thomas)
Total NG PCBs [3] block<0>
Current result (check 455 NG 2/3) Spent time 11

BarNum 1234567890

SYM ADRS TTL NG Begin NG_ID
C3 BO02 35 4 06/04/25 3
2C5 BO05 35 1 06/04/25 -
R41 CO1 35 2 06/04/25 0
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15-3

PCB: Model A PCB: Model B (not mounted)

156-3 Handling Similar PCB by One Inspection Program

Some of you may handle PCBs which are almost the same but a few components are ‘not mounted’ or
‘different components are mounted’. You can manage these PCB by one inspection program with Model
Variation function. Model Variation function is like link files to the inspection program and you define the

difference of each PCB in these link files (nhamed variation files).
V¥ 15-3-1 How to create Variation Files

1. Create an inspection program to be a basis of all similar PCBs. What you do in variation files is
to define "Inspection skipped component(s)". Therefore all necessary stamps must be

located in this inspection program.

* Of course you can add stamps later at any timing. It is OK not to locate stamps for all kind of PCB

now.

2. Next, create variation files. Select Model Variation from File menu. Select Create/Edit Variation
File (Screen 1). A window "Welcome to Model Variation menu!" will be displayed. Create the first

variation file by following the description and click OK (Screen 2).

15-3-1

(Screen 2)
(Screen 1)

(Screen 3)
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l

(Screen 4)
(Screen 6)
(Screen 5)
(Screen 7)
3. Model Variation window will be displayed (Screen 3). The left side is Variation File list, and the

right side is the Reference Designator list. You can designate the skipped location, however
now we are on the way to create variation files, so we move to next operation. Please read the

following pages to learn how to skip.

* Maximum 400 variation files are possible to create.

4.

*The

The second and more variation files can be added by + button (Screen 4).

. Press OK button and close the window. You can open variations from Model Variation in File

menu (Screen 5).

. Variation files are saved in the folder which is automatically created at the same directory as

inspection program. Do not move/delete/change name the variation files from Finder (Screen 6).

The variation file is virtually treated as an inspection program. File name is displayed
"Inspection Program name _ Variation File nhame". The variation file opened once can
be opened by "Open recent file" from next time (Screen 7).

inspection file name sent to Production Management Software (Rc22X or CS-Center), is also

"Inspection Program name _ Variation File name".
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8. After editing variation file, you will be asked to save the file. The file name being confirmed here

is Inspection Program name, not variation name. Please save file.

V¥ 15-3-2 Designate to skip

You can designate the stamps to skip in 2 ways.

Stamp Direct Operation

1. Open variation file. Move to the stamp to be skipped.

2. Select the stamp by mouse.

3. Select "Designate to skip" from Model Variation. The skip mark is displayed on the stamp
frame, and the frame will be skipped from inspection (Screen 1).

4. There is shortcut key "command + y" to do the same operation.

5. Skip can be reset by "Revert" from Model Variation.

Designate in Model Variation window

1. Open Model Variation window.
2. Check on the variation file name on left list (Screen 2).
* You can select all variation files by Check on All from pull-down at bottom left.
3. Check boxes for all Reference Designators will be shown on right. Check on the Reference
Designators which you want to skip the inspection (Screen 2).

4. As same as Stamp Direct Operation, the stamp will be designated to be skipped (Screen 3).

15-3-2

=

(Screen 1)

(Screen 2) (Screen 3)
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(Screen 1) (Screen 2)

V¥ 15-3-3 Information that you can define in Variation Files

Even the PCBs are quite similar, there are some informations must be independent from the others. In

variation file, you can define below informations individually:

- PCB Number (barcode to open program) / LOT / NOTE [In Recently used programs]

- Inspection history [in Map View]

* It is not possible to have Map View or Virtual PCB map in variation file.

V¥ 15-3-4 Export skip setting in CSV file

You can export the skip setting to CSV file.
1. Open Model Variation window.
2. Check on the variation file name on left list.
3. Press Export button at bottom. CSV file will be output.
4. In CSV file, 0 represents Skip and 1 represents Not Skip.

* Only the Variation you had checked in Variation list will be exported.
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V¥ 15-3-5 Import skip setting in CSV file

You can import the setting contents of Model Variation which is edited by external editor.

1. Open Model Variation window.
. Click "lImport" button in bottom screen, and select the file (.csv) which you want to import.

. File contents will be imported to the setting window of Model Variation.

A W N

. Setting will be applied when clicking "OK".

*

All setting will be overwrote and displayed after import. If you want to keep the setting, please
export the file previously, and create the file for restoration.
This function is available from V4.9.6r2 or greater. CSV file which is created with prior version

cannot be imported.

V¥ 15-3-6 Practical Application

Model Variation is a function to designate the components to skip from inspection. However, you can
apply Model Variation to PCB on which “different component” is mounted.

On below example PCBs, the capacitors of different capacity are mounted. In such case, create
inspection program based on PCB A. Then paste the stamp for PCB C’s capacitors: overlap stamp for
grey capacitor onto stamp for brown capacitor. (Below example image is slightly not overlapping, but it is

for easier to understand. Actually, you should paste stamp C exactly on stamp A.)

After pasting stamps overlapped, it is difficult to designate to skip by direct operation. It is better to

designate from Model Variation window by check box.

15-3-6

PCB: Model A PCB: Model C Paste stamp C
(Different components mounted) on stamp A
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V¥ 15-3-7 Limitations

* Model Variation is a function to define stamps to skip. Therefore, if you delete/add stamps in

variation file, it is reflected to the inspection program. By same reason, the file name to be displayed

to confirm the file save, is also the inspection program name (not variation file name.)

* This function is not possible to use if "Save all files at quitting (Enable RAM) is active.

* Saving inspection program as different name will duplicate variation files too.

* Variation file will be swaped also when executing A/B side sswap, however model variation will not
copied when executing Copy this side.

* Please be careful that Model Variation will be saved automatically. For the detail please refer to

"Save" menu in Chapter 14 "Menu and Shortcut List".
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16. Special Stamps and Functions

Some Stamps are called Special Stamps, and have special features. Special Stamps are displayed in

outline type in the Stamp list. Special Stamps are included in Installer named as StampLibVxxx.

Activate/Deactivate “Use Master Picture”

Normal stamps (pattern matching or histogram) always uses master pictures. Only stamp in Stamp List

has master pictures and the stamps pasted in Work Area are referring the master pictuers.

But there is an exception. Some special stamps (BlockMark, PanelBlockMark, TagetFrame, CellAid,
NewCellAid, Doughnut, SlitWidth, Scratch, AngleCheck, KadoSta) can deactivate "Use Master Picture”,
and also is possible to activate. The default condition is deactive, because often these stamps are better
not to use master pictures. When "Use Master Picture" is deactive, each stamp pasted in Work Area has

individual master pictures.

To switch active/deactive "Use Master Picture", please click the small picture in Stamp List. When the

picture is fine, "Use Master Picture" is active. When the picture is blur, "Use Master Picture" is deactive.
16-1 CellAidStamp for Location Correction

(Since NewCellAid Stamp was introduced, CellAidStamp is now less used.) The fundamental concept of
PCB inspection is to compare the PCB with the Master PCB, but when the comparison sensitivity is too
high, slight warping or misalignments may be judged as NG. Therefore, this program has a special Stamp
called the CellAidStamp. When this Stamp is used, the characteristic points within the PCB are found first,
and the overall inspection screen (Cell) position will be given offset, then the inspection will start. With this

Stamp, PWBs (Printed Wired Board) can be inspected efficiently in one Inspection Program.

>
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16-1-1

(Screen 1) (Screen 2)

* CellAidStamp is used to adjust the offset by Cell units (in order to adjust the offset of the entire PCB,

use NewCellAidStamp).

* If there is a variance in light reflections, do not use this stamp because matching will not be stable.

V¥ 16-1-1 Using CellAidStamps

1. Place the CellAidStamp in a place that will be the reference point of the inspection screen (Screen
1). The line surrounding the rectangle shows the range for Find. Images inside the frame will be
searched for within this range and they will become the reference point to provide offset for the
entire cell.

2. Double-click on the frame to open settings. The range for Find is defined by “Enter cell find
range” (default value is 8 pixels).

3. For screens containing the CellAidStamp, the CellAidStamp will be verified first before inspec-
tion. The CellAidStamp searches for a picture that matches the Master Picture. The position will
be corrected by taking the gap between the position of the picture found and the master’s posi-
tion, providing this as an offset to the frame positioned in the screen to be inspected. Offset can

be made inactive in the settings screen.

The CellAidStamp has a different shape than regular Inspection Frames. The line surrounding the rect-
angle designates the range for Search. This area can be changed by pixels in the dialog that is displayed

when you double-click on the Frame (normal value is 8 pixels) (Screen 2).
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16-2 NewCellAidStamp for Location Correction with Flexible PCBs

NewCellAidStamp is an extended version of CellAidStamp. It does not depend only on a characteristic
point image like the CellAidStamp. It provides offset for the entire PCB based on the initially stored char-
acteristics, which makes it capable of handling stability problems when setting PCBs (Screen 1). A cross
mark in the center of the frame when positioning the Stamp indicates that NewCellAidStamp is in use (this

will not be displayed with a CellAidStamp).

V¥ 16-2-1 The principle of NewCellAidStamp

NewCellAidStamp executes the offset by the following procedure.

e If there is a CellAidStamp, positioning will be corrected first using the Cell Aid Stamp, then the NewCel-
IAidStamp will be activated).

* The whole cell image is checked, and if offset is necessary, the correction amount, in pixels, is obtained.

e |f it differs greatly from the original image (for example, if the PCB type is different), it will fail for position
alignment.

e |f the Stamp contains a characteristic point, it is possible to adjust the position only using the Stamp
picture in the NewCellAidStamp. In this case, the overall image will not be used.

e Store images includes a silk screen image. In order to correct the relative misalignment amounts be-
tween the silk screen image and the pattern, further tuning will be made using Inspection Frames con-
tained in the cell (more than 3 Inspection Frames with special characteristics and the appropriate size
will be necessary). If there are no silk screen images, or this adjustment is not necessary, this process

can be skipped.

To use these procedures efficiently, you may skip Fiducial Mark inspection, which may result in improved

tact time, and you may get virtual zero mechanical position differences, which may result in stable inspec-

tion results.

* If large corrections are made with this Stamp, the frames located at the edge of the screen may be
cut off from the offset and be judged as NG during inspection.

* This feature is screen-size dependent. Since data formats are different, there is no compatibility be-

16-2

>

(Screen 1)
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tween different model of AOI. (Read/write is possible, but data will be initialized)
* Inspection time with CellAidStamp will not change much with machines. Processing may feel slow

depending on the CPU (inspection time varies by the number of cells).

V¥ 16-2-2 Use NewCellAidStamp

1. Load Stamp Library from Open Stamp File from the Stamp menu.
2. Place PCB to be the master. This Stamp should be positioned somewhere on a cell that does
not have Fiducial Marks or Marks for side recognitions on a completed Inspection Program
When a characteristic part is surrounded by a frame, you can use this Stamp as the characteristic point
(similar to the CellAidStamp) (however, when correction by Stamp is used, correction by overall image will
not be executed).
3. Select the NewCellAidStamp Frame and double-click on it. A pop-up menu will appear, so
select the appropriate menu (Screen 2).
* When Use Stamp picture is checked, correction will be made only by the characteristic points within
the NewCellAidStamp frame.
* Under Use stamp picture, there is an option Enable Angle Offset (Angle Offset Impossible). This is a
special option, and normally do not use.
* When you activate “Correct Angle too with AngleCheck stamp”, shifting of component during the
inspection is corrected with X-Y direction and rotating direction. Corrected value will be shown in
NweCellAid Stamp by the order of X, Y, 6 after inspection. Please create the Stamp with follwing

procedure before activating this function.

- Move the camera to the position which the offset center of the rotation will be placed in
the center of the screen.

- Place AngleCheck Stamp, and place NewCellAid Stamp surrounding AngleCheck Stamp (Screen 3).
Please use AngleCheck Stamp with no angle shifting since the image in AngleCheck Stamp is used
for offset value.

- After placing, select and put check mark on "Correct Angle too with AngleCheck stamp” in
the setting of NewCellAid Stamp.

* This function corrects the angle after X-Y offset.
* AngleCheck Stamp is placed for setting angle offset of NewCellAid Stamp, not for angle shifting
inspection.

* When Apply to all cells is selected, the same NewCellAidStamp Frame will be positioned to all cells

16-2-2

(Screen 2)
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16-2-2

Angle Check Stamp

(Screen 3)

N

Correct Angle too with AngleCheck Stamp (No correction) Correct Angle too with AngleCheck Stamp (After correction)

except cells with CellAidStamp, Fiducial Marks and Marks for side recognition.

+ Correction by positioned Inspection Frame (Trigger by inspection frame) and correction by

6.

Stamp picture (Use stamp picture) can be all set at once from Trigger by inspection frames

and Use stamp pictures.

. Press the stop button on the machine or on the screen, and then press the inspection start

button. Characteristic Data will be extracted while inspection is being run. When Speed Prior-
ity is selected in the configuration, this setting will be removed temporarily, making the process
extremely slow. This is because it attempts to obtain an accurate image by waiting for the ma-

chine to completely stop vibrating. The actual data creation does not take very much time.

. During Characteristic Data extraction, an error message, “Insufficient positioning triggers re-

quired correction” may be displayed, causing the software to pause. You can ignore this and
press start, but if possible, move the frame to a distinguishable place before starting. In this
case, avoid silk screen areas. If overall adjustments do not work well, the picture in the Stamp
will be used for recovery (this feature can be utilized effectively if Stamps are set up to include
characteristic points).

The process is complete if inspection can be executed. Just in case, make sure that the New-

CellAidStamp is placed in an appropriate position for correction.
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V¥ 16-2-3 Appearance

The NewCellAidStamp Frames will differ in appearance depending on the status.
Menu Description
When the center icon is gray, there is no picture stored in this frame. This is how the

Frame will look when Update including stamp picture is selected.

When the center icon is blue, the frame stores picture data. Since the picture inside of
the frame is not characteristic, corrections cannot be made by the picture in the Stamp.

Since the frame contains a characteristic point, an antenna icon is shown on the upper
part of the frame. Correction by Stamp pictures is possible (however, turning this feature
ON will disable correction by the overall picture). Even if there are characteristics, if the
frame size is too small, it will be considered unstable, thus the antenna will not appear,
and corrections to Stamp pictures cannot be made.

The antenna mark in the upper part of the frame designates the characteristics level.
This figure is a “bad” example since it is a picture of silk screen characters, but since the
picture is characteristic, the characteristic level is 3.

The rounded corners indicate that Trigger by inspection frames is active. Normally,
correction by overall characteristic detection will be sufficiently accurate, but the relative
position of the silk screen image (white letters printed on the PCB) will be misaligned in
many cases. By selecting Trigger by inspection frames, the Inspection Frames will be
actively adjusted by the saved Master Picture, avoiding this problem.

After inspection. The background of the letters of the corrected values will be shown in
red. This means that since overall characteristic detection was not good enough, it was
inspected more strictly. If you see this often, move the frame position a little. By doing so,
the Characteristic Data will be updated. However, it is not recommended to frequently
update Characteristic Data by moving or changing sizes.

This status is after inspection. The background of the corrected value letters will be
shown in green. This means that since the overall correction was not good enough,
correction was made by the picture of the NewCellAidStamp.

This status is after inspection. This shows that position correction was attempted using

various methods, but the process failed. This means that the PCB is totally different, or
the characteristic points are not found.

When positional correction has failed, the component(s) that are out of alignment will be
shown with a red line.

When the center icon turns yellow, it means that the NewCellAidStamp is turned off . You
can toggle on/off all NewCellAidStamps at once by checking on/off Position correction

active. This is generally used to confirm the effects of the NewCellAidStamp.

V¥V 16-2-4 Other Functions

When you press the Command key while the NewCellAidStamp Frame is displayed and placed the mouse

pointer on the frame, the status of this Stamp can be confirmed in real-time.
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16-3 ICLeadGap Stamp

ICLeadGap Stamp is a Special Stamp for Detection of Solder Shorts/bridges between IC leads (ICLead-
Gap Stamp) This Stamp does not search for locations or compare with pictures. To change settings, after
positioning ICLeadGap Stamp (Screen 1), double-click on the frame and display the Lead gap inspection
setting window.

* Can’t use for the component with 2 leads (more than 3 leads required).

V¥ 16-3-1 Lead gap inspection setting Window

The following items can be set in the Lead gap inspection setting window (Screen 2).

H Short detection

This is a level setting for the binarisation of the lead gaps area.

M Lead detection

This is a level setting for the binarisation of the lead area. The lever should be set so that white will be the

lead and black will be the gap.

M 2 pixel pass

A green line passes through the gap between leads. This line can pass through a 1 dot (pixel) gap. When
the lead gaps have been binarised in black and white and there is a 1 dot gap, this can be filled to prevent
the green line from passing and judging as a defect with the 2 pixel pass check box. You can detect Sol-

der shorts more strictly with this feature.

H Blur leads

Leads and lead gaps contain a lot of noise, causing false reports. By blurring leads, the noise can be re-

duced using software processing.

16-3

(Screen 1) (Screen 2)
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B Auto Brightness

There will be differences in brightness in the overall inspection area at set up time and at actual inspection
time, which may affect the detection level and make it unstable. Auto Brightness will stabilize the bright-
ness of the Inspection Area, thus reducing variances in detection level. Since the detection level differs

significantly when this setting is applied, check this item first before moving on to other settings.

H Glue leads

When setting the intensity of stripes (the leads and the lead gaps), the lead may split into two parts. This
happens because the entire lead does not shine, and the center is projected as a black shadow. This fea-

ture unites split leads and deletes fine white lines shown as a noise.

H Reduce flux

If there remains much flux on the PCB, the Stamp recognizes the flux’s white reflection as a lead. In such
cases, check this on. Reduce flux recognizes the flux and subtracts it. However, it will increase the inspec-

tion tolerance and, as a result, the solder dust between the leads can be passed over.

Bl Reduce pattern

If there are patterns in IC lead gaps, the pattern color will be eliminated to improve detection accuracy. Do
not use this setting for PCBs without patterns.

This option has one more function, when component color is white (bright), IC Lead Gap stamp tends

to detects the white area as short when component is slightly shifted. By activating this option, this false

detection is prevented. Activate this for white body color components.

M Integrate Lead

Dirt or roughness on the surface of IC leads may cause 1 lead to appear as if it is split into 2, this increas-

es the blur level. However, increasing this too much will prevent lead detection, resulting in false reports.

H Detour limit

Even though there may be some white spots (solder or noise) on the green line passing through leads, if
there is enough space for the line to pass through, it can detour such spots. Normally, it will be judged as
good area if the line can reach from the starting point to the end point even with detours. It is also possible
to judge the area as bad if a straight line cannot pass without detours. It is also possible to judge as good
if there is any gap whatsoever. These settings can be defined here. The default value is 5 (up to 5 direction

changes). The minimum value is O (straight line only) and the maximum is F (no limit).
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Hl Max pitch diff.

Since a solder bridge is detected by lead gaps and their positions, if the lead gap is completely filled with
solder, the lead gap cannot be detected. In such cases, judgment can be made by distinguishing a lead
gap pitch that clearly differs from an average lead gap pitch. The default value is 50% (ex: if average pitch

is 12, with pitch 18 and higher or 6 and lower set as NG), and the range is from 50 to 20.

H Test corner shorts

Inspection can be executed even if the leads at both ends have completely bridged and may appear to be

1 lead.

M Include fillet check

In order to execute solder bridge detection and fillet check simultaneously, it is not necessary to set a Fillet
Inspection Frame to every lead. Check this box and it will find 1 Fillet Inspection Frame contained in the
ICLeadGapStamp Stamp, apply that to all leads to run inspection. Only 1 fillet inspection frame needs to

be positioned, and the zoom property must be the same.

H Count gaps

Check this to count the number of gaps after setting the Stamp. The number will also be checked con-
stantly during inspection. For example, if 2 leads bridge and appear to be 1 lead, the number will be differ-

ent, and be judged as NG.

H Continuous testing

The moment the picture was taken is not necessarily the best condition. Even with the same area, the im-
age changes gradually. By checking this box, an average setting can be applied to the gradually changing

conditions, enabling the optimum settings at inspection time.

H Camera Special Setting

For leads and flux reflections varies, the defect can be seen easier when capturing the image by chang-

ing camera conditions by using camera special settings. See chapter 20-2. You can also switch lighting

by pressing this button with option key if your AQI has lighting selection. This will be effective specially for

white PCB by using DOAL light.

* Since this is designed for IC lead gap inspection, it cannot be used for other purposes.

* If there are NGs in this Stamps, solder bridge areas will be shown on the screen in red circles in Map
View. You cannot compare the picture with Master Picture

* If the component’s body color is light, activate Reduce Pattern for preventing false detection.

* A complete bridge (lead gap filled up) will be detected as a lead pitch error (+/- 50%). Therefore, de-
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tection accuracy will be lower than the conventional matching method.
* If silk screen is printed in the IC lead gaps area, detection by ICLeadGapStamp may be difficult.
*When the Stamp is positioned at a slanted angle, the solder bridge of the inspection result and the
displayed Fillet Inspection Frames may appear different from the actual components. In this case,
the bridge display can be corrected using the arrow button which may be added in the Lead gap
inspection setting window when rotated. The Fillet Inspection Frame can be corrected using the Re-

inspection Button.

16-4 Stamp for Solder Bridge detection

Solder bridge detection stamp is a stamp specialized in the bridge detection. It is effective for the
following cases.
- False calls with ICLeadGap Stamp and Doughnut Stamp when silk screen is printed around
through hole or between the leads of SOP , QFP, etc.
- False calls with Doughnut Stamp when inspecting bridged through hole.
- When you want to detect solder bridge between the components which cannot handle with

Doughnut Stamp.

V¥ 16-4-1 How to use

Draw the frame with pointer tool, and start Stamp Creation Wizard for Beginners. "SolderBridge Settings"
window will appear when you select "Solder bridge detection”. Place long and narrow window in the
center between two points for making the frame. [t is detected as bridge when the solder exist across the

shorter side of the window.

V¥ 16-4-2 Description of window

H Settings
1. Light selection
Set the lighting for inspection. Need to select the different color for solder and its surrounding.
2. Less sensitive
Decrease sensor for detecting solder. Default value 16% is the most strict setting.
If you do not want to detect too small solder, increase this value.
3. Target color
Designate the color of solder for inspection. Red is selected for AOI model which has “White
main lighting + Red side lighting + DOAL lighting” configuration which uses Red lighting as
side lighting. Blue is selected for AOI model which has “RGB lighting + DOAL lighting”
configuration which uses Blue lighting.
H Color Reduction
1. Light selection
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Set the lighting for inspection. Select the lighting which is easy to see the point which you do
not want to recognize as solder.
2. Color pickup
Designate the exclusion color for inspection. Press color selection button, and the mouse cur-
sor becomes color picker. Drag the mouse onto the color in the stamp frame. By dragging, the
selected color will be painted in blue. Tolerance increases with more painted area if you drag wide
area. Exclusion color and tolerance will be shown at right side in Advanced setting window.
You can select maximum of 100 colors for exclusion color. If you have unnecessary color, click
trash can icon to delete.
By selecting exception color edit button on the lower right, color panel is displayed. It enables edit
of extracted color.
3. Pixel expansion
You can extend the painted area by increasing the minimum number of pixels for painting.
You can use this function if the tolerance is too wide for color reduction variance, and failed to
detect the bridge.
4. Test
Check the present condition. Point with Bridge is displayed in red color, and other target color
is displayed in blue or green.
* Thin Bridge cannot be detected with actual size for few numbers of pixels. Zoom the Stamp when
you detect the thin Bridge. To zoom the Stamp, you need to register new Stamp by clicking Revis-
ing Stamps button after selecting inspection frame, and click “Flip zoom/un-zoom” from Zoom

menu.

16-4-2
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16-5 Special Blockmark Stamp

PanelBlockMark stamp
Stamp for handling bad mark to skip the inspection of useless panel(s) on PCB.

V¥ 16-5-1 How to use PanelBlockMark stamp

1. Create Block Cells. When the Cells are grouped in Block, the Block is automatically set number

from 1,2...(Screen 1)

2. Place PanelBlockMark stamp at the point where to check bad mark. Save master picture in
the stamp (Screen 2).

3. Double-click on PanelBlockMark stamp and open sub-menu. Confirm if TargetBlock is
checked, then input applicable Block number by selecting Setting Number (Screen 3).
* Set filter if necessary by selecting Setting Filter.

4. Start inspection. Block (s) that is checked as bad will not be inspected. (In Screen 4, No.4

yellow Block was not inspected because red bad seal was marked so that PanelBlockMark was

judged as NG)

V¥ 16-5-2 TargetFrame stamp

When there are more than 1 panels in a Cell (FoV), it is effective to use TargetFrame togather with

PanelBlockMark.

16-5-1
(Screen 1)
(Screen 2)
(Screen 3) (Screen 4)
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16-5-3

(Screen 2)
(Screen 1)

V¥ 16-5-3 How to use TargetFrame stamp

1. Place TargetFrame in Work Area, and resize to fit the panel size (see blue frames in below
picture). If the panel lies in multiple Cells, place TargetFrame in each Cell (Screen 1). Double-
click on TargetFrame, then sub-menu as TargetFrameNumber is displayed. Input number other
than 0 (Screen 2). If you place multiple TargetFrames for one panel, set them all the same
number.

2. Place PanelBlockMark on bad marking point. Save master picture in the stamp.

3. Double-click on PanelBlockMark stamp and open sub-menu. Switch the check of TargetBlock
to TargetFrame by clicking, then input applicable TargetFrame number by selecting Setting
Number.

* Set filter of PanelBlockMark stamp if necessary by selecting Setting Filter.
4. Start inspection. Within TargetFrame (s) is not inspected if the corresponding PanelBlockMark

is judged as NG.

16-6 Stamp for Measuring Angle to Check Theta Rotation

AngleCheck stamp

Stamp for detecting components’ position shifting and rotating.
This stamp can obviously catch slight rotation of components
that used to be difficult to find by pattern matching or histogram
algorithm.

* NG points can not be confirmed in NG Cell View mode.
* Without using this stamp, you can measure angle by new Sereen

function in Pack stamp too. For detail, please refer 8-7-6

Extra Settings No.2 Measure/offset Angle.

V¥ 16-6-1 How to use

1. Load AngleCheck stamp (Screen 1).

2. Place the stamp on area where you want to detect angle.
(Screen 2)
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16-6-1

(Screen 4)
(Screen 5)

(Screen 3) (Screen 6)

Resize the stamp to fit the target area. When resizing, the direction to measure angle should
be longer than the other side (Screen 2). This stamp measures the angle of longer side of
rectangle.

3. Double-click the stamp, list of the limit of angle from Non (no measurement), 0.5, 1.0...6.0
degrees will be shown. Select the limit (Screen 3). If you select "mylimit" function, voluntary
angle setup window will appear, and you can set the angle in 0.1 steps from 0.1 to 6.0 (Screen 4).
For the machine with DOAL lighting, DOAL is displayed for selection. When you select DOAL,
switching of main lighting and DOAL lighting is possible, so please use the function depend on
the place and parts. Then, start inspection.

4. The component which exceeds angle limit is judged Not Good and angle is shown (Screen 5).
Angle is shown with minus (-) when component rotates in clock-wise.

5. You can even know the angle of good component by executing re-inspect or analyze. Result

will be displayed in message bar (Screen 6).

V¥ 16-6-2 Include in Pack Stamp

If AngleCheck stamp is in Pack stamp (Screen 1), the list of angle limit can be selected from
Pack window (Screen 2). In addition, option settings for detecting angle can be selectable

(Screen 3). For detail of this option settings, please refer the chapter 10-10.

16-6-2

+ b

(Screen 1) (Screen 2)

[] -

(Screen 3)
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WV 16-6-3 Notice
- If the size of AngleCheck stamp is too small, it can't be measured. When stamp size is too small,
the line color of the stamp will be faint.
If inspection starts in this condition, the angle limiti will compulsory be Non, and inspection
result will be "Could not detect angle"(Screen 1).

Enlarge stamp, then set angle limit again.

- Angle is result from measuring line which is abstracted the difference of brightness in the frame.
If there is no difference found, the result will be "Could not detect angle". You can confirm the
failure reason by analyzing stamp (Screen 2).

- If AngleCheck stamp can detect more than one line to measure, the line more bright and clear
will be the measurement target (Screen 3). Resize the stamp for correct inspection.

- AngleCheck stamp requires 15 Ms per inspection point. However, the calculation is carried out
in the other thread. Therefore, this will not affect to inspection speed much. (Our experiment
shows, when 87 inspection points required 6.92 seconds, added AngleCheck stamp on each
point, the inspection speed for total 174 points was 7.32 seconds.)

- ltis possible to include more than one AngleCheck stamp in Pack stamp. Only one voluntary
stamp will be the measurement target.

- Angle limit can be set in 0.5 steps, however actual measurement accuracy is 0.08 degree.

16-6-3

(Screen 1)

)

analyze

(Screen 2)

) )

analyze analyze

(Screen 3)
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V¥ 16-6-4 Caution

This stamp is slightly different from the ordinary stamp.

Does not adjust the position by master picture.

- Does not search position with master picture, does not have more than one master picture,
does not have reversing picture, because this stamp is not using pattern matching algorithm.

- Unable to set Search Area / Area Limit / Mask.

- Does not follow Pack Master in Pack Stamp.

- NG pictures of AngleStamp are not sent to CS-Center when using NG Cell View or Auto

send for all NG in faster mode.

16-7 Doughnut: Stamp for Wave Soldering Through Hole

Doughnut stamp

Exclusive stamp for detecting solder bridging between through-holes or leads, and detecting no
solder area on the pad, or inspecting solder fillet and existance of lead for wave soldering PCB

without complex settings.

* This stump cannot be used on AOI with W lighting and Conform corting inspection machine.

V¥ 16-7-1 Detect bridging

1. Paste Doughnut stamp on through hole. Resize the stamp to fit the hole size (Screen 1).

2. If the stamp escapes defects or too many false calls, double-click the stamp and adjust settings

(Screen 2).

16-7-1

(Screen 1)

214

16.Special Stamps and Functions




16-7-1

(Screen 2)

Menu

Description

Test button

Show how solder is detected. Solder area is colored in Blue or Red (depend on
model). White area is no solder area 'Screen 3).

Detection Area

By moving lever up, detection area is increased (Screen 4). (Ring of detection
area becomes wider.)

Less Sensitive

Decrease sensor for detecting solder. Default value 16% is the most strict
setting. If you do not want to detect too small solder, increase this.

Area threshold

Represent % of solder area to be NG out of total area. Default value 1% is the
most strict setting. If you increase %, more solder is necessary to be NG, as a
result, detecting setting will be tolerant.

Target color

Normally this is automatically selected according to AOI's type. Red will be
selected for DL/HDL models, and Blue will be selected for HML model. However,
if your AOI’s illumination is special model, change color to fit your AQI.

Detect stable bridge

This is an option when you just want to detect bridge which is making two

only through holes be definete short circuit. This is useful in case solder amount/
shape is unstable but still good, or in case flux is reflecting as solder (Screen 5).
16-7-1 r 1 r 1
(Screen 3) (Screen 4)
Flux refrects as solder,
however red solder area does
not go through the ring. Thus
inspection result is Good.
Too much flux
Red area (solder) goes completely
through the ring. The line is shown
in green.
Bridge to next hole
(Screen 5)
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Menu

Description

Detect all bridge

If you put check and activate the function, all status which lead from the
periphery to an inner periphery is detectable as bridge (NG). (Screen 6)
* This "Detect all bridge" function cannot be used with "Detect stable bridge

only" function. You can only set either function.

Detect solder
excess

Detect both bridge and excess of solder paste at same time. The detection
area can be adjusted by 10% between 50 - 100%. This option can be used with
Detect stable bridge only or Detect all bridge.

Deactivate bridge
detection

Detection for short of leads is not executed. Check this on when you only want
to detect No Solder Area and execute Inspect solder fillet and pin.

Inspect solder fillet

Inspect the solder fillet of through hole and existance of lead. Detail is described

and pin in Chapter 16-6-3.

Position This option enables to search and adjust area for solder inspection. The
sensitivity of color which is recognized as a solder paste area can be adjusted
by using a slider bar on the right of the item.

Solder area The result % is shown when pressing Test button. If the result is good, shown in

blue color, if not good, shown in red color.

Mask1 / Mask2

You can set mask (non inspection area) to the direction of pin. Mask can be set
2 directions (Screen 6).

Angle Selectable from 0 (no mask) to 180 degrees.
Direction Set direction to mask. Selectable from -180 to +180 degrees. The picture shows
the example of masking when pin is down to the direction of 12 o'clock.
No Solder The detail is described on 16-7-2.
Exclusion color You can detect short of leads by treating silk as exceptional color.
Default Clear setting and get back to the default value.
Edit Mask Put mask anywhere on the stamp. The mask created here is applied on
ICLeadGap and No solder.
16-7-1
Detect stable bridge only : OK Detect stable bridge only : OK Detect stable bridge only : NG
Detect all bridge :OK Detect all bridge NG Detect all bridge :NG
(Screen 6)
(Screen 7)
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V¥V 16-7-2 Detect No Solder

By this function, no solder area is easily detected without complicated tune-up (Screen 1).
This stamp is effective on RGB lighting AQI, as Histogram Stamp may give a false NG under the lighting.
The setting procedure is as below:

1. Place Doughnut stamp on a through-hole. Resize to fit the through-hole.

2. Select No Solder tab, check Enable on.

3. Place this stamp to all through-holes on the PCB and start inspection.

4. If lead passes through straightly in the center, and the edge of the lead is not wet, this will be
detected as no solder area. If you want to exclude this, activate Exclude red colored area in
master pictures (Screen 3). If AOI has ML lighting, tick High detection to increase sensitivity.

5. If there is missing defect or false NG, see [How to treat escaping defects / false calls].

* The smallest detection size is 4 pixels.
*When "Exclude red colored area in master picture" is active, if there is real no solder area, this will

be escapiing from detection. Thus be careful when activating this function.

[How to treat escaping defects / false calls]

1. When_escaping large area of no solder on the pad, Doughnut may not detect the color of the

pad successfully. Slide the contrast lever next to Enable check-box from 0 to 5 - 10 (Screen
4). (This adjustment solves escaping problem especially when the pad color is not bright red,
instead dark or rather beige.)

If no solder area is still not detected, change Level of sensitivity from 65% to 70-80%.

When no solder area is slightly found by increasing any of contrast or sensitivity, increase the
effective lever until no solder area is clearly detected.

* Some models do not have contrast lever. Adjust settings by sensitivity Level.

16-7-2

Analyze *

(Screen 3)

Area colored in red is no solder on pad

(Screen 1) (Screen 2)

(Screen 4)
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16-7-2

——1 —1 (Screen 6)
(Screen 5)
@)
(Screen 7) (Screen 8)

2. When escaping small area of no solder, change Minimum size from 0.5 to 0.4-0.2mm. Then
small non soldering area will be detected as well (Screen 5).
3. On the other hand, if the line allows slight no solder area, expand the Minimum size.

4. When there are false calls caused by detecting thin soldered area, decrease contrast lever

next to Enable check-box from 0 to -5 or -10. If this does not improve the false calls, decrease

sensitivity Level from 65% to 55-50%.

[Extending usage]

The area other than through-hole pad can be also insufficient soldered in the wave soldering process.

Here we show to apply Doughnut stamp to detect the no solder of component’s fillet.

1. Normally Doughnut stamp is Oval shape (Screen 6), but you can change its shape to square by

checking Rectangle on (Screen 7).
2. Resize the frame to fit the fillet size (Screen 8).

3. If the bridging detection is unnecessary, check Deactivate bridge detection.

V¥ 16-7-3 Solder fillet and lead inspection

The obvious defects such as below samples can now be detected by doughnut stamp.

16-7-3

(Blowhole)
(No Lead) (No Lead and No Solder)
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[How to use]

1. Place Doughnut stamp on a through-hole. Resize to fit the through-hole (Screen 1).

2. Double-click the stamp, and open the settings window. Check on "Inspect solder fillet and
pin". The "solder fillet area" and "lead area" will be painted (in the sample picture, they are
painted in dark pink and blue). (Screen 2)

* Shrink the bridge "Detection area" as less as possible when enabling Solder fillet and Lead
inspection. Also, resize the stamp size as close as to be the TH size. If unnecessary area is included,

the inspection result may be incorrect.

3. Assign the master picture (Screen 3). Update stamp and save in new name.

* Master picture was not necessary for doughnut stamp in previous version. But for solder fillet and
lead inspection, the criterion is depend on the RGB color elements of master picture, therefore
master picture must be used and it is important factor.

4. Paste doughnut stamp to all holes. Start inspection.
5. There will be many false calls after inspection, because the shape of TH solder fillet varies.

Debug them in following procedure.

[Debugging]
For killing false calls, add a few master pictures. The reason is because criterion is made by RGB
colors of master picture (Screen 4)
Doughnut stamp is using master picture, however, it is not copying pattern matching algorithm. Our
pattern matching algorithm is, to divide frame by grid and make small squares of pixels, then compare the
squares to the ones of good master pictures. In doughnut stamp, area is not divided by grid, therefore_

false calls will be improved by adding less pictures than pattern matching stamp.

16-7-3

(Screen 3)

(Screen 1) (Screen 2)

-

(Screen 4)
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*You may have to add as much pictures as pattern matching frame to kill false NG on some AOI.

You can also use NG master picture (Screen 5). By adding NG master picture, the similar defect can be
certainly found. When creating the inspection program, use the PCB with defects so that better inspection

program will be made.

[Explanations in detail]

- Solder fillet and lead is not inspected if the TH is detected NG by "bridge".

- When executing analyze/re-inspection, the inspection result of "No Solder" is shown and
the result of "Solder fillet and lead" can't be shown. If "No Solder" inspection is inactive, the
result of "Solder fillet and lead" will be shown (Screen 6). Nevertheless, the inspection result of

"Solder fillet and lead"_just shows the tendency of color, means the color does not represent

the status of OK/NG.

- With HDL type illumination, the detection algorithm is different. Therefore when showing the
result of "Solder fillet and lead", the shapes of solder is shown by edge filter, too (Screen 7).

- There is a way to see the inspection process of "Solder filet and lead" even "No Solder" is
enabled. Open settings window, select Mask 1 or Mask 2 tab and press Test button. If you are
in No Solder tab, the inspection process of "No Solder" will be shown.

- When the lead is not straight-up in the center, is bent, in such case the fillet shape would be
even vary and can be similar to the defect one. If you use "Solder fillet and lead inspection” on

such lead-bent TH, there is possibility that defect can escape (Screen 8).

16-7-3

l Analyze

(Screen 5)
Result of "No Solder" is shown Result of "Fillet and Lead" is shown
when "No Solder" is inactive
(Screen 6)
(Screen 7) (Screen 8)
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Addint defect picture can
prevent escaping of defect
(Screen 9)

- With HDL type illumination, if the brightness of the combination of fillet area and lead area is
similar, even the obvious defect can escape. Test those defects by debugging with defect PCB,

and if any defect escapes, add as NG master picture (Screen 9).

V¥ 16-7-4 Caution

This stamp is slightly different from the ordinary stamp.

- Does not search position with master picture.
- Does not have more than one master picture and does not have reversing picture, because this
stamp is not using pattern matching algorithm.

- Unable to set Search Area /Area Limit in version 6.0.3 or prior.

Hidden Technique

If you like to apply the change to all Doughnut stamps created with No
Solder tab or Exclusion color tab, press OK button with option key
(Be careful, you must press OK button while opening No Solder tab or
Silk tab). Then, a message appears and the change will be applied to

all Doughnut stamps created with same tab.
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16-8 Scratch: Stamp for Detecting Scratch/Stain/Crack

Scratch Stamp

Exclusive stamp for detecting stain/solder balls on ceramic board or pad, insufficient of gold pattern, or

scratch/crack of package components without complex settings.
There are 2 approaches; Detect foreign object by automatic binarizing in the frame, or detect foreign

object in selection color area. In case the area in the frame is mono color, automatic binarizing method is

recommended for its setting is easier.

Automatic binarizing and

color selection ' +

(PCB color is false detected) (PCB color ignored)

In case the area in the frame is including more than one color or the area is tend to shift position, selection

color method is recommended. Selection color method has [Normal], [Advanced], and [Area] mode.
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V¥ 16-8-1 Normal

A simple mode to find a scratch. The meaning of each parameter is as below.

Menu

Description

1. Minimum

Set minimum size to be detected (either height or width). The size less than this
value will be ignored.

2. Maximum

Set maximum size to be detected (either height or width). The size more than
this value will be ignored.

3. Result

Result of test or analyzing is shown. If the result is Good, shown in blue color,
and if the result is Not Good, shown in red color.

4. Color Selection

Select color when detecting by Color Selection Method.

5. Angle Enable to rotate frame from -180 to +180 degrees. By pressing up/down button,
rotate by 15 degrees step.

6. test Executes inspection. The analyzing process is shown for 1 or 2 seconds.

7. Edit Mask Mask edit screen is displayed.

8. Light AOI with multiple lighting models can change lighting.

9. Auto detection Checked on default. Detect scratch/stain automatically. Current detection level is

shown on the right after inspection.

10. Level

Auto detection level can up/down a little by sliding Level from 0 to +/-2.In
Automatic Binarizing method, detection is more tolerant by -, and is less tolerant
by +. In Color Selection method, colored area is larger by -, and smaller by +.

11. Manual detection

Check off auto detect, then this will be activated. Level can be selected from 16
to 240. In Automatic Binarizing method, his level does not represent the sensor
of detection, this represents black/white level. In Color Selection method, you

can manually change the allowance of area to be painted, larger than Auto detec-
tion (Color gradation allowance fixed)
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[Automatic Binarizing Method]
1. Place the stamp on target. Resize the stamp to fit the target size (Screen 1).

It is better that target has real defect, so that adjustment will be easier.

)

(Screen 1)

2. Mask the area which will affect to the inspection (Screen 2).
Scratch stamp detects defects by comparing brightness per pixel, thus black text on white
ceramics or white text/polarity on black package component should be masked.

3. Double-click stamp’s frame, setting window will be open. Input minimum and maximum size to
be found as defect. Press test button to confirm if the scratch is found. Start inspection (Screen

3). Area found as scratch/stain is shown with red frame.

» >

(Screen 2)

4. If the target is not found or too many false calls, switch detection mode from Auto to Manual.
Check-off Auto detection, then you can slide bar for Manual detection. Find the best level by

sliding the bar right to left.

(Screen 3)
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[Color Selection Method (Normal) ]
1. Press color selection button, the mouse cursor becomes color picker. Drag the mouse onto the
color in the stamp frame. By dragging, the selected color will be painted in blue. The painted area

is the target to measure.

(Not Evenly) (Evenly)

Screen 4)

2. Please pay attention to select color; target area must be painted evenly without including
unnecessary color. (Screen 4) By dragging mouse larger, the area painted in blue will be
increased. (If it is not possible to paint the target in blue evenly, the inspection result will be

unstable. In such case, Scratch stamp may not be optimum method for your inspection)

3. To reset the color, click in the area other than inside stamp's frame by color picker. After color

selection is reset, the inspection method reverts to binarizing method.

4. In color selection mode, if you switch illumination other than Default, "Auto detection" is not
possible to use. With other illumination such as DOAL or Side Lighting, the edge between PCB
and pad is tend to be blurred or have more color gradation, and it is too difficult to find good

balance by automatic. Thus, you need to adjust manually (Screen 5).

(Screen 5)
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[Color Selection Method (Advanced) ]

With Advanced mode, you can enter long/short side length. Also, maximum 100 colors and exception

colors are available. If defect area is at the edge of the inspection target area, comparing inspection with

Master Picture is executed.

Menu Description
1. Minimum Set minimum size to be detected. The size less than this value will be ignored.
2. Maximum Set maximum size to be detected. The size more than this value will be ignored.
3. Result Result of test or analyzing is shown. If the result is Good, shown in blue color,

and if the result is Not Good, shown in red color.

4. Color Selection

Select color when detecting by Color Selection Method.

5. Angle Enable to rotate frame from -180 to +180 degrees. By pressing up/down button,
rotate by 15 degrees step.

6. Search The angle can be set in the range of -180 to +180 degrees. Pressing the up/
down button will input the angle in 15-degree increments.

7. Test Executes inspection. The analyzing process is shown for 1 or 2 seconds.

8. Light AOI with multiple lighting models can change lighting.

9. Selected color/
Exception color

Selected color is displayed. Check [N] to set the color as an [Exception color].
See the next page for detail.

10. Tolerance

Extends the recognition range of the selected color. If the value exceeds 25, the
text color will change to warn of missed colors.

11. Delete Deletes a selected color.
12. Color chart Edits a selected color using a color chart.
13. Edit Mask Mask edit screen is displayed.
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16-8-1

(Screen 6) (Screen 7)

1. Switch to Advanced tab (Screen 6). Press color selection button, the mouse cursor becomes
color picker. Drag the mouse onto the color in the stamp frame. By dragging, the selected color
will be painted in blue. The painted area is the target to measure.

*When tolerance exceeds 25 to 30, tiny object or object in similar color won't be detected. Do

not increase tolerance instead add color.

2. By checking on 'N', you can designate sampled color as exclusion color. Inspection target color
will be painted in blue, and exclusion color will be painted in red (Screen 7).
* Because area painted by exclusion color is as same as masked area (non-inspection area),

defect in this area is not detected.

[ Notes ]

By activating "N checkbox for color list in Scratch designates NG color" in Action tab of For
Supervisors menu will change Exclusion color to NG color. Designating NG color will be useful

when you already know the defective color such as detecting the splash of bond on pad.

When using Advanced method, the stamp should be applied "Use Master Picture". Without

applying "Use Master Picture", inspection will be less strict.

If the tolerance of color is too wide, defect will escape. The text color of tolerance becomes

brown at over 25, and becomes red at over 40. Confirm the risk of escaping by text color, and it

is better to add new color than increasing color tolerance.

If there is color difference between the current PCB and master PCB, false calls will occur.
In such case, open settings window and press "Test" button. Confirm if there isn't area not

painted in blue. If there is non painted area, sample the area and add as new color.

227

16.Special Stamps and Functions




[Color Selection Method (Area) ]

This inspection has a function to determine if the area of an area filled with a specified color is greater than

or equal to a set value (%) in addition to the [Advanced] inspection.

Menu Description
1. Minimum Set minimum size to be detected. The size less than this value will be ignored.
2. Maximum Set maximum size to be detected. The size more than this value will be ignored.
3. Result Result of test or analyzing is shown. If the result is Good, shown in blue color,

and if the result is Not Good, shown in red color.

4. Color Selection

Select color when detecting by Color Selection Method.

5. Area

Enter the area percentage of the specified color. If the value is greater than or
equal to the entered value, it is judged as Good.

6. detect each area

An option to detect the specified color percentage for each detected area.

7. Angle Enable to rotate frame from -180 to +180 degrees. By pressing up/down button,
rotate by 15 degrees step.

8. Search The angle can be set in the range of -180 to +180 degrees. Pressing the up/
down button will input the angle in 15-degree increments.

9. Test Executes inspection. The analyzing process is shown for 1 or 2 seconds.

10. Light AQOI with multiple lighting models can change lighting.

11. Selected color/
Exception color

Selected color is displayed. Check [N] to set the color as an [Exception color].
See the next page for detail.

12. Tolerance

Extends the recognition range of the selected color. If the value exceeds 25, the
text color will change to warn of missed colors.

13. Delete Deletes a selected color.
14. Color chart Edits a selected color using a color chart.
15. Edit Mask Mask edit screen is displayed.
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Usage

Input the setting value in percent (%) for “Area”. Click “Color Pickup” button, and display color picker. Drag
the mouse on target color within inspection frame. Colored area will be the inspection target.

When you specify the color of target component, and if there is more area than set value, it is possible

to set the judgment result as Good. Function can be used for large area inspection. (Screen 1)

(Screen 1)

Practical application

Activate “detect each area” when you want to inspect smaller inspection area, such as stain and crack

at the surface of ceramics or blow hole, and splash of solder on pad before solder coating. You can also
execute the inspection by NG color when you activate “N” (NG is OK) of specified color. (Screen 2)

You can refer to following image as example to detect small NG point from wide inspection area. If you do
not activate “detect each area”, the detection area will be small and causes escape.

Please select appropriate setting depend on the target to inspect. (Screen 3)

(Screen 2)

(Screen 3)
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V¥ 16-8-4 Notice

Set search area when PCB tends to shift position.

Use zoomed frame if tiny defective object is escaped. non-zoomed frame has less resolution.
- Inputting too small/big value in minimum/maximum fields will give bad influence to inspection

because this can cause many false calls.
- Scratch stamp finds all defective foreign object, however maximum 100 points can be

displayed with red NG frames. If there are more than 100 objects, some may not be displayed

with red NG frame.
- In Normal color selection mode, software tries to detect "foreign object" in the selected color
area. Therefore, "Large splash (more than the half of pad area)", "Mark made by paint", or

"Symmetric object" won't be detected.

V¥ 16-8-5 Caution

This stamp is slightly different from the ordinary stamp.

Does not adjust the position by master picture in Color Selection Method (Normal).

Unable to set Search Area /Area Limit in version 6.0.3 or prior.

Does not search position with master picture, does not have more than one master picture,

does not have reversing picture, because this stamp is not using pattern matching algorithm.

Does not follow the Pack Master in Pack Stamp in Color Selection Method (Normal).
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16-9 SlitWidth: Stamp for Measuring Slit Width

SlitWidth stamp

Exclusive stamp for measuring slit width to detect insufficient Ni/Au printing or scratch on printing.

Menu

Description

1. Minimum

Set minimum size to be judged Good. The size less than this value is judged Not
Good.

2. Maximum

Set maximum size to be judged Good. The size more than this value is judged
Not Good.

3. Result / Average

Result of Test or analyzing is shown. If the result is Good, shown in blue color,
and if the result is Not Good, shown in red color. If the measurement is failed,
result is shown in red with minus value. Average shows the average of area in the
frame.

4. Test / auto width

Show the result of current settings. By pressing auto width button, Minimum/
Maximum target size is automatically input. Place SlitWidth stamp on the target
(not defective sample), press this button. Minimum/Maximum size will be input
based on the sample.

5. Allowance for auto
width

The allowance for automatic Minimum/Maximum target size input. The default
allowance is 0.02mm. By pressing up/down button, you can increase/decrease
allowance per 0.02 step. Our recommendation is 0.04mm allowance.

6. light

AQOI with multiple lighting models can change lighting.

7. angle

Enable to rotate frame from -180 to +180 degrees. By pressing up/down button,
rotate by 15 degrees step.

8. Color Selection
tool, Low Path
Filter and R.cut

Use Color Selection tool when you want to measure width by Color Selection
method. Low Path Filter is the filter to ignore a little noise (Screen 1), selectable

only in color selection method. In case if you like to detect even tiny difference,
please deactivate this option.
R.cut means “Round Cut” option to ignore the shape difference at edge (Screen 2)

(LPF OFF)
(Screen 1)

> >

(LPF ON) (R.cut OFF) (LPF ON)
(Screen 2)
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16-9

(Suitable to Automatic Binarizing method) (Suitable to Color Selection method)

V¥ 16-9-1 How to use
[Automatic Binarizing Method]

1. Place SlitWidth stamp on the target (Screen 1).
2. Open setting window, and set the threshold of width (Screen 2).
3. You can start inspection (Screen 3).

* When placing stamp, pay attention by reading Notice on below.

16-9-1

> >

(Screen 1) (Screen 2) (Screen 3)

- If the area other than slit is small, detection may fail (Screen 4). Enlarge stamp to increase area.
- If stamp is including silk print, pattern or components, color is not uniform, or color of slit and
non-slit area is very similar, detection may fail. An error message "No Measurement target

found" will be shown with minus result value (Screen 5).

I Open setting window and TEST...

(Screen 4) (Screen 5: Area other than slit is too small, and area includes the pattern.)
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16-9-1

(Screen 6)

O

(Not evenly) (Evenly)

(Screen 7) (Screen 8)

- Width is calculated by averaging measuring several points in stamp. If the stamp size is too big,
the result will be more standardized, and you can not get precise result. If you measure long

shape, do not enlarge stamp, but place many stamps (Screen 6)

[Color Selection Method]

1. Press Color Selection button, select the color of target in the frame. By pressing this button,
the mouse cursor becomes color picker. Drag the mouse onto the color in the stamp frame. By
dragging, the selected color will be painted in blue. The painted area is the target to measure.

* When selecting color, pay attention by reading Notice on below.

- Target area must be painted evenly without including unnecessary color (Screen 8). By dragging
mouse larger, the area painted in blue will be increased. (If it is not possible to paint the target
in blue evenly, the inspection result will be unstable. In such case, SlitWidth stamp may not be
optimum method for your inspection)

- To reset the color, click in the area other than inside stamp's frame by color picker. After color
selection is reset, the inspection method reverts to binarizing method.

- By binarizing method, the width is measured along the longer side of frame, on the other hand,

the shorter side of frame is measured by color selection method.
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V¥ 16-9-3 Caution
This stamp is slightly different from the ordinary stamp.
- Does not adjust the position by master picture.
- Unable to set Search Area / Area Limit in version 6.0.3 or prior.
- Unable to set mask.
- Does not search position with master picture, does not have more than one master picture,

does not have reversing picture, because this stamp is not using pattern matching algorithm.
16-10 KadoSta: PCB stop position adjustment stamp for inline

If your PCB’s shape is somewhat like below sample PCB (Image 1), and unable to stop PCB on accurate
position because your PCB’s top left corner is not square or component like connector exists there, as a
result the stopper does not work well on inline AOI, you should try KadoSta

KadoSta detects the edge of PCB and give offset.

V¥ 16-10-1 How to use KadoSta

1. First, move camera by Move tool in order the PCB edge to be at the center (Screen 1), place
KadoSta to be in the center (Screen 2). In case using KadoSta for giving offset to Y direction, resize
KadoSta to be longer to Y direction. If it is resized, the mark <-- X--> changes into <--Y-->.

* When placing KadoSta, select PCB area where no pattern or white silk printing exists near the edge.
If a straight white silk line is runnning near the edge, AOI mis-detect the white line as the edge.

2. Press Analyze button. When the edge is detected correctly, the green line is displayed on the edge,
and red line graph which represents the difference is peaked on the edge (Screen 3). If detection
fails, the green line is not displayed and orange line graph is displayed in stead of red graph.

3. If detection fails, error messages as "Not enough blank space" or "Image has too few characteristic

area." pop up. In such case, please adjust KadoSta by following 16-10-3 Adjustment.

16-10-1

(Screen 1) (Screen 2) (Screen 3)

(Image 1)

234

16.Special Stamps and Functions




16-10-2

(Screen 1)

V¥ 16-10-2 Display explanation

1. Red graph's peak (at edge) should be above this yellow line.

2. Blank area (where no PCB) should be below this yellow line. Also KadoSta should have at least
1/5 blank area.

3. This green graph is displayed where PCB edge is detected.

4. Red line graph represents the barometer of color difference.

5. Value of position offset. If the result is for example X2(96%) then 2 pixel position missalignment
to X direction and the position is 96% correct.

6. If AOI has multi lighting, you can switch lighting by clicking on the frame of KadoSta.

V¥ 16-10-3 Adjustment

1.Enlarge KadoSta frame size. Especially enlarge blank (non-PCB) area.

2.If white straight silk printing is running near the PCB edge, resize KadoSta smaller to exclude the
white color.

3. If PCB color is too dark and can not detect, select DOAL illunimation if your AQOI is multi lighting

type.
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16-11 BumpArray: Solder Bumps and Pad inspection

“BumpArray” stamp is an exclusive stamp for inspecting solder bumps, and pad before pasting solder.
This stamp can detect scratch or unexpected object on pad, and detects of the bump (size, no solder,
bridge and shape). In addition, BumpArray stamp can detect scratch or unexpected objects (such as dust
or solder balls) on the neighboring pad.

* Because the bumps are quite small, please select AOI with high resolution lens.

* For ML illumination model only. Can't be active on the other model.

* Detection is not possible on the models which RGB lighting position is reversing.

V¥ 16-11-1 How to use

At first, sampling PCB position, bump numbers and bump position from master PCB. Master PCB must
be the good one without defect.

1. Set PCB on AQI, load StamplLibrary.

2. Move camera onto the target, paste BumpArray stamp.

3. You can resize the frame to fit the target size. This operation is different from case 1 “Bump

only” and case 2 “Not only Bump also neighboring Pad”.

[Case 1 (Bump only)]

3-1. Enlarge stamp size to include all bumps, large enough to include all bumps, but small enough
to exclude Pad area.

Caution: Select the best piece (target), because this is going to be the master. All bumps
must be in good shape, good size, correct number and in accurate position.

3-2. Open settings window by double-clicking the frame. When the inspection target is solder
bump, select Bump. When the inspection target is pad (before printing solder), select
Pattern. Press re-inspect button, and confirm the result to be OK. Mouse over the frame
of BumpArray stamp (Screen 1). A message “Bump OK 0/225” will be shown (225 is the total
bump number here). Confirm the last number (225 here) is as same as the number of bumps

that you count with your eyes.

16-11-1

Bump OK 0/225

(Screen 1) (Screen 2) (Screen 3)
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* If the number of bumps differs, change the piece and re-take the master picture.
3-3. Next, set the Search Area. Move mouse cursor on the bottom-right corner of the frame,
drag the frame with pressing control key (Screen 2). Press the golden stamp button in Master

Picture Area and update the BumpArray stamp (Screen 3).

[Case 2 (Not only Bump also neighboring Pad)]

3-1. Enlarge stamp size to include not only bumps but also pad (Screen 4).

3-2. Let’s separate Bump area and Pad area. Drag the bottom-right corner of the frame to inside
(toward diagnostic side), shrink the frame until the mouse cursor comes to the bottom-right
corner of Bump area. Release the mouse button. A message “Resizing a stamp...” will be s
hown (Screen 5), press OK. Continuously, a selection menu pops up. Select “Bump and Pad
inspection”.

3-3. As well as 3-2, shrink the top-left conrner of the frame to fit the Bump area. Now the frame for
Bump inspection is created inside the frame for neighboring Pad inspection.

3-4. Open settings window by double-clicking the frame. When the inspection target is solder
bump, select Bump. When the inspection target is pad (before printing solder), select
Pattern. Press re-inspect button, and confirm the result to be OK. Mouse over the frame of
BumpArray stamp. A message “Bump OK 0/225” will be shown (225 is the total bump number
here). Confirm the last number (225 here) is as same as the number of bumps that you count
with your eyes.

3-5. Next, set the Search Area. Move mouse cursor on the bottom-right corner of the frame, drag
the frame with pressing control key. Press the golden stamp button in Master Picture Area

and update the BumpArray stamp.

16-11-1

I (Screen 5)

(Screen 4)
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16-11-1

(Screen 6)

[Case 3 (Big BGA Bump)]

1. Set PCB on AQI, load StampLibrary.

2. Move camera onto the target, paste BumpArray stamp.

3. Select Sp.BUmp for Inspection Item. There will be Color selection tool in Detection setting.
Sample the solder area to be painted blue. (Screen 6)

4. Input bump size and minimum allowanced bump size in Size setting.

5. Set allowance of insufficient solder area in percentage (default 60% means if 60% area is

printed by solder, it is judged OK.)

16-11-2

V¥ 16-11-2 Settings Window

Settings Window is shown by double-clicking the frame of stamp.

Size setting ( micron)

Standard diameter: The ideal size of a bump diameter in micron. The number on the right is
the number converted to pixel.
Minimum diameter: The minimum size of a bump diameter to be OK. The number on the right

is the number converted to pixel.

Detection settings (Menu differs whether Bump or Pattern is selected)
(CC.Bump: Solder Bump inspection after printing)

Too red: Detect “No Solder Area”. When pad color is gold and solder color is grey, this will be
effective. Enable to switch active/deactive.
Aspect Ratio: Detect the defect of bump by shape. Default 60% means, if the width’s and

height’s length is differ more than 60%, should be NG. Enable to switch active/deactive.
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Exclusion noise: Specify the minimum size of object to detect as unexpected object. (Also has

affect to reduce noise). This setting influences also inspection of neighboring pad.

(Pattern: Bump Pad inspection before printing)

Exclusion noise (bump): Specify the minimum size of object to detect as unexpected object
on pad of bump.

Aspect Ratio: Detect the defect of bump by shape. Default 60% means, if the width’s and
height’s length is differ more than 60%, should be NG. Enable to switch active/deactive.
Exclusion noise: Same as selecting Bump, however the threshold is much more strict because

it is pure pad inspection when selecting Pattern.

(Sp.Bump: Big Solder Bump inspection after printing)

Color Selection Tool: Select bump color
Aspect Ratio: Detect the defect of bump by shape. Default 60% means, if the width’s and

height’s length is differ more than 60%, should be NG. Enable to switch active/deactive.

Default: Reset all settings

Test: Confirm the inspection result in current settings.
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V¥ 16-11-3 Inspection and Debugging
After the inspection, defects are marked by color circles. Mouse over on the frame line, an error message,

e.g. “Bump NG 3/255” will be shown (Screen 1). This represents “NG number / Total number” of bump.

When there are false calls, change the tolerance according to the cause of NG. For example, if a false NG
occurred by ‘Bump area too small (yellow circle), increase the value of “Minimum diameter” (Screen 2).
* In example, the minimum diameter is 45 microns (9 pixels). In 9 pixels, there is a margin of error of 1

or 2 pixels. Therefore, if you want to detect 45 microns bump, input 60 micron in practice.

16-11-3

(Screen 1) (Screen 2)

Defects marked by color circles

Red: Bump not found Rose: Insufficient (or No ) Solder Yellow: Bump Area too small

Green: Unexpected Object Light Blue: Bridge or Shape incorrect
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16-12 Length Measurement

Measure the distance between two objects by using pattern matching or Pack type stamp, the accuracy
of 0.01mm. Suitable to inspect the components such as sensor or LED which are requested to mount on

very accurate position.

V¥ 16-12-1 How to use

Prepare the PCB to be master. (If you have CAD data and the distance is specified in the CAD, you can
manually input the length.) Place pattern matching stamps or Pack stamps on the objects that you want to

measure the distance.

1. Activate "Length Measurement Setting" in Settings menu (Screen 1).

2. Move mouse cursor near the center of the inspection frame. The cursor shape changes to pen

shape (Screen 2).

3. Mouse down and drag the mouse to the other frame . Yellow arrow will be displayed. Release

the mouse when reaching to the frame (Screen 3).

4. Setting window will be displayed. There are length and difference shown on the yellow arrow.
The length is measured from the center of each frames. The difference is defined 0.00 here,

because this will be the master (Screen 4).

16-12-1

(Screen 1)
(Screen 2) (Screen 3)

(Screen 4) (Screen 6) (Screen 6)
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5. Select if you like to measure length X, length Y or both by checkbox. Then input tolerance from
minus (shorter) to plus (longer) (Screen 5) .
Do not change the pull down menu "In Center". Do not also change the "length", but if the length

is regulated in CAD data, input the value from keyboard.

6. Click OK. The dialogue to input the name will be displayed. Input name for the measurement

setting (Screen 6) you can't input the same name exist in the stamp list.

* The setting is saved, however this setting is not saved as stamp. It is saved in the inspection
program and not possible to re-use in the other inspection program. In this program, you can re-use

from top pull down menu (Screen 7).

* Setting is not saved/linked to the stamp, e.g. Set length measurement between stamp A and B in
a Cell. Then move to the other Cell and paste stamp A and B, but length measurement is not set
between the stamps in the other Cell.

If you want to duplicate the stamps and length settings simultaneously, please duplicate by Cell

Duplication or select stamp A and B, copy and paste them in the other Cell.

7. Setting is completed. Start inspection.

8. Length error will be displayed while verification (Screen 8).
* If stamp is NG by the other reason such as Mismatch or Mismatch by Hue, these error reasons
are prior shown than the distance error. Therefore, the stamp setting should be tolerant for not

to detected as NG by Mismatch or Mismatch by Hue.

16-12-1

(Screen 7) (Screen 8)
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V¥ 16-12-2 How to debug
Please debug when there are escaping or false calls.
1. Measurement for escaping.

Shrink the threshold. While Length Measurement Setting is checked (Screen 1), move mouse
cursor near the center of the destination frame. The cursor shape changes to pen shape. Click
the center of the destination frame (Screen 2), the setting window opens.

* The cursor shape changes to pen shape even if it moves closer to the departure frame, however
setting window will not open by double-click. In place you can create the 2nd setting to the
other object. The multiple measurement settings are possible to create from one departure

frame to multiple destination frames (Screen 3).

2. Measurement for false calls.
Please observe the stamps. The stamps position after searching is shown by rose lines at
the 4 corners. The rose cross hair is displayed in the center. Departure frame is linked to

destination frame by rose line, and current length and difference is displayed (Screen 4).

Confirm if rose lines at the 4 corners are in the correct positions. If positioning is not good,
the color difference between object and PCB is too less and it is difficult to position, thus
the object is not suitable for measuring distance. If tolerance is not wide enough, give more

tolerance.

3. Confirming the result after changing value. Press re-confirm button to confirm in selecting both

departure and destination stamps. Analysis button does not work for this function (Screen 5).

16-12-2

(Screen 1) (Screen 2)

(Screen 3) (Screen 4) (Screen 5)
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16-12-3

Ed B &=

(Screen 1) (Screen 2)

V¥ 16-12-3 Window

Explains other window items which are not explained by here (Screen 1).

1. Selectable from "In Center", "Inside" or "Outside". Normally select "In Center", however if you
like to measure between the inside edge of objects, select "Inside" and if you like to measure
between the outside edge of objects, select "Outside" (Screen 2).

2. Reload the value by reading current value.

3. Reset (delete) the length measurement.

4. Save in the other name.

V¥V 16-12-4 Limitations

- Not possible to use in NG Cell View or Auto trace in faster mode.
- Pattern matching type stamp or Pack stamp only.

- Measuring other than rectangle shape may result in incorrect value.
- Not possible to measure beyond the Cells.

- Measuring between rotated cell in free degrees (not 90 or 180 degrees) may result in incorrect

value.

- Re-setting required after rotating Cell.
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16-13 Inspection Program Splitting Function for More Than One AOI

In version 4.9.9 or later, you can inspect the PCB by splitting inspection area for more than one AOL.
The inspection program can be split up to 3 AOI’s.

*Barcode setting is required to apply this function.
V¥ 16-13-1 How to setup

1. Open “Settings for Supervisors” window from menu Settings > Configuration > For Supervisor.
Open Plus tab. Put check mark on “Machine number of separation data”.
Assign the number to AOI’s.
First AOl:  AOI #1
Second AOI: AOI #2
2. Create the inspection frame.
3. Select the “AOI#1” from the menu displayed by clicking with pressing [Control] key on Cell Map
Area. Next, with same procedure, select “AOI#2” from the menu.
4. Copy the inspection program you had created in first AOI to second AOI. Then open the file.
5. Execute inspection in first AOl. Then, execute inspection in second AOL.

6. In Catch System, split data will be combined and displayed.

V¥ 16-13-2 Setting of CS-Center

*CS-Center V1235 is required to apply this function.
1. Set the address in CS-Center. Set IP Address and Port individually as same as usual. Be sure to
set same AOI name if you use this function.
2. Go to menu Setting > General Settings. Put check on to “Use Combination” in Combination
setting tab. Set same Group number for AOI’'s which uses splitting inspection program.
For example, if you use splitting inspection function for two production lines, and each line has
2 AOI’s, apply Group number 1 to the AOl in first line, and apply Group number 2 to the AOIl in

second line.
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17. Extra Parts and Solder Balls

Normally the Inspection Frame must be pasted onto the part/component you want to inspect. However,
in the actual production process, the PCB may become defective due to unexpected scratches and extra

objects or solder balls. Therefore, this software has a special Stamps for inspecting the entire cell.

The stamp to detect extra objects and scratches is called the Extra Parts Stamp or EP Stamp. In a cell
with the EP Stamp, a Master Image is created from several good PCBs to deal with the component’s
slight differences in position, shape and color. Then, the Master Image will be compared to the actual im-
age to detect differences.

Extra Parts stamp is not suitable to detect small solder balls. There is Solder Ball Detection stamp for it.In

this chapter, how to use Extra Parts stamp and Solder Ball Detection stamp is discribed.
17-1 How to Use Extra Parts Stamp
The Extra Parts Stamp can be used in following procedure:

1. Paste the Extra Parts Stamp. Because position alignment is done by the stamp’s picture,
paste the stamp on where characteristic and not tend to differ per each PCB. Change the
stamp size if necessary to suite the target object (Screen 1).

2. Double-click on the frame and the EP stamp setting window will be displayed (Screen 2).
At this stage, you do not need to change parameters. But, if you wish the stable inspection,
change learning number from 10pcs to 30-50 pcs. The more PCB is learned, the more stable

detection is possible.

17

(Screen 1) (Screen 2)
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3. Set a good PCB and start Inspection This 1st PCB will be the master.

4. Inspect PCB of learning number, while inspecting after learning a few PCB, observe if position
offset is working correctly and if the variation of PCB is absorbed.

5. To observe the position offset, click the Extra Parts stamp frame and open setting window.
There is “Add/Delete fiducial markers” in Details tab (Screen 3). If one frame for offet is not
enough, you can add more frames to offset (Screen 4). If searching is not working well, expand
search area (Screen 5).

6. The solder area such as QFP leads can vary because of reflection, it is better to mask them.
Open “Edit Mask”, select “Mask to decrease sensitivity”. Draw mask by edit tools. Sensitivity
100% means ignore inspection, sensitivity 30 means inspection is done but slight difference is
ignored (Screen 6).

7. Continue learning.

8. When completing learning, you can start real inspection.

* This process requires huge memory.. We recommend to use Mac with large RAM memory. The
consumption of memory is not depend on the learning number, it depends on the number of Cells
where Extra Parts stamp exists. If Extra Parts stamp is pasted to all Cells on large PCB, memory will
be lacked. Because Extra Parts stamp compares whole Cell image to learned image, it takes time to
inspect than normal stamps.

* Depend on the combination of OS and Mac hardware, the number of PCB learned will not be up-
count after the first inspection when opening the inspection program which contains Extra Parts

stamps that were already inspected many times. Counter will be up on and after the second inspec-

tion.
17-1
More
Search Area
(Screen 4) (Screen 5)
(Screen 3)
(Screen 6)
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17-2 EP Stamp Setting Window

ltems to be set up in the EP stamp setting window are as follows:

e Basic setting Tab (Screen 1-a)
M Start inspect after learning of “ ” pcs

Set the number of PCBs to be learned. When 10 is entered here, the first PCB will be recorded as the
Master PCB, and 10 PCBs starting with the next PCB will be used for learning.

H Method

Selects a detection method. [Method 2] is faster than [Method 1].

M Light

Change the lighting to be used. Changing this setting after learning will erase the learnt resullt.

<Setting of detection>
Bl Min. size of parts<

Set the minimum pixel value by size. If 80 is set here, a block of NG pixels with less than 80 pixels will not

be detected as an extra part. This setting prevents noise and minute dust from being detected.

H Max. width >

Set the maximum pixel value for width. If 500 is set as the maximum, a block of NG pixels whose width

exceeds 500 pixels will not be detected. The default value is 9999, which will detect all widths.

Hl Max. height >

(Screen 1-a)
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Set the maximum pixel value for height. If 500 is set as the maximum, a block of NG pixels whose height

exceeds 500 pixels will not be detected. The default value is 9999, which will detect all heights.

H Min. width <

Set the minimum pixel value for width. If 10 is set as the minimum, a block of NG pixels whose width is

less than 10 pixels will not be detected as an extra part. The default value is 1, which will detect all widths.

H Min. height <

Set the minimum pixel value for height. If 10 is set as the minimum, a block of NG pixels whose height is

less than 10 pixels will not be detected as an extra part. The default value is 1, which will detect all heights.

M height/width > width/height >

Set the aspect ratio of a block of NG pixels. If 5 is set in height/width, a block of NG pixels whose aspect

ratio (h/w) exceeds 5will not be detected as an extra part.

M detected / total <

Set the rate of the area of a block of NG pixels in relation to the area of a circumscribed rectangle drawn

around the NG block. If 0.10 is set, blocks less than 10% of all NG pixels in the area will not be detected.

Bl Mask under inspection frames

By ticking this, arranged inspection frames are excepted from the inspection.

e Both in Basic setting Tab / Details Tab
H Edit Mask Button

Display the editMask window.

<Learning information>
H PCB learned

The total number of PCBs learned, including the number of PCBs judged as OK will be displayed. The first

inspection will not be counted here since it is used for learning.

H Learning weight

Sets the weight of PCBs learned. 1 is the maximum value and represents a learning weight of 100%. As
the value moves closer to 0, the impact of learned PCBs is reduced, in turn increasing the impact of the

original PCB.
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M reLearn

Click here to open the reLearn window (Screen 1-b). You will be able to set the additional number of
PCBs to be learned after inspections, when you feel that more PCBs should be learned in order to stan-
dardize the Master Image. If you check [Apply to all] and select [OK], relearning will also be performed on

the EP stamps other than the one currently selected.

H Apply to all

This function changes all allocated Extra Parts Stamps in the program to the same values after changing
the settings. Click on the Apply to all button, and click OK when the confirmation window is displayed.
This function is valid only after inspection or if you have opened the EP stamp setting window at least

once. This setting will not be applied to a stamp that has only been placed.

H Reset

Delete all learned images and mask details. The setting values will not be reset.

¢ Details Tab (Screen 2)
H Tolerance

Set the detection sensitivity here. When the value is set higher, the detection sensitivity will be reduced.

M Error weight

This adjusts the degree of detection for each RGB element. Normally, you do not need to change this.
When detecting by each RGB element, if the value calculated based on the set value exceeds the value
setin R + G + B >, it will be detected as an extra part (when detected by each element, the set value + set

value * rate of error (10%) will be the value assigned to R + G + B).

Hl Weight change

Set the timing (number of PCBs) in which to change the weight of learning. The weight up to this number

will be the value set in Learning weight in Learning information.

17-2

(Screen 1-b) (Screen 2)
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l Changed Weight
Set the rate of how learning weight changes after it exceeds the number of Weight change. Once the

number exceeds the value set in Learning step, the weight will be Changed weight in Learning infor-

mation * Learning Weight. Set a value of 1 or less.

Bl Add/Delete fiducial markers

During inspection, Extra Parts Stamp works like a Fiducial because it offsets the whole cell, but if the im-
age is unstable, you can add Fiducial Marks. When adding the marker, use the Add/Delete fiducial
markers button. Click on this button to display the matching Rects window. Drag the mouse over the
area you wish to add, drawing a red rectangle. This will be the Marker, and it will enable you to apply offset

even if Cell offset by the Extra Parts Stamp fails (Screen 3).

Bl Show NG details

If the inspection result is NG, click here to display the setupDetails window for more detailed information.

This window shows a differential Image between the actual image and the Learned Images.

- Disp. frame

If you activate this function, a rectangle showing the area and the arrow of the inspection result will

be displayed.

- Clear

If you activate this function, the screen will black out all areas except for the NG area (Screen 4).
17-2

(Screen 3)

(Screen 4)
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17-2

(Screen 5)

- Place mouse pointer on the rectangle area of the NG point
Detail of the area will be displayed. The details include average values and maximum values of R/G/B,
the end points of the rectangular area and the number of pixels. Offset of Marker and current position

of the mouse are always displayed (Screen 5).

- Indicate the point exceeds the setting of Error weight
This function shows the point which exceeds the Error weight set value. While pressing [option] key
in “setupDetails” window, the point which exceeds the Error weight set value is shown in gray
(RGB:127,127,127), and the point which is less than set value is shown in red between 0 — 255.

*When the “Clear” is checked (activated), only the point which exceeds the Error weight set value is shown.

- Indicate the value of "Red” “Green” “Blue” and “Red+Green+Blue”
The total value of Red “R”, Green “G”, Blue “B”, and Red+Green+Blue “R+G+B” is displayed in
“setupDetails” window by putting mouse pointer on differential Ilmage between the actual image and
the learned image (Screen 6). It is possible to set the value of Error weight referring this value.

* Caution: In Mac OS, the position that mouse pointer shows is the black tip of the pointer. The value of “R”, “G”,
“B”, and “R+G+B” is the value of the black tip of the pointer position (Screen 7). It is not the white colored part

of the pointer.

(Screen 6)

(Screen 7) Value of black tip

0 oo

(Screen 8)
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- Adjustment of “R + G + B >”

In EP Stamp setting window, click “Show NG details”, and “setupDetails” window will appear.
There you can confirm the result of “R+G+B>" while changing its value. You can change the value
by horizontal slider or vertical stepper. Changed value is reflected immediately to the image.

Possible set value range is from 100 to 500.

- Individual adjustment of “Red”, “Green”, and “Blue”

As same as the adjustment of “R+G+B>", you can confirm the result by changing the value “Red”,
“Green”, “Blue” individually in “setupDetails” window. You can change each value using vertical stepper.
Changed value is reflected after a while that certain time is necessary for calculation. Possible set value

range is from O to 127 (Screen 8).

H Edit Mask

Parts which have large differences between PCBs, such as components with text or glossy parts, can be
masked so that you can reduce false reports. It is grayed out at default, but will become active after an in-

spection.

17-3 Mask too sensitive area

In the EP stamp setting window, click on Edit Mask (which will become active once inspected) and the

edit Mask window will be displayed (Screen 1). You can edit masks here to reduce false reports.

H Pen Tool

Create masks by free hand.

17-3

(Screen 1)
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H Straight Line Tool

Create masks with lines.

H Square Tool

Create square shaped masks.

H Circle Tool

Create Oval shaped masks.

Bl Undo

The masks applied during the mask’s frame edit will be undone at one task per click.

H Pen Size

Sets the thickness of the masks made by the pen tool and the straight line tool.

M Sensitivity

This sets the opacity of the mask. The larger the value, the higher the opacity of the mask will become,
reducing the detection sensitivity. If it is set to 100%, the image underneath the mask will be completely
hidden. This setting should be applied before drawing the mask. This setting cannot be applied to existing

masks.

B Mask to decrease/increase sensitivity

This switches the mask type. This should be set before drawing the mask.

B Average/ upper/ lower

Average means the average of learned images. Upper/Lower are to show the insensitive area of learned

results. The stronger the white is, the less sensitive it will be.

17-4 Tune-up Extra Parts Stamp

When performing inspection, false reports may occur. In this case, apply the following adjustments de-

pending on the situation.

1. If the Extra Parts Stamp is judged as NG when inspected by Re-inspection button, make the

current picture to be learned by pressing command-+return keys.
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2. Inspect the PCB using the current picture in the G/NG Confirmation Mode. When you come
to the Extra Parts Stamp inspection result, click on the Learn Extra part data in Work Area
or hold down the Shift key + Good to learn. By pressing Shift key in G/NG confirmation mode,
you can see the image with NG detail filtering.

3. Learn several good PCBs using the Relearn button.

4. Apply masking to decrease sensitivity.

5. Adjust the tolerance with Setting of detection (Min. size of parts, Max width, Max. height...)

in Basic setting TAB.

17-5 How to use Solder Ball Detection Stamp

Detect solder balls bigger than 80 micron.

* The solder ball size telling in this stamp is not the actual size. The size is calculated from the
combinations of lightings, therefore the size maybe different from the size measured by ruler.

* Possible to use this algorithm from Stamp Creation Wizard.

* 10 micron resolution lens recommended. At least 18.75 micron lens required.

* Exclusive algorithm for AOI with Diffuse-On Axis LED (DL, HDL/HDA, HML/HMA, FDL/FDA, FML/
FDA) However, the Diffuse-On Axis LED for DL type is spot lighting type. Therefore the repeatability
of detection may be worse than the other types. AOI with RGB lightings such as HML/HMA and
FML/FMA may false detect white silk print.

* Not possible to detect solder balls on white PCB.

1. Select a PCB. Normally when create normal inspection program, we use "Champion PCB" (the
PCB without detect). But here we better to use the defective PCB with solder balls, so that you

can learn the tendency of solder ball shape/size while program creation and debugging.

2. Move camera to the area where solder balls exist. Create stamp at any place in the view,

because Solder Ball stamp detects all solder balls in the view (cell), the place is not the matter.

3. Draw a frame with selection tool. Stamp Creation Wizard will be displayed, select "Detect
Solder Balls" from pull down menu. Setting window will be displayed (Screen 1). Set the

minimum and maximum solder ball size. Click OK and save as stamp.

4. Start inspection or press re-inspect button to confirm if the solder balls are detected (Screen 2).
* If solder balls are not detected or the other objects are false detected as solder ball, refer to the

following pages to tune-up the settings.
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5. If this work is at the end process of data creation, open the setting window, and press Copy
to all cells button (Screen 3). If this work is at the beginning process of data creation, execute

"Duplicate Selection" from Edit menu, and duplicate this stamp to all over the PCB.

Meantime, you can delete unnecessary solder ball stamps when more than one solder ball
stamp exist accidentally in a Cell with Delete duplication in cells button. This is useful after

Cell optimization (Screen 4).
17-6 Handling of Missing NGs and False NGs

The shape of solder balls differ depend on the mixture of solder agents or the condition of reflow oven.
The shape can be almost round or can be a bit mashed. Therefore, you need to tune-up the settings

when you face to the escaping or false defects.

17-5

(Screen 1) (Screen 2)

(Screen 3) (Screen 4)
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V¥ 17-6-1 Missing NGs

1. Allow ball shape variation
On default setting, only the balls almost perfect round shape is possible to detect. In case, your solder

balls are not detected even they are within minimum/maximum size, increase “Allow shape irregularity/

variety” level (Screen 1).

Increasing from O -> 1 -> 2 result in (Screen 2);
detect solder balls -> detect something like solder balls -> detect something looks like solder balls

After changing the level, press Test button and confirm the result.
Circled by green: recognized as solder ball
Circled by yellow: nearly recognized as solder ball (detection may be unstable)

However, the other objects than solder balls can be also detected by increasing the level (Screen 3).
Please control these false calls by reading following pages. Nevertheless, false calls occur by level-up
the “Allow shape irregularity/variety” and it is quite difficult to control this completely.

2. Change the sensitivity

* This change will be saved in AOI settings (not possible to change per inspection programs).

Click the detail settings icon, the sensitivity adjust window will be shown (Screen 4).

17-6-1
Level O
Level 1
Level 2
(Screen 1) (Screen 2)
Pad of empty component Fillet of diode
(Screen 3)
(Screen 4)
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17-6-1

(Screen 5) (Screen )

The most important condition to detect solder ball is to catch the brightness of solder. You can change
the sensitivity of the brightness at the bottom item “White sensitivity (center)” (Screen 5).

Press up/down the button and find the most suitable sensitivity. When there is enough brightness, the
solder ball is colored in green (Screen 6).

* The up/down button does not mean sensitivity up/down. So, without thinking moving to plus or

minus, find the best level to detect the solder balls.

Next, adjust the blue and red sensitivities (Screen 7). There is a correlation between these sensitivities.
Please adjust together by observing carefully.

In below example, there was no change seen by up/down blue sensitivity from -0.5 to + 0.5. Let’s reset
blue sensitivity to 0 and try red sensitivity.

By increasing red sensitivity, a solder ball is detected (Screen 8).
By increasing red sensitivity more, more solder balls are detected (Screen 9).
As this example, find the best sensitivities by observing the balance.

17-6-1

(Screen 7)

(Screen 8)

(Screen 9)
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WV 17-6-2 False NGs

1. Less tolerant to maximum size
If your setting is “Allow shape irregularity/variety” increased, and “maximum diameter” is bigger,
software will detect the objects other than solder balls. (Screen 1)
To kill such false detections, set “maximum diameter” to as smaller as not to miss the solder balls.

2. Masking by inspection frame
There is an option named “Mask under inspection frames...” (Screen 2) If the part of fillet is detected
as solder ball, activate this option. Then, the area where inspection frame is pasted is masked (invisible)
and escaped from solder ball inspection (Screen 3).
For Doughnut stamp, inside area of the stamp is masked and escaped from solder ball inspection.

There is proviso in this option, “(exclude PassiveComponent stamp)’, and you can set the “Detection
Area along chip body”. This proviso means;

Detect solder balls along the chip body on which Passive Component stamp is pasted

Solder balls are tend to attach to the capacitor/register chip body. In order not to miss these balls,
Passive Component stamp has special masking function.
Even Passive Component stamp is packed, it works as well (Screen 4).

17-6-2
Pad of empty component Fillet of diode
(Screen 1)
(Screen 2)
(Screen3)  False detection Masked by frame
Passive Component Press Test button in Solder Ball Detect stamp. ~ Solder ball detected
(Screen 4) stamp on capacitor Dark area is masked, red area is not masked. while inspection
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17-7 Limitations for Solder Ball Detection Stamp

This stamp inspects the whole Work Area (Cell), therefore slightly different from the other stamps.

- Not possible to pack
- Not possible to have master picture
- Not possible to edit Reference Designator or Comment

- Not possible to verify in angular camera view

Memo: When Passive Component stamp is not used for chip inspection ...

If you use pattern matching + histogram algorithms for chip inspection, but you do not want

to miss the solder balls on chip body, you can just use Passive Component stamp to detect
solder balls.

- Check off all boxes.
- Input 0 to Angle and Rotation check

-
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18. 2D Solder Paste Inspection

This machine is capable of inspecting the printed solder paste. By checking dimensions, positions and
shapes, it is very easy to detect solder paste errors. The area to be inspected can be set manually or
sampled automatically, and it can also be set up based on Gerber data (Gerber data must be converted
using the special conversion software included on the CD-ROM).

Since this is an optional function, the detection accuracy is not as good as with 3D SPI machines, but ex-
treme misprints can be detected with sufficient accuracy. It is also possible to inspect parts/components

and solder paste in one Inspection Program.
18-1 Preparation
Confirm the following 2 points before data creation.

1. Check that the size ratio between the PCB and the screen is correct at the PCB surface height.
If this ratio is not correct, size and position of frames may be misaligned when automatic cell
optimization is performed after frame positions are generated from the Gerber data.

Make the line width thinner with Setting > Configuration > Object Frame and create a frame
matched to the pad. The frame color will turn white when the screen is moved. Then compare
the position of the frame and the pad.

If they become shifted when moved, go to Setting for supervisor > Movement > Pixels per
1cm and change the value little by little to correct the position and set the ratio between the
PCB and the screen accurately (Screen 1).

2. Next, confirm the sensitivity to sample the solder paste area. When sampling with automatic
sampling mode, you will not detect the proper size of the solder if you do not make adjustments
to match the sensitivity to the solder condition.

Set a good PCB on the machine and move the camera to the inspection area. Then select Sol-
der Paste Check from the Window menu to display the Area Edit Window (Screen 2). The le-
ver on the left is for Sensitivity, and the lever on the right is for Size. Set the area to 0 (zero) and
slide the Sensitivity bar so that the paste area will be painted in yellow (the paint is displayed
only while you are sliding the lever with the mouse). In addition, use the lever to set the image to
be about 5% larger than the actual paste area (Screen 3). The values set here will become the

default values for Area Edit Window.
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18-1

(Screen 1)

(Screen 2) (Screen 3)

18-2 Creating Data

Hl Manual Settings

With this method, you will create a standard Inspection Frame and change that frame to a Solder Paste

Inspection (SPI) Frame.
1. Set a good PCB and move the camera to the inspection area.
2. Draw an Inspection Frame on a solder pad. After selecting the Inspection Frame, select Solder

Paste Check from the Window menu and click the Assign button.

*When an Inspection Frame is selected, the Sample button will become the Assign button (Screen 1).

After changes have been applied, it will become the Resample button.

3. Now, this inspection Frame has been set as the Solder Paste Inspection Frame. It can also be

registered as a Stamp.
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M Automatic Sampling

With this method, all of the solder paste areas will be detected automatically and be converted to the Sol-

der Paste Inspection Frame at the same time.

1. Set a good PCB and move the camera to the inspection area.

2. Open the Area Edit Window and click on setup of details to display the Recognition details
setting. Make sure that Restore split frames has been checked (Screen 2) and press OK.
This feature will make the shapes of Inspection Frames created by automatic sampling smooth.

However, it doesn’t work for frames with some shapes.

* Refer to 18-3 Frame Adjustment for details.

3. Confirm that the print area will be painted yellow using the Sensitivity lever and the Size lever
in the Area Edit Window.

4. If no Inspection Frames are selected, the button in the center will be shown as the Sample but-
ton. When you click on Sample here, all the yellow areas will be set as Solder Paste Inspection
Frames.

5. The Inspection Frame is now created, but lightness may differ depending on the area on the
screen, so you may need to change the sensitivity by frames. The Auto level button will al-
low you to automatically adjust sensitivity for each frame. Select Inspection Frames and click
the Auto level button. Adjusted frames will be displayed in blue, and those that could not be
adjusted will be displayed in red. If the red frame is a false report, you will need to make further

adjustments (refer to 18-3, Frame Adjustment).

* Auto level is valid only for Inspection Frames with the same lighting and for the same target color.

18-2

(Screen 1) (Screen 2)
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18-2

(Screen 3) (Screen 4)

M Using Gerber Data

1. The Gerber data should be converted using the conversion software before setting the PCB.

2. When you import the converted data by selecting Import Data File in the File menu, it will
automatically be recognized that it is the data for Solder Paste Inspection, and the Position ad-
justment Window will appear. Make sure that the button at the upper right is the Solder Paste
Inspection Frame button before adjusting the position (Screen 3). The Solder Paste Inspec-
tion Frame button will automatically adjust all frames as Solder Paste Inspection Frames.
Stamps will be created here for each size (Screen 4).

3. Select Auto Reposition from the Edit menu and the procedure is complete. If you would like to
reduce the number of cells, combine the frames in the screen into one cell by selecting Inspec-

tion Frames with the Control key. The screen cannot be rotated or flipped here.

* See 6-7, Cell Optimization and 6-8, Merging cells for details.
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18-3 Adjustment

Once you have completed preparation for the Solder Paste Inspection Frame, start inspection (this task is
not necessary for Frames created with automatic sampling). When you place the cursor near the Solder
Paste Inspection Frame after inspection, area/position/shape results will be displayed.

If the results are shown in red, it means that the value has exceeded the tolerance limit (Screen 1). If you

get false reports, you will need to adjust the values in the Area Edit Window. The procedure is as follows:

1. Select the Inspection Frame, and double-click to display the Area Edit Window.

2. Adjust the values in Set up area limits. The maximum limit represents the limit for solder
excess, and the minimum limit represents the threshold for solder insufficiency. X limit and
Y limit refers to the misalignment of the solder paste area from the center, which is defined in
mm. shape limit is used to define the tolerance level for the difference between the shapes of
frames and detected shapes in percentages (Screen 2). Enter values in the items you wish to
change and click Update.

3. If you wish to exclude the non solder paste area, select that area with a standard Inspection
Frame and press the Exclude button. Excluded frames will become shaded (Screen 3).

4. If you would like to change multiple Solder Paste Inspection Frames to the same status, select

those frames before applying the settings.

18-3

(Screen 1) (Screen 2)

(Screen 3)
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*When the Area Edit Window is opened without selecting a frame, the values will be the default val-
ues of this software. This default value is applied when a new application is opened, except for color

and lighting that will be Gray and Default, respectively.

M Reducing Shape Limit Depending on Frame Size

The shape limits of frames are automatically set when you create the data from Gerber data. For each
frame: The smaller the size, the lower the shape limit will be. This will save you the trouble of adjusting sen-
sitivity by varying frame sizes. However, since this is just an estimate, make adjustments as needed. Even
when Solder Paste Inspection Frames are set up by other procedures, it is common to reduce the shape

limit if the frame is small.

H Color Emphasis

During solder paste inspection, false reports may occur on printed patterns misjudged as solder paste
area. In these cases, it is possible to make adjustments in Other pattern exclusion Level, but it is also
possible to emphasize the Green/Red/Blue colors to highlight the differences between patterns and sol-
der paste. Hold down the mouse on the color that should be emphasized and drag up or down to change

the value (Screen 4).

* When frames are selected, the Green/Red/Blue rectangles will be colored, but if no frames are se-
lected, only the rectangle frames will be colored.

(The Update button will apply changes only to the selected Solder Paste Inspection Frame).

M Side Lamp

When inspecting solder printed on a solder-plated pad, you can improve the inspection accuracy by us-
ing the Side Lamp. Select camera special in the Area Edit Window, select one of the Custom 1 -8

options and click Side lamp or blink (Screen 5). In general, Side lamp should be used for red colored

18-3

(Screen 4) (Screen 5)
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PCBs or pads that have bumps caused by printing, and blink should be used for PCBs with colors other
than red. Make sure to verify sensitivity after this setting has been applied.

* Refer to 20-3, Camera Special Setting, for details on the Camera Special Setting window.

* Camera special settings and Lighting are exclusive. If both settings are set, only the last one

selected will be applied.

H DetectingText by Selecting Target Color

Since gray is generally used for solder paste inspection, the default color is gray. You can also select
white, black, red, blue and green, so you can use this Solder Paste Inspection when inspecting parts other
than solder pastes (Screen 6). For example, it is useful to detect text by setting the color of the letters (such

as white).

H Advanced Settings

You may not be able to apply paint to judge the solder paste area by only adjusting Sensitivity and Size.
In this case, click on setup of details to adjust the Recognition details setting (Screen 7) (hormally,

default values should be used here).

* These settings affect the entire system. They can not be set up for each frame.

<A setup for the detection>

e Min size (pixel/width)

Set the minimum area and width required for inspection. Raise the pixel value in case small objects other
than the solder are detected, and increase the width value in case thin objects such as silk are detected,

so that they will not be recognized.

18-3

(Screen 6) (Screen 7)
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¢ Max aspect ratio (ratio min/fill)

This limits the maximum aspect ratio of the solder paste area. When long objects such as silk printed
lines are detected, the value in ratio min should be smaller. The number in the fill means the maximum
percentage. When you sample the solder paste area, it is possible that some points cannot be detected
and left as gaps. If the ratio of the gaps is within this number, it will be filled in. If this cannot be sufficiently
loaded due to roughness on the print surface, set a high value.

¢ Dot joint (while running sampling)

This sets the pixel unit to fill the space when inspecting (running) and when sampling If inspection fails due
to roughness on the print surface, set a high value.

® Restore split frames

When Automatic Sampling is performed, the solder paste area may not be displayed in the intended
shape. This check box will put them together into the intended shape. This may not work depending on
the shape.

® Defaults

All values will be set to default with this button.

<rendering settings>

e Other pattern exclusion level

Sets the saturation level other than the solder paste Area. For example, this can be used to exclude the
green color of the PCBs from inspection before solder inspection.

o Blur level

If the solder paste surface is rough and sampling is unstable, raise this level for adjustment.

® Frame separation

¢ Frame combination

These values are used to either split or combine adjacent solder paste areas.

¢ Display OK frames (in speed priority mode)

Displays the solder paste area in blue when speed priority mode is applied.

® +Try

Sets frequency of additional re-inspections only for the solder paste inspection area.

e Auto adjust

The reflection can cause false NGs. To prevent such false NGs, this software has an Auto adjust function
to compensate for the reflections.

The level can be changed in Auto adjust. The larger the value, the larger the compensation will be. This
feature will be disabled when O is selected.

® Frame position update

This is used to correct the data created by the Gerber data to match the actual PCB position. Perform in-
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18-3

(Screen 8a) (Screen 8b)

spection once, and then click on the button. Individual Inspection Frame positions will be adjusted based

on the misalignment values from the previous inspection results.

M Area Edit Window status

The values of the Area Edit Window will be immediately reflected in the Work Area.

When the Area Setting Window is opened without selecting a frame, all of the parameters will be set to the
default values of the entire application, but when a Frame is selected, only values belonging to that frame
will be displayed. It is very important to know whether this setting window is for the entire application or

just for one frame. There are a few points to look for to make sure:

<Window for the entire application> (Frame is not selected)

(Screen 8-a)

¢ The Red/Blue/Green are shown as the frame color in the Color Emphasis field.
* The Setup area limits field only says Setup area limits.

¢ The button on the top center is Sample instead of Resample.

<Window for a Frame>

(Screen 8-b)

¢ The Red/Blue/Green in the Color Emphasis field is painted out.

e The Setup area limits field says Selected frame : Set area limits (when the selected frames are for
solder paste inspection) .

e The button on the top center is Resample instead of Sample (when the selected frames are for solder

paste inspection).

H Apply changes on a frame to the other framess

While debugging Solder Paste Inspection frames, if you change settings of one frame, now you can apply
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the change to all frames in the same area group. Area groups are basically organized by the similar area
size frames. However, you can customize to split frames in many groups or in a few big group or even in

one group.

How to use

1. Select a frame that you would like to change settings. Change parameters in Area Edit Window.

2. Click on the grey arrow button on the left-top of Area Edit Window.

New window opens. The window lists all the solder inspection frames in this program. The frames are
grouped in simillar area pixel size automatically. The group colored in blue on the list is the group that
selected frame is belonging. All frames belongs to blue colored group are also colored in blue in Work
Area.

3. The number of groups can be increase/decrease by pressing up/down arrow buttons on the left-
bottom corner of the window.

4. Press Appl. button. Then, the frame setting change is applied to all frames which belong to the same

area group.

Set Area Limits

Set Area Limits menu (the lower half of the Area Edit Window) can be hidden by arrow key on the right-
middle. When changing items in Set Area Limits menu, if you press Appli. button with Set Area Limits
menu opens, the changes in Set Area Limits menu are also applied to frames in the blue group.

But, if you close Set Area Limits menu after changing some of its items, and press Appl. button, these

changes are not applied to the frames.

* Press grey arrow button on top-left without selecting a frame, the Apply Same Area window does

not open.

18-3

(Screen 9)
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19. Auto Program Creation Guide

This function is useful for creating simple component inspection such as missing, reversing, wrong in
few minutes without any stamp library, Create inspection frames for components automatically from
CAD data, if the data contains components' size X and Y. With this function, user can start component
inspection immediately because frame creation, saving frame as stamp and Cell optimization work is done

automatically.

19-1 CAD Data Format

Should be CSV or TXT format with comma or tab separators. Order of each information should be as;
coordinate X, coordinate Y, angle, casette No., reference designator, component name, size X, size Y

* Even if there is no data of casette No., please input any text or number (for example, copying

component name).

19-1
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19-2

(Screen 1) (Screen 2)

19-2 Work Flow

1. Set a PCB on AOI. Import CAD data from Import Data File in File menu. If the data has
component size X and Y in column 7 and 8, Automatic inspection program creation window
pops up (Screen 1).

2. Press OK button. If you want to change the filter settings or want to create smaller frames,
change settings value.

3. CAD coordinates arrangement window pops up. Arrange coordinates to components. Press
complete button, then Stamp Applying window pops up (Screen 2). Confirm that new stamps
are created in Stamp List, and they are all applied to components (Parts Name list). Press OK
button.

4. In Main screen, inspection frames (stamps) are placed on components. Start inspection for
teaching. Create Main/Sub fiducial reading frames.

5. Execute inspection again with same PCB for verification.

* If some components have no size information, no stamp is created for them. Draw inspection frames
by yourself while teaching.
* If you already loading stamp libraries for some components, new stamps are not created for these

components.
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19-3

19-3 Setting Window

All stamps created from X and Y size information have the same settings.

. If X or Y size of component is less than input value, Zoomed (High Resolution) stamp is created.

Default value is less than 0.5mm, then components such as 0402 or 0201 will be zoomed
stamps. Value can be input from 0.20 to 2.00.

. If X or Y size of component is more than input value, the square stamp is created instead of

actual XY size. QFP or SOP is often too big than FoV and if the frame is too big, the resolution
will be lowered and it will loose accuracy. To prevent these inconveniences, a smaller square
frame is placed. Value can be input from 1.00 to infinity.

. Size of square frame to be created as replacement. Value can be input from 0.20 to 5.00.
. Input ratio if you want to create smaller or bigger size frame than actual size. For example, to

make a bit smaller stamps, input 95 (%).

. Specify how small a frame should be divided into segments. Default value is 4, means a

frame is divided into 4 segments. If the frame shape is rectangle, then it can be divided into
8 segments. Value can be input from 2 to 16. This value is the number to divid, thus it has no
relation with the value of resolution(grid) in Filter setting window. (In Filter setting window, if you
set resolution 4, then a frame is divided per 4 pixels segments.)

. Set searching area. The area can be set by frame size ratio. If you set 1/4, then component is

searched around its 1/4 outer area. No setting still search 5 pixels around.

. Check on if all components can disregard polarity. By checking on this option, all master

pictures has also 180 degrees reversing pictures when saving.

. Create Pack Stamp.
. Save the change to a setting file. Without saving, the change is applied to only current

inspection program.

10. By checking on Blur option, stamps are set level 1 blur. Brightness, Contrast, Hue, Saturation

level can be changed between -4 to +4.
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19-4 One minute Tune Up for Better inspection
In case, you have some time, pleae do these additional tune-up. The inspection will be more stable and

accurate.
1. Resize frame to fit text or polarity of odd components such as QFP or SOP (Screen1).

2. Check on Letter if the text is not clear (Screen 2).

* Do not forget to press Golden Stamp to apply change (Screen 3).

19-5 Create Stamps Automatically even without Size information

This is the mode to create the square shape stamps automatically without component size information in

CAD data.

1. Open ForSupervisors menu, move to Plus tab. Check on "Create square stamps automatically

from CAD data". (Screen 1)
2. At importing CAD data, the window for Automatic inspection program creation will be displayed.
In the center of the window, there is a field to input square size. Set the stamp size that you like

to create.

19-4

)

(Screen 2)

3

(Screen 1) (Screen 3)

19-5

(Screen 1) (Screen 2)
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20. Whole Pattern Matching Settings

This chapter explains settings in pattern matching filter which are not mentioned in Chapter 8. Some items
are not used on all models. Also some are old functions and seldom used in today’s inspection. Please

select and use functions only valuable for your production.
20-1 Camera Special Setting

Machines with digital cameras, camera gain, sharpness and saturation can be controlled to emphasize

the color differences when capturing the image, facilitating stable inspection.

V¥ 20-1-1 Camera Special Setting Window

In the filter setting window, press the Special setup button to the right of Brightness (Screen 1) to display
the Camera Special Setting Window (Screen 2). Default is Standard, but 8 different settings from Custom
1 to Custom 8 can be saved here. The selected setting will be recorded with each stamp (if the Inspection
Frame does not use a stamp, with each frame). However, on machines with a side lamp, Custom 8 will be

used only for solder fillet inspection, and cannot be used with regular Inspection Frames.

H Selection Button

Standard is selected by default, but to create your own settings, select one of the Custom items and move

the levers to change the settings. Use the Switch button to change from Custom 1 -4 and Custom 5 - 8.

H Levers

From top to bottom, the levers are for gain, sharpness and saturation. All ranges are from 0 to 10.

Default is 2 for gain, 3 for sharpness, and 5 for saturation.

O

p0-1-1

(Screen 1) (Screen 2)
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20-1-1

White main light only White main light + side light Side light only

(Screen 3)

H Side lamp

If the machine is equipped with a side lamp, the Side lamp check box will be displayed.

If you put check, “White main light + side light “ is activated. If you do not put check, only White main light
is activated. If machine has “White main light + side light + DOAL” construction, light setting can be se-
lected from 3 types among “White main light only”, “White main light + side light”, and “Side light only” by

changing the status of check box of “Side lamp” (Screen 3).

Hl Lower Luminosity

A check box to reduce luminance by 25% will be displayed when the function is available.

H R G B Selection

With ML lighting AOI, R, G and B check boxes appear. You can only light each lighting or complex light-
ings. With ML and DOAL lighting, D box appears. Lighting D is special light for detecting “no solder”. Use-

ful for detecting wave soldering.

For stamps with master picture, these settings will be memorized in stamp. If the Inspection Frame does

not use a stamp, it will be memorized by each Inspection Frame.

WV 20-1-2 Camera Special Setting Procedures

1. Confirm calibration.

2. Double-click on the Inspection Frame to display the Set filter Window.

3. Press the Camera Sp. button to display the Camera Special Setting Window.

4. Select the Custom No. to make adjustments.

5. Once adjustment is complete, enter the setting name for the Custom No. box.

6. Click OK. A warning dialog will appear. Click OK and close the dialog.

7. Click the Capture again button in the Set filter Window. This replaces the Master picture.

8. Click OK to close the filter setting screen. Modify or save the stamp to complete this procedure.
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WV 20-1-3 Camera Special Setting in Solder Paste Inspection

Camera Special Setup in solder paste inspection is done according to the following procedures:

1. Select Solder Paste Check from the Window menu to display the Area Edit Window while the
Inspection Frame is selected (Screen 1).

2. Press the Camera sp. button (Screen 2) in the Area Edit Window, and the Camera Special Set-
ting Window will appear. Make adjustments here.

3. Inspection will not be affected even if the Master picture is not replaced after adjustment.

When you start inspection, it will start from the Inspection Frame that has no special settings, execute all
the way to re-inspection and then move on to Custom 1, 2, 3, and so on. Even if the Inspection Frames
are in the same cell, if the Camera Special Settings are not the same, they will not be inspected at the
same time. Therefore, the more settings there are, the longer the inspection will take. When a frame with

Camera Special Settings is being inspected, the entire screen will be in Special Setting mode.

20-1-3

(Screen 1)

(Screen 2)
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V¥ 20-1-4 Calibration

Calibration standard values need to be set for saved Special Camera Settings. This setting will be record-
ed in the inspection program file, so once the standard value is set, it will be corrected regularly even if the

tool or lighting conditions change, and inspection can be executed under the same conditions.

1. Select Calibration Settings in the Settings menu.

2. Press the Auto Cal. button in the Calibration Setting window to set normal calibration.

3. If a Special Camera Setting is set, press the Special Setup button and select the registered
setting from the pull-down menu. The screen will change, and the position of the meters will
move (Screen 1). The position of the brightness meter will be recorded here and become the
standard value. The reference position will be shown as a red dot on the brightness meter.

(The red dot will be displayed the next time)

Confirm the meters here, and if they are off, click on the meters or adjust using the Gain lever.

When you have set a Camera Special Setting, make sure to set calibration and define the standard value.
If the standard value is not set, a warning message “The brightness calibration standard value is not de-
fined” will appear. Click Calibrate Now to start calibration. However, if the program has been transferred
from another device, the conditions will be different. In that case, click Cancel to terminate calibration,
confirm Special Camera Setting values in the device that the setting was performed on, enter that value in

the bottom left field of the warning window and then click Calibrate Now.

20-1-4

(Screen 1)
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20-2 White or Black PCB/Components Inspection

If the PCB or the component’s colors are close to white, normal lighting may cause overexposure, mak-
ing it difficult to inspect. In this case, Luminance can be reduced to obtain an image that is easier to see
and to inspect. On the other hand, if PCB color is too dark, the filter setting for black components such as
SOT will be difficult, in this case, luminance can be increased.

This feature is available only on AQI with digital camera.

WV 20-2-1 Setting

If the PCB is white, check Reduce/Enhance light in General Settings. This setting will be effective for
each Inspection Program (Screen 1). If PCB is dark, click Reduce Light twice, then it will change into De-
crease Light (Screen 2).If the components/parts are white, check Lower Luminosity in Special Camera
Settings in the Filter Settings. This setting will be effective for each Inspection Frame (Screen 3).

In order to avoid minor differences between machines, calibration will be executed for when Luminance is

reduced in addition to normal Luminance calibration.

20-2-1
(Screen 1)
(Screen 2)
(Screen 3)
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20-3 Text filter for AOl with RGB LED

Models with RGB lighting can sometimes not detect text well because of position or component’s height.
This is caused by Layer structure of RGB light.

We developed new text detection filter only for RGB light model. This filter will decrease the difference of
RGB lighting ratio in stamp area. When normal filter setting can not detect text well, try this new option.

* Limited to AOI with RGB LED models. The button is not displayed in the other models.

* This is effective only to normal lighting, will not be much effective to lightings created by lighting

selection.

H How to set

Check Text box on. A new button will be shown next to Text box. Press this button. The color of button

will turn in grey. Now new text detection filter is activated. Sensitivity Level will be set AT (Automatic).

20-3

(Normal condition) (With RGB text filter)

» OO O
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21. Fillet Inspection (old method)

As old method, you can inspect fillet by Pattern Matching or Wave Form methods. These old methods are
not often used because Histogram method is better nowadays.

* These features are available only on machines with red side LED lamps.

H The machine casts a red LED light on the PCB surface at an angle to emphasize the components/parts
on the curved surface of the solder in red and make the forms stand out. A high-speed rendering process
will be applied to the image and only the fillet will be extracted for matching judgment against an OK or
NG (Screen 1).

LED flashing synchronizes with image capture, capturing images when the LED is both on and off, allow-
ing simultaneous inspection of parts and fillets. In addition, with the machine red LED can be always on,

enabling inspection for areas such as laser markers that are difficult to extract with only the main lighting.

Bl When closing the Setting screen, a warning message, “Reflection from side light too low/high”, may be
displayed with fillet Inspection Frame’s for QFP and SOP leads (Screen 2). This means that the red area is
either insufficient or nonexistent. With the pattern matching method, the red area is insufficient when in-
specting small fillets, making it very difficult to get stable inspection results.

Therefore, this software is equipped with Waveform Inspection in addition to Pattern Matching Inspec-
tion. Waveform Inspection takes the sections that are picked up in red within the Inspection Frame and
displays the red sensitivity of both the horizontal and vertical waveforms. The intensity of red sensitivity is

determined by the angle at which the angled LED light (Side light) is reflected. In other words, if the fillet

>

(Screen 1) (Screen 2)

21

(Screen 3)
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has round edges, a mountain-shaped waveform will be displayed with a certain point being the peak. The
Waveform Inspection compares this waveform to the waveform of the Master Picture. This method is less
likely to be affected by variances in fillet forms and volume, and inspection is possible even with only a few

master pictures (Screen 3).

21-1 Pattern Matching

In this chapter, the programming of Components and IC Leads are described separately.

V¥ 21-1-1 Passive Component

1. Draw an Inspection Frame on the fillet. It is better to include not just the fillet but also the PCB
so that the red form will stand out inside the black Frame (Screen 1). If only the fillet is in the
frame, it is difficult to judge the difference in appearance between other parts, making it difficult
to adjust the filter. For 0402 size components, draw a Frame on the entire part.

2. Select the Inspection Frame, open the Set Filter Window and check the Fillet button. Hue Sen-
sitivity and Saturation Sensitivity will be hidden and Red level and Auto Adjust levers will be dis-
played (Screen 2). The picture will be colored red as it is illuminated by the LED (Screen 3). Red
Level is used to adjust sensitivity when extracting red parts from the captured image, and Auto-
matic Correction is used to set acceptable tolerances of the red color in the Master Picture.

3. Adjust the red sensitivity lever so that the fillet becomes more/less red. If the red area is too

small, a warning, “Reflection from side light too low”, will be displayed.

21141

(Screen 1) (Screen 2) (Screen 3) (Screen 4)
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211

(Screen 6)

(Screen 5)

(Screen 7) (Screen 8)

. Adjust the Track button according to the size of the fillet and pads. The default value is 3, but

change this to a value between 5 and 7 for components larger than 0603 size (Screen 4). Like-
wise, set the Resolution button. The default will split the Frame in grids, which can be changed
to stripes (Screen 5). If a red part is displayed at the edge, it may cause false reports, and

stripes are effective in this case (Screen 6).

. If the shapes are varied, check Blur. The type of blur can be selected in the Blur area at the

bottom, dragging the mouse to the selected type, or use the A V¥ buttons on the right to adjust

the level.

. Once the filters have been adjusted, click OK, and if an alert dialog to replace the Master Pic-

ture appears, click on “Capture again” and replace the picture (Screen 7). If the Fillet check
box is checked, the picture will be taken with the LED on. The Master Picture must be replaced
even if no changes are made to the parameters. You should make a habit of always replacing

the Master Picture with the capture again Button (the camera icon).

. Once all settings are complete, register the frame as a Stamp. After registration, you should

double-click on the icon in the Stamp List Window to apply the picture (Stamps with master

pictures will be displayed in bold letters). (Screen 8).
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V¥ 21-1-2IC Lead
With IC leads, Inspection Frame’s can be placed effectively by using the standard ICLeadGap Stamp.

1. First, create one fillet Inspection Frame for each IC lead. The procedure is the same as with
components (Screen 1).

2. Place the ICLeadGap stamps to include the fillet Inspection Frame’s that you have just created
(Screen 2).

3. Double-click on the ICLeadGap stamp Frame and the Lead gap inspection setting IV window
will appear. Check Include Fillet check (Screen 3).

4. Once the ICLeadGap stamp is adjusted, close the window. When the ICLeadGap Stamp is in-
spected, the Bridge Inspection and the Lead Fillet Inspection of the Stamp will be executed si-
multaneously (Screen 4).

*When adjusting Lead detection in the ICLeadGap Stamp, the white part will be considered as the
Lead. If the center of Lead is reflected in white, or if the silk and patterns in between Leads are dis-

played white, IC Lead inspection will not be performed correctly.

V¥ 21-1-3 Cautions on Adjustment
B Adding Master Pictures

¢ Understanding the Characteristics of components/parts
When you have expanded the tolerance to reduce false reports, make sure you check to see that defect
will be judged NG. Points that still cause false reports may be fixed by adding Master Pictures.

One thing to be careful about when adding Master Pictures is to add them in the order of those that are

21-1-2 Fillet Inspection Frame
IC Lead Frame ——
(Screen 1)
(Screen 2)
(Screen 3) (Screen 4)
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most likely to be in the majority (an average OK picture). You may be able to resolve 100 false reports by
adding an appropriate Master Picture,, but you may also be able to resolve only 1 false report by adding
an inappropriate Master Picture. Needless to say, the more Master Pictures you have, the more inspection
time it will take, so it will be important to know the Characteristics of components/parts before inspection.
e | imit number of used picture

When many Master Pictures are selected, the inspection time will increase. To speed up inspection time,
you can compare only Master Pictures with a high frequency of matches. Perform inspections on a couple
of PCBs, and once you have learned the trend, designate the number of pictures by choosing Limit num-
ber of used picture in Sensitivity from the Settings for supervisor window (Screen 1). This value
designates how many Master Pictures will be used for comparison, in order of highest matching frequen-

cy, and O will select all Master Pictures.

H Filter Settings

¢ | evel of Brightness

When Brightness levels are raised, points that should be judged NG may be judged OK. In this case, you
will need to verify the points that should be judged NG.

® Red level

For points where red reflections are too small, you may have to skip inspection of the point and inspect
manually, or you may have to include it in the inspection knowing that it will be a false report depending on
the level of red insufficiency. If you increase Brightness too much due to filter adjustment, this may cause
NGs to be judged as OK.

® Resolution grid

By splitting the Inspection Frame into Stripes, you can handle false reports caused by small parts at the
corner of the Frame. Click on the resolution button in the Set filter Window, and select Stripe-short/
long from the pull-down menu (Refer to 21-2-1 Passive Component).

e Auto Adjust

Auto Adjust (Red auto adjust range) is set at 20% maximum by default, which can be changed in Red
auto adjust range in Sensitivity in the Settings for supervisor window (Screen 2). 2 is equivalent to

20%.

21-1-3

(Screen 1) (Screen 2)

286

21.Fillet Inspection (old method)




22. Options for G/NG Gonfirmation
Mode

22-1 Prevent operator's mis-judgement

When using the mouse, you/operator may unintentionally judge an Inspection Frame as Good by clicking
continuously. In order to avoid such operational errors, you can set it not to allow the continuous Good
clicking "unless a certain amount of time past", "Move mouse pointer away from Good button”, or "Unable

to click Good button under certain conditions". The procedure is as follows:

VW 22-1-1 Set and activate

1. Select “Extra settings for G/NG Mode” in Map View setting window, or press the Option key
while Good/NG is displayed in the Cell Map menu. A clock icon will appear. Click on the icon to
display a setting window. Click on the icon to display a setting window (Screen 1).

2. Set to prevent Good button clicking.

3. If the click interval is set, the Minimum click Interval will be displayed dimly on the bottom left
corner of the Good button.

4. To set to unable to click Good button, select "Unable to click Good button" tab, a warning
message is displayed on screen, and it becomes not possible to press Good button (Screen 2).

* This minimum click interval is valid only for the Good Button.

* Normally when there are multiple NG stamps in a Pack Stamp, the voluntary NG error message is
displayed, but if "Unable to click Good button" is set, warning messages of all NG are displayed.
This can assist you strongly not to let escape any defects.

* Good button click interval and Unable to click Good button can also be used in NG Cell View.

22-1-1

(Screen 1) (Screen 2)
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22-1-2

V¥ 22-1-2 Setting Window

Each function is described below.

1. If a number other than 0 is entered in the field, the Good button cannot be pressed until the set
number of seconds has elapsed. A minimum of 0.1 seconds and a maximum of 10 seconds.

2. If set to ON, O and K input on the keyboard is required to press the Good button. Similarly, to
press the NG judgment button, N and G input on the keyboard is required.

3. If set to ON, the NG and Next buttons cannot be pressed until the set number of seconds
entered in [1] has elapsed.
4. If this check box is checked, mouse pointer always comes back on NG button after clicking.
This helps operator to click Good button unexpectedly. Interval time set in [1] becomes invalid.
5. If this check box is checked, operator can not press Good button, when classifying NG which
corresponds to NG condition set on [9].

6. Recovers settings to default status.

7. Changes the character size of Error message.

8. By activating this, Good button is activated while pressing Y key.

9. Operator can not press Good button when types of NG checked here appear.
NGs written in black in NG Type column are NG types that this machine defined.
NGs written in blue in NG Type column are original NG message that user defined in Hide/Show
Object of Window menu. When the detected NG is corresponded to both machine defined NG
and your original defined NG, machine NG has priority and displayed.
For example, if the condition is just like above picture, and original frame type set to be text,

and judged matching NG, the error message is [Lower than OK rate] instead of [Must NG].
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22-2 Alert too many false NG

Even

AQI detects a defect, operator can classify it as Good by keep pressing Good button carelessly.

This option is, if an operator keeps classifying Good on where AQI classified NG, an alerting message is

displayed after exceeding certain number of Good classification, and after exceeding final alert limitation,

operator can not press Good button anymore.

WV 22-2-1 Set and activate

1.

Press the Option key while Good/NG is displayed in the Cell Map Area. A clock icon will appear.
Click on the icon to display a setting window. Or click Extra setting for G/NG mode in Map view

settings.

. Select Alert False NG tab, check Set alert for too many false NG, and set accumulate false NG

number, alert message, etc (Screen 1).

. If any of inspection frame exceeds the limit of alerting accumulative number, an alerting

message is displayed in Work Area from next inspection (Screen 2). If any of inspection frame
exceed the limit of final alerting accumulative number, a warning message is displayed in Work
Area and the operator can not press Good button from next inspection (Screen 3). If Good not
allowed is checked and any of inspection frame exceeds the limit of alerting number, a window

to request program improvement pops up every time after classification (Screen 4).

. When the operator can not press Good button anymore, he should call the programmer to ask

improving inspection data.

22-21

(Screen 1) (Screen 2)

(Screen 3) (Screen 4)
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22-2-1

(Screen 5) (Screen 6)

5. The programmer debugs inspection frames with too many false NG. (For comfort debugging,
the program setting should be as followings: check on "Display NG on Map" in Configuration
General of Settings menu in order to display NG and false NG points in Map View after
inspection.) Double click on an orange circle of false NG in Map View (Screen 5). Then Map
View slides to right side and target frame is displayed in Work Area (Screen 6).

6. If the inspection frame is improved, the count of accumulative false NG for the frame is cleared,
and the operator can classify the frame again Good. To reset count for Good not allowed

message, press Clear false NG count button, and input password for releasing.

* Accumulate number and alert message can be customized freely.

* Map View slided to aside on procedure step 5 is disappeared when starting to edit inspection frame
in Work Area unless Freeze is checked on.

*When Show false NG in Map View is checked and false NG is displayed with orange circle mark,

number is shown on next. The number is accumulative number of NG and not of false NG.
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22-2-2

(Screen 1)

V¥ 22-2-2 Setting Window

Each function is described below.

A W N

* Even

. Activate this function.
. Accumulative false NG number to start alerting, and alerting message.
. Accumulative false NG number and alerting message to start alerting and unabile to click Good.

. After accumulative false NG number for Final alert exceeds setting number, a window to request

program improvement is always displayed after Good/NG classification. On inline AQI, patlight

blinks.

. By single click, it is checked with bar. In this case, false NG inspection points which are ever

been classified as false NG are displayed in Map View after classification in orange circles
togather with NG red circles. By double click, it is checked and false NG points of the previous

inspection result are displayed in Map View in orange circles (Screen 1).

. Clear all accumulative false NGs. When you press this button for the first time, you will be asked

to input a password. Because this button is protected by password in purpose of avoiding
dishonest count clear by the operator. If you check Good not allow on, you must set password.

if you do not activate this function, false NG points are displayed in Map view by checking on

Show false NG in Map View.
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22-2-3

(Screen 1) (Screen 2)

V¥ 22-2-3 For inline AOI: Stop convey when Good not allowed message is displayed

To strongly alert the operator to improve inspection program when too many false NG, programmer can
set to stop AOl's convey when improvement request window pops up. Select Tendency NG... from

Configuration in Settings menu (Screen 1). Check Stop conveyer on (Screen 2).
22-3 Auto saving PCB image and debugging afterward

In factory, if there are too many false calls while inspecting by in-line AOI, operator calls programmer for

debugging. While debugging, the PCB production line stops.

This function enables “If false NG / NG is too many, then create virtual PCB map automatically”.

Later, the programmer can debug inspection program with PCB images of false calls created by this
function on OLT (Off-line Teaching software), and get inspection program back to in-line AQI.

It is not necessary to stop the production line for long, because time spent on in-line AQI is only replacing
(over-writing) inspection program.

In addition, this function is not only effective for false NG debugging, but also effective for collecting NG

PCB pictures.

You can also save all PCB's virtual PCB map (PCB image) no matter it has defect or not. The PCB map

can be converted to jpeg format. For viewing PCB map, you do not need Off-Line Teaching Software.
* This function is available only in G/NG confirmation mode.

First, function “If false NG / NG is too many, then create virtual PCB map automatically”.is explained, then

"save all virtual PCB's map automatically" is explained
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22-3-1

(Screen 1) (Screen 2)

(Screen 3)

V¥V 22-3-1 Save PCB map when too many false NG or NG

. Select “Extra settings for G/NG Mode” in Map View setting window.
. Setting window is displayed (Screen 1).

. Select Virtual PCB auto-creation tab. Check "Create Virtual PCB map when false NG / NG is

over setting number".

. After inspection, if False NG / NG is more than setting number, a message pops up (Screen 2).

. Select OK to start creating virtual PCB map. A folder named “program _vs” is created in the

same directory as inspection program. In the folder, sub folders are also created in specified

name (date_time is set here). In the sub folder, a master virtual file and vs virtual files (there

can be vs1 to vs3 files depending on your AQI illuminations) are created (Screen 3).
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22-3-2

V¥ 22-3-2 Setting Window

Each

function is as following;

. Check on to activate this function.
. Check on if you want to create NG Virtual Map while inspection.

. Set limit of false NG / NG number from 1 to 99999. Set limit of file to be stored, number can be

input from 1 to 9999, if the file exceeds 9999, the oldest file is overwritten by the latest.

. Set target for creating virtual PCB map from [false NG], [NG], [false NG + NG] or [all].

. Set sub folder name from [date_time], [number] or [barcode]. [number] is the historical

inspection number memorized in the inspection program, you can see it as TTL on top bar in

map view. For the detail, please refer Manual Chapter 13-1 Map View Mode.

. Set Map Area. If you select [target], only false NG or NG area is captured. If you select [with

fiducials], in addition to false NG or NG area, fiducial markers are also captured. If you select

[all], all Cells are captured.

7. Set image format. If you select [22x], PCB map is created in non-compressed / high resolution /

big file size. If you select [JPEG], PCB map is created in compressed / low resolution /small file

size.

*If you select sub folder name to be barcode, barcode should be readable and AOI should be

connected to optional CS-Center software. If barcode is failed to be read, the sub folder is created

in date_time name.

* The less camera captures False NG (NG) area, the less virtual files' size will be in JPEG format. But if

you select 22x format, the file size will be the same how many screens camera captures.

* When creating virtual map in JPEG format, it requires more RAM memory than 22x format because

of compressing operation.
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V¥ 22-3-3 Off-line debugging of false NGs

Procedure for debugging virtual PCB data on OLT.

1. Start OLT (Off-line Teaching software).

2. Select inspection program from Open... in the File menu. In the example Screen 3, TEST (with
inspection data icon) is selected.

3. Open virtual PCB map from Snap Shot in the File menu. In the example Screen3, the master
virtual file TEST (with OLT brown folder icon) in [080723_162030_vs] in [TEST_vs] is selected.

4. Debug the inspection stamps for false NG components (False NG points are marked by red as
same as NG points.

5. Open next virtual file.
Open virtual PCB map from Snap Shot in the File menu. In the example Screen3, the master
virtual file TEST (with OLT folder icon) in [080723_162342_vs] in [TEST_vs] is selected.

6. Debug the inspection stamps for false NG components. Open next virtual file and so on... At
last, save the inspection program and shut down OLT.

7. Copy (over-write) the inspection program in in-line AOI.

*If you open virtual PCB files by NOT selecting virtual file master , false NG or NG is not

displayed in red.

Next explanation is how to save and view all PCB’s virtual PCB map.
Different from “Create Virtual PCB map when false NG /NG is over setting number” function, Virtual PCB
maps must be stored in the exclusive HDD. Data can not be saved in the HDD where OS is installed.

This is because Virtual PCB map is full size and many.
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V¥ 22-3-4 Create Virtual PCB map for all PCB

1. In Virtual PCB auto creation tab, check "Create Virtual PCB map for all PCB" on (Screen 1).

2. Selecting "Map for Main lighting only" will create only one PCB image taken by main light.
Selecting "Map for all lighting" will create also PCB images by side light or DOAL light on AOI
with those lighting.

* We recommend to select "Map for Main lightin only", because it takes time to take many _vs files.

3. Press Save to button (written as Un-setup), select HDD from the list (Screen 2). Even if you
forget to select the target disk, you will be asked to select a disk after the 1st inspection.

4. Start inspection. When inspection has finished, a message "Data sampling for debugging" is

displayed, and PCB images are saved.

Function "Create NG Virtual PCB map while inspection"

If you put check to "Create NG Virtual PCB map while inspection " function, you can prevent the
lowering of inspection speed by saving the Cell image detected as NG. Also smaller disk space is
necessary with saving only NG Cell image. Furthermore debug is possible when NG is detected in the

Cell using Z axis.

* Off-Line Teaching software is necessary for this function.

22-3-4

-

(Screen 1) (Screen 2)

(Screen 3)
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22-3-4

Screen 4

How to setup

Put check to "Create NG Virtual PCB map while inspection " (Screen 4). This function is only for
following setting: “more than: 1, Target: NG, Folder name: date_time, Map area: target only, Format:
22X”. You can only change the number of maximum file to be stored.

You cannot use this function together with “Create Virtual PCB map when false NG / NG is over setting
number” function.

Operation of 22X software
1. Load the inspection program, and create the virtual map of whole Map view. This function
creates the Virtual map for each Cell based on virtual map of whole Map view.
2. Start inspection.
3. Create the virtual map for each Cell if it has NG. Folder [Inspection program name_cs] is
created automatically in the same directory of inspection program. Cell virtual map is created
in this folder with Master virtual file and Cell folder (folder only with numbers).

Operation of Off-line Teaching software
Load the inspection program, and load the master virtual file from “Open virtual PCB map” in File menu.

* This function is not available with Special Camera Settings. Cell virtual map is not created even

the inspection frame with Special Camera Settings is detected as NG.
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V¥ 22-3-5 Display false NG point in Virtual PCB Map for each Cell

In Cell Map area, red colored frame indicates the cell which contains NG points & Cell which contains
both NG points and false NG points. Blue colored frame indicates the cell which contains false NG points.
In Work area, red colored frame indicates the inspection frame of NG point, and blue colored frame
indicates the inspection frame of false NG point. False NG points of inspection frame inside the Pack is
shown by blue colored frame.

* Setting of Virtual PCB Map for each Cell should be completed to use the function for false NG

confirmation.

WV 22-3-6 View Virtual PCB map

A directory named "VirtualFiles_For22X" is created at root of HDD. PCB images are saved under this
directory in different folder "Inspection Program name + _vs". Under this directory, each PCB image is

named "Inspection Program name + _vs" and saved in "Date_Hour_vs" folder (Screen 3)

*In the folder, the master virtual file is always created together with _vs files. The master virtual

file created here does not include the inspection result like the master virtual file created by "Create

Virtual PCB map when false NG / NG is over setting number".
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1. Start "vs_converter " software (Screen 1).

2. Select Open... from File menu (Screen 2), a Finder to open file will be shown. Select _vs file
(Screen 3). Or you can drag & drop a _vs file on software in Dock.

3. PCB image file will be opened (Screen 4). Window size is resizable. As well as Map view on 22X
software, you can zoom the area by dragging mouse (Screen 5). Zoom can be reset by pressing
mouse longer.

4. PCB image file can convert to jpeg file. Select Convert... from File menu (Screen 6).

5. A dialogue to save file will be shown. Select jpeg format (Screen 7). You can select format other
than jpeg, however only jpeg is possibly to save.

* It takes time to open and to convert PCB image more than 2GB.

22-3-6
(Screen 1)
(Screen 2)
(Screen 3)
(Screen 4)
(Screen 5)
(Screen 6)
(Screen 7)
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23. OFF-Line Teaching Software

This software is for programming data of Marantz Model 22X series Automated Optical Inspection ma-
chines, without connecting PC to the machine.

23-1 Features

W Inspection program can be created as if the machine has being connected. Therefore if you have
knowledge of machine's operation software, you do not need any additional study for this software.

W Virtual PCB map (image data) from the machine is used for creating inspection program, thus there is
high compatibility between data created on this software and data created on operation software con-
nected to the machine. After creating data in office, you can immediately start inspection in the line by
copying the data.

W This software has a function named "Tact Simulator" to simulate/analyze inspection time.

23-2 Conditions and Cautions

H This software can be installed on Mac PC.

H The size of virtual PCB map is very big. When creating and opening image data, it requires large
memory. At least 16GB RAM memory should be installed in Mac PC for this software. The required
memory for AOI's Mac is different from PCB size and lens resolution (ex. 1).

W Virtual PCB map is created by jointing small pictures, "mm versus pixel" setting on the machine
should be accurate enough. The pictures of jointing area can be imperfect, if the component is in the
area, you may not able to create the good inspection frame. On the machine without telecentric lens,
the joints of small pictures does not become accurate when high components exist at the joint (ex. 2).

W This software is applied a protection system against illegal copy. USB key is required while running.

ex. 1

with 20 micron lens

with 18.7 micron lens

with 10 micron lens

PCB size 650x550

8GB

10GB

20GB

PCB size 350x250

3.5GB

2.5GB

5GB

ex. 2 Actual image

Images created by normal lens and telecentric lens

By normal lens

By Telecentric lens
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23-3 Installation

1.
2.

Install the driver for USB key following instruction in attached CD-ROM..
Install "22xx_OLT" application from CD-ROM onto Mac PC. Put USB key in USB port.

23-4 Procedure for creating inspection program

Creating virtual PCB map (operation at PC connected to the machine)

1. Set PCB and execute calibration.

2.
. Move to the position where PCB bottom-right corner is displayed. Create a frame. (Screen 2)

o o~ W

Move to the position where PCB top-left corner is displayed. Create a frame. (Screen 1)

. Save the program. Here we name the program, for example ABCD.
. Select File -> Snap shot -> Create Virtual PCB (Screen 3)
. A dialogue for creating virtual PCB map is displayed. If you would like to create high resolution

picture (big file size), press GO. If you would like to create low resolution picture (small file size),
check JPEG File on, then press GO.

In the dialogue, these are displayed: size of sampled virtual PCB in mm, available RAM memory,
required RAM memory, memory bar which represents the ratio of required RAM memory ver-
sus available RAM memory. (Screen 4)

. If there is not enough available RAM memory, Go button is not active, and you can not press

it. On 0S10.6, a warning message to inform insufficient memory is shown. In such case, create
smaller area of virtual PCB map by replacing 2 frames on top-left and bottom-right, or install
more RAM memory onto Mac PC.

. When checking JPEG File on, operation requires more RAM memory for compressing file, and

the image file's quality is not good, but file size is approximately 1/10.
* According to Mac OS's bug, if big size PCB virtual map is created in JPEG File, the picture will
be broken.

. After pressing GO button, the machine starts to create virtual PCB map. If the machine mounts

SIDE light, firstly PCB image is taken by MAIN light, then secondary PCB image is taken by
SIDE light. If the machine mounts DOAL light too, thirdly PCB image is taken by DOAL light.
While taking pictures, the status is displayed in the message bar.

Screen 1 Screen 2

Screen 4 Screen 3
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10. After taking pictures, PCB image map(s) is automatically created. Each file name is, if it is tak-
en by MAIN light, ABCD_vsi, if it is taken by SIDE light, ABCD_vs2,
When JPEG File is checked on, each file has JPEG file extension
* There are two types of virtual maps. Small virtual map (one file size is less than 3.4GB and file length/
width is less than 3 million pixels: Screen 5), and Big virtual map (one file size is more than 3.4GB or
file length/width is more than 3 million pixels: Screen 6).

23-5 Work on the inspection program + virtual PCB map(s)

(Operation at PC which OFF-Line Teaching Software is installed)

Startup and settings
Double click the icon of OFF-Line Teaching software. Adjust monitor resolution to be same as its of AOI's
PC (ex. 3). To apply the resolution change, quite and restart software.

Screen 5 Screen 6

3

ex. 3
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Loading

1. Load inspection program and virtual PCB map(s). It is recommended to create a new folder
named ABCD_folder and input them. (Screen 1) .

2. Open ABCD from menu -> File -> Open... Simultaneously virtual PCB map(s) is open. (Screen 2)

3. While loading files (Screen 3), the specification data (Size, offset, mm versus pixel settings
of the machine where virtual PCB map(s) is created.) is also loaded, and PC where OFF-Line
Teaching Software is installed becomes same conditions as PC where virtual PCB map(s) is
created.

4. Move to one of the frame which you drew during creating virtual PCB map(s) procedure. Con-
firm that the screen displayed is exactly same as the screen you have seen while creating (Screen
4). If moving to the area out of virtual PCB map, the screen is black out.

* If RAM memory is short for PCB size, inspection speed and display response will be extremely slow.

Programming and Saving data
- Programming using these files is possible without any difference from programming by using
the machine.
- However, camera special settings, calibration, etc the operations related to the machine are not
possible.
- After programming, save the ABCD inspection program, and get the ABCD program back to PC
which the machine is connected. It is not necessary to get virtual PCB map(s) back.

Screen 1
Loading...
Screen 3
Screen 2 Screen 4
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Create program for PCB which needs to inspect surface and back

Create inspection program and virtual PCB maps for both surface (side A) and backface (side B) in
different name. Program these data on Off-Line Teaching software. On 22X software, open inspection
program of side A, then switch to side B by side switching button. Open inspection program of side B. A
message "Reading B-Side data..." is shown, click OK. Save the inspetion program. Now the program has
both side A and B.

23-6 Tact Simulator

Tact Simulator is a support tool for simulating inspection time on OFF-Line Teaching Software. Also it can
divide an inspection program into two. The divided programs can be used in two inspection machines, as
a result it can decrease total time spent in factory's production line.

Normally inspection time on OFF-Line Teaching Software does not count movement of camera and car-
rier, therefore it is shorter than the time spent on when inspection with the machine.

But, Tact Simulator calculates the movement time, and inspection time will be as close as real inspection
time.

After simulating, if inspection time is slower than expectation, Tact Simulator can divide a program into A
and B sides, and enable to share the inspection of one PCB.

(Normally A and B sides are used as surface and back.)

Limitation

1. When dividing a program into two programs, do not use the program which has Side B.

2. Group stamp can not be placed in Side B.

3. NewCellAid stamp or CellAid stamp will automatically be deleted when cells in Side A contains
no inspection frame after dividing.

4. Stamps like Fiducials or barcode stamp are copied to Side B too, in order to retain Side B pro-
gram to be as a complete program.

5. The technique of dividing a program is based on dividing stamps whether they belong to Side
A or Side B. Therefore you may not decrease inspection time with PCB which same stamps are
placed on many area. In such case, make cells into blocks instead of divide PCB into Side A
and B, (Screen 1) (Screen 2)

Screen 1 Screen 2
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Tact Simulator Window (Screen 3)

1. Controller Panel

NON: Simulate inspection time for the whole program

A: Simulate inspection time for Side A program

B: Simulate inspection time for Side B program

* After selecting radio button, press Appl. button

Reset: Undo distribution of stamps (All stamps are back to Side A.)
2. Stamp List

STAMP: All stamps are listed

N: Total number of each stamp

Tim: Time spent for inspecting the stamp in second

A/B: Checked stamp does not exist on that Side.

* Child stamp in Pack stamp is not listed. Pack stamp is listed as one stamp.
*When check is on B, and then switch it on A, the check on B is automatically
unchecked. On the other hand, if A is checked and switched the check on B,
the check on A is not automatically unchecked.
3. Opens [Parameter settings of virtual machine] (Screen 4).

4. maximum speed (Mm/sec)
Maximum speed of movement. Enable to input from 100 to 1000.

5. accelerator (sec/max speed)
Acceleration speed. Enable to input from 0.01 to 1.

6. others overhead (sec)
Time spend except machine movement. It is mainly time spent for capturing images. Enable to input
from O to 3. This is the most of time required when inspecting with real machine.

7. Reset the value to default.

8. Apply the change on each value, and write new value into ParaPreference file.

1
2
4
5
6
B 1
3
Screen 3 Screen 4
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Work Flow for Simulating inspection time

1. Open an inspection program by OFF-Line Teaching Software.

2. Select Tact simulation from Configuration in Settings menu. (Screen 5)
Tact simulator window opens.

3. Keep opening the window, start inspection. The inspection time displayed in the message bar will be
very close to the inspection with real machine. (Screen 6 "Normal inspection time")
(Screen 7 "Inspection time by Tact Simulator")

Work Flow for dividing inspection program

1. After simulation, divide stamps into Side A and Side B by referring time spent for inspecting each
stamp.

2. Simulate Side A and Side B by switching A and B buttons on the Control Panel.

3. If the result does not match to your expectation, adjust stamps to which side they belong.

4. If the result matches to your expectation, quit the window by pressing red button on the top-left.
Then, a dialogue pops up. (Screen 8). Selecting Quit without dividing PCB will just quit Tact
Simulator. Selecting Divide PCB into A/B sides will divide the program into A and B sides. Selecting
Cancel will be back to Tact Simulator window.

* When dividing PCB into A/B sides, save the divided programs in new names. Otherwise, the

original data will be replaced.

5. After dividing the program, use Side A program on one inspection machine, and use Side B program
on the other inspection machine.

Screen 5

Screen 6 Screen 7

Screen 8
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24. Scanning bharcode and Tracing
PCB

You can scan the barcode on the PCB using the camera on the machine. The barcode scanned is at-
tached to the inspection result. You can also use external barcode scanner to read barcode.
The inspection result can be output on roll paper printer, or sent to the optional Production Management

software (Rc22x/CS-Center) via LAN. How to set and work is described in this chapter.

24-1 Scan barcode with AOI’'s camera

Paste special stamp onto the barcode on PCB. Barcode will be captured automatically during inspection.

V¥V 24-1-1 Compatible Barcodes

Barcode must be smaller than Work Area (If it is larger than Work Area, AOI's camera can’t scan.) Resolu-
tion is 0.1mm for any barcode. Maximum 256 characters can be handled. Below is the table to show the

list of barcode enable to decode by AOI and by Production Management software CS-Center.

Decode-able barcode By AOI By Rc22X or CS-Center

QR Code (model 2) J J
Data Matrix (ECC200) J J
Code 39 J J
Code 128 J J
Interleaved 2 of 5 x J
Micro QR Code A (optional, charged) A (optional, charged)

WV 24-1-2 Setting Stamp for Barcode

1. Place the Special Stamp for scanning barcode such as DataMatrix.

2. Adjust the size to be slightly larger than the barcode, and press the Re-inspection button.

3. Once scanning is complete, the details will be displayed at the bottom of the screen. A “read
Error” will be displayed if reading fails.

4. Double click the stamp’s frame and open settings. Decide whether keeping inspection without

barcode “Ignore” or inputting manually “Manual” when failing to scan barcode.
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V¥V 24-1-3 Adjustment

Adjust barcode stamp settings when a “read Error” is displayed. Double-click on the Inspection Frame to
display the setting window. While adjusting setting, you can see changes in real-time. Press Re-inspec-
tion button when you get a clear image.

* Setting items differ depend on model.

- Color reduction will exclude checked color.
- Camera Special button (lamp icon) will enable to use Special lighting to read barcode.
- Negative will reverse black and white.
- Lighting Selection will enable to use other lighting than main light.
* Camera special settings and Lighting are exclusive. If both settings are set, only the last one
selected will be applied.
- Erode is used when reading barcode printed with not enough ink. This emphasizes black color.
- Dilate is used when reading barcode printed with too much ink. Or to sharpen lines when Erode
works too much.
- AutoBW judges the borderline of white and black, and converts to optimal image.
- Use search area when barcode sticker is not always pasted at the same place. Select frame by

pressing Control key. You can set Search Area.

V¥V 24-1-4 Use Barcode Stamp as parts number

You can use barcode as part number by activating "Use for parts number” function at setting window of
Barcode Stamp (Screen 1). Possible to send the data to production management software not only as

PCB serial code, but as part lot number.

[2017..419 13:47:53 ]

Total PCBs checked[4] block<0>

Total NG PCBs [0] block<0O>

Current result (check 0 NG 0/0) Spent time 3 (check2 2)[0/0/1]
BarNum (123456789)

24-1-4

(Screen 1) I I
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plist 1,35700,30000,0,0,0,0,0,0,1920,1920,266

SYM  TTL NG NG_ID _X Y. _NOTE
0 0 - 14444 13065... (* *) ABCD123456789/BCD
{QRcode}

Read contents will be outputted between “A\BCD” and “A/BCD” in “_NOTE”".

WV 24-1-5 Block assignment

Possible to assign Block number to Barcode Stamp from setting window. If you make Block with the
Cell which contains Barcode Stamp, the inspection is executed by Block. Therefore inspection took time
when Barcode and inspection frame in same Block were located far apart (Screen 1). Barcode inspection
frame will be inspected before Blocked Cell with this function, so the tact time will improve compared to
the status when disactivate the function.

How to setup

1. Create inspection frame for Barcode.

2. In setting window, put check mark and activate "Apply for barcode in Block". Set the Block number

(Screen 2).

Operation
- If you activate the frame of Block number, minimum value is set automatically.
- Value is cleared when the check of “Apply for barcode in Block” is removed (deactivated the

function).

24-1-5

(Screen 1)

(Screen 2)
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24-1-5

Example: Activate Block number of Barcode Stamp E, Example: Change Block number of Barcode Stamp E
and set value "1". (Screen 3) from "6" to "1". (Screen 4)

- Block number cannot be used together with another Barcode Stamp. If you set the duplicated
value, operation will be following.

- If "Apply for barcode in Block" is not valid, put check, and set duplicated Block humber. Duplicated
Barcode Stamp and Block number of Barcode Stamp which has greater and consecutive value will
increase by 1 (Screen 3).

- If "Apply for barcode in Block" is valid, adjust the duplicated Block number. Duplicated Barcode
Stamp and Block number is exchanged (Screen 4).

- Block assignment function becomes invalid when assigning Block to Barcode Stamp which already
assigned the Block.

- If you want to copy the Cell with Block assigned Barcode Stamp, open Copying window, and click
“OK” with pressing [option] key. Block number is assigned automatically to the copied Barcode
Stamp.

* If another Stamp is applied inside the same Cell with Barcode Stamp, copied Cell will become Block.

When you copy the Cell, please operate with the Cell which only Barcode Stamp is located.

V¥V 24-1-6 Barcode stamps in Pack

The same kind of barcode stamps can be in Pack. The packed barcode stamps behave “If one of the
barcode stamp can read, the Pack is judged OK”.

Start inspection. The barcode stamps in Pack is decoded in voluntary order; decode the 1st stamp, if it is
failed, decode the 2nd stamp and so on ... until any stamp is successfully decoded. When one stamp is

decoded,_the rest of stamps are not decoded.

If all stamps fail to be decoded, it is result in Read Error. If any barcode in Pack is decoded successfully,
the Pack is colored in blue and so is the decoded stamp, but the other stamps (failed to decode and not

decoded) are colored in red.
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Only barcode of same type can be in a Pack. For example, QRcode and Datamatrix stamps
can't be in a Pack. As same, the other kinds of stamps such as pattern matching or histogram

can't be in a Pack together.

- The barcode stamps in Pack are in OR condition, therefore the Matrix tab in Pack setting is

not possible to change.

- Barcode Pack frame is not possible to rotate.

- When any barcode stamp in Pack is decoded, the inspection of rest of barcode stamps is

aborted. For this reason, the barcode stamps in Pack after inspection is colored in red except

the decoded one (colored in blue).

- Pack Master function not possible to use.

WV 24-1-7 Read Error

When Manual Input is selected for error settings in this window, a Barcode Input dialog will be displayed

for key input when reading fails. No barcode number will be input if you press Cancel

At this timing, if you press “STOP” button on AQI, inspection will be paused and you can move camera
freely. This function is useful when barcode number is written out of the FoV. After confirming barcode
number, press START button. While inspecting, the Barcode Input dialog will be displayed again.

* Settings -> General -> NG Re-inspect must be active

* If barcode is inspected at the end of all inspection frames, this doesn’t function.

The same window will appear when you press the Space bar while waiting for barcode Data, and you can

input the barcode number from your keyboard (Screen 1).

24-1-7

(Screen 1)
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24-2 Scan Barcode with Handy Scanner, Open File by Barcode

By connecting a barcode scanner to Mac, the barcode on the PCB can be scanned. The barcode which
is not possible to scan by AOI can be decoded by using external scanner. In addition, by using external

scanner, you can memorize barcode number to the inspection program and call it by scanning barcode.

WV 24-2-1 Connecting a Barcode Scanner

The barcode scanner should be connected by the USB or RS232C (Fig. 1).

When using USB, connect via a USB HUB that has a power supply due to high power consumption. Avoid
connecting directly into USB port of PC.

When using the RS232C interface, Buffalo RS232C-USB converter (the recommended model) is required,
and serial spec should be set for each barcode scanner. These settings can be made in Setting for su-

pervisor > Other > Barcode reader > Setup button (Screen 2).

The barcode scanner can be used for Open file and/or LAN output. This can be selected in the Other

Tab in Setting for supervisor.

*Open file... Assign the barcode to an inspection program, when scanning the barcode, the correspond-
ing file will automatically open.
o AN...... When the barcode is scanned, the barcode number is added to the inspection results and sent

to the Rc22x.

p4-2-1

Barcode reader
Serial type or USB type

| KeyBoard

USB Serial

(Fig. 1) (Screen 2)
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WV 24-2-2 LAN (Identify PCB by barcode)

1. Select Setting for supervisor > Other > Barcode Reader > LAN.

2. Check Setting for supervisor > LAN > Send result after reading bar code. This will add the
barcode number scanned by the barcode scanner to the inspection results and send it to the
Rc22x after inspection (Screen 1). If Send bar code before inspection is checked, inspec-
tion start after reading barcode. This barcode number can be used as a reference number for
matching the PCB and the inspected data when using repair software(Rep22x).

3. When the machine is in standby status, a standby message will flash. Standby will be aborted
after 1 hour. If you wish to abort standby, click the Stop button on the screen, the Stop button

on the machine, or press the Esc key. Key input can be enabled with the Space key.

WV 24-2-3 Open file (Open inspection program by barcodes)

1. The File menu contains an item Open recent file, and the files used recently will be listed here.
Usually, only the location of the file is linked to this file name.
Check Setting for supervisor > Other > Barcode Reader and select Open File, and the bar-
code number will be linked to this list.

2. If a file containing a barcode number is opened after you make this setting, the file will be dis-
played in italics in the Open recent file (Screen 1).

3. When the barcode scanner scans a number, that number and the barcode numbers stored in
the italicized files will be matched, and the corresponding file will open.

4. If no corresponding number is found for the number read by the barcode reader, a warning will
be displayed. Please check the settings in the [Edit Recent files] screen (Screen 2).

5. By using optional “Do not save files when opened by barcode scanning”, the file is opened by
read-only mode and you will not be asked to save or not save file.

* By pressing START button in 60 seconds after reading barcode for switching the inspection pro-

gram, the barcode is attached to the inspection result of the 1st PCB.

24-2-2 24-2-3

(Screen 1) (Screen 1) (Screen 2)
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H Edit Recent Files

When you select Edit Recent Files from the Window menu, a window to edit the barcode numbers, lot
numbers and notes of recent files will be displayed (Screen 3). Click on the item name at the top, to sort

files by item.

¢ Files that have been moved or deleted are displayed in red text. You can delete a file from the list by se-
lecting it and clicking the “Delete” button or double-clicking NAME column. Multiple files can be deleted

from the list simultaneously by selecting some files and clicking the [Delete] button.

e Barcodes can be edited in the NUMBER column. You can use the Wild character (* ) here, wild card
can replace more than one number, e.g. 123" will correspond to 123456 or 123789, but if you want to
use wild card between numbers such as 123**7, you must use one wild card for one number.

¢ |In version 4.9.9 and later, more than one barcode can be set by separating them with “” (comma). Input
barcode number to “BARCODE” in the edit window.

Example) a00001,b002,c00*

* Maximum number of text to set for barcode is 127 to prevent inspection of incorrect PCB. Comma is
included in the number of text.

¢ To add LOT information, click on the cell in the LOT column. Up to 31 single-byte letters can be entered.
Once the cell has been edited, select LAN Window from the Window menu and press connect to up-
date the information.

* The recent files can store up to 9999 files. If the capacity is exceeded, older files will be deleted.

24-2-3

(Screen 3)
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(Screen 4)

(Screen 5)

¢ [CLIENT] column is displayed when [Send client name] option is activated on [For Supervisor].
The CLIENT name entered here is imported into CS-Repair.

¢ Possible to import/export the resent file list (Screen 5). Exported file is editable by text format.
Information of each file is in order from file pass, NUMBER, date, LOT, NOTE, and output by a line. Each
item is separated by Tab.

* Please use text editor or Excel for editing exported file.
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(Screen 2)

(Screen 1)

(Screen 3) (Screen 4)

24-3 Prevent inspecting incorrect PCB by assigning barcode

In a factory, sometimes operator opens incorrect inspection program or inspects incorrect PCB. This
option may prevent such human mistakes by using barcode on PCB.
* By activating this option, you can't use the function "Open File by barcode".

* Barcode in Block is not applicable.

V¥ 24-3-1 How to use

1. Open For Supervisors menu from Configuration in Settings menu. Move to Action tab,
check on " Prevent inspecting incorrect PCB by assigning barcode" (Screen 1)

2. A caution message will be displayed, click OK and activate this option.

3. Next step is assigning barcode to the inspection program. Open "Edit Recent Files" in Window
menu (Screen 2).

4. Input barcode number in BARCODE field. For example, if your PCB has barcode such as
abc001, abc002 ..., input abc™. (Screen 3)

V¥V 24-3-2 Running

After changing PCB model, when the first PCB arrives to AOI, the barcode on PCB is scanned. If the
barcode is other than the assigned numer, an error message will be displayed (Screen 4).

* This also works in case using USB handy scanner.
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24-4 Connect to Production Management Software

This chapter describes how to connect to Production Management Software CS-Center via LAN. Select
Setting for supervisor from Configuration in the Settings menu and move to the LAN tab. Set the
Port and IP Address to that of CS-Center, check Enable LAN for CS-Center, and check at least the fol-
lowing items. (Screen 1)

B Show remote G/NG screen

M Send inspection result text

H Enable remote Start/Stop
If a LAN connection is enabled and CS-Center is activated, it will be connected automatically and the con-
nection icon will be displayed next to Eyeglass button. When disconnected, the center of the icon will turn
red. Click this icon to connect again.
* If you start 22x with LAN connect on, and if CS-Center is not started, 22x re-tries for 10 seconds, to

terminate this connection, press Esc key.

Send barcode number too Attach numbers from barcode to inspection result.

Read before inspection (by USB Inspection starts after reading barcode.

reader) * This option is only valid when using external barcode scanner
to read barcode

Send Good data too (dx, dy) When this is checked on, 22X sends not only NG data but

also OK data to the management software. When checking up

position shifting of components, check this on.

Send Stamp name too Output inspection result includes stamp names too.

Send Cell images (CS-Center only) |This is an option for Catch System. If this is checked on, 22X

sends Cell images, too.

*When machine is not connected to CS-Center via LAN, this
menu is inactive.

Send client name Adds [CLIENT] column on [Edit Recent File].

24-4

(Screen 1)
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24-5 Remarks

V¥V 24-5-1 Send OK Data

l Check Setting for Supervisor > LAN > Results include OK data to send OK data as well as NG
data to the Rc22x/CS-Center.

Bl When this setting is activated, the result data transferred to the Rc22x has shift information in the
NOTES column in X/Y coordinates (mm).

Ex: (-0.014 0.02)

The shift information is calculated from the Frame position to the inspection target. With wide tolerance

frames that match even if they are imperfect, accurate misalignment figures cannot be obtained, and this

should be used only as a guide. This data will be sent via LAN and be checked in the Rc22X.

* Since values cannot be obtained with Inspection Frames that do not use matching algorithms, the
value will be (* *).

*In a package, the center misalignment of the pack master will be displayed. If there are no pack

masters, the value will be (* *).

V¥ 24-5-2 Limitations when using Rc22X/CS-Center

- When sending data to CS-Center, you must select G/NG Confirmation mode or NG Cell View.
Otherwise NG pictures are not sent.

- When sending data from multiple AOI to CS-Center, do not use Auto Trace with bar check in G/
NG Confirmation mode. Because in this mode, all NG pictures are sent simultaneously and the
software can not operate these enormous pictures.

- When Esc/clear keys are pressed during verification in G/NG confirmation mode, log is output
to Log22x.log, you can confirm from Console.

- On AOQI with angular cameras, images from angular cameras are not sent to CS-Center if Auto

Trace is active.

WV 24-5-3 Cut LAN connection during data transmission

When sending data to optional software Rc22X or CS-Center, if you press STOP button before data
transmission is completed, “Wait for the transmitting completion. Do you cut LAN?” message appears.
Data transmission is not cut even pressing OK button in the dialogue. This is because of preventing mis-

operation by operators. If you must stop transmission immediately, press OK button with option key.
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Note: Hints when data output is too slower than inspection

First treatment is to send machine inspection result without confirming by operator. It is very use-
ful especially with in-line machine, because it can not be stopped. Later operator can confirm and

classify inspection result on CS-Repair.

To set this, open Map View Setting, and check Auto send for all NG in G/NG Confirmation
Mode. (For details, please refer chapter 13-8.) By the way, if you set Screen mode in Small and im-

age Quality in Standard, the time may be reduced.

Faster mode is also available. As NG images are sent continuously. This mode may be useful when

your network is high-speed.

To set this, open Map View Setting, and click Auto send for all NG twice in G/NG Confirmation
Mode. The check mark turns into bar mark. The NG images transferred in this mode is. if there is
empty space, colored in green.

This faster mode is only available when connecting with CatchSystem.
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25. PC SetUp and Installation

The PC (Macintosh) must be set up properly before using AOL.
* Some items may have different names depending on the OS version, but their function is generally

the same.
25-1 Accounts

Accounts are set up when starting up the PC for the first time. Set up your user name, computer name

and password. Be sure to remember the password since it will be needed when you install the software.
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(Screen 1)

(Screen 2)

(Screen 3)

25-2 System Preferences

Set up the following items in system preferences.

® Energy Saver

Set Never for Computer sleep and Display sleep. Uncheck Put the hard disks to sleep when pos-
sible (Screen 1).

e Desktop & Screen Savor

Click on the Screen Saver tab and select Never from pull down (Screen 2).

If Screensaver is active, the connection between PC and AOI may be cut.

e Software Update

Uncheck Automatically check for updates (Screen 3).

e Keyboard

Aluminum keyboard ( July 2007 on sale ) has a check option “Use all F1, F2, etc. keys...”

If you do not check on this box, shortcut keys for 22x are not available.

e General

On Mac 0S10.5, we recommend to change a font setting in Appearance of System Preference.
Change the value of "Turn off text smoothing for font sizes about 8. Without changing this,

there is no influence on software, but some small text is not smoothly displayed.

Prohibited

Never activate Screen Sharing or install 3rd party's screen share software. Screen sharing is heavy task

as a result the synchronization of illumination and camera capturing will be incorrect.
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(Screen 2) (Screen 3) (Screen 4)

(Screen 1)

25-3 Software Installation

1.

Double-click on Installer-1(.pkg) and follow the instructions (you will need the password that

you setup in Accounts).

2. The PC will reboot and the installation will be complete.

3.

When the software starts up, the screen size will automatically be optimized regardless of the
System’s Screen Resolution (screen size) settings. If you would like to use a different screen
resolution, set the Resolution in System Preferences > Displays and then go to Settings >
Configuration > Let 22X stay in this display mode in the software. This will link the current
display mode to software startup, and the screen size will always change to this resolution at
software startup. After saving this setting, the menu will change to the Remain in desktop dis-

play mode menu to remove the startup link. (Screen 1)

. Select Settings > Configuration > Settings for Supervisor > Other. Confirm that Enable

cache is selected here (Screen 2).

. Copy the Stamp Library to the hard disk. Copy the library on the USB to User/ User name/

Documents for example (Screen 3).Feel free to copy this library to a location that is convenient

for you, we are sure you will find the various stamps useful.

. To automatically start this software on system startup, add 22X to Accounts > Login Items in

System Preferences (Screen 4).
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25-4 Connect Mac to LAN

Inspection programs are very important, confidential information for your company. Therefore AOl's
operational PC should not be connect to open network like office LAN, which has connection with
outside. You should create private network exclusive for AOI, Stamp Database or Management software

Catch System.

How to make private network with fixed IP address is discribed in this chapter. For settings of Catch

System, please refer to their instruction manual.

B Equipments
- LAN cables for each Mac

- Switch Hub (if you dare connect to office LAN, this is not necessary)

- Each Mac should have ethernet board inside.

* LAN cable should be greater than category 5e for 1Gbps speed, straight cable. Less than category
5 is 100Mbps speed.

* Switch Hub can be called Ethernet Hub or just Hub. Select product for 1000Base-T or greater.

* Even LAN cable and Switch Hub is 1Gbps, Mac except Mac Pro (such as Power Mac G5, iMac) can

have ethernet card for 100Base, then access speed will be decreased.

l Setting 1 [ Physical Connection ]

1. Connect LAN cable to ethernet port on the rear panel of Mac. Mac Pro has 2 ports, connect to
Ethernet 1 (Screen 1).

2. Connect the other side of LAN cable to Hub. Any port of Hub is fine. Setting is completed.

25-4

(Screen 1)
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H Setting 2 [ Setting on Mac ]

1. Open System Preferences (Screen 2), click Network (Screen 3).
2. Select Ethernet1 (Screen 4)
* If you log in by non administrator account, key on left bottom is locked. Input administrator password
and release lock.
3. Change configuration to Manually, input 192.168.1.1 for IP Address, and 255.255.255.0 for
Subnet Mask (Screen 4).
4. If your Mac has AirPort, turn it off.
5. Press Apply button, close System Preference window. Setting is done.
6. For another Mac, assign 2,3,4...for the last digit of IP Address (ex. 192.168.1.2). Subnetmask
should be all the same, 255.255.255.0.
7. When connecting PC where stamp database or Rc22X/CS-Center is installed, assign IP
address as same rule. IP address must be unique.
* If you dare connect Mac to office LAN, ask IP Address, subnetmask, router setting will differ, please

ask administration. However, IP Address should be fixed address.

(Screen 2) (Screen 3)

(Screen 4)
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26. Initial Settings

Usually, these initial settings are already set by the suppliers, but if you are in need please refer each item.
26-1 Authorisation

Before setup, select File > Authorisation > Supervisor mode. This will give you access to all the func-
tions of the machine and software (Screen 1).

* See chapter 3 Startup, Shut Down and Authorisation for details on the Authorisation Mode.
26-2 Lighting Stabilization and Warm-up

After the software has started up, a message Waiting for illumination to stabilize may appear. lllumi-
nation stabilization is not necessary for AOI with LED. During stabilization, a warm-up for the drive unit (heat
run) can be executed. Warm-up operation will first set the Origin Position, then it moves around to the
Fiducial Points in the 4 corners of the PCB carrier. After the heat run, the machine will confirm the Origin

Position again and go to the Eject Position.
26-3 Camera Calibration

Calibration is an important task to set up a standard for the displayed image color. The calibration position

26-1 26-3-1

(Screen 1)

(Screen 1)
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is not preset, so when using this device for the first time, you must set the calibration position.

V¥ 26-3-1 Calibration Setting

1. Select Calibrate from the Settings menu. Click OK when the message "Move to calibration
position?" is displayed. A gray seal will be displayed on the screen, and the Calibrate window
will be displayed (Screen 1).

2. Press the Auto Cal button to adjust the level.

3. If the meters for Red, Green, Blue and Brightness are pointing straight up and the saturation
level is set to the far left (0), it does not matter what level the hue is set to.

4. On some types, calibration executed not only with standard lighting, also with Reduced Light.

5. Confirm that the manual adjustment Gain level is within the range of the arrow under the Gain
slider bar.

6. Press Renew DOAL timing if your AOI has Diffuse-On-Axis LED.

7. Once adjustment is complete, press the Auto Cal. button and end the calibration adjustment

process.

26-4 Mechanical Calibration

There is a plate attached for correcting position and compensate for distortion of the drive. By reading
these 4 Fiducials on the plate, the physical position can be converted into a logical position.

Please confirm Mechanical Calibration after un-packing AOI or after moving place.

V¥ 26-4-1 Confirming Mechanical Calibration

Select Settings > Machine Setup > Mechanical Calibration > Check.

Make sure that each Fiducial is close to the center of the screen. If they are not in the center, execute “Up-
date”. Even they are not in the center, you need to create new Mechanical Calibration by reading the fol-
lowing chapter. After new Mechanical Calibration is created, the coordinates of inspection programs made
in old Mechanical Calibration value will be shifted.

*In order to update (change) the Mechanical Calibration Value set here, hold down the Option key

while selecting Machine Setup > Mechanical Calibration > Update to change the offset value.
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V¥ 26-4-2 Creating New Carrier Fiducial Marks

. Select Setting > Machine Setup >Mechanical Calibration > New. A message window "Ex-

ecute new mechanical calibration.” will be displayed. Click OK.

. Go to the top left Carrier Fiducial, and the Marker will be displayed in the Work area along with

the center line. At the same time, the Marker Setup Bar will be displayed underneath the win-

dow.

. Select the Inspection Frame Tool and select the Fiducial at a size roughly twice the size of the

marker (Screen 1).

. Binarise the Fiducial Mark to black and white. Use the Black and White Adjustment Lever in

the Marker Setting window (displayed when you double-click on the border line of the Inspec-
tion Frame) to clearly distinguish the black and white inside the marker (Screen 2). Do not press

the Center Correction Button.

. Once Binarisation is complete, click on the Start Inspection Button. To stop inspection, press

the Stop Button.

. Follow the same procedure to adjust markers from top right --> bottom right to bottom left.

. After all 4 corners have been adjusted, the Mechanical Calibration Value will be displayed. Click

OK.

This Mechanical Calibration Value will be stored in the file and can be used for Mechanical Calibrations in

the future.

26-4-2

(Screen 1) (Screen 2)
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27. Stamp Database

This software has stamp library in each program file. This method is simple and easy because user does
not need to have another stamp library file and manage it. However, if you want to use same stamps for all

programs or to use stamps between different AQI, it will be efficient to use Stamp Database.

This database can be used in 2 styles. One is alone style: Use stamps for 1 AQI, install database in Mac
which is controlling the AOI. The other is share style: Share stamps with multiple AQI, install database in

Mac which is prepared exclusive for database, and every AOI access to it via LAN.

Before starting up database, you should first install “Database Management Software DB22X”, while first
set-up of DB22X, database is automatically installed. For installation and set-up of DB22X, refer to its Help

Manual. This chapter only describes operations of StampDB which is a tool to access database on 22X.

27-1 Limitations

- OS should be greater than macOS 10.14, and 22X software should be greater than V6.0.0.

- Network should be 1000 Base eithernet connected via cables. Database response will be slower
under 100 Base environment. Wireless network is not guaranteed.

- Due to the update of 22x operation software to V6.0.0, DB22X can be used with V3.0.0 or
greater. Stamp you had been created and used with operation software V4.9.9 or older cannot
be used with DB22X V3.0.0 or greater. File conversion work is necessary to apply the Stamp

created by older software version to new version.
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27-2 First Start-up
Start-up the DB after installation.

If you use database in alone style, StampDB automatically search and connect to database.

In share style, make connection to shared database by yourself as following;

1. Open StampDB by clicking Stamp DB on Stamp menu or Folder Open icon in the right bottom
of Stamp List (Screen 1). A window "StampDB" opens, and message "No DB is set, please

set DB first." is displayed (Screen 2).

2. Click OK, then click Please set DB and select DB settings... (Screen 3)

3. DB setting window opens. Press Select...button to set DB preference file (Screen 4). Select

shared directory of Mac for DB, select DB22X.plist in user's public folder (Screen 5).

4. After proper DB preference file is set, database will be listed on Database List. Click OK to
finish setup. From the next time, DB is connected automatically. If the auto connection does not

work well, check 27-6 Troubleshooting.

pr-2
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Status Symbols

S
—4 Copy stamp in DB to 22X program

Update stamp in 22X program by latest stamp
in DB

Add stamp in 22X program to DB

Update stamp in DB by latest stamp in 22X
program

Stamp not listing on current category, but
: : existing in DB (Add this stamp to current E&»
SLnTTTT LTINS g category, and update stamps in DB.)

................................

"teesesesesesesesesssecesssscsennes

Here describes interface and functions of StampDB. The numbers below correspond to the image above.

1. Current category.

2. All stamps in current category is displayed by pressing this Home button.

3. Changes stamp list order: Ascending, Descending, Pack Prior or Status order.

4. Search stamp button in current category.

5. Stamp list. Displaying status, master picture and stamp name. Pack stamp is colored in purple.

6. Information navigator;
Selecting 1 stamp: show information of the stamp, if Pack Stamp, configured stamps listed
Selecting multiple stamps: show number of the selected stamps
Operation result: show message after updating stamps, etc

7. Check button to compare stamps used in 22X program with stamps in DB.

8. Check all stamps button to compare all stamps in 22X program with stamps in DB.

9. Copy selected stamp(s) from database to inspection program.

10. Copy selected stamp(s) from inspection program to database. Writing is protected when

the key icon is displyed. Click the icon and enter password to unlock.

11. Selects database.

12. Gets selected stamp(s) from DB and updates stamp(s) in the inspection program.

13. By checking this option, confirms stamp update while opening the file and save the changed
item(s) automatically.

14. Syncronizes all stamps in the inspection program and DB. Writing is protected when the key

icon is displyed. Click the icon and enter password to unlock.
* The inspection program is automatically saved when stamp(s) is saved/loaded by Sync, or saved

by DB Master stamplist.
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27-4 Work Flow

A general procedure is shown as sample.

4 Open program and StampDB )

v
Compare stamps

v
Update stamps in program (Get)

v
Start programming and finish

v
Update stamps in DB (syncronize)

v
\_ Complete )

V¥ 27-4-1 Open StampDB

Start 22X software and open an inspection program. Open DB from Stamp menu or right bottom of

Stamp List (See Screen 1 of 27-2).

WV 27-4-2 Compare stamps

Press Check button to compare stamps between the inspection program and database. In case you
create new inspection program, click Check all stamps. You can load all stamps in cactegory.

After comparing, if there are updated (latest) stamps on database, a green left arrow is displayed on stat
column (Screen 1). If there is no change between stamps in program and database, no stamp is displayed

on list.

WV 27-4-3 Update stamps in program (Get)

Update stamps. Select stamps and Press Local Stamplist button, or update all by Get button.
* While confirm update at file open is checked, stamp(s) on the inspection program and DB is

automatically compared and changed stamp information are gotten after displaying a message (Screen 2).

27-4

(Screen 1)
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V¥ 27-4-4 Start programming and finish

Create or debug the inspection program.

V¥ 27-4-5 Update stamps in DB (syncronize)

Press Check button and compare if any stamps in the program are changed. After comparing, a red
right arrow is displayed on stat column (Screen 3). (If you are using DB in share mode, green left arrow
may be displayed because other operators can be updating stamps while you are working.)

Press DB Master Stamplist button or Sync button and enter password to update DB (Screen 4).

* When you want to confirm if stamp is surely updated, press home button and display stamps in

current category. Select any updated stamp and see information.

WV 27-4-6 Complete

Save inspection program and exit 22X software.

p7-4
r oA
I 1
I 1
I 1
I 1
I 1
| S|
(Screen 2) . -
L |
| S
(Screen 3) (Screen 4)
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27-5 About Stamps and Protection

Stamps once saved in DB has unique ID (UUID), for the detail of UUID please refer to the instruction

manual of DB22X Chapter 7-3.

On StampDB, user can handle Pack stamp without caring that it is Pack stamp. When updating or
copying Pack stamp, just select Pack stamp, you do not need to care for stamps inside Pack stamp,

because they automatically follows Pack stamp.

WV 27-5-1 Stamps with same name

Because stamp is given an unique ID, you can add a stamp with same name on DB. However the
category can not have stamps with same name. If you try to add, a dialogue to allow or not allow
overwriting current stamp is displayed (Screen 1). Select which stamp to use, and click OK. Then
the stamp to overwrite the other one is displayed on StampDB. (Screen 2) Press Get/Sync or Local
Stamplist/DB Master Stamplist button to update (overwrite).

The sample screen is an example to overwrite the stamp in DB by the stamp in the inspection program.

On 22X software, if you load stamp with same name, a dialogue to select whether overwriting current
stamp or not is always displayed. The dialogue is also displayed even the stamp has same unique ID in

order for user to pay attention (Screen 3).

(Screen 1) (Screen 2)

(Screen 3)
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V¥V 27-5-2 Database protection

Database is usually protected from writing. It is because of avoiding careless stamp update by operator in

share mode. To unlock protection, click Key icon and input password.

If you are using database in alone mode and you are the only operator to access database, check

Verify password only when first access on DB22X. If this is checked, after inputting password once,

protection is always released.
27-6 Network Troubleshooting

1. Network icon does not exist on left menu in Finder.

Confirm Finder's Preference if Network is checked in Slidebar tab (Screen 1).

2. No PC is listed on SHARE menu.
Confirm Finder's Preference if Connected Servers and Bonjour Computers are checked (Screen 2).

Or network settings can be incorrect. Refer to DB22X manual, Appendix A, and confirm settings.

3. No PC is listed when clicking Network icon.
Depending on network environment, it takes time to show network computers. Please wait for a

while. If still nothing is shown, network settings can be incorrect. Refer to DB22X manual Appendix A,

and confirm settings.

4. Logged in the Mac where DB is installed, however no volume is listed on Volume to mount.
- Confirm if you surely log in by right account (not wrong account nor guest account).

- Folder share setting can be incorrect. Refer to DB22X manual Appendix B and confirm share

setting.

27-6

(Screen 1) (Screen 2)
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5. When | try to update database, "Database is locked" message is shown.
- In case of other operator is writing, wait for a while and try again.
- If you are using database in share mode, and access to database from local StampDB, other
network users can not write in database.

- Guest user has no permission to write.

6. In share mode, when | open StampDB next time after first setup, StampDB can not
automatically connect to DB.
- Confirm if you can find Mac for DB in network. If you cannot find it, there is something wrong with
network or network settings.
- If you change PC name, DB can not be connected. In this case, set DB again by following 27-2-2.

- Confirm if Mac for DB is powered on.

7. Connect to Server dialogue is always displayed when opening StampDB.

If no password is set for the user account, the dialogue is displayed because Mac can not remember

password in Keychain.
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28. Angular Cameras (for Gompatible
Models)

Angular camera unit is for inspecting and viewing defective components from 8 angles each 45 degrees in
360 degrees. V22X and UV models are not supported. This chapter only describes the operation of Angu-
lar Camera. For setup, installation, or troubleshooting, please refer the Chapter "Angular Camera Unit" on

the Hardware Manual.
28-1 Limitations

- Verification mode is available in G/NG confirmation mode and NG Cell View mode. On NG Cell
View mode, some menus are unavailable.

- Power on AOI before PC. If PC is powered on at first, recognition of angular cameras may fail.
28-2 Settings Menu

There are settings for Angular Cameras in For Supervisors menu, Angular Camera tab (Screen 1).

B Enable angular cameras (require restarting)

Activate / Deactivate angular cameras.

B Use angular camera screen for verification

If you want to always verify with angular cameras, check this on. If this is not activated, operator verifies in
normal G/NG confirmation mode view, and when the operator wants to check with angular cameras, he

should switch the view manually by clicking mouse or pressing slash (/) key.

28-2

(Screen 1)
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H Selected stamps only
Normally angular camera screen is used for verification, however if this option is active, only selected
stamp are displayed in angular camera view.

* By activating this option, automatically view45 stamps only option is activated also.

Stamps can be selected by following procedure. open Show/Hide Object Type window. Here you decide

which ID should use angular camera view (Screen 2). Select the stamps you want to display in the angular

camera screen by checking the checkbox in the [Show/Hide] window (Screen 2).

* Beforehand, you need to assign ID to stamps. Please refer the manual chapter 8-10 to know how to
assign ID to stamps.

* Angular camera view of view45 stamps are only sent to CS-Center. The other stamps verified after

switching to angular camera view are also sent.

B View45 stamps only

Normally angular camera screen is used for verification, however if this option is active, only View45Stamp
and View45Calc stamp is displayed in angular camera view. Of course while verifying the other stamps,
by pressing / or pressing screen switch button, the other stamps are also able to be confirmed by angular
camera view.

* Angular camera view of view45 stamps are only sent to CS-Center. The other stamps verified after

switching to angular camera view are also sent.

B Auto-move camera on NG position in Pack

Check this on, if you want angular cameras to show the defect stamp in the center in case of pack stamp.
For example, if there is a lifted lead detected in a QFP pack stamp, angular cameras show the lifted lead

in the center (Screen 3).

(Screen 4)
(Screen 2)

(Screen 3)
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H Views for NG direction in Pack be noticeable

If this option is checked, the views except NG direction are hidden on Pack Stamp. This effect is made for
operators to find NG location as fast as possible (Screen 2 is the example, the 3 views on NG direction are
shown, but the rest of 5 views are hidden).

* For the same display in CS-Center, please enable [Views for NG direction in Pack be noticeable] in

[Settings] - [Side Camera] in CS-Center.

W Show only NG direction in 4 views

Show NG area even bigger in 4 views. You can still switch to normal 9 views by pressing “view switching
button” at the bottom left (Screen 4).

* If there are defects in multiple views, you can't switch to 4 views.

* For the same display in CS-Center, please enable [Show only NG direction in 4 views] in [Settings] -

[Side Camera] in CS-Center.

B Send 'View45Stamp' result as OK to Server

Viewd5Stamp is an exclusive stamp for angular cameras. The stamp let the operator confirm the specified

location with eyes by angular camera view.

When running AOI in auto tracing mode, operator does not verify PCB right after inspection, in stead all
inspection results and NG pictures are sent to server, then after while, confirmed on Repair software with

buffered PCB. Normally, the location where View45Stamp is pasted are sent to Server as NG.

However, if you check on “Send ‘View45Stamp’ result as OK to Server”, the result is sent to Server as

OK. If you pay attention on the production status such as RTY rate, please check this option on.

W Show message to prohibit operation while startup

Show full screen startup message.

M Enable to assign reference number for trap frame

This option is assigning reference number to trap frame for tracing. The reference number is attached to
inspection result and sent to our optional production management software. The number is added from
setting window on view45calc stamp trap frame. On CS-Center, ID information is added on CYM column.
* By activating this option, there are multiple results for one reference designator. This influences the

statistics on the management software.
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B Capture delay(ms)

Set the display time for image for auto trace with G/NG confirmation by angular camra. Initial value is 100.

If the image of angular camera is blurred with G/NG confirmation, you can adjust by setting greater value.

M Reduce Light

If this value is changed and then the lighting is suppressed in the General Settings under [Reduce/En-
hance Light], the illumination will dim according to the changed value. Due to hardware limitations, the

value when the illuminance is brightened cannot be changed.

l use angular camera in NG Cell View mode

Switching main screen and angular camera screen is enabled on NG Cell View mode by pressing slash key
or clicking angular camera icon. Under NG Cell View mode, some menus are grayed out on For Supervi-

sor and Map View settings.

M Side Camera Debug

Image of NG result is displayed in the window of View45Calc Stamp when we want to debug false NG
point with View45Calc Stamp after inspection. You can switch the screen to current image by clicking
lower left button in the window, so you can check the latest image (Screen 5). Icon will be displayed at
Message Bar in Main Window when this function is activated (Screen 6).

* Inspection image is deleted when you clear the inspection result with pressing “STOP” button.

28-2

O

(Screen 5) (Screen 6)

(Screen 7) (Screen 8)
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B Confirm all NG stamps inside the Pack
If there are several NG in Pack, you can check each NG point by angular camera in G/NG confirmation.
Right and left arrow is displayed under the GOOD/NG button in the right side of angular camera window.
You can move to other NG point by clicking arrows (Screen?). Numbers shown below arrow buttons are
NG number and quantity inside the Pack. Display order of NG points in Pack will be order of Pack Stamp
which had been judged as NG first.
Regardless of displayed NG position, point moves to another NG point by clicking GOOD/NG or Next/
Prev button. It is not possible to judge GOOD/NG for individual NG points inside the Pack.
* Camera displays NG position of short and fillet for ICLead Stamp.
* Possible to display NG points inside the Pack with Auto trace mode, and send the result to Catch
System. Also remote control operation with CS-Center is possible.

* Function is available with following version for CS-Center and Cs-Repair.

- CS-Center: Version 1.2.2.9 or greater

- CS-Repair: Version 1.2.2.6 or greater

H Activate GOOD button only when confirming all NG stamps

If you activate this function, you cannot click GOOD button until you confirm all NG’s inside the Pack.
GOQOD button is activated only when confirming all NG with right and left arrow displayed under the
GOOD/NG button in the right side of angular camera window (Screen 8).

* You need to activate “Confirm all NG stamps inside the Pack” to select this function.

Below menu is only shown with Angular Cameras for U22X Series.
H Information

Show information of Angular Cameras, and enable to save the information file on desktop for investigation

when trouble occurs.

B Angular Camera Settings

Menu to confirm and re-position angular cameras. Settings menu will not be used unless trouble hap-

pens. Please refer Error and Troubleshooting in Angular Camera Unit for U22X Series manual.

B Enable Histogram Inspection

Show editing window for F series will be displayed in place of existent pattern matching window. Please

read next chapter 28-3 for usage.
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28-3

(Screen 1)

(Screen 2)

(Screen 3) (Screen 4)

28-3 Creating Inspection Programs [for 22X F Series]

There is a special stamp named "View45Calc" for inspecting by angular cameras. The inspection method
is simple pattern matching and histogram analysis. By simple pattern matchig, first check the matching
of whole image (tolerant), if passed, image is inspected in detail (less tolerant). Histogram analysis is the

same analysis process as original.

Here is the example workflow to create a program to detect QFP lifted lead.

V¥ Load view45Calc stamp

Load View45Calc stamp. Place the stamp where you want to inspect by angular cameras (Screen 1). The
stamp may possible to resize, however resizing stamp size does not change the view size to be captured

by angular cameras.

VW Setting view45Calc stamp

1. By double-clicking the frame of View45Stamp, the angular camera screen opens (Screen 2).
Look at 8 views, and examine on which view you can see the lead the best. Here we use the

bottom center view where leads are seen from front.

2. At first, we recommend to place a frame for compansating the position shifting because angular
cameras are very high resolution, a slight position shifting may influence to inspection. Draw a

frame on a object which color is distinguishable to surrounding area. Here we draw a frame on
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the lead leg. Select frame creation tool at bottom and draw a frame. Inspection menu window

will open (Screen 3).

3. Select Cell Aid Frame from pull down menu (Screen 4). Frame color changes from green into

purple. This frame is now for position offset.
4. Next, draw a frame where you want to inspect. Here we like to detect the lifting lead, as a first
step draw a frame on one of the leg. Because lead joint is solder, select Histogram Analysis.

Press Go button or double click the frame. Histogram Analysis window opens (Screen 5).

5. Create trap frames and complete the histogram analysis settings (for the detail of Histogram

Analysis, please read the Chapter about Histogram Analysis Method.)

6. Copy the histogram frame to the other legs by pressing option key and dragging (Screen 6). The

copied frames have same settings as original, and have same number.

* If you resize the copy frame, the frame will be re-numbered.

* Copy to the different view is not possible.

7. Close the window by pressing OK.

8. Paste to all the legs of QFP.

(Screen 5) (Screen 6)

(Screen 7)

342
28. Angular Cameras (Optional)




9. Start inspection. When lifted lead is detected, show in angular camera view while verification

(Screen 7).

* In this example, we place frames only in one view, however you can place frames on any view.
* Maximum 100 frames can be placed in total views.
* There are other keys than option key possible to be used for operation. For detail, please open Help (?

icon in angular camera view.)

V¥ Tune-Up and Adjustment

Viewd5Calc stamp for angular camera inspection does not show the inspection result by pressing Re-
inspect or Analyze button in Cell Map Area. To confirm the criterion, press Start button and inspect whole

PCB or press Re-inspect button in angular camera view.

V¥ Window

1. Release Anchor When there is Cell Aid frame, the frame position is with offset. By pressing this
anchor icon, the offset is released.

2. Help Explainign operation keys possible to use in these views

3. Selection Tool Select frame. Selected frame opens/shows settings window.

4. Frame Creation Tool Specify the area to be inspected by angular camera by creating trap frames.
After creation, settings window opens and can adjust settings.

4. Delete Delete frames. Also possible to delete frames by delete key.

5. Re-inspect Button Re-inspect all frames.

V¥ Inspection Menu

1. Inspection Selection Selection from Simple Pattern Matching, Histogram Analysis or Cell Aid
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2. Matching Blur Level

3. Search Area

4. Add/Delete Picture

5. Number

V¥ Inspection Method

Frame. Press Go button for Histogram Analysis to open Histogram
setting window.

Set matching level of selected trap frame. Default level is 60% matching.
Searching area for selected trap frame in pixels. Set to X or Y direction
by sliding levers. Area is shown by dotted line around trap frame.
Default size is 1/2 of short side of width or length.

Add (+) or Delete (-) master picture.

Master picture can be added maximum 12.

Assign ID to trap frame. (when Enable to assign reference number is

active.)

There are 3 inspection method available.

Histogram Analysis:

Major method for inspection. Setting and creterion is the same as normal histogram analysis by top cam-

era. However some functions are missing such as sampling debugging.

Simple Pattern Matching:

Simplified pattern matching method.

Cell Aid Frame:

This frame is not for inspection. This frame is for compensating position shifting. Placing a Cell Aid Frame

in one of the 8 views, offset is common in all 8 views. When more than one view has Cell Aid Frame in its

view, the offset is applied to individual view.
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28-4

(Screen 1)

(Screen 2)

28-4 Creating Inspection Programs [for 22X U Series]

There is a special stamp named "View45Calc" for inspecting by angular cameras. The inspection method
is matching. First check the matching of whole image (tolerant), if passed, image is inspected in detail (less

tolerant).

V¥ How to use

1. Load View45Calc stamp
2. Place the stamp where you want to inspect by angular cameras (Screen 1).
* The stamp's default size is same as the size to be seen by Angular Camera (8 angular camera's FoV
is smaller than 22X main camera). By resizing the stamp size, the FoV by angular camera does not
change.

* This stamp can't be included in Pack Stamp.

V¥ Data Creation

By double-clicking the frame of View45Stamp, the angular camera screen with drawing tools opens Cre-
ate frames by drawing tools. You can draw many frames. Dragging mouse by pressing option key, you
can copy the frame. Copied frame keeps the same setting, for example, if you add new master picture,
the copied frames also have the new picture (screen 2).

After setting is finished, close the window by pressing OK button.
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28-4

(Screen 3)

V¥ Window (Screen 3)

1. Selection Tool Select trap frame. Selected trap frame opens/shows settings window.

2. Frame Drawing Tool Specify the area to be inspected by angular camera by creating trap frames.
After creation, settings window opens and can adjust settings.

3. Trash Delete trap frames. Also possible to delete trap frames by delete key.

4. Re-inspect Button Re-inspect all trap frames.

V¥ Settings Window (Screen 3)

1. Master Picture List Show master pictures of selected trap frame.

2. Add/Delete Picture Add (+) or Delete (-) master picture. Master picture can be added maximum 12.

3. Search Area Searching area for selected trap frame in pixels. Set to X or Y direction by sliding
levers. Area is shown by dotted line around trap frame. Default size is 1/2 of short
side of width or length.

4. Matching Level Set matching level of selected trap frame. Default level is 60% matching.

5. Blur Level Add blur effect to decrease false calls..

V¥ Tune-Up and Adjustment

View45Calc stamp does not show the inspection result by pressing Re-inspect or Analyze button in Cell
Map Area. To confirm the criterion, press Start button and inspect whole PCB or press Re-inspect but-
ton in angular camera view (Screen 4). After inspection, the passed frames are colored in blue and failed
frames are colored in red. Matching % and NG reason (in case of NG) will be shown by mouse over the

trap frames (Screen 5).

If there are false calls, you can adjust by 1. Adding master picture 2. Decrease matching level or 3. In-
creasing Search Area.

If NG reason is Matching (Detail) NG **%, adding master picture is the most recommended method.
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(Screen 4)

(Screen 5)

28-5 Inspection with White Side Light

Function to brighten the angular camera image by lighting the components from sideway is available with

white side light mounted model. It is effective if main light from the top has difficulty to reach the inspection

point. Please refer to “28-3 Creating Inspection Programs [for 22X F Series] for data creation procedure.

V¥ Applicable model

Model with white side lighting (S or GTAz series)

V¥ Setting of Stamp for auto inspection (view45Calc)

Display window by double clicking “view45Calc” Stamp. You can ON/OFF the side LED by clicking the
button in lower left of the window. For the inspection with side LED, set the trap frame after turn on LED.
* When you change the setting in one inspection frame, the setting will be reflected to other inspec-

tion frame.

28-5

Power OFF Power ON
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28-6 Viewing Operation
V¥ Switch 22X main screen to angular camera screen

Switching from 22X main screen to angular camera screen;
Press slash "/" key on keyboard (including tenkey), or press switch button at the top-right corner of the
22X main window (Screen 1). Do the same operation for getting back to 22X main screen.

* Switching screen is not possible when the camera is at Eject/Home position.

V¥ Operation while verification

Various operation to recognize NG more clearly is possible from G/NG confirmation window of
angular camra.
- Verify the defective components by pressing Good/NG buttons by mouse or arrow keys
on keyboard.
- While verifying, if the image is difficult to see, click each picture to enlarge or press * (as-
terisk) key (Screen 2).
- While verifying, if it is difficult to find the target component, press "+" key and display red
cross-hair in the center (Screen 3).
- If the area that you want to see is not seen by angular cameras well, double-click the
desired position in the center picture (by 22X top camera) with pressing control key, the

angular cameras move to the clicked position.

28-6

(Screen 1) (Screen 2)

(Screen 3)
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- When you click the icon in the lower left corner of the side camera screen, orange borders
are displayed between each image (Screen 4). This function is available in G/NG Confir-
mation Mode, NG Cell View Mode, and View45Calc. If the lines are displayed on one of
these modes, they will continue to be displayed in the other modes. This setting has no
effect on CatchSystem.

- When you click the red colored camera icon in bottom right of G/NG Confirmation win-
dow, red colored camera icon appears on NG Stamp in main screen. You can confirm
the position of NG stamp currently displayed (Screen 5). Icon in NG Stamp disappears
when you click the red colored icon again at bottom right of screen. The status of display
the icon is saved for each machine.

* This function is available when “Confirm all NG stamp inside the Pack” is activated in

Angular Camera tab from Settings for Supervisors menu.

28-6

(Screen 4)

(Screen 5)
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V¥ Operation while debugging
You can also use angular cameras for efficient debugging. While creating the inspection program, you can
use the angular cameras to confirm if the component/fillet is defect or not by pressing /" key or clicking

switch button.

If you are selecting the pointer tool or the frame creation tool (Screen 6), you can zoom

the center picture by clicking (Screen 7).

If you are selecting the move tool, you can freely move the camera position (Screen 8),

but can not zoom the center picture.

If you click each picture, you can zoom the image (Screen 9). You can also zoom the im-

age by pressing “*” key.

You can display the cross-hair by pressing "+ " key (Screen 10).

28-6

(Screen 6)

(Screen 7)

(Screen 8) Move to the right, views from angular cameras are also

refreshed together with top camera)

(Screen 9)

(Screen 10)
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28-7 Viewer Stamp

There is a speical stamp named "View45Stamp" for angular cameras. The area where View45Stamp is
placed, is not inspected by AOI, but when confirming AOI's inspection result, the area is shown by Angu-

lara Cameras. This stamp let operator to verify by his eyes.

V¥ How to use

1. Place the stamp where you want to confirm after inspection (Screen 1).
2. Start inspection. After inspection, the screen will be in G/NG confirmation mode. Camera

stops the area where View45Stamp is placed, and wait for human verification (Screen 2).

V¥ Setting

By double-clicking the frame of View45Stamp, the setting window opens (Screen 3). In this window, you

can set the direction to high-light while verification. Enable [Multiple] to select 3 directions to high-light.

V¥ Caution about this stamp

View45Stamp is a special stamp. This stamp is not for inspection. Therefore you can not set Search Area,

having Master picture or the other setting which ordinary stamps can do.

28-8 Connect to CS-Center

The pictures taken by angular cameras can be sent to CS-Center as well as the inspection result, and re-
confirm by the CS-Repair. The remote vefirication in angular camera screen is also possible on CS-Center.
Below or greater version of software is required to receive pictures of angular cameras;

CS-Center: Version 1.1.3.0  CS-Repair: Version 1.1.3.0

To know the angular camera operation on each software, please read manual of each software.

28-7

(Screen 1) (Screen 2) (Screen 3)
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Z Axis Unit for 22X

Z axis unit is an optional unit enables to customize focus for inspecting high components.

Conditions
- Maximum movement is 28mm to upper and 2mm to down.
- Possible to move up/down in 0.1mm digit.

- Not possible to confirm the PCB picture of customized focus on Off-Line Teaching software.

For Supervisor: Z axis

Change Height on Calibration Seal

Performs calibration at the set height.

Pull in Z axis while moving

To avoid collisions between parts and the camera, the camera is raised to the highest point on the Z-axis

when moving from and to the standby position. i22X has this enabled by default.
Display focus height in actual (1.6mm in place of ‘0%)

PCB surface height is displayed at the bottom of Z Axis icon, and current height is displayed at the top.

Inspect by Z-height order

Performs inspections in order of height along the Z-axis to reduce the inspection time.

(Screen 1)
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Operation
The purpose of Z axis is “To get best focus from thick/thin PCB” and “Inspect the text on high compo-

nent”. In this manual, the procedures are described depend on purpose.

To get best focus from thick/thin PCB

The camera maybe not on focus when treating PCB on jig or in palette, or AOI with non bottom-up clamp-

ing carrier. Wtih Z axis, you can assign height offset to PCB for getting the best focus.

1. Set PCB.
2. Press blue arrow key at the top-right corner of Work Area, select “Customize standard”.
3. Setting window is displayed. Move the slide bar up and down and select the best height.

4. The setting height is saved in the inspection program and inspection is always executed at the

height.
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Inspect the text on high component

To inspect high components, there are special 2 stamps for Z axis; one is Z Axis stamp which change the
camera focus to setting height, and the other is Z Axis Auto Focus stamp which automatically gets the

best camera focus.

How to use Z Axis stamp

Suitable to use for inspecting the text on height components such as aluminum capacitors or relays.

1. Set PCB. Move camera on the component. Draw a frame by selection tool at any place in the
Work Area (Any size is OK for drawing frame, because size will be uniform when saving as
stamp). Select Z AXis from pull down menu at the bottom (Screen 2).

*You can place Z Axis stamp at any place in the Work Area, because it is not used for

inspection or criterion.

2. Setting window will be displayed. Move the sliding bar and find the best height for the target
object (Screen 3).

3. Click OK button and save as stamp. Automatically stamp name suggestion is input for fast pro-
gramming (Screen 4).

4. Create frames for the inspection targets in the Work Area.

5. Start inspection. The Cell with Z Axis stamp will be inspected after normal Cells. After inspec-
tion, the defect will be shown by Z Axis stamp setting height while verification.

* The Cell shape is triangle which Z Axis stamp is assigned.

(Screen 2) (Screen 3)

(Screen 4) (Screen 5)
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How to use Z Axis Auto Focus stamp
Suitable for inspecting the PCB which warps random. Place this stamp in the area where tends to warp.
However, Auto Focus stamps takes double time for inspection to compare with normal Z Axis stamp. We

recommend to use normal Z Axis stamp if warping is not random but regularity.

1. Move camera on the component. Draw a frame by selection tool on the area where you want to
get the best focus. Stamp Creation Wizard will be shown up. Select Z Axis Auto Focus from
pull down menu at the bottom (Screen 1).

* Please select the area carefully when creating Auto Focus stamp. The area must be characteristic.
Do not select the area where mono-color or no text. Auto Focus does not work well. As well, do not
include high object and low object together. Auto focus may fail.

2. Setting window will be displayed. You may quit this window without doing anything, but it is
time consuming to find the best focus between 0 to 30 mm in every inspection. Therefore, it is
better to set Maximum and Minimum movement allowance. Press Sampling (Screen 2). Auto-
matically the Maximum and Minimum allowance is input (Screen 3).

3. Click OK button and frame will be saved as stamp. Automatically stamp name suggestion is in-
put for fast programming.

4. Create frames for the components in the Work Area.

5. Start inspection. The Cell with Z Axis Auto Focus stamp will be inspected after normal Cells.
After inspection, the defect will be shown by height selected by Auto Focus stamp while verifi-
cation.

* The Cell is diamond shape which Z Axis Auto Focus stamp is assigned.

(Screen 2)
(Screen 1)

(Screen 3) (Screen 4)
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Change standard focus height (Change default value)

* This operation is allowed to do only when Marantz Electronics asked to.

Normally, camera is focused to see PCB surface most clearly. However, by the position change of Z axis
chassis, you may need to assign different height (other than PCB surface). In such case, you can change
the standard focus height.

Press blue arrow key, Select “Customize standard”. Setting window appears, press Cancel button with

control and option keys. Window changes. Move camera up to desired height and press OK button.

Limitations

- It takes 2 to 3.5 times more cycle time to use Z Axis stamp than normal inspection. And it takes
4 to 5 times more cycle time to use Z Axis Auto Focus stamp.

- Z Axis Auto Focus stamp is not possible to use for the Cell where fiducial marker, Side recogni-
tion frame or Block Mark stamp exist. Z Axis stamp is possible to use any Cell.

- Bus Stop function is not possible to use.

- Not possible to be Pack stamp.

- Z Axis Auto Focus stamp is not possible to switch illumination or use camera special setting.

- Not possible to use in the program in which Block type Z assigned Cell exists.

- If you place more than one Z Axis or Z Axis Auto Focus stamp, voluntary one of the stamp is se-
lected and height is assigned.

- Z Axis and Z Axis Auto Focus stamp is out of offset target of CellAid or NewCellAid stamps.

- Picture in Work Area warps AOI with non telecentric lens. The center is better and the outer is
worse. Therefore, please move the camera for the target component to be in the center of Work
Area with non telecentric lens AOI. As well, please place Auto Focus stamp as center as pos-

sible in Work Area.

356

Z axis Unit for 22X




Assign Height by Cell Block (old method)

This method is used before Z axis stamps were developed on software older than version 4.9.0. This
method is not possible to use with Z axis stamps. And you can create maximum 20 height in an inspec-

tion program.

How to use

1. Set PCB.

2. First, make stamps for components at normal focus.

3. Move camera to where high component is. Click blue arrows at the top-right in Work Area. Se-
lect New (Screen 1).

4. A window to change height appears, move slide-bar until the component can be seen clearly
(Screen 2). If you like to adjust minutely, use step button next to slide-bar.

5. Press OK button, the color of arrow is red in customized focus.

6. Start to create stamps.

7. After finishing to assign stamps to components, make the Cells be Block which must be in-
spected at customized height. The Cells’ shape will change to triangle (Screen 3).

8. Repeat step 3 to 7 if you like to assign more customized focus.

To revert to the default height, click the arrows, then camera will be lifted down. When completed, the

color of arrows reverts to blue.

Update customized focus

If you like to change the focus afterwards, press mouse down the arrow icon at the top-right of Work Area,

keep pressing for 1.5 seconds, then setting window appears and you can modify the height.

(Screen 1)
(Screen 3)

(Screen 2)
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Conformal Coating Inspection

Inspecting whether coating agent is applied to designated area or detecting splash to prohibited area
by using special Stamp. Detect coating coverage and non-coverage to designated area with Coverage
Stamp. Detect splash to prohibited area with Splashes Stamp. These special Stamps are displayed in
Stamp template as special Stamp when conformal coating inspection function is active.

* In order to perform the inspection, the moisture-proof coating must contain a fluorescent agent.

* Two types of master picture are added from Ver.6.4.0: side lighting (UV lighting) + white lighting (main

lighting). The master picture is added in the order of side lighting image, then white lighting image.

1 Coverage Stamp

Special Stamp for coating coverage inspection whether the coating solvent is applied to designated

area. Detect non-coverage point in designated area and judge by setting.

* This special Stamp is displayed in special Stamp list in Stamp template when you are operating
conformal coating inspection function.

B How to setup

—

. Specify the area of inspection by pointer tool.
2. Select Coverage from special Stamp list. (Screen 1)

3. Coverage Setting window appears. Inspection Cell will change to the screen with
UV lighting (Screen 2).

4. If coating solvent is applied correctly, covered area is displayed in blue color by reacting
to UV lighting. However, considering the unevenness of the judgement from brightness
difference of coating solvent, inspect black colored area, which does not react to UV
lighting, for coverage/non-coverage inspection.

Click Color Pickup button. Move cursor to the area with no coating solvent. Drag and
select black colored area with no coating solvent by pressing the mouse button. (Selected
area can be outside the inspection frame)

Tolerance for extracted color will increase if you drag wide area. Indication for dragging
area is that non-covered area inside the screen turns to yellow color (Screen 3).

5. After picking up the color, click “N” at the left of “Color” and put check mark. For tolerance
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to judge non-coverage, input minimum and maximum value of longer and shorter side.
Also input the ratio of area for judgement as NG (Screen 3).

6. Confirm by clicking Test button to see whether the result will not become false NG.
After confirmation, click OK button and apply the Stamp with name.

7. When you start inspection and detect non-covered area, message “Non coverage areas
were found” is displayed. (If the result is OK, the message is “Coverage is OK".) (Screen 4)

Conformal Coating Inspection-1

(Screen 1) (Screen 2)

Yellow: Designated color area (After dragging) Tolerance

Color pickup NG is OK Color extracted
(Screen 3) (Screen 4)
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Detection result by coating thickness

If you set black color for judgement standard for non-covered area, software recognizes the coating
solvent even if small amount is applied. In case you want to detect small amount of coating solvent,
do not select black color for judgement but select blue color which is for status with coating solvent is
applied. If brightness of blue color varies with the solvent amount, increase the sample of blue color
selection or expand the tolerance.

| >

Area with selected color All area with selected color Variety of color samples

M Difficult to detect the point with thinly applied solvent if Il When you select the colors of solvent with different brightness,

inspecting with black color for non-coverage is selected. you can detect NG color which is not included to selected color.

H Color selection is up to 100 colors.

- J

2 Splashes Stamp

Special Stamp for inspecting splashes of coating solvent to prohibited area. Detect the solvent in
designated area and judge by setting.
* This special Stamp is displayed in special Stamp list in Stamp template when you are operating
conformal coating inspection function.
B How to setup

1. Specify the area of inspection by pointer tool.
2. Select Splashes from special Stamp list (Screen 1).

3. Splashes Setting window appears. Inspection Cell will change to the screen with UV
lighting (Screen 2).

4. If there is no splash of coating solvent, area is displayed in black color not reacting to
UV lighting. However, considering the unevenness of the judgement from brightness
difference of black colored part, inspect blue colored area, which reacts to UV lighting for
splashes.
Click Color Pickup button. Move cursor to the area with coating solvent. Drag and select
blue colored area with coating solvent by pressing the mouse button. (Selected area can
be outside the inspection frame)
Tolerance for extracted color will increase if you drag wide area. Indication for dragging
area is that covered area inside the screen turns to yellow color (Screen 3).
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5. After picking up the color, click “N” at the left of “Color” and put check mark.
For tolerance to judge non-coverage, input minimum and maximum value of longer and
shorter side. Also input 0% for the ratio of area for judgement as NG by detecting even
small amount of coating solvent (Screen 3).

6. Forinspection of splashes, software does not inspect primary created inspection frame
for 100% but judges the detected circumscribed rectangle area as 100% so it can detect

even small amount of splashes by putting check and activate “detect each area” function
(Screen 4).

Conformal Coating Inspection -2

(Screen 1) (Screen 2)

Yellow: Designated color area (After dragging)

Color pickup button NG is OK Color extracted
(Screen 3)
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7. Confirm by clicking Test button to see whether the result will not become false NG.
After confirmation, click OK button and apply the Stamp with name.

8. When you start inspection and detect splashes in prohibited area, message “Splashes
were found” is displayed. (If the result is OK, the message is “There were no Splashes”.)
(Screen 5)

3 Notice

+ Resolution of 10 micron lens is required to detect object less than 0.2mm.

+ Create the Stamp not by actual size but by zoomed size if you cannot detect small
splashes. There is possibility that small splashes are not detected by actual size with
less resolution.

+ Inputting too small/big value in minimum/maximum fields will give bad influence for
inspection because this can cause many false calls.

+ Up to 100 points of Splashes will be displayed. If there are more than 100 points to
inspect, some may not be displayed with red NG frame.

Conformal Coating Inspection -2

O

¥

O

Ratio of the area will increase if you activate “detect each area”.

(Screen 4) (Screen 5)

362

Conformal Coating Inspection



4 Setting Menu

1. Minimum

Set minimum size to be detected (either height or width). The size less than this value will be ignored.

2. Maximum

Set maximum size to be detected (either height or width). The size more than this value will be ignored.

3. Result
Result of test or analyzing is shown. If more than one result is detected, maximum size will be shown.

If the result is Good, shown in blue color, and if the result is Not Good, shown in red color.

4. Color pickup button

Select color with this tool.

5. Area

Judges whether the area painted with the specified color has more area than set value (%).

6. Angle
Enable to set the direction by rotating the frame from -180 to +180 degrees. By clicking up/down

button, it rotates by 15 degrees step.

Conformal Coating Inspection -4
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7. Search

Set the search area by pixel.

8. Test

Execute the inspection and check current status. Analyzing process is shown for 1 or 2 seconds.

9. Edit Mask

You can mask the area which you do not want to inspect.

10. Light

You can change the lighting. Side lighting (UV lighting) is applied for conformal coating inspection.

11. NG is OK and Color extracted

List of colors which you selected by Color pickup button. If you set the NG color, put check and
activate “N” for specified color. On the right side of the list, RGB value and tolerance is shown. You
can select maximum of 100 colors. If you have unnecessary color, you can delete it from the list by

clicking trash bin icon while selecting the color.

12. Tolerance

Show the value of tolerance for selected color.

If you set the color for Good result, defect will escape if the tolerance of color is too wide. The text color
of tolerance becomes brown at over 25, and becomes red at over 40. Confirm the risk of escaping by

text color, and it is better to add new color than increasing color tolerance.
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5 Map View

Conformal Coating AOI creates Map View by lighting both UV lighting and White lighting. This makes

easier recognition of both component inspection and conformal coating inspection.

6 Others

Inspection using white lighting is also available with Conformal Coating AQOI. It can inspect such as
component presence/absence and fiducial or polarity offset by using pattern matching and histogram

algorithm.

* Please refer to each chapter in the instruction manual for the setting of each inspection function.
* Function which requires Diffuse-On-Axis LED and Red or Blue side lighting is not available

with Conformal Coating AOIL.

Conformal Coating Inspection -5

Map View only with UV lighting Map View with both UV lighting and White Lighting
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7 UV Auto Teaching function

7-1 Initial setup
When using this function for the first time, set the starting position for creation. No further setting is

required from the next time.

Set PCB on the AQL. If you want to continue scanning after the setting, please set the good sample.
Select [Edit] - [Make coverage (Full)] from top menu to display the corner position setting menu. If
you want to edit position, [Move to start position?] message is displayed. Select [No (Set position)] to

open the setting menu.

— >

Use the Free Move tool to align the corners of the PCB with the center of the camera.

The setting position differs according to machine type and the loading direction.

Inline (direction: left-to-right) Center the lower right corner of the PCB.
Inline (direction: right-to-left) / Desktop Center the lower left corner of the PCB.

In the case of left-to-right, center the bottom right
Top of the Dual Inspection corner of the PCB; in the case of right-to-left, center

the bottom left corner of the PCB.

In the case of left-to-right, center the bottom left
corner of the PCB; in the case of right-to-left, center
the bottom right corner of the PCB.

Bottom of the Dual Inspection / Bottom
Inspection

ex) In case of Dual Inspection machine and the loading direction is left-to-right:

Center lower right

; Top
Direction | ... . - Camera
left-to-right '

Center lower left

Bottom
Camera
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Select [Set position] to register the corner, then select [Update start position] from the Gear icon.

7-2 Data creation

[ ]

This step is to scan a good sample to create an inspection program. Set the Fiducial Marks before

creating the program.

Select [Edit] - [Make coverage (Full)] from top menu, then select [Yes].

Camera moves to the registered corner position which is set on the initial settings.

[ 1

Set PCB Lengths, Loading Direction, Overlap Width and execution of uncoated areas.

Select [Next] when you finish the setting.

PCB Length(X)

PCB Length(Y)

Enter the length of PCB. If you are unsure

of the size, enter a larger number than the
actual size, because you can exclude areas
outside the range from being inspected using
the settings described below.

This setting is for OLT only. For the Desktop

Loading machine, set [Left to Right]. For the Inline
Direction machine, select the direction according to
the machine.
Widens the inspection area. This setting
Overlap Width | is used to adjust the separation of the
inspection area or to inspect a high part.
When this setting is enabled, cells
Remove no- in uncoated areas will be excluded

coated areas

from inspection during scanning. It is
recommended that this setting be enabled.
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Select the coated cell on the Cell Map Area to move the camera.

Set the inspection conditions. Select [Start] when you finish the setting.

Select Ref.Des. and numerical sequence

Ref.Des. numbers are automatically entered on the
created cells.

Frame Type Select NG-ID.

Number of Grids | Set the number of grids per side.

Detection Level

Adjusts the binarization level between the
coated area (blue) and the uncoated area (black).
Press Caps Lock key on your keyboard to
show/hide the grid.

Set the application percentage to be OK, using

Threshold the area of one grid as 100%. Grids below the
threshold are treated as masks on the first scan.
Tolerance to the threshold value that serves as
a passing criterion. In the case of the setting
shown in the image on the left, the threshold is
Tolerance

60% and the tolerance is 3%, so 57% or more
is OK. It is effective for dealing with variations at
the edge of the application area.

Example of changing the Number of Grids

Number of Grids: 6

Number of Grids: 30 Number of Grids: 60

Example of changing the Detection Level

Detection Level: 1

Detection Level: 100 Detection Level: 200
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7-3 Automatic debug function
This function adjusts the threshold value of each NG grid in the G/NG confirmation mode to stabilize

the inspection accuracy.

If you hold down the Shift key in G/NG confirmation mode, the Good button will change to [Good
+ Learn]. Pressing the [Good + Learn] button reflects the inspection result % of the NG grid to the

threshold. Decimal point values are rounded down.

Ex) If you press [Good + Learn] with a threshold of 60% and a test result of 42.8%, the threshold will

be changed to 42%.

7-4 Debugging of each grid
After setting the UV Auto Teaching, a rectangular inspection frame will be placed in the center of the

screen. Double-click on it or select it and press Enter to open the settings window and display the

grid in the work area.

UV Auto Teaching frame
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The meanings of the grid colors are as follows:

Blue Good

Red NG

The area where Coverage % is less than Threshold
when the masked grid is changed to the inspection

Yellow . o
target. The color will change to blue when it is
judged as Good in the subsequent inspection.
Masked area: not subject to inspection. Grids

No color with Coverage % less than the threshold will be

automatically masked after scanning.

The items in the setting window are as follows:

Ref.Des. Edits Ref.Des.

Frame Type Select NG-ID.

Number of Grids Value fixed. (Cannot edit)

Adjusts the binarization level between the

Detection Level coated area (blue) and the uncoated area
(black).
Changes the threshold value of the selected
Threshold .
grid.
Tolerance Changes the tolerance of the selected grid.

From here, the grid information displayed at the bottom of the
window can be changed, and the settings can be changed in bulk.

Show all Lists the information of all grids.
Show only OK Lists the information of OK grids.
Show only NG Lists the information of NG grids.

Add a check mark to all selected grids to

Set Inspection Grid ] . i
make them subjects to inspection.

Remove a check mark to all selected grids to
make them masks.

Set Mask Grid

Set Threshold to all | The thresholds entered in the input field at the
frames top of the window are reflected in all grids.

Set Tolerance to all | The tolerance entered in the input field at the

frames top of the window are reflected in all grids.

A list of the currently selected grids will be displayed at the bottom
of the setting window. The items are as follows:

Checked grids are for inspection, unchecked
grids are masked.

Checkbox

A number of the grid. They are assigned in
order from the top left to the right.

No.

The percentage of the application area

Coverage %
9e detected during scanning.

The percentage of the application area
detected in this inspection.

Result

This is the percentage of the coverage that is
Threshold

the standard for passing inspections.
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The grid you want to edit can be selected in the work area.

Multiple target grids can be selected at the same time and their settings can be changed at once.
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Height Inspection

This inspection method uses a CLASS?2 laser to measure the height of two points. Only available on

laser-equipped models.
* CLASS 2 lasers are a class of lasers that emit visible light (400 nm to 700 nm). Do not look

directly into the laser emission port, although there is no danger to the eyes if you only look at it

momentarily.

1. How to inspect

Hold down the Control key and click the mouse to select [Create height measurement position].

The reference position is indicated by an orange dot and the measurement position by a pink dot.

Adjust each position by dragging and click [OK].

Sampling to measure height is performed and the settings screen opens.

* During sampling, height measurements are performed multiple times. If you see variations in the

set height, press the Sampling button multiple times to detect the height.
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2. Setting Screen

The contents of the settings screen are as follows:

1 | Ref.Des. Edits Ref.Des.
2 | Frame Type Sets the inspection frame type.
3 | Height The height threshold at which to judge OK. The value detected by sampling
©9 is automatically entered.
4 | Sampling Run sampling and auto-detect height values.
The value of the range within which the product is judged as good if the
5 | Tolerance . L
height is different from the set value.
6 | Result Result is displayed here. Good items are indicated in blue, while defective
esu items are indicated in red.
7 | Adjust Position | Set the reference and measurement positions again.
8 | Test Judges OK/NG.
9 | Cancel Cancels height measurement.
10 | OK Determine the measurement settings and close the screen.

If OK, the reference and measurement positions turn blue. If NG, they turn red.
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3. Remarks

- Height measurements can be used as a stamp. To make it a stamp, select [New Stamp] from [Stamp]
menu or press F3 key as a shortcut.

- It can be rotated by Command + L and Command + R.

- Height inspection is performed after the usual inspection. The result is automatically sent to Catch
System.

- When one of the reference or measurement position is positioned within the inspection frame,
the height measurement follows the Packmaster and automatically adjusts position in case of
misalignment (like the image bottom-left). If neither the reference position nor the measurement
position are NOT on the inspection frame, it will not be tracked (like the image bottom-right).

- Due to the difference between the center of the camera and the laser mounting position, there may
be areas where height measurements cannot be placed if the camera reaches its travel limit. Please
check the specification sheet for details and whether there are areas where placement is not possible,

as these vary by model.

Laser

Red area cannot be inspected| \Camera
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